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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accom-
panying such products and services. Nothing herein should be construed as constituting an additional war-
ranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard com-
mercial license.

For information about third-party license agreements, see the license-agreements directory on the product

installation media.

Copyright Notices

© Copyright 2009 Hewlett-Packard Development Company, L.P.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
Portions Copyright © 1999-2003 The Apache Software Foundation. All rights reserved.

This product includes ASM Bytecode Manipulation Framework software developed by Institute National de
Recherche en Informatique et Automatique (INRIA). Copyright © 2000-2005 INRIA, France Telecom. All
Rights Reserved.

This product includes Commons Discovery software developed by the Apache Software Foundation
(http://www.apache.org/). Copyright © 2002-2009 The Apache Software Foundation. All Rights Reserved.

This product includes Netscape JavaScript Browser Detection Library software, Copyright © Netscape
Communications 1999-2001

This product includes Xerces-J xml parser software developed by the Apache Software Foundation
(http://www.apache.org/). Copyright © 1999-2002 The Apache Software Foundation. All rights reserved.

This product includes software developed by the Indiana University Extreme! Lab (http://ww-
w.extreme.indiana.edu/). Xpp-3 Copyright © 2002 Extreme! Lab, Indiana University. All rights reserved.

Trademark Notices

DOM4J® is a registered trademark of MetaStuff, Ltd.

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations)
on all HP 9000 computers are Open Group UNIX 95 branded products.

Java™ is a US trademark of Sun Microsystems, Inc.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Oracle Technology — Notice of Restricted Rights

Programs delivered subject to the DOD FAR Supplement are ‘commercial computer software’ and use,
duplication, and disclosure of the programs, including documentation, shall be subject to the licensing
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restrictions set forth in the applicable Oracle license agreement. Otherwise, programs delivered subject to
the Federal Acquisition Regulations are ‘restricted computer software’ and use, duplication, and disclosure
of the programs, including documentation, shall be subject to the restrictions in FAR 52.227-19, Com-
mercial Computer Software-Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Red-
wood City, CA 94065.

For the full Oracle license text, see the license-agreements directory on the NNMi product DVD.
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Introduction for NNMi Administrators

As an NNMi administrator, you can use the console to configure the items described in the following table.

What You Can
Configure Description

Sign-In Access
to NNMi

Using the User Accounts and Roles option in the Configuration workspace, provide
and control access to NNMi . Configure a name and password for each user. Assign a
role to each user.

Tip: If your environment manages user names and passwords with a directory service,
NNMi can be configured to use Lightweight Directory Access Protocol (LDAP)
instead of the settings in the Configuration → User Accounts and Roles view.

See "Controlling Access to NNMi" (on page 32) for more information.

ICMP and
SNMP Com-
munication Pro-
tocols

Using the Communication Configuration option in the Configuration workspace, pro-
vide the SNMPv1 or SNMPv2c community strings for your network environment, or pro-
vide the SNMPv3 user names for your network environment. Configure NNMi settings
for timeout, retry, and port usage for ICMP and SNMP traffic. See "Configuring Com-
munication Protocol" (on page 47) for more information.

Discovery Using the Discovery Configuration option in the Configuration workspace, configure
NNMi to discover only those devices that are important to you and your team. See "Dis-
covering Your Network" (on page 76) for more information.

Filters Using the Node Groups and Interface Groups options in the Configuration work-
spaces, define filters. These filters identify groups of devices. Use the filters to quickly
locate information in views. See "Creating Groups of Nodes or Interfaces" (on page
126) for more information.

You can also monitor the health of each group, see "Configure Monitoring Behavior"
(on page 152).

Monitoring Net-
work Health

Using the Monitoring Configuration option in the Configuration workspace, define
how and how often important devices are monitored by NNMi . See "Monitoring Net-
work Health" (on page 151) for more information.

Incidents Using the Incident Configuration option in the Configuration workspace, review the
many predefined incident configurations provided by NNMi . Edit any of the con-
figurations provided by NNMi or create your own . See "Configuring Incidents" (on
page 211) for more information.

Actions Menu Using the URL Actions option in the Configuration workspace, configure the Actions
menu. Add actions that you want to provide to your team. Modify the Actions provided
by NNMi . See "Extending NNMi Capabilities" (on page 302) for more information.

Management
Stations

Using the Management Stations option in the Configuration workspace, configure
how events that are received from NNM 6.x or 7.x management stations are handled
by NNMi . See "Configure Remote NNM 6.x and 7.x Management Stations" (on page
262) for more information.

Configure NNMi
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NNMi provides a variety of tools to assist you with these configuration tasks. Each of these tools is
described in the following table. You can extend NNMi using an HP Smart Plug-in (iSPI) as described in
"Extending NNMi Capabilities" (on page 302).

Tool Description

Configuration
Workspaces

The console provides a workspace for each kind of item you can configure in NNMi . See
the preceding "Configure NNMi " table for more information.

Lookup
Fields

Provided in forms, fields that include the icon provide access to a list of all avail-

able attribute values, and in some locations enable you to create attribute values. See
"Lookup Fields" (on page 18) for more information.

Actions Used to perform automated tasks on a single object or on a group of objects. For exam-
ple, you can use the Actions menu to change the Management Mode of one or more
nodes from Managed to Out of Service.

Actions are available from table views, map views, and forms.

See "Perform Automated Tasks" (on page 21)for more information

NNMi Proc-
esses and
Services

NNMi is built on a group of processes and services. You can list these processes and
services. You can stop and start individual processes and services. See "NNMi Proc-
esses and Services" (on page 25) for more information.

NNMi Administrator Tools

Administrator Tools in the Console

When configuring settings for NNMi, you create configuration object instances. For example, to create a
new URL action, you must create a new URL action instance. As another example, to specify configuration
settings for discovery, you might create object instances that contain ranges of IP addresses that you want
NNMi to use as hints for Spiral Discovery.

The console provides the following tools to assist you with configuration tasks:

l "Configuration Workspaces" (on page 16)

l "Lookup Fields" (on page 18)

l "Create a Configuration Object Instance Using the Form Toolbar" (on page 20)

l "Delete One or More Objects" (on page 20)

Quick Start Configuration Wizard

Note: Before you use the Quick Start Configuration Wizard, complete the initial configuration checklist. See
Help → Documentation Library → Installation Guide for more information.

The Quick Start Configuration Wizard automatically runs immediately after Network Node Manager (NNMi)
installation completes. Use the Quick Start Configuration Wizard to configure NNMi in a limited (or test)
environment. The Quick Start Configuration Wizard helps you to complete the following initial set up tasks:

l Provide the community strings for your SNMPv1 or SNMPv2c environment

l Provide the USM settings for your SNMPv3 environment

Page 15 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Introduction for NNMi Administrators

l Discover a limited range of network nodes

l Set up an initial administrator account

You can launch the wizard using the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/quickstart/

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: HP recommends that you run the Quick Start Configuration Wizard only one time mmediately after
NNMi installation.

After using the Quick Start Configuration Wizard to set up a test network, see "Configuration Workspaces"
(on page 16) for information about completing additional NNMi configuration tasks.

Configuration Workspaces

NNMi administrators use the Configuration workspaces to configure the following items related to NNMi.

Note: On tables in configuration forms, if the cursor changes to indicate a hyperlink when you mouse over
a column heading, you are able to sort the column’s data. You cannot change the sort on some of
the tables on the forms in the configuration workspace.

Name Description

Communication
Configuration                 

Used to configure how NNMi uses ICMP and SNMP in your network environment.                 

Discovery Con-
figuration                 

Used to specify the devices to be discovered.

Monitoring Con-
figuration                 

Used to enable the NNMi State Poller.                 

Incident Con-
figuration                 

Used to specify the information displayed with an incident, including its name, the mes-
sage you want to be displayed, the way it should be categorized, its initial status, and
how you want to identify duplicate traps.                 

Status Con-
figuration

Enables an NNMi administrator to configure Node Group status calculations using
either of the following methods:

l Assign the Node Group the most severe status of any Node Group member. This is
the default.

l Configure the percentage thresholds for one or more Node Group target statuses.

User Interface
Configuration

Enables an NNMi administrator to configure the following user interface features:

l The console time out interval

l The maximum number of nodes that display on a map

l Whether NNMi displays unlicensed features that require a special license, such as

NNMi Configuration Workspaces
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Name Description

NNMi Advanced

Node Groups Used to group your devices for viewing and monitoring purposes.

Node Group
Map Settings

Used to specify the Node Group and background image to be used in a Node Group
map. Map settings include the following:

l Node group name

l The order in which Node Group maps should appear in the Topology workspace

l Minimum role for saving edited locations for each node in the map

l Refresh information

l Connectivity information

l Background image URL

l Background image scale

Interface
Groups

Used to group your devices for viewing and monitoring purposes.

RAMS Servers Used to specify the RAMS appliance and the associated RAMS database to be used
with NNMi when calculating a Path View between devices with IPv4 addresses.

Management
Stations

Used to configure NNM 6.x or 7.x management stations so that they forward events to
NNMi.

User Accounts
and Roles

Used to assign NNMi users to NNMi roles.

Note: If NNMi role assignments are stored in your environment's directory service data-
base, this view is not needed and is not visible. See "Control Access with a
Directory Service" (on page 40).

User Principals This view stores NNMi user names. Principal object instances are automatically
created when you configure access to the NNMi console (using the User Accounts and
Roles view) according to the following scenarios: "Control Access with NNMi
Accounts" (on page 35) and "Control Access Using Both Directory Service and NNMi"
(on page 37).

Note: If NNMi role assignments are stored in your environment's directory service data-
base, this view is not needed and should remain empty. See "Control Access
with a Directory Service" (on page 40).

URL Actions Used to add actions to the Actions menu that you want to be available to your oper-
ators or to other administrators.

IfTypes Provides a list of interface types. NNMi administrators use these ifTypes to define Inter-
face Groups.

Device Profiles                  Stores information about a type or family of device. Device profile information includes
the SNMP object ID, model, and vendor. Use the Device Profile workspace to see and
edit device profile information.
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Lookup Fields

Lookup fields have the following icon: .

The Lookup field represents an associated object instance. For example, an Incident form has an asso-
ciated Source Node attribute. Information about this source node is available in and accessed through the
Lookup field.

Option Description

 Quick
 View

See a subset of information about the selected object. (Use  Open to see all available infor-

mation about this object.)

 Quick
 Find

Display a list of valid choices for populating the current attribute field.

 Open

Open the form for the related object instance that is currently selected in the lookup field.
Review all attributes of the related object. Depending on your role, you can edit these attributes.

 New

Create a new object instance to relate to the current object.

Possible Drop-Down Menu Options in Lookup Fields

You can use Lookup fields in a variety of ways:

l Read-only fields - to provide additional information about the associated object. Click  Quick

View or  Open to see the details of this object.

l Selection fields - to change the association to another object instance. Click  Quick Find to select
from a list of previously configured objects ("Use the Quick Find Window" (on page 19)).

Or type a case-sensitive string into the input box ("Use Autocomplete" (on page 19)).

l Read-write fields - create an entirely new object instance for this association. Click  New. An
empty form opens for you to fill in, creating a new object instance.
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Use the Quick Find Window

The  Quick Find option is available only in Lookup fields that are modifiable. Use the  Quick Find
option to see the list of available object instances appropriate for populating the current Lookup field.

To list all existing object instances that could be related to the current object:

1. From the lookup field of interest, click the  Look up icon:

2. Select  Quick Find.

NNMi displays a table view of object instances that are available to associate with to the current
object instance.

3. In the Quick Find window, do one of the following:

n Click the  Make Empty icon to remove an association with this object. The Quick Find window
closes, and the current lookup field is empty.

n Click the  Select This Item icon that precedes the table row containing an object instance. The
Quick Find window closes, and the object instance you selected populates the current lookup
field.

n Click the  Quick View icon to display a subset of available object attributes.

n Click the  Close icon to return to the previous form.

Use Autocomplete

The autocomplete feature is available only in Lookup fields that are modifiable. As you type, NNMi lists the
available object instances for populating the current Lookup field.

To use the autocomplete feature:

1. Start typing the first few letters (case-sensitive) of the name of the object you want to associate with
the current one.

The Lookup field displays a drop-down list below the input field. This list includes all potential exist-
ing objects with names that match the letters as you enter them.
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2. Use the scroll arrows or the mouse to select from the displayed list.

The selected object populates the lookup field and is now associated with the current object.

Create a Configuration Object Instance Using the Form Toolbar

You can save time by generating a new form from within another form. The new form is based on the
object type for the original form and contains only the default values set by NNMi for particular attributes for
that object. Any attributes that have no default value appear blank.

This tool is useful when you want to create multiple object instances that have similar attribute values.

To create a new object instance using the form toolbar:

1. Open the form representing the object of interest.

2. From the form toolbar, click the Save and New icon.

A new form appears that contains the default attribute values for the object type represented by the
original form.

3. Select the Save and Close icon to save your changes and return to the view.

Delete One or More Objects

Each row in a table view and each symbol in a map view represents an instance of the object type being
displayed. For example, in a node view, each row of the table represents an instance of a node in your net-
work.

NNMi administrators can delete object instances. For example, you might need to delete a node that is no
longer being managed.

All objects related to the deleted object are also deleted. For example, if a node object is deleted, all of its
interfaces, network addresses, and its SNMP Agent are deleted. Related connections with either zero or
one end points remaining are deleted. Related subnets and VLANs with zero remaining members are
deleted.

To delete an object instance:

1. Select the object of interest:

n In a table view, select the check box in the row that represents the object.

n In a map view, click the map symbol.

n In a form, proceed to step 2.

2. To delete the object, click the  Delete icon.

The object is deleted from the NNMi database and removed from the current view.

To delete multiple object instances:

1. Select the objects of interest:
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n In a table view, do one of the following:

o Select the check box in the row that represents each object you want to delete.

o Select the check box above the check-box column to select all objects in the veiw.

n In a map view, CTRL-Click each map symbol.

2. To delete the objects, click the  Delete icon.

Note: For Node objects, you can use this method to delete up to 20 nodes at one time. You can use
the command line method to delete any number of nodes. See "Delete Nodes" (on page 122)
for more information.

Tip: For all other objects, you can delete any number.

Each object is deleted from the NNMi database and removed from the current view.

Perform Automated Tasks

Use the Actions menu to perform automated tasks on a single object or on a group of objects. For example,
you can use the Actions menu to change the Management Mode of one or more nodes from Managed to
Out of Service.

Actions are available within table views, map views, or forms. When in a view, you can access actions from
the console main menu toolbar. If you are in a view that is launched in a separate window, you can access
actions from the view window menu bar. When in a form, you access actions from the form menu bar.

Note: Only those actions that apply to the current object appear in the Actions menu. For example, in an
incident view, close one or more incidents by using the Close action.

To invoke an action from a table or map view:

1. Select the object of interest:

n In a table view, select the  check box that precedes the object information.

n In a map view, single-click the object.

2. In the menu toolbar, click Actions.

3. Select an action from the list of available actions.

For example, from an incident view, select Actions → In Progress to change the lifecycle state of an
incident to In Progress.

To invoke an action from a form:

1. If you do not have a form open:

a. From the workspace navigation panel, select the table view you want to access.

b. In the table view, locate the object (a row in the table).

c. Click the  Open icon in that row to open the object instance (for example, node).

2. In the menu toolbar, click Actions.

3. Select an action from the list of available actions.

For example, from an incident view, select Actions → In Progress to change the lifecycle state of an
incident to In Progress.
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Note: If you are running an action from a form, the action takes effect immediately. This means you do
not have to select Save.

If you are accessing an action from a map, note the following:

l You must select a node, interface, or address before you can access the following actions:

n Manage

n Out of Service

n Unmanage

l You must select a node or interface to access the Manage (Reset All) action.

l (NNM iSPI NET). You must select a node to access the Show Attached End Nodes action. See Dis-
play End Nodes Attached to a Switch for more information.

See "Actions Provided by NNMi" (on page 22) for information about the actions provided by NNMi.

Actions Provided by NNMi

The following tables describe the actions provided by NNMi:

Actions Provided for Incidents

Actions Provided for Nodes

Actions Provided for Interfaces

Actions Provided for Addresses

Actions Provided for Node Groups

As shown in the table, the actions available depend on the object selected.

Note: You can also use the Actions menu to access views and possibly NNM 6.x/7.x features. See Access
NNM 6.x and 7.x Features for more information about the available NNM 6.x/7.x actions.

Action Description

Close Changes the lifecycle state to Closed for the selected incident.

Completed Changes the lifecycle state to Completed for the selected incident.

Configuration
Poll

Launches a real-time configuration check of the selected device to detect any changes
since the last discovery cycle.

Delete Deletes the selected object or objects.

Node Group
Map

Displays the lowest level Node Group map to which the Source Node belongs. For exam-
ple, if the node belongs to a Child Node Group, the Child Node Group displays.

If the Source Node is a member of more than one Node Group at the lowest level, NNMi
prompts you to select the Node Group map you want to display.

If the incident's Source Object is an Island Node Group, NNMi displays the Island Node
Group map.

Note: Incidents whose Source Object is an Island Node Group include Remote site in
the incident message. See "Help for Operators" for more information.

When the selected Source Node is not a member of any Node Group, and you select the

Actions Provided for Incidents
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Action Description

Node Group Map action, NNMi displays an information message.

Node Group
Members

Island Node Group incidents only. Displays a table of the nodes that are members of the
Island Node Group that is the Source Object for the selected incident.

Note: Incidents whose Source Object is an Island Node Group include Remote site in
the incident message.

Own Incident Assigns the incident to the current user. This user name appears in the Assigned To col-
umn of the incident view.

In Progress Changes the lifecycle state to In Progress for the selected incident.

Ping Tests whether a node is reachable using the ping command.

Run Diag-
nostics

If you have NNM iSPI NET, gathers diagnostic information from the Source Node.

Source Node Displays the node form of the source node object instance.

Source
Object

Displays the form of the source object instance.

Status Poll Launches a real-time check of the state of the selected device. If the state has changed,
NNMi calculates an updated status reading for the selected device.

Trace Route Traces a route path using the traceroute command.

Telnet Establishes a connection to a node to view or change configuration information.

Unassign Inci-
dent

Removes the user name from the Assigned To column of the incident view.

Action Description

Communication
Settings

Displays the communication configuration information for the selected node.

Configuration
Poll

Launches a real-time configuration check of the selected device to detect any changes
since the last discovery cycle.

Delete Deletes the selected object or objects (maximum 20).

To delete more than 20 nodes, see the nnmnodedelete.ovpl Reference Page.

Manage Changes the Management Mode of the selected node to Managed. Leaves the Direct
Management Mode of any contained interfaces and addresses unchanged.

Manage (Reset
All)

Changes the Management Mode of the selected node to Managed. Sets the Direct
Management Mode of all contained interfaces and addresses to Inherited.

Monitoring Set-
tings

Checks the monitoring configuration settings that were set for a particular node, inter-
face, or IP address.

Node Group
Map

Displays a current map of the node group to which the node belongs. The map shows
all nodes that belong to the node group.

Actions Provided for Nodes             
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Action Description

Out of Service Changes the Management Mode of the selected node to Out of Service. Leaves the
Direct Management Mode of any contained interfaces or addresses unchanged.

Ping Tests whether a node is reachable using the ping command.

Run Diag-
nostics

If you have NNM iSPI NET, gathers diagnostic information on the current node.

Show Attached
End Nodes

If you have NNM iSPI NET, displays information about the end nodes that NNMi deter-
mines are attached to the specified switch.

Status Poll Launches a real-time check of the state of the selected device. If the state has
changed, NNMi calculates an updated status reading for the selected device.

Telnet Establishes a connection to a node to view or change configuration information.

Trace Route Traces a route path using the traceroute command.

Unmanage Changes the Management Mode of the node to Not Managed. Leaves the Direct Man-
agement Mode of any contained interfaces and addresses unchanged.

Action Description

Manage Changes the Direct Management Mode of the interface to Inherited. Leaves the Direct Man-
agement Mode of any associated addresses unchanged.

Manage
(Reset All)

Changes the Management Mode of the interface to Inherited. Changes the Direct Man-
agement Mode of any associated addresses to Inherited.

Monitoring
Settings

Checks the monitoring configuration settings that were set for a particular node, interface,
or address.

Node
Group Map

Displays a current map of the Node Group to which the node (containing this interface)
belongs. The map shows all nodes that belong to the Node Group.

Out of Serv-
ice

Changes the Management Mode of the interface to Out of Service.

Unmanage Changes the Management Mode of the interface to Not Managed. Leaves the Direct Man-
agement Mode of any associated addresses unchanged.

Actions Provided for Interfaces             

Action Description

Configuration
Poll

Launches a real-time configuration check of the selected device to detect any changes
since the last discovery cycle.

Manage Changes the Direct Management Mode of the address to Inherited.

Monitoring
Settings

Checks the monitoring configuration settings that were set for a particular node, inter-
face, or address.

Actions Provided for Addresses             
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Action Description

Configuration
Poll

Launches a real-time configuration check of the selected device to detect any changes
since the last discovery cycle.

Node Group
Map

Displays a current map of the Node Group to which the node (containing this IP address)
belongs. The map shows all nodes that belong to the Node Group.

Out of Serv-
ice

Changes the management mode of the address to Out of Service.

Ping Tests whether a node is reachable using the ping command.

Telnet Establishes a connection to a node to view or change configuration information.

Trace Route Traces a route path using the traceroute command.

Unmanage Changes the management mode of the address to Not Managed.

Action Description

Node Group Map Displays a current map of all nodes that belong to the selected Node Group.

Show All Inci-
dents

Checks for any Incidents associated with the selected Node Group.

Show All Open
Incidents

Checks for any open Incidents associated with the selected Node Group.

Show Members Displays a list of all nodes that belong to the selected Node Group.

Status Details Launches a real-time status check of the selected Node Group to detect any
changes since the last discovery cycle.

Actions Provided for Node Groups             

Action Description

Monitoring
Settings

Checks the monitoring configuration settings that were set for the Router Redundancy
Member, Tracked Object, or Node Component.

Actions Provided for Router Redundancy Member, Tracked Object, and Node Component             

NNMi Processes and Services

NNMi is built on a group of processes and services. For information about each process or service, see the
following:

l "About Each NNMi Process" (on page 26)

l "About Each NNMi Service" (on page 26)

To verify that everything is running properly, you can use the ovstatus command:

l "Verify that NNMi Processes Are Running" (on page 26)
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About Each NNMi Process

Process
Name Description

OVsPMD                  The control process that manages all the other NNMi processes.                 

pmd                  Event Post Master daemon. This process routes events from the producers to the con-
sumers. Producers of events are NNM 6.x/7.x management stations and processes. Con-
sumers of events are the event pipeline and third party applications.                 

ovjboss                  The process that controls the jboss application server that contains all of the NNMi Services
(see "About Each NNMi Service" (on page 26) for more information).                 

nmsdbmgr NMS Database Manager. Controls the NNMi embedded database, including periodic data-
base connectivity testing.

HP Network Node Manager Processes

Verify that NNMi Processes Are Running

After you install Network Node Manager, a group of processes run on the NNMi management server.

To verify that all NNMi processes are running, do one of the following:

1. Select Tools → NNMi Status to display a report.

2. At the command line, type: ovstatus –c

See the ovstatus Reference Page for more information.

Review the list of processes to ensure that all are running. For more information about each process, see
"About Each NNMi Process" (on page 26).

Stop or Start an NNMi Process

You can stop and start NNMi processes from the command line. See the ovstop and ovstart Reference
Pages for more information.

To stop or start an NNMi process:

At the command line, type the appropriate command:

ovstop <process name>

ovstart <process name>

To generate a list of process names, see "Verify that NNMi Processes Are Running" (on page 26).

About Each NNMi Service

NNMi Services run inside the ovjboss process. The ovjboss process controls the jboss application server
that contains all of the NNMi services.

ovjboss Service Name Description

CommunicationParametersStatusService Tracks internal statistics for measuring SNMP and ICMP con-
figuration performance.

HP Network Node Manager Services
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ovjboss Service Name Description

IslandSpotterService Auto discovers the Island Node Groups using Layer 2 con-
nectivity information in the topology.

ManagedNodeLicenseManager Managed Node License Manager. Responsible for ensuring
that the number of managed nodes does not exceed the
NNMi license capacity.

ModelChangeNotificationAdapter Emits notifications when certain model changes happen (dis-
covery seeds, global settings, Spiral Discovery configuration,
management node).

MonitoringSettingsService Calculates how to monitor each device based on the Mon-
itoring Configuration settings. 

NamedPoll NMS Named Poll Service. Used to trigger immediate state
polls for monitored objects. Used by the Causal Engine dur-
ing neighbor analysis and interface up/down investigations.

NmsApa NMS Active Problem Analyzer (APA) service determines the
root cause of network problems and reports the root cause to
the NMS Event Service. The Causal Engine is a key com-
ponent of the NNMi APA service.

NmsDisco                  NMS Discovery Service. Adds new devices to the database
and keeps the configuration of the managed devices up to
date in the database by periodically rechecking the con-
figuration of the devices.

State Poller uses the Discovery service results to determine
what to monitor.

The Causal Engine depends on the Discovery service to mon-
itor node configurations. The Causal Engine uses the con-
figuration information when calculating status and root cause.

NNMi uses the information provided by the Discovery service
to maintain current device configuration information.

NmsEvents                  NMS Events Service. Populates and manages the infor-
mation displayed in the incident table. The information dis-
played comes from the other NNMi services that are running
on your system. The incidents are filtered so you see only the
most important information about your network.

NmsEventsConfiguration Handles incident configuration changes.

NmsModel                  NMS Topology Model Service. Enables communication
between NNMi services and the NNMi database.

SpmdjbossStart                  The SpmdjbossStart service interacts with the OVsPMD proc-
ess during startup (ovstart), shutdown (ovstop), and reporting
on the status of the ovjboss services (ovstatus –v ovjboss).

StagedIcmp                  Used by the State Poller to ping IP addresses using the Inter-
net Control Message Protocol (ICMP). Also used by Auto-Dis-
covery if Ping Sweep is enabled.
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ovjboss Service Name Description

StagedSnmp                  Used by the State Poller and Discovery to perform Simple
Network Management Protocol (SNMP) read-only queries.

StatePoller                  NMS State Poller Service. State Poller collects meas-
urements that assess the current state of discovered devices.
This information is provided for the Causal Engine to use
when calculating device health.

ovjboss Service Name Log File

RbaManager Used by NNM iSPI NET. Controls diagnostics execution.

NNM iSPI NET Required.

Verify that NNMi Services Are Running

After you install Network Node Manager, a group of services run on the NNMi management server. For
information about each service, see "About Each NNMi Service" (on page 26).

To verify that all NNMi services are running, do one of the following: 

l Select Tools → NNMi Status to display a report. 

l At the command line, type: 

ovstatus –v ovjboss

See the ovstatus Reference Page for more information.

Review the list of services to ensure that all are running.

"Service is started" means this service is working properly.

"Service is stopped" means this service/process is not running.

If you see any of the messages in this list, investigate the log files and look for the keyword Exception
(within the log file for the parent ovjboss process and the log file for the specific service, possible services
are listed in the table below ):

"Service is in created state"
"Service is in failed state"
"Service is in registered state"
"Service is in destroyed state" 
"Service is in started state" 
"Service is in starting state" 
"Service is in stopped state" 
"Service is in stopping state" 
"Service is in unregistered state" 

Log files are found in the following location:

l Windows:
<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
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 Software\log\nnm\<name>.%g.%u.log

<drive> is the drive on which NNMi is installed.

l UNIX:
/var/opt/OV/log/nnm/<name>.%g.%u.log

%g = Zero (0) for active log files. Any other number means an archived log file from previous restarts or
from reaching log file size limits. See logging.properties for information about controlling the number of
archives saved for each log file or for controlling the size of each log file.

%u = Zero (0) unless the parent ovjboss process failed during a logging session. While a service is log-
ging information, the service creates a file named <serviceName>.0.0.log.lck (the lock file). The pres-
ence of this lock file prevents other services from writing to the <serviceName>.0.0.log file. The service
deletes the lock file when it finishes logging. If a <serviceName>.0.0.log.lck file already exists, the
service creates <serviceName>.0.1.log.lck file and writes to the <serviceName>.0.1.log file.

The parent ovjboss process generates the following log files:

l ovjboss.log and ovjboss.log.old

l jbossServer.log and jbossServer.<date>.log

Note: Each restart creates a new ovjboss.log and overwrites the ovjboss.log.old. Each day a new
jbossServer.log file is created, and the previous day's file is renamed by inserting a date stamp
jbossServer.<date>.log

The following table describes the ovjboss services and the log file each service generates.

ovjboss Service Name Log File

CommunicationParametersStatusService snmp.%g.%u.log

ManagedNodeLicenseManager nmslic.%g.%u.log

ModelChangeNotificationAdapter nmsmodel.%g.%u.log

MonitoringSettingsService mon-config.%g.%u.log

NMSLogManager admin.%g.%u.log

NamedPoll statepoller.%g.%u.log

NmsApa apa.%g.%u.log

NmsDisco disco.%g.%u.log

NmsEvents events.%g.%u.log

NmsEventsConfiguration events.%g.%u.log

NmsModel nmsmodel.%g.%u.log

NmsNotification nmsmodel.%g.%u.log

NmsNotificationDestinationManager nmsmodel.%g.%u.log

SpmdjbossStart admin.%g.%u.log

Log File Names for Each ovjboss Service
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ovjboss Service Name Log File

StagedIcmp snmp.%g.%u.log

StagedSnmp snmp.%g.%u.log

StatePoller statepoller.%g.%u.log

Stop or Start NNMi Services

You can stop or start all NNMi services at the same time. You cannot start and stop individual services.
See the ovstop and ovstart Reference Page for more information

To stop or start the NNMi services:

At the command line, type the command:

ovstop ovjboss

ovstart ovjboss
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Use NNMi Help Anywhere, Anytime

The NNMi Help system can run independently from the console. Simply unzip the files into any convenient
location.

To locate the NNMi Help files, on the NNMi management server, navigate to the location appropriate for
the NNMi management server's operating system (see table).

Operating
System NNMi Help System Files

Windows <drive>:\Program Files (x86)\HP\HP BTO
 Software\nonOV\jboss\nms\server\nms\deploy\nnmDocs_en.war

<drive> is the drive on which NNMi is installed

UNIX /opt/OV/nonOV/jboss/nms/server/nms/deploy/nnmDocs_en.war

Location of the NNMi Help System

To access Help independently from the console:

1. Copy the web archive file nnmDocs_en.war to any convenient location.

2. At the command prompt, navigate to the directory where you placed the nnmDocs_en.war file. To
extract the help directory structure and files, type:

jar xvf nnmDocs_en.war

Tip: You can also use WinZip on Windows to decompress the nnmDocs_en.war file.

3. Navigate to and open the /htmlHelp/nmHelp/nmHelp.html file.

4. The NNMi Help system runs as usual in the default browser window.

5.

To Access a PDF version of the NNMi online help:

Go to: http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport ID. To obtain an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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Controlling Access to NNMi

As administrator, you control who accesses the NNMi console. The role you assign to each user deter-
mines which workspaces and actions are available within the NNMi console. To accomplish this, configure
the following:

l "Configure Sign-In Access" (on page 32)

l "Set Up Command Line Access" (on page 42)

l "Audit NNMi User Activity" (on page 43)

Tip: You can configure the NNMi management server to use https/SSL so that data passed between client
and server is encrypted. (See the "Enabling https for NNMi" chapter in the HP Network Node Manager
i-series Software Deployment Guide, which is available at: http://h20230.www2-
.hp.com/selfsolve/manuals)

When configuration is complete, share information about NNMi with your team:

l "Communicate to Your Team" (on page 44)

Configure Sign-In Access

First decide which pre-defined NNMi role is appropriate for each user in your environment:

l "Roles Provided in NNMi" (on page 32)

Then choose how to configure access to the data required for NNMi logins:

1. "Control Access with NNMi Accounts" (on page 35)
User names, passwords, and role assignments are stored in the NNMi database.

2. "Control Access Using Both Directory Service and NNMi" (on page 37)
User names must be stored in both the directory service database and the NNMi database. Pass-
words are stored in the directory service database. Role assignments are stored in the NNMi data-
base. NNMi communicates with the directory service using Lightweight Directory Access Protocol
(LDAP).

3. "Control Access with a Directory Service" (on page 40)
User names, passwords, and role assignments are stored in the directory service. NNMi com-
municates with the directory service using Lightweight Directory Access Protocol (LDAP).

User Name Password Role Mapping

1 NNMi                      NNMi                      NNMi                     

2 Both                      Directory Service                      NNMi                     

3 Directory Service Directory Service Directory Service

Which Database Stores the Information?

Roles Provided in NNMi

As NNMi administrator, you assign a preconfigured NNMi role to each NNMi user. (For more information,
see "Configure Sign-In Access" (on page 32).)
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User roles determine access to the NNMi console workspaces, forms, and actions. NNMi provides the fol-
lowing roles:

l Administrator

l Operator Level 2

l Operator Level 1

l Guest

You cannot create additional roles or change the names of the roles that NNMi provides.

Caution: Do not use the system role or Web Service Client role. NNMi provides the system role for
accessing NNMi the first time during installation and for command line access (see "Set Up Com-
mand Line Access" (on page 42)). NNMi provides a special Web Service Client role to provide
access for software that is integrated with NNMi.

For details about each predefined NNMi role:

l "Determine which NNMi Role to Assign" (on page 33)

l "Access to Forms" (on page 322)

l "Access to Workspaces" (on page 322)

l "Access to Commands" (on page 323)

Tip: NNMi administrators control which roles can access a small subset of Action menu items (see
"Control Menu Access" (on page 34)) and set role permissions for Node Group map modifications
(see "Configure Basic Settings for a Node Group Map" (on page 200)).

Determine which NNMi Role to Assign

Before configuring NNMi sign-in access for your team, determine which predefined NNMi role is appro-
priate for each team member. The roles are hierarchical, meaning the higher level roles include all priv-
ileges of the lower roles in the hierarchy (Administrator is highest, Guest is lowest). See also additional
information about how access to Actions is controlled by role.

As NNMi administrator, you can change a few aspects of role definitions:

l You can restrict access to certain URL actions (provide tighter security than the predefined NNMi roles
enforce). See "Configure URL Action Basic Behavior" (on page 303) for more information about con-
figuring actions.

l You can set role permissions for Node Group map modifications, see "Configure Basic Settings for a
Node Group Map" (on page 200).

Role Workspaces Actions Menu Items

Administrator All workspaces (see the
Views Provided by NNMi)

All actions available in other roles, plus Communication Set-
tings

Operator
Level 2

Incident Management,
Topology Maps, Mon-
itoring, Troubleshooting,
Inventory, Management
Mode, and Incident Brows-
ing

All actions available in Operator Level 1 role, plus Telnet,
Configuration Poll, Status Poll

Role Permissions
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Role Workspaces Actions Menu Items

Operator
Level 1

Incident Management,
Topology Maps, Mon-
itoring, Troubleshooting,
Inventory, and Incident
Browsing

Ping, Trace Route, Monitoring Settings

NNM iSPI NET. Run Diagnostics

Show Members, Show All Incidents, Show All Open Inci-
dents (Node Group views only, see Node Group and Inter-
face Groups for more information about Node Group
actions.)

6.x/7.x Neighbor View, 6.x/7.x Details, 6.x/7.x ovw, 6.x/7.x
Home Base, 6.x/7.x Launcher, SNMP Viewer, Alarms (you
must configure an NNM 6.x/7.x Management Station, see
Access NNM 6.x and 7.x Features from NNMi for more infor-
mation about 6.x/7.x actions.)

Guest Read-only access to the
same views as the Oper-
ator Level 1 role (see
above).

Because users assigned to
Guest role have read-only
access, they cannot make
any changes to NNMi or to
NNMi objects.

No access to actions.

Web Service
Client

Do not assign users on your team to the Web Service Client role. Any login attempt using
this Role results in errors that require restarting your browser.

system Do not assign users on your team to the system role.

Note: You control access to NNMi command line commands. See "Set Up Command Line Access" (on
page 42) for more information.

See About Workspaces for more information about workspaces. See Views Provided by NNMi for more
information about the views provided in each workspace.

Control Menu Access

Access to the Tools and Actions menu items is controlled by user role. (See "Determine which NNMi Role
to Assign" (on page 33) for additional information about role limitations.)

Note: You can restrict access to certain URL actions (provide tighter security than the predefined NNMi
 roles enforce). See "Configure URL Action Basic Behavior" (on page 303) for more information
about configuring actions.

Role Based Access the Tools Menu:

Access to the NNMi Tools menu items is determined by user role.

Tools Menu Item Lowest Role (Security Check)

Find Node Not Applicable

NNMi Status Operator Level 1

Sign In/Sign Out Audit Log Administrator

NNMi Tools Menu Access Limitations
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Role Based Access the Actions Menu:

Access to the NNMi Actions menu is determined by user role.

Note: All menu items are visible, but an Access Denied message displays when any user with insufficient
privileges tries to use a menu item. For example, both Level 1 or Level 2 Operators are denied
access to the Communication Settings action. And Level 2 Operators can access the Monitoring Set-
tings action, but Level 1 Operators are denied access.

Action Menu Item Default Role Lowest Role (Security Check)

Ping (from server) Operator Level 1 Operator Level 1

Traceroute (from server) Operator Level 1 Operator Level 1

Telnet...(from client) Operator Level 2 Operator Level 2

Communication Settings Administrator Administrator

Monitoring Settings Operator Level1 Operator Level 1

Status Poll Operator Level 2 Operator Level 2

Configuration Poll Operator Level 2 Operator Level 2

Node Group Map Guest Guest

Show Members Guest Guest

Show All Incidents Operator Level 1 Operator Level 1

Show All Open Incidents Operator Level 1 Operator Level 1

Status Details Operator Level 1 Operator Level 1

URL Action Access Limitations

See Investigate and Diagnose Network Problems for more information about these actions.

Control Access with NNMi Accounts

To configure NNMi to store user names, passwords, and role assignments in the NNMi database, use the
following instructions.

User Name Password Role Mapping

NNMi                      NNMi                      NNMi                     

Which Database Stores the Information?

Tip: If you prefer to configure NNMi logins to use data stored in the directory service database, see "Control
Access Using Both Directory Service and NNMi" (on page 37) or "Control Access with a Directory Serv-
ice" (on page 40).

To grant NNMi access to a user:
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1. Navigate to the Account Mapping form.

a. From the workspaces navigation panel, select the Configuration workspace.

b. Select the User Accounts and Roles view.

c. Do one of the following:

o To create new configuration, click the  New icon, and continue.

o To edit an existing configuration, select a row, click the  Open icon, and continue.

2. Locate the Account attribute, and click the  Lookup icon. (See "Using the Account Mapping
Form" for more information.)

n To create new account, click the  New icon and provide the required user name and pass-

word. See "Using the User Account Form" for more information.) Then click Save and Close to
return to the Account Mapping form.

Tip: The user name you just created is added to the User Principals view.

n To select an NNMi user configuration (user name and password), click the  Quick Find icon
and make a selection.

3. Locate the Role attribute.

Select a predefined NNMi role from the drop-down menu. See "Roles Provided in NNMi" (on page
32) for more information.

Note: If you accidentally assign two different NNMi roles to the same NNMi user name, NNMi uses
the higher level role.

4. Click Save and Close to save your changes and return to the User Accounts and Roles view.

Related Topics

"Change Password, Name, or Role Assignment" (on page 36)

"Disable a User's Access to NNMi" (on page 41)

"Troubleshoot NNMi Access" (on page 41)

Change Password, Name, or Role Assignment

If configuring NNMi to store user names, passwords, and role assignments in the NNMi database, use the
following instructions.

User Name Password Role Mapping

NNMi                      NNMi                      NNMi                     

Which Database Stores the Information?

Note: If configuring NNMi to use the directory service database, see "Change Role Assignment for a Direc-
tory Service User Name" (on page 39) or "Control Access with a Directory Service" (on page 40).

Only NNMi administrators can change account details.

To change an NNMi user name:

You must "Disable a User's Access to NNMi" (on page 41), and then recreate the account mapping (see
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"Control Access with NNMi Accounts" (on page 35)).

Note: If you disable NNMi access for a user who is currently signed in to the NNMi console, the change
does not take effect until the user signs in next time.

To change an NNMi password:

1. Navigate to the User Accounts and Roles view.

a. From the Workspaces navigation panel, select the Configuration workspace.

b. Select the User Accounts and Roles view.

2. Click the  Open icon in the row representing the account you want to edit.

3. To change the user's password, locate the Account attribute:

a. Click the  Lookup icon and select Open to access the User Account form.

b. Edit the Password value. Type up to 40 alpha-numeric characters, punctuation, spaces, and
underline characters.

c. Click Save and Close to return to the Account Mapping form.

4. Click Save and Close. NNMi immediately implements your changes.

Note: If you change the password for a user who is currently signed in to the NNMi console, the
change does not take effect until the user signs in next time.

To change an NNMi role assignment:

1. Navigate to the User Accounts and Roles view.

a. From the Workspaces navigation panel, select the Configuration workspace.

b. Select the User Accounts and Roles view.

2. Click the  Open icon in the row representing the account you want to edit.

3. To change the user's NNMi role assignment, locate the Role attribute.

Click the drop-down list and select the new role for the current NNMi user. See "Determine which
NNMi Role to Assign" (on page 33) for more information about NNMi user roles and their privileges.

4. Click Save and Close.

Note: If you change the role for a user who is currently signed in to the NNMi console, the change
does not take effect until the user signs in next time.

Control Access Using Both Directory Service and NNMi

To configure NNMi to store role assignments in the NNMi database, but rely on your directory service for
user names and passwords, use the following instructions. NNMi communicates with the directory service
using Lightweight Directory Access Protocol (LDAP).

User Name Password Role Mapping

Both                      Directory Service                      NNMi                     

Which Database Stores the Information?
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Tip: If you prefer to configure NNMi logins to only use data stored in the directory service database, see
"Control Access with a Directory Service" (on page 40).

To enable NNMi to communicate with your environment's directory service:

1. Modify the nms-ldap.properties file. See the"Integrating NNMi with a Directory Service through
LDAP" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is avail-
able at: http://h20230.www2.hp.com/selfsolve/manuals

Note: To make changes to a user name or password, you must now use the appropriate process for
making changes to your environment's directory service software and make changes in NNMi
(see "Change Role Assignment for a Directory Service User Name" (on page 39)).

2. If you are switching from previously storing passwords in the NNMi database, do this step:

Note: The password information is no longer required to be in the NNMi database.

a. Navigate to the User Principals view:

i. From the workspace navigation panel, select the Configuration workspace.

ii. Select the User Principals view.

b. Delete all objects in the User Principals view:

i. Select all objects by clicking in the column heading row.

ii. Click the button in the view toolbar.

c. Navigate to the User Accounts and Roles view:

i. From the workspace navigation panel, select the Configuration workspace.

ii. Select the User Accounts and Roles view.

d. Verify that there are no remaining objects in this view. (When you deleted Principal objects,
any associated account objects were automatically removed.)

e. Continue with the next set of instructions.

3. Establish the NNMi role mappings for directory service users:                         

a. Navigate to the User Accounts and Roles view:

i. From the workspace navigation panel, select the Configuration workspace.

ii. Select the User Accounts and Roles view.

b. Repeat this step for each NNMi user.

Associate each user name from your environment's directory service with a predefined NNMi
role.

Click the  New icon. See "Using the Account Mapping Form".

o Locate the Account attribute.

Click the  New icon. Enter the user name exactly as it appears in your environment's
directory service database (case-sensitive). See "Using the Principal Form".

Tip: The user name you just created is added to the User Principals view.

o Locate the Role attribute.
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Select a predefined NNMi role from the drop-down menu. See "Roles Provided in NNMi"
(on page 32) for more information.

o Click Save and Close to save your role configuration changes and return to the User
Accounts and Roles view.

c. Access the Incident Browsing workspace.

d. Open the All Incidents view.

Sort this view using the Assigned To (AT) column.

Verify that any assigned Incidents are associated with a valid user from the directory service
database.

o If the user names previously stored in the NNMi database are the same (case-sensitive)
as those defined in your environment's directory service, no changes are required for Inci-
dent assignments.

o If the user names have changed, reassign the Incidents to a valid user name (see Assign

an Incident).

Change Role Assignment for a Directory Service User Name

If configuring NNMi to store user names and passwords in your environment's directory service, but to
store role assignments in the NNMi database, use the following instructions. NNMi communicates with the
directory service using Lightweight Directory Access Protocol (LDAP).

User Name Password Role Mapping

Both                      Directory Service                      NNMi                     

Which Database Stores the Information?

Note: To configure NNMi to use directory service for role assignments, see "Control Access with a Direc-
tory Service" (on page 40).

Only NNMi administrators can change the role assigned to each authorized directory service user name.

To change an NNMi role assignment:

1. Navigate to the User Accounts and Roles view.

a. From the Workspaces navigation panel, select the Configuration workspace.

b. Select the User Accounts and Roles view.

2. Click the  Open icon in the row representing the mapping you want to edit.

3. Locate the Role attribute.

Click the drop-down list and select the new NNMi role for the current user. See "Determine which
NNMi Role to Assign" (on page 33) for more information about NNMi user roles and their privileges.

Note: If you accidentally assign two different NNMi roles to the same NNMi user name, NNMi uses
the higher level role.

4. Click Save and Close.

Note: If you change the role for a user who is currently signed in to the NNMi console, the change
does not take effect until the user signs in next time.
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Control Access with a Directory Service

To configure NNMi to rely on your environment's directory service for role assignments, user names, and
passwords, use the following instructions. NNMi communicates with the directory service using Light-
weight Directory Access Protocol (LDAP).

User Name Password Role Mapping

Directory Service Directory Service Directory Service

Which Database Stores the Information?

Tip: If you prefer to configure NNMi to store the role assignments in the NNMi database, see "Control
Access Using Both Directory Service and NNMi" (on page 37).

To enable NNMi to communicate with your environment's directory service:

1. Modify the nms-ldap.properties file. See the "Integrating NNMi with a Directory Service through
LDAP" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is avail-
able at: http://h20230.www2.hp.com/selfsolve/manuals

Note: To make changes to NNMi access (user name, password, or NNMi role assignment), you must
now use the appropriate process for making changes to your environment's directory service
software.

2. If you are switching from previously storing this data in the NNMi database:

a. Navigate to the User Principals view:

i. From the workspace navigation panel, select the Configuration workspace.

ii. Select the User Principals view.

b. Delete all objects in the view:

i. Select all objects by clicking in the column heading row.

ii. Click the button in the view toolbar.

c. Navigate to the User Accounts and Roles view:

i. From the workspace navigation panel, select the Configuration workspace.

ii. Select the User Accounts and Roles view.

d. Verify that there are no remaining objects in this view. (When you deleted Principal objects,
any associated Account Mapping and User Account objects were automatically removed.)

e. Access the Incident Browsing workspace.

f. Open the All Incidents view.

Sort this view using the Assigned To (AT) column.

Verify that any assigned Incidents are associated with a valid user from the directory service
database.

o If the user names previously stored in the NNMi database are the same (case-sensitive)
as those defined in your environment's directory service, no changes are required for Inci-
dent assignments.

o If the user names have changed, reassign the Incidents to a valid user name (see Assign
an Incident).
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Disable a User's Access to NNMi

Note: If you configured NNMi to store role assignments in your environment's directory service database
(not the NNMi database), ignore this topic. To disable a user's access to NNMi, use the appropriate
process required by your environment's directory service software (see "Control Access with a Direc-
tory Service" (on page 40)).

To deny a user's access to the console, delete their user configuration settings from the NNMi database.

Caution: If you delete the last NNMi user assigned to the Administrator role, no one can access the
Configuration workspace. See "Troubleshoot NNMi Access" (on page 41) for more information
about how to recover from this mistake.

To deny a user's access to NNMi:

1. Navigate to the User Principals view.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the User Principals view.

2. Check the selection box ( ) that precedes the row containing their user name.

3. Click the  Delete icon.

The user's configuration is automatically removed from both the User Principals view and the User
Accounts and Roles view.

Tip: Access the Incident Browsing workspace. Open the All Incidents view. Sort this view using the
Assigned To (AT) column. Reassign all Incidents associated with any user you deleted (see Assign an
Incident).

Troubleshoot NNMi Access

If you have accidentally configured NNMi so that no one is assigned to the Administrator role (pre-
venting anyone from being able to access the Configuration workspaces), use the system user account to
correct the problem.

Sign in to the console using the password that was configured for the system account when NNMi was
installed.

If you do not remember the password assigned to the system account, use the nnmchangesyspw.ovpl to
reset the system password. See nnmchangesyspw.ovpl for more information.

Note: If you are still unable to log on to the console, verify that the nms-roles.properties file is in good
working order. See "Restore the System Role" (on page 41) for more information.

Restore the System Role

NNMi provides an nms-roles.properties file that stores the system role assignment. This file is
located in the following directory:

l Windows:                    
<drive>:Program Files (x86)\HP\HP BTO
 Software\nonOV\jboss\nms\server\nms\conf\props\nms-roles.properties

<drive> is the drive on which NNMi is installed
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l UNIX:                     
/opt/OV/nonOV/jboss/nms/server/nms/conf/props/nms-roles.properties

You should not need to ever modify this file.

To verify the contents of this file:

1. With a text editor, open the nms-roles.properties file.

2. Verify that the following required line is present:

system=admin

3. Save and close the file.

Set Up Command Line Access

NNMi limits access to command line interface commands in one of two ways:

l Requiring user name and password.

l Requiring system role.

See Help → Documentation Library → Reference Pages for a list of command line commands. Check
the appropriate Reference Page to determine which strategy applies.

Requiring User Name and Password

If you do not want to enter a user name and password at the command line, you can use the nnmsetcmdu-
serpw.ovpl command to specify the valid user name and password to be used in place of the -u (user
name) and -p (password) options. The credentials defined using the nnmsetcmduserpw.ovpl command
are valid for command execution by the same user. See nnmsetcmduserpw.ovpl for more information.

Requiring System Role

During installation, a special system user account is used to access NNMi for the first time. Thereafter, that
special account should be used only for these purposes: to use some command line interface commands
and to "Troubleshoot NNMi Access" (on page 41).

Command line interface commands that required the system user account must be issued from the NNMi
management server, and you must have read-only or read-write access to the following files on the NNMi
management server:

1. nms-users.properties

2. nms-roles.properties

Caution: Any user with read-write access to the nms-users.properties and nms-roles.properties
files can potentially change the NNMi system user account password. (UNIX: by default, only the
root user has read-write access to these files. Windows: by default, any user name that is asso-
ciated with the Administrators group has read-write access to these files.)

To configure read-only or read-write access to the nms-users.properties and nms-roles.pro-
perties files. Follow the operating system instructions for changing file access permissions.

l Windows:
<drive>:\Program Files (x86)\HP\HP BTO
 Software\nonOV\jboss\nms\server\nms\conf\props\nms-roles.properties

<drive>:\Program Files (x86)\HP\HP BTO
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 Software\nonOV\jboss\nms\server\nms\conf\props\nms-users.properties

<drive> is the drive on which NNMi is installed

l UNIX:
/opt/OV/nonOV/jboss/nms/server/nms/conf/props/nms-roles.properties

/opt/OV/nonOV/jboss/nms/server/nms/conf/props/nms-users.properties

See "Troubleshoot NNMi Access" (on page 41) and "Restore the System Role" (on page 41) for more infor-
mation about the system user account's role and password.

Audit NNMi User Activity

NNMi tracks a history of sign-in and sign-out activity for each NNMi user. This auditing information also
includes a variety of information about user activity since the NNMi management server was last restarted.

NNMi stores the audit log files in the following directory:

l Windows:                     
<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
 Software\log\nnm\

 signin.0.0.log
 nnmui.0.0.log

<drive> is the drive on which NNMi is installed.

l UNIX:                 
/var/opt/OV/log/nnm/

 signin.0.0.log
 nnmui.0.0.log

Note: Log files are consecutively numbered. A new file is created each time you restart the NNMi man-
agement server. For example, <logFileName>.1.0.log and <logFileName>.2.0.log.

To see the most recent sign in audit report:

1. A tool is available to NNMi administrators. In the console menu bar, select Tools → Sign In/Out Audit
Log.

2. The log provides a variety of information about recent account activity. For example:

Sign In/Sign Out Audit Log                             
Jun 14, 2007 10:53:01.926 AM [ThreadID:719] com.hp.ov.ui.util. Sig-
nInOutAuditLog logSignIn:                             

INFO: Successful Sign In                             
User:  system                             
Role:  Administrator (ADMIN)                             
Remote Host: <node IP address>                             
Remote Port: 1549                             
Locale:  en_US                             
Sign In/Out Audit Since 6/14/07 9:33 AM                             
=======================================                             
Currently Signed In:                             
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#1: system <node IP address> 6/14/07 10:53 AM (last access 6/14/07 10:53 AM)                             
No users currently signed out.

To configure the behavior of sign in information in the audit log files:

1. In a text editor, open the logging.properties file:

n Windows:                                     
<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
 Software\shared\nnm\conf\ovjboss\logging.properties

<drive> is the drive on which NNMi is installed.

n UNIX:                                     
/var/opt/OV/shared/nnm/conf/ovjboss/logging.properties

2. Optional. To disable sign in and sign out logging in the signin.0.0.log file, set Sig-
nInOutAuditLog.level to OFF:

com.hp.ov.ui.util.SignInOutAuditLog.level = OFF

3. Optional.To enable sign in and sign out logging in the signin.0.0.log file, set Sig-
nInOutAuditLog.level to CONFIG:

com.hp.ov.ui.util.SignInOutAuditLog.level = CONFIG

4. Optional. To disable sign in and sign out logging in the nnmui.0.0.log file, set SIg-
nInOutAuditLog.useParentHandlers to false:

com.hp.ov.ui.util.SIgnInOutAuditLog.useParentHandlers = false

5. Save and close the logging.properties file.

6. Before NNMi implements the change, you must follow the directions in the logging.properties ref-
erence page (Help → Documentation Library → Reference Pages, in the File Formats category).

Communicate to Your Team

After configuring user passwords and roles, communicate the following information to your team:

l "Open the Console" (on page 44)

l "Sign In to the Console" (on page 46)

l "Sign Out from the Console" (on page 46)

Open the Console

Provide each user with the following information:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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When your NNMi management server has more than one fully-qualified domain name, NNMi chooses one
during the installation process. There are two ways to find out which domain name NNMi is using in your
network environment:

l Click Help → About HP Network Node Manager i-series, find the Management Server section, Fully
Qualified Domain Name (FQDN) attribute value.

l Use the nnmofficialfqdn.ovpl command. See the nnmofficialfqdn.ovpl Reference Page.

To determine the current port number configuration, look at the first line (boss.http.port) in the
nnm.ports.properties file (see table for the location of this file).

Operating
System Identify Current Port Number

Windows <drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
 Software\shared\nnm\conf\nnm.ports.properties

UNIX /var/opt/OV/shared/nnm/conf/nnm.ports.properties

Determine the NNMi Console Port Number

<drive> is the drive on which NNMi is installed.

Communicate the following browser requirements for your team to use the NNMi console: 

l Use Microsoft Internet Explorer 7.0 or later or Mozilla Firefox 2.0 or later. 

l Pop-ups, cookies, and JavaScript must be enabled. 

l Each user's screen resolution must be 1024x768 pixels or higher. 

l When using Microsoft Internet Explorer as your browser, you can access multiple browser sessions of
NNMi. Use a different user name for each browser session. 

l When using Mozilla Firefox as your browser, multiple browser sessions all point to the same window. 

Note: Users can bookmark the URL for the NNMi console. Use the URL for the NNMi console rather than
the NNMi Welcome page. See About the NNMi Console for more information about the NNMi con-
sole. 

To open the console:

1. Type the following URL (Uniform Resource Locator) into your browser navigation bar:
http://<serverName>:<portNumber>/nnm/

2. Sign in with the following name and password:

<name you configured>

<password you configured>

Note: The sign in prompt cannot be disabled, but you can include name and password in the URL.
See "Launch the Console (showMain)" (on page 324).

3. Click the Sign In button. (See "Sign In to the Console" (on page 46) if you need more information.)

4. The console opens in a new window.

5. Optional. Close the NNMi Welcome page.

Note: If you do not close the NNMi Welcome page or sign out, you can relaunch the console from the
NNMi Welcome Page without signing in again.

Page 45 of 422

../../../../../../../refdocs/nnmofficialfqdn.ovpl.1M.html
../../../../../../../refdocs/nnm.ports.properties.4.html
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0100About.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0100About.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0100About.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0100About.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Controlling Access to NNMi

To refresh the console window:

Click the  Refresh icon in the tool bar of any NNMi window.

Sign In to the Console

After entering the URL for the console, users are prompted for a user name and password.

To sign in to the Console:

1. At the User Name prompt, enter the assigned user name.

2. At the Password prompt, enter the currently assigned password.

3. Click the Sign In button.

Each user name is assigned to an NNMi role. The role determines what users can do with the NNMi con-
sole. "Determine which NNMi Role to Assign" (on page 33) for more information.

The user name and the associated role appear in the upper right corner of the console as shown in the

example below:

Sign Out from the Console

To sign out from the console:

1. Select File → Sign Out.

2. Click OK.

Note the following:

l Sign in is not preserved across user sessions. After signing out, each user must sign in again.

l You must sign out of each browser session that is running NNMi. For example, if you have signed in
twice with two different browsers, signing out in one browser does not cause you to lose access in the
other browser.

l NNMi automatically signs out any user after four hours of inactivity.
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Configuring Communication Protocol

NNMi uses the following protocols to discover your network and monitor the health of your network envi-
ronment:

l Simple Network Management Protocol (SNMP) read-only queries, also known as "Get" commands

n SNMPv1 and SNMPv2c require the use of a community string to authenticate messages that are
sent between NNMi and SNMP agents. NNMi cannot discover information about the SNMPv1 and
SNMPv2c devices in your network environment until you provide the appropriate community
strings. During discovery and monitoring, NNMi uses the community strings you provide in the Com-
munication Configuration workspace. When a device is first discovered, NNMi tries all appropriate
community strings and makes a record of the first community string that works. To keep network traf-
fic to a minimum, from then on NNMi uses the recorded community string when communicating with
that device using SNMP. If at some point the device no longer responds to the recorded community
string, NNMi tries all appropriate community strings and makes a record of the first community
string that now works.

n SNMPv3 requires the use of user-based security model (USM) user names instead of community
strings to authenticate messages that are sent between NNMi and SNMP agents. NNMi cannot dis-
cover information about the SNMPv3 devices in your network environment until you provide the
appropriate user name and authentication. During discovery and monitoring, NNMi uses the user
name and authentication you provide in the Communication Configuration workspace. When a
device is first discovered, NNMi tries all appropriate USM user names and makes a record of the
first USM user name that works. To keep network traffic to a minimum, from then on NNMi uses the
recorded USM user name when communicating with that device using SNMP. If at some point the
device no longer responds to the recorded USM user name, NNMi tries all appropriate USM user
names and makes a record of the USM user name that now works.                    

l Internet Control Message Protocol (ICMP) ping commands

Note: If NNMi discovers a device for which no SNMP authentication was provided in the Communication
Configuration workspace, that device is treated as a non-SNMP device.

You control the amount of traffic NNMi generates on your network. You can modify the settings to meet
your needs.

To configure the way NNMi uses ICMP and SNMP protocols, do the following:

1. Navigate to the Communication Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Communication Configuration.

2. Make your configuration choices. Click here for a list of choices .

3. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Note: You control how often the Discovery Service runs by designating the Rediscovery Interval set-
ting. See "Adjust the Discovery Interval" (on page 98) for more information.

Configure Default SNMP and ICMP Protocol Settings

NNMi generates network traffic using ICMP and SNMP protocols to discover and monitor your network
environment. Default settings for the use of these protocols are provided, for example timeout and retry
behavior settings.
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To configure the default communication protocol settings for your environment:

1. Navigate to the Communication Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Communication Configuration.

2. Locate the Default Settings groups.

3. Make your configuration choices (see SNMP table, ICMP table).

For an explanation of how NNMi implements timeout and retry configurations, see "Timeout / Retry
Behavior Example for SNMP" (on page 50).

4. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Attribute Description

Enable
SNMP
Address
Discovery

If  enabled, NNMi automatically identifies which management address (SNMP agent) to
use for each device. If the initially configured address becomes unreachable, NNMi auto-
matically locates another SNMP agent, if possible, and changes the management address
attribute value.

If  disabled, when the current management address (SNMP agent) becomes unreachable,
NNMi reclassifies the node as a non-SNMP node until the previously configured man-
agement address is available again.

SNMP
Timeout

(Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999 mil-
liseconds.

Time that NNMi waits for a response to an SNMP query before reissuing the request. Both
the Discovery Process and the State Poller Service use this setting. For an explanation of
how NNMi implements timeout and retry configurations, see "Timeout / Retry Behavior Exam-
ple for SNMP" (on page 50).

SNMP
Retries
Count

Maximum number of retries that NNMi issues for an SNMP query before determining the
query result to be "unresponsive". Zero means no retries. Both the Discovery Process and
the State Poller Service use this setting.

SNMP
Port

Default is 161. Specifies the management station's port that NNMi uses when generating
SNMP traffic. Both the Discovery Process and the State Poller Service use this setting.

SNMP
 Proxy
Address

Specify the IP address of your SNMP Proxy Server.

You can set up SNMP Proxy Servers to allow communication with nodes that otherwise
might be unreachable (for example, when a node to be managed is behind a firewall). The
SNMP Proxy Server allows NNMi to manage these nodes in the same way as nodes that pro-
vide SNMP access directly.

Note: To enable a proxy, you must also provide the port number of the SNMP Proxy Server.

SNMP
 Proxy
Port

Port number on the SNMP Proxy Server. See SNMP Proxy Address (previous attribute).

Note: To enable a proxy, you must also provide the address of the SNMP Proxy Server.

Default SNMP Settings Attributes
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Attribute Description

SNMP
Minimum
Security
Level

For SNMPv1 or SNMPv2c, configure NNMi to use Community Strings in your network envi-
ronment:

l Community Only (SNMPv1)
NNMi tries only SNMPv1 settings.

l Community Only (SNMPv1 or v2c)
NNMi tries only SNMPv1/SNMPv2c settings.

l Community
NNMi tries SNMPv1/SNMPv2c settings first, then tries SNMPv3 settings if any are con-
figured.

For SNMPv3, configure NNMi to use the User-based Security Module (USM) level of security
required in your network environment (if your environment also uses SNMPv1/SNMPv2c,
select Community):

l No Authentication, No Privacy

l Authentication, No Privacy

l Authentication, Privacy

See "Timeout / Retry Behavior Example for SNMP" (on page 50) for an explanation of NNMi
behavior with each of these choices.

Note: NNMi needs to know which SNMPv1 or SNMPv2c community strings are used in your environment
(see "Configure Default Community Strings (SNMPv1 or SNMPv2c)" (on page 51)) and which
SNMPv3 USM settings are used in your environment (see "Configure Default SNMPv3 Settings" (on
page 54)).

Attribute Description

ICMP
Timeout

(Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999 mil-
liseconds.

Time that NNMi waits for a response to an ICMP query before reissuing the request. For an
explanation of how NNMi implements timeout and retry configurations, see "Timeout / Retry
Behavior Example for ICMP" (on page 51).

ICMP
Retries
Count

Maximum number of retries that NNMi issues for an ICMP query before logging an error. Zero
means no retries.

Default ICMP Settings

Related Topics:

"Configure Default Community Strings (SNMPv1 or SNMPv2c)" (on page 51)

"Configure Regions (Communication Settings)" (on page 56)

"Configure Specific Nodes (Communication Settings)" (on page 66).
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Timeout / Retry Behavior Example for SNMP

When NNMi attempts to contact a device, your configuration settings for Timeout and Retry influence NNMi
behavior.

NNMi attempts to obtain information about a hostname/IP-address using SNMP, then waits the configured
timeout interval for a response. If not successful, NNMi increments the timeout interval before trying again.
This process repeats until one of the following is true:

l The device responds to SNMP.

l The maximum configured number of SNMP Retries fails. For example, if your timeout is 2 seconds and
your retry is 4:

n NNMi attempts to communicate with a device and waits 2 seconds for a response.

n If unsuccessful, NNMi tries again and waits 4 seconds for a response.

n If unsuccessful, NNMi tries again and waits 6 seconds for a response.

n If unsuccessful, NNMi tries again and waits 8 seconds for a response.

If no response, NNMi repeats this process using the next configured SNMP level.

l NNMi exhausts all possibilities. NNMi considers the hostname/IP-address to be a non-SNMP device
until the next Discovery or Monitoring cycle.

Tip: It is best to use the same timeout/retry numbers for both ICMP and SNMP.

Your choice of SNMP Minimum Security Setting determines the range of possibilities:

l If your SNMP Minimum Security Setting is Community Only (SNMPv1), NNMi uses only SNMPv1 to
locate SNMP agents.

l If your SNMP Minimum Security Setting is Community Only (SNMPv1 or v2c), NNMi cycles through
the following until successful:

SNMPv2c

SNMPv1

l If your SNMP Minimum Security Setting is Community, NNMi cycles through the following until suc-
cessful:

SNMPv2c

SNMPv1

SNMPv3 No Authentication, No Privacy settings (if any matching configurations, otherwise skip).

SNMPv3 Authentication, No Privacy settings (if any matching configurations, otherwise skip).

SNMPv3 Authentication, Privacy settings (if any matching configurations).

l If your SNMP Minimum Security Setting is No Authentication, No Privacy, NNMi cycles through the fol-
lowing until successful:

SNMPv3 No Authentication, No Privacy settings (if any matching configurations at this, otherwise skip)
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SNMPv3 Authentication, No Privacy settings (if any matching configurations, otherwise skip).

SNMPv3 Authentication, Privacy settings (if any matching configurations).

l If your SNMP Minimum Security Setting is Authentication, No Privacy, NNMi cycles through the fol-
lowing until successful:

SNMPv3 Authentication, No Privacy settings (if any matching configurations, otherwise skip).

SNMPv3 Authentication, Privacy settings (if any matching configurations).

l If your SNMP Minimum Security Setting is Authentication, Privacy, NNMi cycles through the following
until successful:

SNMPv3 Authentication, Privacy settings (if any matching configurations).

Timeout / Retry Behavior Example for ICMP

When NNMi attempts to contact a device, your configuration settings for Timeout and Retry influence NNMi
behavior.

NNMi attempts to contact the device using ICMP, then waits the configured timeout interval for a response.
If not successful, NNMi increments the timeout interval before trying again. This process repeats until one
of the following is true:

l The device responds to ICMP.

l The maximum configured number of ICMP Retries fails. NNMi considers the device unreachable
through ICMP until the next Discovery or Monitoring cycle. For example, if your timeout is 2 seconds
and your retry is 4:

n NNMi attempts to communicate with a device and waits 2 seconds for a response.

n If unsuccessful, NNMi tries again and waits 4 seconds for a response.

n If unsuccessful, NNMi tries again and waits 6 seconds for a response.

n If unsuccessful, NNMi tries again and waits 8 seconds for a response.

Tip: It is best to use the same timeout/retry numbers for both ICMP and SNMP.

Configure Default Community Strings (SNMPv1 or SNMPv2c)

Use the Default Community Strings tab to provide default SNMPv1 and SNMPv2c passwords. For each
address, NNMi checks the communication configuration settings in this order: communication protocols for
Specific Nodes, communication protocols for Network Regions, and if no match is found, NNMi tries these
default community strings. If NNMi discovers a device for which no SNMP settings are provided, that
device is treated as a Non-SNMP device.

During initial discovery, NNMi tries many community strings until a match is found. After a match is iden-
tified for a node, the information is recorded to prevent future authentication errors.

Note: If you provide a community string for a specific device, NNMi honors your choice and does not try
any Region or Default community strings for that device.
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NNMi uses SNMP read-only queries (Get commands) for ongoing discovery and monitoring of your net-
work environment. SNMP community strings are the validation passwords used to authenticate messages
sent from NNMi to an SNMP agent. NNMi uses SNMP to gather useful information about the devices in
your network environment. After receiving an SNMP request, an SNMP agent compares the community
string in the request to the community strings that are configured for that SNMP agent. The SNMP agent
responds to the request only when the request is accompanied by a valid community string.

During NNMi installation, any community strings that were provided are automatically stored in the table
on the Default Community Strings tab.

Provide any number of additional community strings that are used broadly in your environment (for exam-
ple, by default). The order in which your community string settings appear in this table does not matter.
NNMi checks all Default community strings in parallel.

To configure default SNMPv1 or SNMPv2c community strings for your environment:

1. Navigate to the Communication Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Communication Configuration.

2. Locate the Default Community Strings tab.

3. Do one of the following:

n To establish a community string setting, click the New icon, and continue.

n To edit a community string setting, select a row, click the Open icon, and continue.

n To delete a community string setting, select a row and click the Delete icon.

4. In the Default Community String form, provide the required information.

5. Click Save and Close to return to the Communication Configuration form.

6. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle.

Default Community String Form

Provide any number of additional SNMPv1 or SNMPv2c community strings that are used broadly in your
environment (for example, by default). The order in which your community string settings appear in this
table does not matter. NNMi checks all Default community strings in parallel.

Note:For each address, NNMi checks the communication configuration settings in this order: com-
munication protocols for Specific Devices, communication protocols for Network Regions, and if no
match is found, NNMi tries the default community strings. If NNMi discovers a device for which no
community string is provided, that device is treated as a Non-SNMP device.

To provide a default community string for your environment:

1. Navigate to the Default Community String form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Communication Configuration.

c. Navigate to the Default Community Strings tab.

d. Do one of the following:
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o To establish a community string setting, click the  New icon, and continue.

o To edit a community string setting, select a row, click the  Open icon, and continue.

2. Provide the community string (see table).

3. Click either:

n Save and Close to return to the Communication Configuration form.

n  Save and New to add another community string.

4. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle.

Attribute Description

Read Com-
munity
String

The SNMP "get" (read-only) community string that is used in your network environment.
Case-sensitive.

Many proxy vendors use the community string for specifying remote target information.
NNMi supports substitution parameters within community strings for SNMPv1 or SNMPv2
proxy environments. Click here for more information.

Copy and paste these codes at the end of your Community String to provide the values
required by your proxy environment. NNMi substitutes the actual attribute values from the
NNMi database at runtime: 

${contextName} = Used for specifying VLAN context for switches (VLAN associated with
the remote target node)

${managementAddress} = Node form, Management Address attribute value (the remote tar-
get node)

${snmpPort} = SNMP Agent form, UDP Port attribute value (SNMP agent associated with
the remote target node)

Default Community String

Configure the Default Device Credentials (NNM iSPI NET)

NNMi uses the Default Credentials setting to access devices when running Diagnostics either auto-
matically or when the Actions → Run Diagnostics option is used. (See "Configure Diagnostics for an Inci-
dent (NNM iSPI NET)" (on page 291) and Node Form: Diagnostics Tab for more information.)

NNMi uses Shell (SSH or telnet) as the method for accessing devices with the credentials specified. NNMi
uses SSH as the preferred communication method. If the SSH attempt fails, NNMi uses telnet.

To provide the default credentials setting:

1. Navigate to the Default Device Credentials form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Default Device Credentials tab.
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d. Do one of the following:

o To establish a credential setting, click the  New icon, and continue.

o To edit a credential setting, select a row, click the  Open icon, and continue.

o To delete a credential setting, select a row and click the  Delete icon

2. Provide one setting for the default attribute values (see table).

Caution: Populate only one row in this table.

Note: NNMi tries to use the Specific Node Device Credentials. If none match, NNMi tries the Region
Device Credentials. If none match, NNMi tries the default credential settings provided here.

3. Click Save and Close to return to the Communication Configuration form.

4. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Attribute Description

User
Name

Type the user name that you want NNMi to use for logging into devices by default (when no
Region or Specific Node settings work).

Password Type the password that you want NNMi to use for logging into devices by default (when no
Region or Specific Node settings work).

Note: NNMi encrypts the password and displays asterisks for this attribute. If you want to
change the password, first clear the asterisks displayed in the Password attribute and
enter the new Password value.

Default Device Credential Attributes

Configure Default SNMPv3 Settings

Use the Default SNMPv3 Settings tab to provide default SNMPv3 user-based security model (USM) set-
tings. For each address, NNMi checks the communication configuration settings in this order: com-
munication protocols for Specific Nodes, communication protocols for Network Regions, and if no match is
found, NNMi tries these default user-based security model (USM) settings. If NNMi discovers a device for
which no SNMP settings are provided, that device is treated as a Non-SNMP device.

During initial discovery, NNMi tries many SNMP configuration settings until a match is found. After a match
is identified for a Node, the information is recorded to prevent future authentication errors.

Note: If you provide SNMPv3 user-based security model (USM) settings for a specific device, NNMi honors
your choice and does not try any Region or Default community strings for that device.

NNMi uses SNMP queries for ongoing discovery and monitoring of your network environment. SNMPv3
user-based security model (USM) settings are used to authenticate messages sent from NNMi to an SNMP
agent. NNMi uses SNMP to gather useful information about the devices in your network environment. After
receiving an SNMP request, an SNMP agent compares the SNMPv3 user-based security model (USM) set-
tings in the request to the SNMPv3 user-based security model (USM) settings that are configured for that
SNMP agent. The SNMP agent responds to the request only when the request is accompanied by valid
SNMPv3 user-based security model (USM) settings.

Provide any number of additional SNMPv3 user-based security model (USM) settings that are used
broadly in your environment (for example, by default). The order in which your SNMPv3 user-based secu-
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rity model (USM) settings appear in this table does not matter. NNMi checks all Default SNMPv3 Settings
at a particular security level in parallel.

NNMi uses Default SNMPv3 user-based security model (USM) settings to access devices.

To view the current list of default SNMPv3 USM settings:

1. Navigate to the Default SNMPv3 Settings tab.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Default SNMPv3 Settings tab.

2. The displayed table lists the Unique Name of each default SNMPv3 USM setting.

Note: NNMi tries to use the Specific Node SNMPv3 Settings. If none match, NNMi tries the Region
SNMPv3 Settings. If none match, NNMi tries the default SMNPv3 settings provided here.

3. You can do the following:

n To establish a new setting, click the  New icon. See "Default SNMPv3 Settings form" (on page
55).

Click Save and Close to return to the Default SNMPv3 Settings form.

n To edit an existing setting, select a row, click the  Open icon. See "Default SNMPv3 Settings
form" (on page 55).

Click Save and Close to return to the Default SNMPv3 Settings form.

n To delete an existing setting from the Default list, select a row and click the  Delete icon.

Note: The record remains in the database for possible use elsewhere and is simply removed
from the Default list.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle.

Default SNMPv3 Settings form

NNMi can use SNMPv3 user-based security model (USM) settings to access devices.

NNMi tries to use the current SNMPv3 Settings attribute value from Specific Node Settings. If none match,
NNMi tries the Region SNMPv3 Settings. If none match, NNMi tries the default SMNPv3 settings provided
here.

To configure a Default SNMPv3 Setting:

1. Navigate to the Default SNMPv3 Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Communication Configuration.

c. Navigate to the Default SNMPv3 Settings tab.

d. Do one of the following:
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o To create default SNMPv3 Setting definition, click the  New icon.

o To edit a default SNMPv3 Setting, select a row, click the  Open icon.

2.  Click the SNMPv3 Settings  Lookup icon and select one of the options from the drop-down
menu:

n Quick View to display summary information for the currently configured (selected) SNMPv3
Setting name.  

n  Quick Find to view and select from the list of all existing SNMPv3 Settings (for more infor-
mation see "Use the Quick Find Window" (on page 19)).

n  Open to display the details of the currently configured (selected) SNMPv3 Setting (see
"SNMPv3 Settings Form" for more information).

n  New to create a new SNMPv3 Setting (see "SNMPv3 Settings Form" for more information).

3. Click Save and Close to return to the Default SNMPv3 Settings form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle.

Configure Regions (Communication Settings)

Configuring communication protocols for regions is optional.

NNMi includes a default region that covers all industry-standard private address spaces.

Note: If you provide an SNMPv1 or SNMPv2c community string or an SNMPv3 USM Setting for a specific
device, NNMi honors your choice and does not try any Region or Default settings for that device.

Use the Regions tab to fine tune communication protocol usage and settings for particular regions of your
network (for example, buildings, floors within those buildings, or workgroups within a particular floor).
When you leave a field blank in a region definition, NNMi uses the next applicable configuration setting in
the following order:

l The value for each field as defined in the first Region definition that matches, Regions are checked
according to the Ordering number. The match with the lowest Ordering number applies.

l If no Region definition provides a value for an attribute, the default value is used.

Note: NNMi enables you to set up one or more SNMP Proxy Servers when an SNMP node is otherwise
unreachable (for example, when a node you want to manage is behind a firewall). To enable NNMi
to use the SNMP Proxy Server, when you configure communication protocols for network regions,
you must include the IP address and port number on the SNMP Proxy Server. See "Communication
Region Form" (on page 57) for more information.

If your communication protocol usage is too complex for Region definitions, see "Configure Specific Nodes
(Communication Settings)" (on page 66).

To configure communication protocols for a particular region of your network:

1. Navigate to the Communication Region form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Communication Configuration.
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c. Navigate to the Regions tab.

d. Do one of the following:

o To establish a region definition, click the  New icon, and continue.

o To edit a region definition, select a row, click the  Open icon, and continue.

o To delete a region definition, select a row and click the  Delete icon.

2. Provide the required information. Define the regions with wildcard address, wildcard device names,
or literal addresses and names . See "Communication Region Form" (on page 57).

3. Click Save and Close to return to the Communication Configuration form.

4. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle.

Related Topics:

"Configure Default SNMP and ICMP Protocol Settings" (on page 47)

"Configure Default Community Strings (SNMPv1 or SNMPv2c)" (on page 51)

"Configure Specific Nodes (Communication Settings)" (on page 66)

Communication Region Form

To configure communication regions:

1. Navigate to the Communication Region form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To establish a region definition, click the  New icon, and continue.

o To edit a region definition, select a row, click the  Open icon, and continue.

2. Provide the basic communication region definition (see the Regional Basic Settings table, Regional
SNMP Settings table, and Regional ICMP Settings table).             

3. Make your configuration choices. Click here for a list of choices .             

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Attribute Description

Name A name for this region.

Ordering A numeric value. NNMi checks for configuration settings in the order you define (lowest
number first). NNMi uses the first match found for each address.

Regional Basic Settings
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Attribute Description

No duplicate Ordering numbers are allowed. Each Communication Region ordering
number must be unique.

Tip: It is recommended that ordering numbers are incremented by 10s or 100s to provide
flexibility when adding new regions over time.

Description Optional. Provide any description that would be useful for communication purposes within
your team.

Type a maximum of 255 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Attribute Description

Enable SNMP
Communication

If  enabled, the Discovery Process and State Poller Service generate network traffic
with SNMP protocol to discover and monitor your network devices in this region.

If  disabled, NNMi does not generate any SNMP traffic on your network in this
region.

Caution: At least one IP Address in each node must have SNMP enabled, otherwise
no SNMP data is collected from that Node. With no SNMP data, Spiral Dis-
covery interprets each IP Address as a separate node, Causal Engine cal-
culates Status based only on IP address State, previously discovered
Interfaces show a State attribute value of "Not Polled" and a Status attribute
value of "No Status" with the Interface map-symbol color set to beige, and no
new Interfaces are discovered.

Note: See "Monitoring Network Health" (on page 151) for information about ena-
bling/disabling SNMP communication specifically for the State Poller Service.

Enable SNMP
Address Dis-
covery

If  enabled, NNMi automatically identifies which management address (SNMP
agent) to use for each device. If the initially configured address becomes unreachable,
NNMi automatically locates another SNMP agent, if possible, and changes the man-
agement address attribute value.

If  disabled, when the current management address (SNMP agent) becomes
unreachable, NNMi reclassifies the node as a non-SNMP node until the previously
configured management address is available again.

SNMP Timeout (Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999
milliseconds.

Time that NNMi waits for a response to an SNMP query before reissuing the request.
Both the Discovery Process and the State Poller Service use this setting in this region.
For an explanation of how NNMi implements timeout and retry configurations, see
"Timeout / Retry Behavior Example for SNMP" (on page 50).

SNMP Retries
Count

Maximum number of retries that NNMi issues for an SNMP query before determining
the query result to be "unresponsive". Zero means no retries. Both the Discovery Proc-
ess and the State Poller Service use this setting in this region.

SNMP Port Default is 161. Specifies the management station's port that NNMi uses when gen-
erating SNMP traffic. Both the Discovery Process and the State Poller Service use this
setting in this region.

Regional SNMP Settings
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Attribute Description

SNMP Proxy
Address

Specify the IP address of your SNMP Proxy Server.

You can set up one or more SNMP Proxy Servers to allow communication with nodes
that otherwise might be unreachable (for example, when a node to be managed is
behind a firewall). The SNMP Proxy Server allows NNMi to manage these nodes in the
same way as nodes that provide SNMP access directly.

SNMP Proxy
Port

Port number on the SNMP Proxy Server. See SNMP Proxy Address (previous attrib-
ute).

SNMP Mini-
mum Security
Level

For SNMPv1 or SNMPv2c, configure NNMi to use Community Strings in your network
environment:

l Community Only (SNMPv1)
NNMi tries only SNMPv1 settings.

l Community Only (SNMPv1 or v2c)
NNMi tries only SNMPv1/SNMPv2c settings.

l Community
NNMi tries SNMPv1/SNMPv2c settings first, then tries SNMPv3 settings if any are
configured.

For SNMPv3, configure NNMi to use the User-based Security Module (USM) level of
security required in your network environment (if your environment also uses
SNMPv1/SNMPv2c, select Community):

l No Authentication, No Privacy

l Authentication, No Privacy

l Authentication, Privacy

See "Timeout / Retry Behavior Example for SNMP" (on page 50) for an explanation of
NNMi behavior with each of these choices.

Attribute Description

Enable ICMP
Communication

If  enabled, NNMi generates network traffic with ICMP protocol in this region.

If  disabled, NNMi does not generate any ICMP traffic on your network in this region:

l Addresses in this Region (both previously discovered and newly discovered) have
a State attribute value of "Not Polled" and a Status attribute value of "No Status"
with the IP Address map-symbol color set to beige.

l Nodes with all IP addresses and interfaces showing a Status attribute value of "No
Status" have a map-symbol background shape color set to beige. However, it is
possible for a node to have IP addresses in multiple regions with multiple Status
values.

Note: See "Monitoring Network Health" (on page 151) for information about ena-
bling/disabling ICMP communication specifically for the State Poller Service.

ICMP Timeout (Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999
milliseconds.

Regional ICMP Settings
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Attribute Description

Time that NNMi waits for a response to an ICMP query before reissuing the request in
this region. For an explanation of how NNMi implements timeout and retry con-
figurations, see "Timeout / Retry Behavior Example for ICMP" (on page 51).

ICMP Retries
Count

Maximum number of retries that NNMi issues for an ICMP query in this region before
logging an error. Zero means no retries.

Configure Address Ranges for Regions

To configure an address range for this region:

1. Navigate to the Region Included Address Range form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To establish a region definition, click the  New icon, and continue.

o To edit a region definition, select a row, click the  Open icon, and continue.

e. In the Communication Region form, navigate to the Included Address Regions tab.

f. Do one of the following:

o To establish an address range setting, click the  New icon, and continue.

o To edit an address range setting, select a row, click the  Open icon, and continue.

o To delete an address range setting, select a row and click the  Delete icon.

2. Provide address range definition (see table).

If you provide multiple IP address ranges for a region, each device must pass at least one to meet the
criteria.

Tip: If you provide both IP address ranges and hostname wildcards, each device must pass at least
one in either category (not both) to meet the criteria.

3. Click Save and Close to return to the Communication Region form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Attribute Description

IP Range Used to specify the range of IP addresses for this Communication Region.

An IPv4 Address range is a modified dotted-notation where each octet is one of the fol-
lowing:

l A specific octet value between 0 and 255

Address Range Definition Attribute
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Attribute Description

l A low-high range specification for the octet value (for example, "112-119")

l An asterisk (*) wildcard character which is equivalent to the range expression "0-255"

Note: The following two IPv4 addresses are considered invalid: 0.0.0.0 and 127.0.0.0

Examples of valid IPv4 address wildcards include:
10.1.1.*
10.*.*.*
10.1.1.1-99
10.10.50-55.*
10.22.*.4
10.1-9.1-9.1-9

Configure Hostname Filters for Regions

Define the Communication Region with hostname patterns.

To establish a Hostname Filter setting:

1. Navigate to the Region Hostname Filter form.

n From the workspace navigation panel, select the Configuration workspace.

n Select the Communication Configuration.

n Navigate to the Regions tab.

n Do one of the following:

o To create a region definition, click the  New icon.

o To edit a region definition, select a row, click the  Open icon.

n In the Communication Region form, access the Hostname Filters tab.

n Do one of the following:

o To create a hostname wildcard definition, click the  New icon.

o To edit a hostname wildcard definition, select a row, click the  Open icon.

o To delete a hostname wildcard setting, select a row and click the  Delete icon.

2. Type an appropriate hostname filter (see table).

If you provide multiple hostname wildcards for a region, each device must pass at least one to meet
the criteria.

Tip: If you provide both hostname wildcards and IP address ranges, each device must pass at least
one in either category (not both) to meet the criteria.

3. Click Save and Close to return to the Communication Region form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.
See "Discovering Your Network" (on page 76) and Verify Device Configuration Details.

Page 61 of 422

../../../../nmOperHelp/Content/nmOperHelp/nmOprActions0150configPoll.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprActions0150configPoll.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprActions0150configPoll.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprActions0150configPoll.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Communication Protocol

Attribute Description

Hostname
Filter

Enter a wildcard expression using ? (one character) and * (multiple characters).

Wildcards are not case-sensitive. So a wildcard of ABC* would match devices with host-
names beginning with ABC*, abc*, and Abc*

Caution: The Hostname attribute value on the Node form of the discovered node must
match what is entered here (see the Hostname attribute the Node form help topic).

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to determine
the hostname. Click here for details.

1. If a hostname is available, it must resolve to a valid IP address. NNMi stores the fully-
qualifiedhostname in the database as all lowercase characters.

2. If more than one address is associated with a node, the loopback address1 is used
with the following exceptions:

n NNMi prefers loopback interfaces for management communication, where pos-
sible. However, NNMi automatically filters out addresses in the reserved loopback
network range 127/24 (127.*.*.*).

n NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Ren-
dezvous Point IP Address2.

3. If a node has multiple loopback addresses, NNMi uses the loopback address with the
lowest number that resolves to a hostname (for example, 10.16.42.197 is a lower
number than 10.16.197.42).

4. If no loopback address resolves to a hostname and the device supports SNMP, NNMi
 uses the current value from the Management Address attribute on the Node form.

5. If the device does not support SNMP, the IP address or DNS name found during the
current rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change from
cycle to cycle (for example, if an address did not respond to SNMP queries due to network
problems or node reconfiguration).

Node Hostname Filter Definition

Configure Community Strings for Regions

If more than one SNMPv1 or SNMPv2c "get" community string is used within this region, repeat this step
any number of times. Order does not matter because all community strings defined for this Region are
checked in parallel.

During initial discovery, NNMi tries many community strings until a match is found. After a match is iden-
tified for a Node, the information is recorded to prevent future authentication errors.

To provide a community string for this region:

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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1. Navigate to the Region Community String form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To establish a region definition, click the New icon, and continue.

o To edit a region definition, select a row, click the Open icon, and continue.

e. In the Communication Region form, navigate to the Community Strings tab.

f. Do one of the following:

o To establish a community string setting, click the  New icon, and continue.

o To edit a community string setting, select a row, click the  Open icon, and continue.

o To delete a community string setting, select a row and click the  Delete icon

2. Provide a community string for this region (see table).

Note: If you do not provide any community strings, NNMi uses the Default Community Strings.

3. Click Save and Close to return to the Communication Region form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle. 

Attribute Description

Read Com-
munity
String

The SNMPv1 or SNMPv2c "get" (read-only) community string that is used for this region.
Case-sensitive.

Tip: If no values appear in this table, the default settings are used (see "Configure Default
Community Strings (SNMPv1 or SNMPv2c)" (on page 51)).

Many proxy vendors use the community string for specifying remote target information.
NNMi supports substitution parameters within community strings for SNMPv1 or SNMPv2
proxy environments. Click here for more information.

Copy and paste these codes at the end of your Community String to provide the values
required by your proxy environment. NNMi substitutes the actual attribute values from the
NNMi database at runtime: 

${contextName} = Used for specifying VLAN context for switches (VLAN associated with
the remote target node)

${managementAddress} = Node form, Management Address attribute value (the remote tar-
get node)

${snmpPort} = SNMP Agent form, UDP Port attribute value (SNMP agent associated with
the remote target node)

SNMPv1 or SNMPv2c Community String for this Region
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Configure Credential Settings for Regions (NNM iSPI NET)

NNMi uses Default Credential Settings to access devices when running Diagnostics either automatically or
when the Actions → Run Diagnostics option is used. (See "Configure Diagnostics for an Incident (NNM
iSPI NET)" (on page 291) and Node Form: Diagnostics Tab for more information.)

NNMi uses Shell (SSH or telnet) as the method for accessing devices with the credentials specified. NNMi
uses SSH as the preferred communication method. If the SSH attempt fails, NNMi uses telnet.

To provide credential settings for this region:

1. Navigate to the Region Device Credentials form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To establish a region definition, click the New icon, and continue.

o To edit a region definition, select a row, click the Open icon, and continue.

e. In the Communication Region form, navigate to the Device Credentials tab.

f. Do one of the following:

o To establish a credential setting, click the  New icon, and continue.

o To edit a credential setting, select a row, click the  Open icon, and continue.

o To delete a credential setting, select a row and click the  Delete icon

2. Provide the attribute values of credentials for this region (see table).

Note: NNMi tries to use the Specific Node Device Credentials. If none match, NNMi tries the Region
Device Credential settings provided here. If none match, NNMi tries the Default Device Cre-
dentials.

3. Click Save and Close to return to the Communication Region form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close.

Attribute Description

User
Name

Type the user name that you want NNMi to use for logging into devices in this Com-
munication Region.

Password Type the password that you want NNMi to use for logging into devices in this Com-
munication Region.

Note: NNMi encrypts the password and displays asterisks for this attribute. If you want to
change the password, first clear the asterisks displayed in the Password attribute and
enter the new Password value.

Device Credential Attributes for this Region
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Configure SNMPv3 Settings for Regions

NNMi can use SNMPv3 user-based security model (USM) settings to access devices.

To view the current list of SNMPv3 USM settings for a Region:

1. Navigate to the SNMPv3 Settings tab on the Communication Region form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To create a region definition, click the  New icon.

o To edit a region definition, select a row, click the  Open icon.

e. In the Communication Region form, access the SNMPv3 Settings tab.

2. The displayed table lists the Unique Name of each SNMPv3 USM setting for this region.

Note: NNMi tries to use the Specific Node SNMPv3 Settings. If none match, NNMi tries the Region
SNMPv3 Settings provided here. If none match, NNMi tries the default SMNPv3 settings.

3. You can also do the following:

n To establish a new setting, click the  New icon. See "Communication Region SNMPv3 Settings
form" (on page 65).

Click Save and Close to return to the Communication Region form.

n To edit an existing setting, select a row, click the  Open icon. See "Communication Region
SNMPv3 Settings form" (on page 65).

Click Save and Close to return to the Communication Region form.

n To delete a setting from the Region's list, select a row and click the  Delete icon.

Note:The record remains in the database for possible use elsewhere and is simply removed from
this Communication Region's list.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Communication Region SNMPv3 Settings form

NNMi can use SNMPv3 user-based security model (USM) settings to access devices.

NNMi tries to use the current SNMPv3 Settings attribute value from Specific Node Settings. If none match,
NNMi tries the Region SNMPv3 Settings provided here. If none match, NNMi tries the default SMNPv3 set-
tings.

To configure an SNMPv3 Setting for a Region:

1. Navigate to the Communication Region SNMPv3 Settings form.

a. From the workspace navigation panel, select the Configuration workspace.
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b. Select the Communication Configuration.

c. Navigate to the Regions tab.

d. Do one of the following:

o To create a region definition, click the  New icon.

o To edit a region definition, select a row, click the  Open icon.

e. In the Communication Region form, navigate to the SNMPv3 Settings tab.

f. Do one of the following:

o To create an SNMPv3 Setting definition, click the  New icon.

o To edit an SNMPv3 Setting, select a row, click the  Open icon.

o To remove an SNMPv3 Setting from this Region, select a row, click the  Delete icon.

Note: The record remains in the database for possible use elsewhere and is simply

removed from this Communication Region's list.

2.  Click the SNMPv3 Settings  Lookup icon and select one of the options from the drop-down
menu:

n Quick View to display summary information for the currently configured (selected) SNMPv3
Setting name.  

n  Quick Find to view and select from the list of all existing SNMPv3 Settings (for more infor-
mation see "Use the Quick Find Window" (on page 19)).

n  Open to display the details of the currently configured (selected) SNMPv3 Setting (see
"SNMPv3 Settings Form" for more information).

n  New to create a new SNMPv3 Setting (see "SNMPv3 Settings Form" for more information).

3. Click Save and Close to return to the Communication Region SNMPv3 Settings form.

4. Click Save and Close to return to the Communication Region form.

5. Click Save and Close to return to the Communication Configuration form.

6. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.

Configure Specific Nodes (Communication Settings)

Configuring communication protocols for specific devices is optional.

Use the Specific Node Settings tab to fine tune communication protocol usage and settings for a particular
device within your environment. For example, provide settings for your most important devices, or disable
communication with the least important devices.

When you leave a field blank, NNMi uses the next applicable configuration setting for that field in the fol-
lowing order:

l The value configured for a Region that includes this device. If multiple Region definitions include this
device (for example, buildings, floors within those buildings, or workgroups within a particular floor),
the first match applies (the matching region with the lowest Ordering number) . See "Configure

Page 66 of 422

../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm
../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm
../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm
../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm
../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm
../../../Content/nmAdminHelp/nmAdm0100AboutSNMPv3.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Communication Protocol

Regions (Communication Settings)" (on page 56).

l The default value for this field (see "Configure Default SNMP and ICMP Protocol Settings" (on page 47)
, "Configure Default Community Strings (SNMPv1 or SNMPv2c)" (on page 51), "Configure the Default
Device Credentials (NNM iSPI NET)" (on page 53), and "Configure Default SNMPv3 Settings" (on page
54).

Note: NNMi enables you to set up one or more SNMP Proxy Servers in the cases where an SNMP node is
otherwise unreachable (for example, when a node you want to manage is behind a firewall). To ena-
ble NNMi to use the SNMP Proxy Server, when you configure communication protocols for specific
devices, you must include the IP address and port number on the SNMP Proxy Server. See "Specific
Node Settings Form (Communication Settings)" (on page 67) for more information.

To configure specific devices, you have two choices:

l "Specific Node Settings Form (Communication Settings)" (on page 67).

l "Load Specific Node Settings from a File" (on page 74)

Specific Node Settings Form (Communication Settings)

Create specific node settings to control the way NNMi monitors your most important devices or least impor-
tant devices.

Tip: If no value is provided for an attribute in the Communication Node form, NNMi uses the applicable
Region settings and if none match, NNMi uses the default settings.

To configure communication protocol settings for a specific node:

1. Access the Specific Node Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Communication Configuration.

c. Navigate to the Specific Node Settings tab.

d. Do one of the following:

o To establish settings for a node, click the New icon, and continue.

o To edit settings for a node, select a row, click the Open icons, and continue.

o To delete settings for a node, select a row and click the Delete icon.

2. Provide the communication protocol settings for the node (see the Basic Settings table, SNMP Set-
tings table, and ICMP Settings table).

3. Optional. Make additional configuration choices. Click here for a list of choices .             

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close. Your changes are available for the next Discovery or Monitoring cycle.
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Attribute Description

Target Host-
name                     

Caution: The Hostname attribute value on the Node form of the discovered node must
match what is entered here (see the Hostname attribute the Node form help
topic).

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to deter-
mine the hostname. Click here for details.

1. If a hostname is available, it must resolve to a valid IP address. NNMi stores the
fully-qualifiedhostname in the database as all lowercase characters.

2. If more than one address is associated with a node, the loopback address1 is used
with the following exceptions:

n NNMi prefers loopback interfaces for management communication, where pos-
sible. However, NNMi automatically filters out addresses in the reserved loop-
back network range 127/24 (127.*.*.*).

n NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Ren-
dezvous Point IP Address2.

3. If a node has multiple loopback addresses, NNMi uses the loopback address with
the lowest number that resolves to a hostname (for example, 10.16.42.197 is a
lower number than 10.16.197.42).

4. If no loopback address resolves to a hostname and the device supports SNMP,
NNMi uses the current value from the Management Address attribute on the Node
form.

5. If the device does not support SNMP, the IP address or DNS name found during the
current rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change
from cycle to cycle (for example, if an address did not respond to SNMP queries due to
network problems or node reconfiguration).

Preferred
Management
Address

Specify the address you want NNMi to use for SNMP communications with this device. If
you enter an invalid or unreachable address, the device is not discovered or monitored.

If this attribute is left empty (null), NNMi dynamically selects the address based on
responses from the device's SNMP agent.

Basic Settings for this Device

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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Attribute Description

When NNMi determines the Management Address, NNMi handles cases where the
SNMP agent supports multiple IP addresses by following a set of rules. Click here for
details.

1. If the node has only one loopback address1, that address is used with the fol-
lowing exceptions:

n NNMi prefers loopback interfaces for management communication, where pos-
sible. However, NNMi automatically filters out addresses in the reserved loop-
back network range 127/24 (127.*.*.*).

n NNMi ignores any address that is virtual (HSRP/VRRP), an Anycast Ren-
dezvous Point IP Address2, or whose interface is administratively down.

2. If an SNMP agent supports multiple loopback addresses, NNMi uses the loopback
address with the lowest number to which this SNMP agent responds (for example,
10.16.42.197 is a lower number than 10.16.197.42).

3. If no loopback address is supported, NNMi uses the address that meets the fol-
lowing criteria:

n During initial discovery, NNMi uses the first address to which the associated
SNMP agent responded.

Note: The first address might be either a discovery seed address or an ARP
 cache address gathered in the path to this node.

n During any other discovery cycle, NNMi uses the current Management Address
value.

For this sequence, if the SNMP agent does not respond to any of the above addresses,
NNMi automatically repeats the sequence with SNMPv2c, SNMPv1, and SNMPv3
(according to the current NNMi Communication Configuration settings established by
your NNMi administrator).

This sequence is repeated during each configuration polling cycle. And the address
could change over time (for example, if an address did not respond to SNMP queries due
to network problems or node reconfiguration).

Attribute Description

Enable SNMP
Communication

If  enabled, the Discovery Process and State Poller Service generate network traffic
with SNMP protocol to discover and monitor this device.

If  disabled, NNMi does not generate any SNMP traffic to this device.

SNMP Settings for this Device

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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Attribute Description

Caution: With no SNMP data, Spiral Discovery interprets each IP Address as a sep-
arate node, Causal Engine calculates Status based only on IP address State,
previously discovered Interfaces show a State attribute value of "Not Polled"
and a Status attribute value of "No Status" with the Interface map-symbol color
set to beige, and no new Interfaces are discovered.

Note: Your choice might be overridden if Monitoring Configuration settings disable
SNMP usage for the State Poller Service, see "Set Global Monitoring" (on page
153) or "Configure Monitoring Behavior" (on page 152).

Enable SNMP
Address Dis-
covery

If  enabled, NNMi automatically identifies which management address (SNMP
agent) to use for each device. If the initially configured address becomes unreachable,
NNMi automatically locates another SNMP agent, if possible, and changes the man-
agement address attribute value.

If  disabled, when the current management address (SNMP agent) becomes
unreachable, NNMi reclassifies the node as a non-SNMP node until the previously
configured management address is available again.

SNMP Timeout (Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999
milliseconds.

Time that NNMi waits for a response to an SNMP query before reissuing the request.
Both the Discovery Process and the State Poller Service use this setting for this device.
For an explanation of how NNMi implements timeout and retry configurations, see
"Timeout / Retry Behavior Example for SNMP" (on page 50).

SNMP Retries
Count

Maximum number of retries that NNMi issues for an SNMP query before determining
the query result to be "unresponsive". Zero means no retries. Both the Discovery Proc-
ess and the State Poller Service use this setting for this device.

SNMP Port Default is 161. Specifies the management station's port that NNMi uses when gen-
erating SNMP traffic. Both the Discovery Process and the State Poller Service use this
setting for this device.

SNMP Proxy
Address

Specify the IP address of your SNMP Proxy Server.

You can set up one or more SNMP Proxy Servers to enable communication with
nodes that otherwise might be unreachable (for example, when a node to be managed
is behind a firewall). The SNMP Proxy Server allows NNMi to manage these nodes in
the same way as nodes that provide SNMP access directly.

SNMP Proxy
Port

Port number on the SNMP Proxy Server. See SNMP Proxy Address (previous attrib-
ute).
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Attribute Description

SNMPv3 Set-
tings

 Click the SNMPv3 Settings  Lookup icon and select one of the options from the
drop-down menu:

l Quick View to display summary information for the currently configured
(selected) SNMPv3 Setting name.  

l  Quick Find to view and select from the list of all existing SNMPv3 Settings (for
more information see "Use the Quick Find Window" (on page 19)).

l  Open to display the details of the currently configured (selected) SNMPv3 Set-
ting.

l  New to create a new SNMPv3 Setting.

The SNMPv3 Settings form opens. See "SNMPv3 Settings Form" for information about
each attribute.

Attribute Description

Enable ICMP
Communication

If  enabled, NNMi generates network traffic with ICMP protocol to this device.

If  disabled, NNMi does not generate any ICMP traffic to this device:

l Addresses in this Node (both previously discovered and newly discovered) have a
State attribute value of "Not Polled" and a Status attribute value of "No Status" with
the IP Address map-symbol color set to beige.

l If both ICMP and SNMP are disabled, the Node has a Status attribute value of "No
Status" have a map-symbol background shape color set to beige.

Note: Your choice might be overridden if Monitoring Configuration settings disable
ICMP usage for the State Poller Service, see "Set Global Monitoring" (on page
153) or "Configure Monitoring Behavior" (on page 152).

ICMP Timeout (Seconds:Milliseconds) Maximum 1 millisecond less than a minute: 59 seconds 999
milliseconds.

Time that NNMi waits for a response to an ICMP query before reissuing the request to
this device. For an explanation of how NNMi implements timeout and retry con-
figurations, see "Timeout / Retry Behavior Example for ICMP" (on page 51).

ICMP Retries
Count

Maximum number of retries that NNMi issues for an ICMP query to this device before
logging an error. Zero means no retries.

ICMP Settings for this Device

Related Topics:

"Configure Default SNMP and ICMP Protocol Settings" (on page 47)

"Configure Default Community Strings (SNMPv1 or SNMPv2c)" (on page 51)

"Configure Regions (Communication Settings)" (on page 56)
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Configure Community Strings for Nodes

Configure one SNMPv1 or SNMPv2c "get" community string for each node.

To provide a community string for a specific device:

1. Navigate to the Specific Node Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Specific Node Settings tab.

d. Do one of the following:

o To establish a node definition, click the New icon, and continue.

o To edit a node definition, select a row, click the Open icon, and continue.

e. In the Specific Node Settings form, navigate to the Community Strings tab.

2. Provide a community string for this region (see table).

Tip: : If you do not provide any community strings, NNMi uses the applicable Region settings and if
none match, NNMi uses the default settings .

3. Click Save and Close to return to the Communication Configuration form.

4. Click Save and Close. NNMi updates the affected SNMP Agent objects in the NNMi database.
Your changes are available for the next Discovery or Monitoring cycle. 

Attribute Description

Read Com-
munity
String

The SNMPv1 or SNMPv2c "get" (read-only) community string that is used for this device.
Case-sensitive.

Many proxy vendors use the community string for specifying remote target information.
NNMi supports substitution parameters within community strings for SNMPv1 or SNMPv2
proxy environments. Click here for more information.

Copy and paste these codes at the end of your Community String to provide the values
required by your proxy environment. NNMi substitutes the actual attribute values from the
NNMi database at runtime: 

${contextName} = Used for specifying VLAN context for switches (VLAN associated with
the remote target node)

${managementAddress} = Node form, Management Address attribute value (the remote tar-
get node)

${snmpPort} = SNMP Agent form, UDP Port attribute value (SNMP agent associated with
the remote target node)

SNMPv1 or SNMPv2c Community String for this Device
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Configure Credential Settings for Nodes (NNM iSPI NET)

NNMi uses Default Credential Settings to access devices when running Diagnostics either automatically or
when the Actions → Run Diagnostics option is used. (See "Configure Diagnostics for an Incident (NNM
iSPI NET)" (on page 291) and Node Form: Diagnostics Tab for more information.)

NNMi uses Shell (SSH or telnet) as the method for accessing devices with the credentials specified. NNMi
uses SSH as the preferred communication method. If the SSH attempt fails, NNMi uses telnet.

To provide credential settings for a specific node:

1. Navigate to the Specific Node Device Credentials form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Navigate to the Specific Node Settings tab.

d. Do one of the following:

o To establish a definition, click the New icon, and continue.

o To edit a definition, select a row, click the Open icon, and continue.

e. In the Specific Nodes Settings form, navigate to the Device Credentials tab.

f. Do one of the following:

o To establish a credential setting, click the  New icon, and continue.

o To edit a credential setting, select a row, click the  Open icon, and continue.

o To delete a credential setting, select a row and click the  Delete icon

2. Provide the attribute values of credentials for this node (see table).

Note: NNMi tries to use the Specific Node Device Credentials provided here. If none match, NNMi
tries the Region Device Credential settings. If none match, NNMi tries the Default Device Cre-
dentials.

3. Click Save and Close to return to the Specific Node Settings form.

4. Click Save and Close to return to the Communication Configuration form.

5. Click Save and Close.

Attribute Description

User
Name

Type the user name that you want NNMi to use for logging into this device.

Password Type the password that you want NNMi to use for logging into this device.

Note: NNMi encrypts the password and displays asterisks for this attribute. If you want to
change the password, first clear the asterisks displayed in the Password attribute and
enter the new Password value.

Specific Node Device Credential Attributes
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Load Specific Node Settings from a File

Import a list of devices, using a command line command. You also have the option of importing the
SNMPv1 or SNMPv2c community string for each device or the SNMPv3 USM settings. This is useful when
your SNMP is managed by a change control mechanism. You can bulk insert the SNMP assignments into
NNMi. Each assignment shows up as an individual entry in the table on the Communication Con-
figuration form's Specific Node Settings tab.

To import SNMP assignments:

1. On the NNMi management server's hard drive, create a text file according to the specifications in the
nnmcommload.ovpl reference page. Create one line for each device. For more information, see
nnmcommload.ovpl

To add comments to your file, place a # character at the beginning of each comment line.

Note: When you load this file, the data in the file overwrites any previously entered information about
each hostname.

2. Use the following command line command to load the information into the NNMi database:

Windows:
<drive>:\Program Files (x86)\HP\HP BTO Software\bin\nnmcommload.ovpl -u <NNMi-
adminUserName> -p <NNMiadminPassword> -file <path/filename>

<drive> is the drive on which NNMi is installed

UNIX:
/opt/OV/bin/nnmcommload.ovpl -u <NNMiadminUserName> -p <NNMiadminPassword> -
file <path/filename>

3. Verify that the import worked properly:

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Communication Configuration.

c. Access the Specific Node Settings tab.

4. Review each entry in the table to verify that the import was successful.

To verify the SNMP configuration for an IP Address, at the command line, type:

Note: For more information, see nnmcommconf.ovpl

Windows:
<drive>:\Program Files (x86)\HP\HP BTO Software\bin\nnmcommconf.ovpl -u <NNMi-
adminUsername> -p <NNMiadminPassword> -proto snmp -host <node IP address>

<drive> is the drive on which NNMi is installed

UNIX:
/opt/OV/bin/nnmcommconf.ovpl -u <NNMiadminUsername> -p <NNMiadminPassword> -proto
snmp -host <node IP address>

To verify the ICMP configuration for an IP Address, at the command line, type:

Note: For more information, see nnmcommconf.ovpl
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Windows:
<drive>:\Program Files (x86)\HP\HP BTO Software\bin\nnmcommconf.ovpl -u <NNMi-
adminUsername> -p <NNMiadminPassword> -proto icmp -host <node IP address>

<drive> is the drive on which NNMi is installed

UNIX:
/opt/OV/bin/nnmcommconf.ovpl -u <NNMiadminUsername> -p <NNMiadminPassword> -proto
icmp -host <node IP address>

Verify Your Communication Settings

After you configure your communication settings, you can check to determine what parameters NNMi is
using to communicate with a node of interest.

Use the Actions → Communication Settings menu item to display a report.

NNMi displays the communication configuration information for the node selected, including the SNMP

 and ICMP configuration information.

To navigate to a table view and select a node:

1. From the workspace navigation panel, select the workspace of interest. For example, Inventory.

2. Select the view that contains the node whose communication settings you want to check. For exam-
ple, Nodes.

3. From the table view, select the  check box that precedes the node whose configuration you want to
check.

4. Select Actions → Communication Settings.

To navigate to a map view and select a node:

1. Navigate to the table view.

2. From a table view, select the  check box that precedes the node of interest.

3. Select the Actions menu.

4. From the drop-down menu, select the map view of interest.

5. From the map view, click the node whose configuration you want to check.

6. Select Actions → Communication Settings.

To select a node from a form:

1. From a table view, click the  Open icon that precedes the node of interest.

2. From a map view, click the node of interest on the map and click the  Open icon.

3. Select Actions → Communication Settings.

See "Configuring Communication Protocol" (on page 47) for information about configuring communication
settings.

Related Topics

nnmcommconf.ovpl
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Discovering Your Network

Configure NNMi to discover only the nodes that are important to you and your team.

Using a wide range of protocols and techniques, NNMi Spiral Discovery gathers a wealth of information
about your network inventory, ascertains the relationships between devices (such as subnets and VLANs),
and accurately maps out the connectivity between those devices. The NNMi Causal Engine determines
the current status of each device (plus each associated interface and address within that device) and
proactively notifies you when NNMi detects any trouble or potential trouble.

This dynamic discovery process continues over time. When things change in your network management
domain, Spiral Discovery automatically updates information according to a schedule that you set. The
topology maps always reflect accurate timely information about any changes in your network.

Note: Review and complete the prerequisites before configuring discovery, "Prerequisites for Discovery"
(on page 86).

You decide which nodes are discovered and how often NNMi checks for new devices in your network (see

"Determine Your Approach to Discovery" (on page 88) for ideas). The steps required depend on what you
want to do:

l "Adjust the Discovery Interval" (on page 98) – Optional. The time NNMi waits between the discovery
cycles that keep your network information current. By default, NNMi updates information about devices
and connections every 24 hours.

l "Configure the Node Name Strategy" (on page 99) – Optional. Choose the node naming strategy for
NNMi to use for the map icons and in the Name column of the table views.

l "Configure Auto-Discovery Rules" (on page 101) – Optional. Specify whether you want NNMi to auto-
matically discover groups of network devices (identified by IP address ranges and MIB II sysObjectIDs).
NNMi extends discovery by using requests for Address Resolution Protocol (ARP) cache information
about neighbors. NNMi uses a variety of protocols to gather information from all neighbor devices. See
"Auto-Discovery Rules" (on page 83) for more details.

Specify whether NNMi uses Ping Sweep (ICMP ping) or your Discovery Seeds as starting points for
gathering information about neighboring devices.

NNMi discovers any devices that comply with your rule configurations, and creates a record of each
device in the NNMi database. If the device supports SNMP, all addresses for that device are combined
into one Node object. If the device does not support SNMP, NNMi queries DNS to determines the host-
name. If this hostname matches another non-SNMP node, NNMi merges the information to create only
one node with multiple associated addresses.

l "Configure an Excluded IP Addresses Filter" (on page 108) – Optional. Specify addresses that you do
not want NNMi to discover.

l "Specify Discovery Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112) –
Optional. Use Discovery Seeds to accomplish either of the following purposes:

n Limit Spiral Discovery to only the seeds that you specify.

n Provide seeds as starting points for your Auto-Discovery Rules.

For details about how Spiral Discovery works:

For a list of the types of things NNMi can discover, see About Map Symbols.

Page 76 of 422

../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0800Symbols.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0800Symbols.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0800Symbols.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Discovering Your Network

From the information collected, NNMi constructs a model of your network configuration in the database,
and displays this information in the map views. See View Maps of Network Connectivity for more infor-
mation about the available map views.

How Spiral Discovery Works

NNMi uses a variety of network protocols (read-only queries) within your defined network management
domain to gather information about each discovered device. You see the real-time accumulation of infor-
mation as it is collected, rather than waiting until NNMi discovers your entire network environment.

Spiral Discovery dynamically gathers two categories of information from each discovered node:

1. Information about the node — NNMi gathers detailed information about each device. You can review
this data on the device's Node form. Examples of configuration details include IP address, subnet
information, sysObjectID, number of interfaces, and version of SNMP supported.

2. Conectivity details — NNMi gathers information about how devices are connected to each other on
Layer 21 and Layer 32 of your network.

1Refers to the Data Link layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Data Link layer moves data across the physical links in the network. The switches and bridges
are devices that redirect data messages at the layer 2 level, using the destination Media Access Control
(MAC) address to determine where to direct the message.
2Refers to the Network layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Network layer is concerned with knowing the address of the neighboring nodes in the network,
selecting routes and quality of service, and recognizing and forwarding incoming messages to local host
domains. The router and switch-router are the devices that redirect data messages at the Layer 3 level.
Everything in a subnet is connected at the Layer 3 (IP) level.
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Spiral Discovery checks for changes according to a schedule determined by the Discovery Interval. NNMi
administrators can set the schedule to meet any service-level agreement (SLA) commitments.

After NNMi completes initial discovery of your network, ongoing discovery takes over according to the Dis-
covery Interval:

l If a new node is added to your defined network management domain, NNMi dynamically updates the
topology database and maps. The node form provides details of the new node's configuration. The
maps reflect the new connectivity information.

l If configuration settings change on an existing node, NNMi dynamically updates the database and
maps to reflect the changes.

The only exception is when non-SNMP addresses that had the same DNS hostname are changed to
have separate DNS hostnames, NNMi must completely rediscover the non-SNMP nodes to correctly
update the database objects (node, interface, address, connection, and incidents). The NNMi admin-
istrator must delete the old non-SNMP node object and force NNMi to rediscover the new node con-
figurations. See "Delete Nodes" (on page 122).

Tip: At any time, you can initiate an on-demand rediscovery poll to gather the most current information

about a previously discovered device. Select a node and click the Actions → Configuration Poll com-
mand, or use the nnmconfigpoll.ovpl command.

A number of NNMi tools let NNMi administrators control how Spiral Discovery works.

For details about how Spiral Discovery works:

Discovery Intervals

Specify how often your entire network is checked for the latest information.

This interval controls how often NNMi generates network traffic to gather the following information:

l Information about the nodes, addresses, and interfaces you configure for discovery.

l Information about Level 2 connectivity between interfaces and VLANs in your network.

l Information about Level 3 connectivity between addresses in your network.

Make sure that you allow plenty of time for the interval so that Spiral Discovery cycles do not overlap. The
larger your network environment, the longer the time required to complete a Spiral Discovery cycle.

See "Adjust the Discovery Interval" (on page 98) to learn how to set the discovery interval.

For details about how Spiral Discovery works:

Discovery Node Name Choices

Control how the Name attribute on node forms is populated during discovery. This Name value is used to
identify the object in NNMi maps and table views. You specify a hierarchy for discovery to use. You con-
figure three levels in the hierarchy. See "Node Name Decision Tree" (on page 81).

You can designate any of the following for each level of the node Name decision hierarchy:

l DNS Names. Discovery uses the results of hostname resolution.

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to determine the host-
name. Click here for details.

a. If a hostname is available, it must resolve to a valid IP address. NNMi stores the fully-
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qualifiedhostname in the database as all lowercase characters.

b. If more than one address is associated with a node, the loopback address1 is used with the fol-
lowing exceptions:

o NNMi prefers loopback interfaces for management communication, where possible. How-
ever, NNMi automatically filters out addresses in the reserved loopback network range
127/24 (127.*.*.*).

o NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Rendezvous Point
IP Address2.

c. If a node has multiple loopback addresses, NNMi uses the loopback address with the lowest
number that resolves to a hostname (for example, 10.16.42.197 is a lower number than
10.16.197.42).

d. If no loopback address resolves to a hostname and the device supports SNMP, NNMi uses the
current value from the Management Address attribute on the Node form.

e. If the device does not support SNMP, the IP address or DNS name found during the current

rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change from cycle to
cycle (for example, if an address did not respond to SNMP queries due to network problems or node
reconfiguration).

l MIB II sysName Values. Device administrators set the sysName. Discovery avoids populating the
NNMi database with multiple devices having the same manufacturer's default sysName. If a sysName
matches or starts with the manufacturer's default factory setting (case-sensitive), discovery ignores
sysName as a choice for the Name attribute of the node. NNMi ships with a Device Profile for each
device type. The Device Profile includes a record of the manufacturer's default sysName.

Caution: You can override this choice using the Device Profile's Advanced settings, Never Use
sysName attribute. See "Configure Device Profiles" (on page 95) for more information.

l IP addresses. The addresses are gathered from discovery seed addresses that you provided, ping
sweep configurations, or neighbor addresses gathered using Auto-DiscoveryRules. Discovery avoids
potential confusion when a device has multiple IP addresses by following these rules:

n If the device supports SNMP, the address of the responding SNMP agent is recorded (the Man-
agement Address) and the other addresses are associated with the node. See "Specific Node Set-
tings Form (Communication Settings)" (on page 67) for more information about configuring the
management address.

n If the device does not support SNMP, NNMi queries DNS to determine the hostname. If this host-
name matches another non-SNMP node, NNMi merges the information to create only one node
with multiple associated addresses.

See "Configure the Node Name Strategy" (on page 99) to learn how to configure the NNMi node name
strategy.

For details about how Spiral Discovery works:

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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Node Name Decision Tree

For each discovered address, NNMi gathers multiple attributes that are used to implement your Node
Name strategy. NNMi chooses the node Name based on the Management Address, System Name, and
Hostname collected during discovery. The following diagram shows how NNMi determines values for
these attributes.

For details about how Spiral Discovery works:
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Discovery Seeds (as a starting point)

An optional discovery seed is a specific node that you want NNMi to discover. For example, a discovery
seed might be a core router in your management environment.

Each discovery seed is identified by an IP address or hostname. When you add an optional discovery
seed, NNMi immediately tries to discover that device (without waiting until the next regularly scheduled dis-
covery interval). If discovery is not successful, NNMi tries again 10 minutes later, and continues trying. The
time between each attempt is doubled until the time reaches 1 week or equals your current discovery inter-
val.

Discovery seeds override Auto-Discovery Rule definitions. NNMi discovers seed addresses regardless of
how you configure Auto-Discovery Rules or the Excluded IP Addresses filter.

Note: Nodes configured as discovery seeds are always discovered and added to the topology database. If
you change your mind and delete a discovery seed configuration, the node is not automatically
deleted from the topology database. See "Delete Nodes" (on page 122).

If you configure one or more Auto-Discovery Rules, note the following:

l If Discover Included Nodes is enabled for an Auto-Discovery Rule, NNMi uses each discovery
seed as a starting point to gather information about neighboring devices and expand discovery.

Note: You can use the Ping Sweep option in your Auto-Discovery Rules in addition to or instead of Dis-
covery Seeds.

l If Discover Included Nodes is disabled for an Auto-Discovery Rule, no devices matching that rule's
criteria are discovered and added to the topology database unless:

n The device's address is a discovery seed.

n The device's address is reported as a neighbor to another discovered address.

See "Specify Discovery Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112) to learn
how to establish discovery seeds.

For details about how Spiral Discovery works:

Ping Sweep (as a starting point)

You have two choices for Auto-Discovery starting points. Use either or both to best advantage in your net-
work environment:

l Discovery Seeds (You designate specific IP addresses or hostnames where Auto-Discovery starts gath-
ering neighbor information.)

l Ping Sweep (NNMi issues ICMP pings to certain addresses gathered from neighbor information.)

Ping Sweep sends ICMP ping commands to IP addresses in the ranges defined in your Auto-Discovery
rules. Ping Sweep enforces the following limits to the ICMP pings:

n For each specific IP address range, NNMi issues pings across a maximum of the last two octets in
the IPv4 address range. This is equivalent to a /16 subnet

n ICMP pings are limited to 500 at one time. This avoids flooding your network or tripping spam detec-
tion tools.

Ping Sweep is useful In wide area networks such as ATM, Frame Relay, and Point-to-Point that do not con-
tain an Address Resolution Protocol (ARP) cache.

You configure the Ping Sweep feature at two levels:
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l "Configure Ping Sweep Global Settings" (on page 98)

l "IP Address Ranges for Auto-Discovery" (on page 104) (Ping Sweep configuration for each rule)

For details about how Spiral Discovery works:

Auto-Discovery Rules

Auto-Discovery Rules control the extent of automatic discovery. You choose the starting points for auto-
matic discovery (either Discovery Seeds or Ping Sweep, or both).

l If Discover Included Nodes is disabled for a particular Auto-Discovery Rule, nodes that match the
Rule criteria are affected as follows:

n IP Address ranges are not used for gathering neighbor information, see "Limit Sources of Neighbor
Information" (on page 93).

n System Object ID ranges are excluded from discovery. For examples, see "Specific System Object
IDs Not Discovered" (on page 94) .

l If Discover Included Nodes is enabled for a particular Auto-Discovery Rule, a variety of protocols
are used to gather information about the neighbors adjacent to each discovered device. Spiral Dis-
covery then requests neighbor information from each new neighbor. This sequence continues until the
boundaries identified by your rule definition are reached.

See "Configure Auto-Discovery Rules" (on page 101) to learn how to establish the rules that control auto-
matic discovery.

When defining Auto-Discovery Rules, you must provide at least one Auto-Discovery Rule that includes an
IP address range to define the limits of your management domain. By default NNMi discovers routers and
switches. You can expand the number of device types that NNMi discovers by including one or more Sys-
tem Object ID Ranges (based on MIB II sysObjectID values). Your address ranges and system object ID
ranges determine which discovered addresses are added to the NNMi database.

NNMi gathers information about neighboring devices using ARP cache, DNS, and the following protocols:

l BGP — Border Gateway Protocol

l CDP — Cisco Discovery Protocol

l EIGRP — Cisco Enhanced Interior Gateway Routing Protocol

l ENDP — Enterasys Discovery Protocol (also known as CDP - Cabletron Discovery Protocol)

l FDP — Foundry Discovery Protocol

l OSPF — Open Shortest Path First

In Wide Area Networks (WANs) such as ATM, Frame Relay, and Point-to-Point (where ARP cache is not
available), the optional Ping Sweep feature locates nodes for Auto-Discovery to use when gathering
neighbor information and evaluating subnet connection rules.

For details about how Spiral Discovery works:

Filters to Exclude Certain IP Addresses

When configuring Spiral Discovery in NNMi, sometimes it is useful to exclude certain addresses or ranges
of addresses from discovery and monitoring. For example:
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l There are multiple Nortel switches in your environment. They each have a non-routable IP address of
192.168.168.168 that is defined by the manufacturer. This special address is used to establish the
default VLAN for the switch. However, NNMi discovers this duplicate address and establishes a lot of
unnecessary connections on the Layer 3 Neighbor View map.

l Your service provider does not allow ICMP or SNMP traffic from your NNMi installation. That range of
addresses can easily be excluded to prevent violating your contractual agreement with the vendor.

l The Provider Edge (PE) routers have addresses that NNMi ICMP ping commands cannot reach or
have addresses that you want to exclude from Subnet views.

Note: The node and interface associated with any address identified in your Excluded IP Address filter
shows up in the topology database and maps.

Carefully select the addresses for your Excluded IP Addresses filter. Do not populate the Excluded IP
Addresses filter with the addresses associated with SNMPv1/SNMPv2c agents or SNMPv3 engines (the
Management Addresses). See "Configure an Excluded IP Addresses Filter" (on page 108) to learn how to
exclude an address or range of addresses from discovery.

For details about how Spiral Discovery works:

Subnet Connection Rules

Sometimes it is useful to monitor connections in the following categories:

l Virtual tunnel connections within your management domain.

l Connections to remote sites (across a Service Provider's network or a WAN).

NNMi accomplishes this by following special rules for subnets with prefix lengths between 28 and 31.
These special rules are called Subnet Connection Rules. NNMi provides a group of predefined Subnet
Connection Rules (see "Subnet Connection Rules Provided by NNMi" (on page 111)). You can edit an
existing Subnet Connection Rule or create your own (see "Configure Subnet Connection Rules" (on page
109)).

If you limit Spiral Discovery to only your Discovery Seeds, NNMi uses the Subnet Connection Rules to
detect connections among those devices.

If you use Auto-Discovery rules to configure Spiral Discovery, when NNMi detects a subnet prefix between
28 and 31, NNMi uses the Subnet Connection Rules:

1. NNMi checks for an applicable Subnet Connection Rule (see "Subnet Connection Rules Provided by
NNMi" (on page 111)).

2. If a match is found, Spiral Discovery checks the topology database for existing data about each IPv4
address in the subnet. If no data is found for a particular IPv4 address, NNMi issues an SNMP query
to the new IPv4 address. The number of available IPv4 addresses for each valid prefix length is
described in the following table:

Valid Minimum IPv4 Prefix Length Values Number of Usable IPv4 Addresses

28 14 (16-2=14)*

29 6 (8-2=6)*

30 2 (4-2=2)*

31 2

Valid Minimum Prefix Length Values (Subnet Mask Length)
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* Two IPv4 addresses are reserved in each subnet. The first IPv4 address is used for the network
itself and the last IPv4 address is reserved for broadcast.

3. NNMi checks the Excluded IP Addresses list. Any addresses in the list are dropped. For details, see
"Filters to Exclude Certain IP Addresses" (on page 83).

4. New IPv4 addresses that respond to SNMP are added to the topology database and available for
monitoring purposes. New IPv4 addresses that do not respond to SNMP are ignored.

5. If the IPv4 address on each end of a connection has an associated interface, NNMi uses the subnet
connection rule to display the connection on map views.

In a Layer 3 Neighbor View map, if NNMi discovers an interface that is connected to more than one
interface, the results of your subnet connection rule look like the following:

In a Layer 2 Neighbor View map, if NNMi discovers an interface that is connected to more than one
interface, the results of your subnet connection rule look like the following:

See "Configure Subnet Connection Rules" (on page 109) to learn how to configure Subnet Connection
Rules.  

For details about how Spiral Discovery works:

Device Profiles and Discovery

You can modify the settings in the Device Profiles to fine-tune Spiral Discovery and the device symbols on
the maps.

You can also use the Configuration → Device Profiles view to see the list of all known system object IDs
(MIBII sysObjectIDs) at the time NNMi released. This list of system object IDs is useful if you want to
expand the range of devices that NNMi discovers. By default, NNMi discovers only routers and switches
(see "SNMP System Object ID Ranges for Discovery" (on page 106)).

See the Advanced Settings section of "Configure Device Profiles" (on page 95) for more information.

For details about how Spiral Discovery works:
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Prerequisites for Discovery

NNMi uses SNMP and DNS while discovering and monitoring devices in your network environment. To
ensure accurate network topology information, verify that these prerequisites are working properly:

l "SNMP Prerequisites" (on page 86)

l "Well-Configured DNS Prerequisite" (on page 86)

SNMP Prerequisites

Spiral Discovery uses SNMP while detecting devices and connections among the devices in your network
environment. NNMi also uses SNMP as part of monitoring and reporting on the health of devices in your
network environment.

NNMi supports the following SNMP versions:

l SNMPv1

l SNMPv2c

l SNMPv3

NNMi uses information gathered from Routers to establish subnet membership for Layer 3 connections.
Make sure that important Routers in your network environment are SNMP enabled.

NNMi uses either of the following criteria to identify a Router:

l Each Router responds with appropriate values for sysServices (1.3.6.1.2.1.1.7)  and ipForwarding 
(1.3.6.1.2.1.4.1). See RFC1213-MIB for details.

l Identify Routers with the Device Profile configuration settings for a particular device type.

You must provide the appropriate SNMP Community Stings to NNMi. See "Configuring Communication
Protocol" (on page 47).

Before configuring NNMi discovery, complete the following steps:

1. Enable SNMP communication on important devices in your network (each device that you want
NNMi to actively monitor).

See the manufacturer's documentation for information about how to configure SNMP on each of your
devices.

n Configure the SNMP agents.

n Establish Read-Only community strings for SNMPv1 or SNMPv2c.

n Establish the appropriate SNMPv3 User-based Security Module (USM) level of security for
authentication and privacy.

2. Configure NNMi to use the appropriate community strings or USM settings for your network envi-
ronment. See "Configuring Communication Protocol" (on page 47).

Well-Configured DNS Prerequisite

NNMi uses Domain Name System (DNS) to determine relationships between hostnames and IP
addresses. This can result in a large number of nslookup requests.
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Tip: To improve the response time for nsLookup, deploy a secondary DNS service on the NNMi man-
agement server or another system on the same subnet as the NNMi management server. Configure
this secondary DNS service to mirror the information from the primary DNS service. Another option is to
use */etc/hosts instead of DNS in small environments.

Use nslookup to Verify DNS Server Configurations

Verify that your DNS servers are well configured to prevent long delays when resolving nslookup
requests. This means the DNS server responding to NNMi nslookup requests has these qualities:

l The DNS server is an authoritative server and does not forward DNS requests.

l The DNS server has consistent hostname-to-IP address mappings and IP address-to-hostname map-
pings.

l If your network uses multiple DNS servers, all respond consistently to any particular nslookup request.

Caution: Round-robin DNS (used to do load balancing of web application servers) is not appropriate
because any given hostname can map to different IP addresses over time.

On the NNMi management server, verify that the following are configured appropriately for your envi-
ronment:

l All operating systems: Locate your */etc/hosts file and ensure that the host file contains a mini-
mum of two entries. When an nslookup command is not successful, this file takes over:

127.0.0.1 (loopback loghost) 
<NNMi_server_address> (the IP address of the NNMi management server)

Windows: The following registry key determines the location of this file:

\HKEY_LOCAL_MACHINE\SY-
STEM\CurrentControlSet\Services\Tcpip\Parameters\DataBasePath

UNIX: This file is in the /etc directory.

l Windows: Use the Control Panel to navigate to your Network and Internet Connections configuration,
Network Connections, Local Area Connections, Support tab, and click the Details button. Verify that all
identified DNS servers provide consistent hostname-to-IP address mappings and IP address-to-host-
name mappings.

l UNIX: Ensure that the nslookup search path resolves to the nsswitch.conf file. See the
nsswitch.conf(4) manpage that was provided with your operating system. Verify that all identified DNS
servers provide consistent hostname-to-IP address mappings and IP address-to-hostname mappings.

Exclude Problem Devices from nmlookup

You can populate two files that instruct nslookup to exclude certain addresses. The benefits of doing this
are as follows:

l Speed up Spiral Discovery.

l Keep network traffic generated by NNMi to a minimum.

If you know there are problems with the DNS configuration in your network domain (hostnames or
addresses that do not resolve properly), instruct NNMi to avoid nslookup requests for unimportant
devices.

To identify problem devices, create the following two files prior to configuring NNMi discovery. NNMi never
issues a DNS request for hostnames or IP addresses identified in these files:
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l hostNoLookup.conf (enter fully-qualified hostnames or wildcards that identify groups of hostnames)

l ipNoLookup.conf (enter fully-qualified IP addresses or wildcards that identify groups of IP addresses)

Use an ASCII editor to populate the files. Place the files in the following location on the NNMi management
server:

l Windows:
<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO Soft-
ware\shared\nnm\conf\

<drive> is the drive on which NNMi is installed.

l UNIX:
/var/opt/OV/shared/nnm/conf/

Determine Your Approach to Discovery

Discover and monitor only the network devices that you and your team consider to be important. Take any

approach that makes sense to you.

Tip: See the following examples for ideas. Print one or more of the following topics to use as a guide when
you are configuring NNMi discovery.

Maintain absolute control over what is discovered.

l "Do Not Use Auto-Discovery Rules" (on page 88)

Configure Spiral Discovery to make decisions about what is discovered.

Create one or more Auto-Discovery Rules that define the boundaries of what is important to you and your
team:

l "Routers and Switches Discovered" (on page 89) (Auto-Discovery Rules default behavior)

l "All SNMP Devices Discovered" (on page 90) (more than Routers and Switches)

l "Everything Discovered" (on page 91) (all SNMP enabled devices and all Non-SNMP devices)

Fine tune Spiral Discovery behavior.

Identify the things your team is not interested in monitoring:

l "All Devices from a Specific Vendor Discovered" (on page 92)

l "Limit Sources of Neighbor Information" (on page 93)

l "Exclude Problem IP Addresses from Discovery" (on page 94)

l "Specific System Object IDs Not Discovered" (on page 94)

Do Not Use Auto-Discovery Rules

If you want NNMi to discover only what you specify, use these guidelines.

Note: After you set your configuration according to these guidelines, when a new device is added to your
network, NNMi does not discover that device unless you configure another discovery seed to iden-
tify that device.
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Task How

Do not include any Auto-Discovery Rules. None are required for
this strategy.

In the Discovery Seeds settings, designate the hostname or IP address of each
device you want NNMi to discover and configure NNMi to monitor your SNMP
devices. See "Monitoring Network Health" (on page 151).

"In the Console, Con-
figure Discovery
Seeds " (on page
113)

Configuration Steps to Discover Only What You Specify

Note: You control how often Spiral Discovery checks the discovered nodes based on a Rediscovery Inter-
val setting. See "Adjust the Discovery Interval" (on page 98) for more information.

Routers and Switches Discovered

If you want Spiral Discovery to automatically find devices on your network, use these guidelines. By
default, Spiral Discovery Rules apply only to routers and switches. If you want to discover more devices,
see "All SNMP Devices Discovered" (on page 90) or "Everything Discovered" (on page 91).

Note: After you set your configuration according to these guidelines, when a new router or switch is added
to your network, you do not need to do anything. NNMi discovers it during the next discovery cycle.

Task How

Create an Auto-Discovery Rule. Set the following attribute values:

l Enter Ordering
It is recommended that you use Ordering number 500. This pro-
vides flexibility if you want to expand or limit Spiral Discovery
behavior later by creating additional rules with higher or lower
Ordering numbers.

l Enable Discover Included Nodes

l Disable Discover Any SNMP Device

l Disable Discover Non-SNMP Devices

Note: Discover Included Nodes is enabled by default.

"Configure Auto-Discovery
Rules" (on page 101)

Create one or more IP Ranges settings that identify the entire scope
of the addresses in your network domain:

Enter IP Range (at least one)

Set Range Type

"IP Address Ranges for Auto-
Discovery" (on page 104)

Optional. NNMi can use Enable Ping Sweep (instead of or in addi-
tion to discovery seeds, see below) to gather neighbor information.

"Ping Sweep (as a starting
point)" (on page 82)

Configuration Steps to Discover Only Routers and Switches
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Task How

If you want Spiral Discovery to find all routers and switches. Do not
create any System Object ID Ranges.

If you want to limit Spiral Discovery to only the vendor/make/model of
routers and switches that you specify, create one or more System
Object ID Ranges. Your list must include everything you want Spiral
Discovery to find.

"SNMP System Object ID
Ranges for Discovery" (on page
106)

Tip: Navigate to the Con-
figuration workspace, and
select the Device Profiles
view to see all known system
object IDs at the time NNMi
 released.

Optional. In the Discovery Seeds settings, designate one or more
hostnames or addresses. Consider using devices with the largest
neighbor data. For example, a good choice would be a core router.
The discovery seeds become the starting points from which Spiral Dis-
covery explores your network.

"In the Console, Configure Dis-
covery Seeds " (on page 113)

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting. See
"Adjust the Discovery Interval" (on page 98) for more information.

If you want to fine tune the Spiral Discovery results, see:

l "All Devices from a Specific Vendor Discovered" (on page 92) (more than routers and switches from
the vendor)

l "Limit Sources of Neighbor Information" (on page 93) (less than all routers and switches)

l "Specific System Object IDs Not Discovered" (on page 94) (less than all routers and switches)

l "Exclude Problem IP Addresses from Discovery" (on page 94)

All SNMP Devices Discovered

If you want Spiral Discovery to find any device that has a working SNMP agent, use these guidelines. How-
ever, this strategy may cause you to reach your license limit very quickly. Consider defining additional
Auto-Discovery Rules to limit this strategy. (See "Specific System Object IDs Not Discovered" (on page 94),
or "Limit Sources of Neighbor Information" (on page 93). See also "Filters to Exclude Certain IP Addresses"
(on page 83)).

Note: When a new SNMP-supported device is added to your network, you do not need to do anything.
NNMi discovers it during the next discovery cycle.

Task How

Create an Auto-Discovery Rule. Set the following attribute values:

l Enter Ordering
It is recommended that you use Ordering number 500. This provides flexibility if
you want to expand or limit Spiral Discovery behavior later by creating additional
rules with higher or lower Ordering numbers.

l Enable Discover Included Nodes

l Enable Discover Any SNMP Device

l Disable Discover Non-SNMP Devices

Note: This strategy may cause you to reach your license limit very quickly.

"Configure Auto-
Discovery Rules"
(on page 101)

Configuration Steps to Discover All Devices that Have SNMP Agents
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Task How

Create one or more IP Range settings that identify the entire scope of the addresses
in your network domain:

Enter IP Range (at least one)

Set Range Type

"IP Address
Ranges for Auto-
Discovery" (on
page 104)

Optional. NNMi can use Enable Ping Sweep (instead of or in addition to discovery
seeds, see below) to gather neighbor information.

"Ping Sweep (as
a starting point)"
(on page 82)

Do not create any System Object ID Ranges. When Discover Any SNMP Device is
enabled and no ranges are specified, all SNMP devices are discovered (every
sysObjectID that responds to an SNMP query).

Optional. In the Discovery Seeds settings, designate one or more hostnames or

addresses. Consider using devices with the largest neighbor data. For example, a
good choice would be a core router. The discovery seeds become the starting points
for Spiral Discovery.

"In the Console,

Configure Dis-
covery Seeds "
(on page 113)

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting.
"Adjust the Discovery Interval" (on page 98) for more information.

Everything Discovered

If you want Spiral Discovery to find all devices in your network, use these guidelines. However, this
strategy may cause you to reach your license limit very quickly. Consider defining additional Auto-Dis-
covery Rules to limit this strategy. (See "All Devices from a Specific Vendor Discovered" (on page 92),
"Specific System Object IDs Not Discovered" (on page 94), or "Limit Sources of Neighbor Information" (on
page 93). See also "Filters to Exclude Certain IP Addresses" (on page 83)).

If the device does not support SNMP, NNMi queries DNS to determine the hostname. If this hostname
matches another non-SNMP node, NNMi merges the information to create only one node with multiple
associated addresses to keep your license count low.

Note: After you set your configuration according to these guidelines, when a new device is added to your
network, you do not need to do anything. NNMi discovers it during the next discovery cycle.

Task How

Create an Auto-Discovery Rule. Set the following attribute values:

l Enter Ordering
It is recommended that you use Ordering number 500. This provides flexibility if
you want to expand or limit Spiral Discovery behavior later by creating additional
rules with higher or lower Ordering numbers.

l Enable Discover Included Nodes

l Enable Discover Any SNMP Device

l Enable Discover Non-SNMP Devices

Note: This strategy may cause you to reach your license limit very quickly. Consider

"Configure Auto-
Discovery Rules"
(on page 101)

Configuration Steps to Discover Everything
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Task How

adding your non-SNMP devices using seeds instead of selecting the Dis-
cover Non-SNMP Devices option.

Create one or more IP Ranges settings that identify the entire scope of the
addresses in your network domain:

Enter IP Range (at least one is required)

Set Range Type

"IP Address
Ranges for Auto-
Discovery" (on
page 104)

Optional. NNMi can use Enable Ping Sweep (instead of or in addition to discovery
seeds, see below) to gather neighbor information.

"Ping Sweep (as
a starting point)"
(on page 82)

Do not include any System Object ID Ranges. When Discover All SNMP Devices is
enabled and no ranges are specified, all SNMP devices are discovered (every
sysObjectID that responds to an SNMP query).

Optional. In the Discovery Seeds settings, designate one or more hostnames or
addresses. Consider using devices with the largest neighbor data. For example, a
good choice would be a core router. The discovery seeds become the starting points
for Spiral Discovery.

"In the Console,
Configure Dis-
covery Seeds "
(on page 113)

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting. See
"Adjust the Discovery Interval" (on page 98) for more information.

All Devices from a Specific Vendor Discovered

If you want to expand Spiral Discovery to all devices manufactured by a specific vendor (more than routers
and switches), use these guidelines.

To implement this strategy, you must create two Auto-Discovery Rules (see prerequisite). The prerequisite
rule configures Spiral Discovery to find any router or switch, regardless of vendor.

Note: After you set your configuration according to these guidelines, when a new device is added to your
network, you do not need to do anything. NNMi discovers or skips devices according to your con-
figuration choices.

Prerequisite: Create an Auto-Discovery Rule that uses IP address ranges to specify the outer limits of your
network management domain. This rule instructs Spiral Discovery to find devices manufactured by
any vendor. See "Routers and Switches Discovered" (on page 89), "All SNMP Devices Discovered"
(on page 90) or "Everything Discovered" (on page 91).

Task How

Create an Auto-Discovery Rule. Set the following
attribute values:

l Enter Ordering
It is recommended that you use Ordering number
 400. This rule must have a lower number than
the prerequisite rule.

l Enable Discover Included Nodes

"Configure Auto-Discovery Rules" (on page 101)

Configuration Steps to Discover All Devices from Specific Vendors
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Task How

l Enable Discover Any SNMP Device

l Disable Discover Non-SNMP Devices

Create one or more IP Ranges settings that identify
the entire scope of the addresses in your network
domain:

Enter IP Range (at least one)

Set Range Type

"IP Address Ranges for Auto-Discovery" (on
page 104)

When Discover Any SNMP Devices is enabled and
you specify one or more System Object ID Ranges,
only the sysObjectIDs you specify are discovered.

Create one or more System Object ID Ranges set-
tings. Enter the SNMP sysObjectID prefix that iden-
tifies each vendor whose devices you want to
discover.

For example, to include all HP devices, use the fol-
lowing prefix: 
1.3.6.1.4.1.11. 

Enter System Object ID Prefix

Set Range Type

"SNMP System Object ID Ranges for Discovery"
(on page 106)

Tip: Navigate to the Configuration workspace,
and select the Device Profiles view to see all
known system object IDs at the time NNMi
 released.

Note:You control how often Spiral Discovery runs by designating the Rediscovery Interval setting.
"Adjust the Discovery Interval" (on page 98) for more information.

Limit Sources of Neighbor Information

If you want Auto-Discovery to never request neighbor information from certain addresses within your man-
agement domain, use these guidelines. In other words, Auto-Discovery will not use these addresses as
resources for further discovery.

Note: The addresses identified in your IP address Range might show up in the topology database if their
neighbors provide information about them.

To implement this strategy, you must create two Auto-Discovery Rules (see prerequisite).

Prerequisite: Create an Auto-Discovery Rule that uses IP address ranges to specify the outer limits of your
network management domain. See "Routers and Switches Discovered" (on page 89), "All SNMP
Devices Discovered" (on page 90) or "Everything Discovered" (on page 91).

Task How To

Create an Auto-Discovery Rule. Set the following attribute values:

l
Enter Ordering
It is recommended that you use Ordering number 100. This rule
must have a lower number than the prerequisite rule.

"Configure Auto-Discovery
Rules" (on page 101)

Configuration Steps to Exclude Some IP addresses from Providing Neighbor Data
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Task How To

l Disable Discover Included Nodes

l Disable Discover Any SNMP Device

l Disable Discover Non-SNMP Devices

Note: This strategy instructs NNMi to "not gather neighbor information "
from certain addresses.

Create one or more IP Ranges settings that identify all addresses from
which Auto-Discovery never requests neighbor information.

Enter IP Range (at least one)

Set Range Type

"IP Address Ranges for Auto-
Discovery" (on page 104)

Create a list of IP addresses that NNMi should never discover. "Configure an Excluded IP
 Addresses Filter" (on page
108)

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting. See
"Adjust the Discovery Interval" (on page 98) for more information.

Exclude Problem IP Addresses from Discovery

If you want Spiral Discovery to never discover certain IP addresses, use these guidelines.

Note: The node and interface associated with any address identified in your Exluded IP Address filter are
added to the topology database and maps.

Task How To

Create at least one Excluded IP Addresses
filter.

"Configure an Excluded IP Addresses Filter" (on page
108)

Configuration Steps to Exclude Certain IP Addresses from Spiral Discovery

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting. See
"Adjust the Discovery Interval" (on page 98) for more information.

Specific System Object IDs Not Discovered

If you want to limit Spiral Discovery to never discover certain device makes/models, use these guidelines.
You must be able to identify the devices using SNMP system object IDs.

To implement this strategy, you must create two Auto-Discovery Rules (see prerequisite).

Note: After you set your configuration according to these guidelines, when a new device is added to your
network, you do not need to do anything. NNMi discovers or skips devices according to your con-
figuration choices.

Prerequisite: Create an Auto-Discovery Rule that uses IP address ranges to specify the outer limits of your
network management domain. See "Routers and Switches Discovered" (on page 89), "All SNMP
Devices Discovered" (on page 90) or "Everything Discovered" (on page 91).
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Task How To

Create an Auto-Discovery Rule. Set the following attribute
values:

l Enter Ordering
It is recommended that you use Ordering number 200. This
rule must have a lower number than the prerequisite rule.

l Disable Discover Included Nodes

l Disable Discover Any SNMP Device

l Disable Discover Non-SNMP Devices

Note: This strategy instructs NNMi to "not discover" certain things.

"Configure Auto-Discovery Rules"
(on page 101)

Do not include any IP Ranges. When no IP address ranges are
defined within an Auto-Discovery Rule, your system object ID
ranges take precedence over all Auto-Discovery Rules that have
higher Ordering numbers than this Auto-Discovery Rule.

Note: NNMi automatically treats any Auto-Discovery Rules with-

out any IP Range as if Discover Included Nodes were
disabled.

Create one or more System Object ID Ranges settings. Enter
the SNMP sysObjectID that identifies the make/model of the
SNMP device that you do not want to discover.

Enter System Object ID Prefix

Set Range Type

"SNMP System Object ID Ranges for
Discovery" (on page 106)

Tip: Navigate to the Configuration
workspace, and select the
Device Profiles view to see all
known system object IDs at the
time NNMi released.

Configuration Steps to Exclude Some System Object IDs from Spiral Discovery

Note: You control how often Spiral Discovery runs by designating the Rediscovery Interval setting. See
"Adjust the Discovery Interval" (on page 98) for more information.

Configure Device Profiles

According to industry standards (RFC 1213, MIB II), each combination of vendor, device type, and model
number is assigned a unique SNMP system object ID (sysObjectID). For example, all Cisco 6500 series
switches have the same sysObjectID prefix: .1.3.6.1.4.1.9.*

HP provides well over three thousand preconfigured Device Profiles, one for each known sysObjectID at
the time NNMi released.

NNMi uses Device Profiles (which equate to sysObjectIDs) to control certain types of behavior:

l Spiral Discovery determines the closest matching device profile, and uses the device profile settings to
control certain attribute values for the discovered device. The Device Profile also influences the fol-
lowing:

n Auto-Discovery Rules can provide a list of sysObjectIDs that expand the default discovery behavior
(beyond routers and switches) or prevent troublesome device types from being discovered.
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n The Node Name value might be affected, depending on your choices, see "Configure the Node
Name Strategy" (on page 99).

l When Node Groups are defined based on system object IDs, the State Poller Service monitors devices
based on attribute values in the device profiles. Device Profile settings determine how State Poller
detects renumbered interfaces.

l In Map views, the background shape of map icons is determined by the Device Category. See About
Map Symbols for an example of each available shape. There is also a Force Device attribute that ena-
bles category overrides in troublesome situations.

Tip: To quickly locate the device profile settings for a particular network device, sort or filter the Device Pro-
files view by clicking the heading for the Device Vendor, Device Model, or Device Category columns.

To access the device profile definition for a particular device type:

1. Navigate to the Device Profile view.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Device Profiles view.

2. Do one of the following:

n To create a device profile, click the  New icon.

n To edit a device profile, select a row, click the  Open icon.

3. Modify the settings as needed:

n The basic settings Device Category attribute value modifies NNMi behavior for Spiral Discovery
and map symbols.

n The advanced settings control NNMi behavior for Spiral Discovery and Node name selection. For
example, instruct NNMi to treat a certain devise type as a Router.

If you make changes, remember to place your name in the Author attribute. See Device Profile Author
form.

Caution: When you make a change, NNMi must update all references to device profiles. This can
take some time and slow down your system. Consider making this change during a slow time
in your network environment.

4. Click Save and Close. NNMi applies your changes during the next regularly scheduled discovery
cycle. To apply the changes immediately, use Actions → Configuration Poll. See Using Actions to
Perform Tasks for more information.

Configure Discovery

NNMi uses Simple Network Management Protocol (SNMP read-only queries), and a variety of com-
munication protocols to discover the devices within the network management domain that you define. See
"How Spiral Discovery Works" (on page 77) for more information.

By default, NNMi does the following (and you can change these default settings):

l Drops all non-SNMP nodes from discovery.

l Discovers routers and switches.

If you want NNMi to discover non-SNMP devices or more than routers and switches, use Auto-Discovery
Rules that configure discovery behavior to meet your needs. Or add the specific devices as discovery
seeds.
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To configure the NNMi Discovery Process, do the following:

1. Complete all prerequisites. See "Prerequisites for Discovery" (on page 86).

2. Navigate to the Discovery Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Discovery Configuration.

3. Make your configuration choices (see table).

4. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval. To apply the changes immediately, use Actions → Configuration Poll.
See Using Actions to Perform Tasks for more information.

Task How

"Determine Your
Approach to Dis-
covery" (on page 88)

Read these guidelines to understand how to configure discovery for the types of
devices you want to discover, including the following:

For strategies to discover devices:

For strategies to prevent specific devices from being discovered:

"Adjust the Discovery
Interval" (on page
98)

Optional. Use the Discovery Configuration workspace to modify the global dis-
covery interval setting. The Global Control setting for Rediscovery Interval con-
trols the frequency that NNMi uses for network discovery traffic.

"Configure Ping
Sweep Global Set-
tings" (on page 98)

Optional. Use the Discovery Configuration workspace to configure the starting
points for Auto-Discovery. The choices are Discovery Seeds or Ping Sweep
within Auto-Discovery Rules (ICMP ping commands) or both. The Global Control
settings for Spiral Discovery Ping Sweep Control provide control across all Auto-
Discovery Rules.

"Configure the Node
Name Strategy" (on
page 99)

Optional. Use the Discovery Configuration workspace to specify a node naming
strategy. The Global Control settings for Node Name enable you to choose the
most meaningful name for devices in your environment.

"Configure Auto-Dis-
covery Rules" (on
page 101)

Optional. Use the Auto-Discovery Rules tab to specify any IP address ranges or
MIB II sysObjectID ranges (or both) that you want NNMi to use for automatic dis-
covery. Within each Rule you can specify whether Ping Sweep is used as a start-
ing point (in addition to or instead of discovery seeds).

"Configure an
Excluded IP
 Addresses Filter" (on
page 108)

Optional. Use the Excluded IP Addresses tab to provide a list of specific
addresses or ranges of addresses that you want NNMi to never discover or mon-
itor.

"Configure Subnet
Connection Rules"
(on page 109)

Optional. Use the Subnet Connection Rules tab to connect interfaces on devices
that do not respond to Layer 2 Discovery protocols (for example, WAN edge
devices).

"Specify Discovery
Seeds: Initial Routers
or Specific Nodes to
be Discovered" (on
page 112)

Optional. Use the Discovery Seeds tab to specify nodes to be discovered or to
indicate which nodes are used as starting points for your Auto-Discovery Rules.

Tip: Use the Discovery Seeds tab to verify that NNMi successfully located each
Discovery Seed that you provided. See "Discovery Seed Results" (on page
118).

Discovery Configuration Tasks

Page 97 of 422

../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Discovering Your Network

Task How

Adjust the Discovery Interval

When configuring Spiral Discovery, you determine how often network traffic is generated to gather and ver-
ify information about your network management domain. This time interval controls how frequently infor-
mation is gathered about nodes, interfaces, IP addresses, subnets, VLANs, and connections in the
network. See "Discovery Intervals" (on page 79) for more information.

To adjust the discovery cycle interval:

1. Navigate to the Discovery Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

2. Locate the Global Control settings.

3. In the Rediscovery Interval attribute, set the time interval that Spiral Discovery waits between infor-
mation gathering cycles.

The default is 24 hours between cycles. The minimum is 1 hour.

Make sure that you allow plenty of time for the interval so that Spiral Discovery cycles do not overlap.
The larger your network environment, the longer the time required to complete a Spiral Discovery
cycle.

4. Click  Save and Close to apply your changes.

Configure Ping Sweep Global Settings

You have two choices for Auto-Discovery starting points. Use either or both to best advantage in your net-
work environment:

l Discovery Seeds: You designate specific IP addresses or hostnames where Auto-Discovery starts gath-
ering neighbor information.

For details see "Discovery Seeds (as a starting point)" (on page 82). For information about creating Dis-
covery Seeds, see "Specify Discovery Seeds: Initial Routers or Specific Nodes to be Discovered" (on
page 112).

l Ping Sweep: NNMi issues ICMP pings to certain addresses to find new nodes. For details, see "Ping
Sweep (as a starting point)" (on page 82).

Ping Sweep uses the current default ICMP interval and timeout settings from the Communications Con-
figuration settings. See "Configure Default SNMP and ICMP Protocol Settings" (on page 47).

To configure the global Auto-Discovery setting for Ping Sweep:

1. Navigate to the Discovery Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

2. Navigate to the Global Control settings.

3. Designate the global setting for Ping Sweep. Your choice determines how Spiral Discovery uses
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ICMP ping commands for the discovery process in your network environment:

n Each Rule (as configured)— The instructions for Ping Sweep within each Auto-Discovery Rule
configuration are followed exactly.

To configure Ping Sweep for a specific Auto-Discovery Rule, see "IP Address Ranges for Auto-
Discovery" (on page 104).

n All Rules— Ping Sweep is applied for all of your current Auto-Discovery Rules. This overrides the
Ping Sweep settings within each rule.

n None of the Rules— Ping Sweep is not used for any of your current Auto-Discovery Rules. This
overrides the Ping Sweep settings within each rule. This is useful to temporarily suspend issuing
any ping commands within your network.

Note: If things don't work as expected, check whether ICMP is allowed (see if "Communication
Region Form" (on page 57)).

4. Designate the Sweep Interval (days/hours) that controls how often Spiral Discovery reissues ICMP
 Ping for each address.

5. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval.

Configure the Node Name Strategy

When configuring discovery in NNMi, you control how the Name attribute on the Node form is populated.
For details see "Discovery Node Name Choices" (on page 79).

To resolve issues about choosing the Name value, NNMi follows a sequence of rules. If NNMi is unable to
determine a Name based on your three choices, the node name is determined using the NNMi factory
defaults for these three choices (see list in step 3).

The node Name shows up beneath the node symbol on the maps and in the Name column on table views.

To control how node names are determined for your network devices:

1. Navigate to the Discovery Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

2. Locate the Node Name Resolution attributes on the left side of the form (see table).

3. Specify the three-level hierarchy for node naming decisions.

Short name and full name are related. The short name is everything before the first period in the full
name. For example, full name cisco5500.abc.xyz.com and the short name cisco5500.

Select among the following choices. Use each choice only one time:

n Short DNS Name – (first by default) Use the group of characters prior to the first period in your in-
house DNS naming standards.

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to determine the
hostname. Click here for details.

i. If a hostname is available, it must resolve to a valid IP address. NNMi stores the fully-qual-
ifiedhostname in the database as all lowercase characters.
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ii. If more than one address is associated with a node, the loopback address1 is used with
the following exceptions:

o NNMi prefers loopback interfaces for management communication, where possible.
However, NNMi automatically filters out addresses in the reserved loopback network
range 127/24 (127.*.*.*).

o NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Rendezvous
Point IP Address2.

iii. If a node has multiple loopback addresses, NNMi uses the loopback address with the low-
est number that resolves to a hostname (for example, 10.16.42.197 is a lower number
than 10.16.197.42).

iv. If no loopback address resolves to a hostname and the device supports SNMP, NNMi
 uses the current value from the Management Address attribute on the Node form.

v. If the device does not support SNMP, the IP address or DNS name found during the cur-
rent rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change from
cycle to cycle (for example, if an address did not respond to SNMP queries due to network prob-
lems or node reconfiguration).

n Fully Qualified DNS Name – Use the full in-house DNS naming standards.

n Short sysName – (second by default) Use the group of characters prior to the first period in the
current MIB II sysName value established by the administrator for each SNMP enabled device.
See "Discovery Node Name Choices" (on page 79) for possible issues with using sysName.

n Full sysName – Use the full current MIB II sysName value established by the administrator for
each SNMP enabled device.

n IP Address – (third by default) Use the IP address. If the node responds to SNMP, the SNMP Man-
agement Address is used. For non-SNMP nodes, name is set to either a discovery seed address
associated with this node or a neighbor address gathered by Spiral Discovery along the path to
this node.

Note: If you listed the address in your Excluded IP Address filter, Spiral Discovery skips that
address . See "Exclude Problem IP Addresses from Discovery" (on page 94).

4. Click Save and Close. Spiral Discovery implements your changes during the next regularly sched-
uled discovery interval. To apply the changes immediately, use Actions → Configuration Poll. See
Using Actions to Perform Tasks for more information.

Attribute Description

First
Choice

Click the drop-down list and choose the predefined node name strategy you want dis-
covery to use first.

Node Name Resolution Settings

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.

Page 100 of 422

../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConIntro0800ActionsAutoTsk.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Discovering Your Network

Attribute Description

Second
Choice

Click the drop-down list and choose the predefined node name strategy you want dis-
covery to use if the first choice fails.

Third
Choice

Click the drop-down list and choose the predefined node name strategy you want dis-
covery to use if the second choice fails.

Configure Auto-Discovery Rules

Auto-Discovery Rule configuration settings control Spiral Discovery behavior (for details see "Auto-Dis-
covery Rules" (on page 83)):

l Rules define the outer limits of discovery.

l Rules expand or reduce the types of devices that are discovered and added to the topology database.

Before you start, have a clear idea of what you want to accomplish, see "Determine Your Approach to Dis-
covery" (on page 88).

If you do not configure any Auto-Discovery Rules, Spiral Discovery is limited to only discovery seeds. See
"Discovery Seeds (as a starting point)" (on page 82) for more information.

To configure Auto-Discovery Rules, do the following:

1. Complete all prerequisites. See "Prerequisites for Discovery" (on page 86).

2. Navigate to the Auto-Discovery Rules tab.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Discovery Configuration.

c. Select the Auto-Discovery Rules tab.

3. Make your configuration choices (see table).

4. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval. To apply the changes immediately, use Actions → Configuration Poll.
See Using Actions to Perform Tasks for more information.

Task How

"Configure Basic Settings
for the Auto-Discovery
Rule" (on page 102)

Provide the basic requirements for an Auto-Discovery Rule configuration.
This includes name and Ordering number. You designate how ICMP and
SNMP are used for this segment of discovery.

"IP Address Ranges for
Auto-Discovery" (on page
104)

Optional. Use IP addresses with wildcards to specify the area you want Spi-
ral Discovery to find in your network environment. You decide whether Ping
Sweep is used for this segment of discovery.

"SNMP System Object ID
Ranges for Discovery" (on
page 106)

Optional. Use industry standard System Object IDs to control Spiral Dis-
covery:

l Expand Spiral Discovery to include more device types than the default
routers and switches .

l Instruct Spiral Discovery to never discover specific troublesome models
of routers, switches, or other devices.

Auto-Discovery Rule Configuration Tasks
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Configure Basic Settings for the Auto-Discovery Rule

The Auto-Discovery Rule settings determine which methods Spiral Discovery applies when discovering
the part of your network defined in the rule.

To configure this Auto-Discovery Rule:

1. Navigate to the Auto-Discovery Rule form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Locate the Auto-Discovery Rules tab.

d. Do one of the following:

o To establish a rule, click the  New icon, and continue.

o To edit a rule, select a row, click the  Open icon, and continue.

o To delete a rule, select a row, and click the  Delete icon.

2. Provide the required basic settings (see the Basics for this Auto-Discovery Rule table).

3. Provide the behavior settings for this rule (see the Auto-Discovery Behavior for this Rule table).

4. There are many ways to implement discovery. Before you start this step, "Determine Your Approach
to Discovery" (on page 88).

Configure one or more ranges, to identify the devices you want to discover.

n "IP Address Ranges for Auto-Discovery" (on page 104)

n "SNMP System Object ID Ranges for Discovery" (on page 106)

5. Click Save and Close to return to the Discovery Configuration form.

6. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval.

7. Optional: Open the Discovery Configuration workspace again and provide a discovery seed for
each address range of this region. Core routers make the best seeds. See "Specify Discovery Seeds:
Initial Routers or Specific Nodes to be Discovered" (on page 112).

Task How

Name Give this Auto-Discovery Rule a meaningful name.                     

Ordering Determine the order in which the Auto-Discovery Rules are applied. No Duplicate Ordering
numbers are allowed. Each Auto-Discovery Rule ordering number must be unique.

Tip: It is recommended that ordering numbers are incremented by 10s or 100s to provide flex-
ibility when adding new rules over time.

IP address ranges: If a device falls within two Auto-Discovery Rules, the Auto-Discovery
Rule with the lowest ordering number applies. For example, if an Auto-Discovery Rule
includes certain IP addresses, then no other Auto-Discovery Rules with higher ordering
numbers apply to those addresses.

System Object ID ranges:

Basics for this Auto-Discovery Rule

Page 102 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Discovering Your Network

Task How

l If no IP address range is included in this Auto-Discovery Rule, then the system object ID
settings take precedence over all Auto-Discovery Rules that have higher Ordering
numbers than this Auto-Discovery Rule.

l If an IP address range is included in this Auto-Discovery Rule, your system object ID
range applies only within this Auto-Discovery Rule.

Notes Provide any additional useful information about this Auto-Discovery Rule.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Task How

Discover
Included
Nodes

If  enabled, Auto-Discovery gathers information about neighboring devices and adds
devices to the NNMi database if they meet the rule's criteria. For more information see "Auto-
Discovery Rules" (on page 83).

Note: Auto-Discovery requires at least one IP address range with the Range Type attribute
set to Include. Routers and switches are discovered by default. If enabled, Discover
Any SNMP Device and Discover Non-SNMP Devices extend discovery to more than
routers and switches.

If  disabled, Auto-Discovery ignores devices in this rule unless those devices are spe-
cifically identified in the discovery seeds configuration settings.

Enable
Ping
Sweep

If  enabled, Auto-Discovery issues a wide range of ICMP ping commands to determine
starting points for Spiral Discovery. For details, see "Ping Sweep (as a starting point)" (on
page 82).

If  disabled, Auto-Discovery depends on Discovery Seeds as starting points for Spiral Dis-
covery. For details, see "Discovery Seeds (as a starting point)" (on page 82).

Discover
Any
SNMP
 Device

Note: This value is ignored if Discover Included Nodes is unchecked. However, if you con-
figure any device as a discovery seed, discovery always adds that device to the data-
base.

If  enabled, discovery gathers information about any device that responds to SNMP
 queries (in addition to routers or switches that are discovered by default). These nodes
appear on maps and are monitored. 

If  disabled, discovery ignores all device types except routers, switches, discovery seeds,
and device types specified in your system object ID ranges. (Routers and switches are iden-
tified by the settings in the device profile.)

Discover
Non-
SNMP
Devices

Note: This value is ignored if Discover Included Nodes is unchecked. However, if you con-
figure any device as a discovery seed, discovery always adds that device to the data-
base.

Non-SNMP devices are those that do not respond to SNMP queries.

If you enable Discover Non-SNMP Devices, note the following:

l If you do not want NNMi to discover every node in your network, make sure your Auto-Dis-
covery Rules correctly limit the scope of the discovery. See"Determine Your Approach to
Discovery" (on page 88) for more information.

Auto-Discovery Behavior for this Rule
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Task How

l Selecting this option may cause you to reach your license limit very quickly.

l If NNMi determines that a non-SNMP node has a hostname matching another non-SNMP
node, NNMi merges the information to create only one node and includes any additional
IP address information under the same node.

Non-SNMP nodes might be inaccurately represented under the following circumstances:

n One or more non-SNMP nodes in your network use the same hostname.

n The same non-SNMP node has multiple hostnames.

n A non-SNMP node name changes (see "Delete Nodes" (on page 122)).

If  enabled, addresses that do not respond to SNMP queries are added to the database.

If  disabled, discovery ignores any address that does not respond to SNMP queries.

IP Address Ranges for Auto-Discovery

Auto-Discovery IP address ranges determine the outer limits for the area controlled by the current Auto-Dis-
covery Rule. You can create multiple IP ranges within one Auto-Discovery Rule. Before you start, have a
clear idea of what you want to accomplish, see "Determine Your Approach to Discovery" (on page 88).

If  Discover Included Nodes is disabled for the rule, click here for additional information about IP
address ranges when defining a rule with Discover Included Nodes disabled.

l Spiral Discovery does not gather neighbor information from the addresses identified in any IP address
range included in this rule. The addresses, themselves, may still show up in the topology database.

Note: Neighbor information is still gathered from IP addresses specifically identified in the discovery
seeds configuration settings.

l IP address ranges are optional. However, when no IP address range is provided:

n One or more system object ID (MIB II sysObjectIDs) ranges must be defined. This technique con-
stricts or extends the types of devices affected by this rule. See "SNMP System Object ID Ranges
for Discovery" (on page 106) for more information.

n The system object ID range criteria applies to all Discovery Rules with higher Ordering numbers.

If  Discover Included Nodes is enabled for the rule, click here for additional information about IP
address ranges when defining a rule with Discover Included Nodes enabled.

l At least one IP address range is required to be designated as an Include in rule range type. Auto-Dis-
covery gathers neighbor information from those addresses to extend discovery.

l Optional. You can configure NNMi to ignore subsets of those IP addresses (an Ignored by rule range,
which means that those addresses are available for other Auto-Discovery Rules).

l Optional. Specify system object ID (MIB II sysObjectIDs) ranges to be included or ignored. This tech-
nique constricts or extends the types of devices affected by this rule. See "SNMP System Object ID
Ranges for Discovery" (on page 106) for more information.

NNMi discovers any devices that comply with your rule configurations, and creates a record of each device
in the NNMi database. If the device supports SNMP, all addresses for that device are combined into one
Node object. If the device does not support SNMP, NNMi queries DNS to determines the hostname. If this
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hostname matches another non-SNMP node, NNMi merges the information to create only one node with
multiple associated addresses.

To specify an IP address range:

1. Navigate to the Auto-Discovery IP Range form.

a. In the Workspace navigation panel, open the Configuration workspace.

b. Select Discovery Configuration.

c. Select the Auto-Discovery Rule tab.

d. Do one of the following:

o To establish an Auto-Discovery Rule, click the New icon.

o To edit an Auto-Discovery Rule, select a row, and click the  Open icon.

a. Select the IP Ranges tab.

b. Do one of the following:

o To create an IP range, click the New icon, and continue.

o To edit an IP range, select a row, and click the Open icon, and continue.

o To delete an IP range, select a row, and click the Delete icon.

2. Decide whether Ping Sweep is used in this segment of network discovery:

n Enable Ping Sweep
Auto-Discovery issues a wide range of ICMP ping commands to determine starting points for Spi-
ral Discovery. For details, see "Ping Sweep (as a starting point)" (on page 82).

n Enable Ping Sweep
Auto-Discovery depends on Discovery Seeds as starting points for Spiral Discovery. For details,
see "Discovery Seeds (as a starting point)" (on page 82).

Note: There are two ways to override this choice. If things don't work as expected, check whether
Ping Sweep is disabled (see "Configure Ping Sweep Global Settings" (on page 98)) and
check whether ICMP is allowed (see if "Communication Region Form" (on page 57)).

3. Provide the IP address range information for this Auto-Discovery Rule (see table).

Note: If you choose to not include any IP address ranges in a particular Auto-Discovery Rule, then
you must provide at least one system object ID range (see "SNMP System Object ID Ranges

for Discovery" (on page 106)). And Auto-Discovery Rules without any IP Range must have
Discover Included Nodes disabled in the Auto-Discovery Rule form.

4. Click Save and Close to return to the Auto-Discovery Rule form.

5. Click Save and Close to return to the Discovery Configuration form.

6. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval.
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Name Description

IP
Range

Used to specify a range of IP addresses for this Auto-Discovery Rule.

Note: If you enter an IP address value that represents only one IP address, Auto-Discovery
gathers neighbor information only from the address you enter. (Discovery extends only
one hop out from this address.)

An IPv4 Address range is a modified dotted-notation where each octet is one of the following:

l A specific octet value between 0 and 255

l A low-high range specification for the octet value (for example, "112-119")

l An asterisk (*) wildcard character which is equivalent to the range expression "0-255"

Note: The following two IPv4 addresses are considered invalid: 0.0.0.0 and 127.0.0.0

Examples of valid IPv4 address wildcards include:
10.1.1.*
10.*.*.*
10.1.1.1-99
10.10.50-55.*
10.22.*.4
10.1-9.1-9.1-9

Caution: If Ping Sweep is enabled for this rule (see step 2 above), NNMi only uses Ping Sweep
across a maximum of the last two octets (/16) of the network specified by each IP
 Range. 

Range
Type

Include in rule - The current Auto-Discovery Rule settings apply to the addresses in this range.

Ignored by rule - The current Auto-Discovery Rule settings do not apply to the addresses in this
range. Use the Ignored by rule setting to identify a subset of addresses within a larger range.
The addresses in the ignored range are available to conform to an Auto-Discovery Rule with a
higher ordering number.

Discovery IP Range Form

SNMP System Object ID Ranges for Discovery

Vendors are assigned a system object ID (RFC 1213 MIB II sysObjectID) for each type of network device
that they manufacture. This system object ID number is unique for each combination of vendor, device
type, and model number. For example, all Cisco 6509 routers have the same system object ID.

Tip: See "Configure Device Profiles" (on page 95) for more information about system object IDs. In the
Device Profiles view (in the Configuration workspace), you can quickly and easily locate the system
object IDs of devices in your network environment.

System object ID ranges are powerful tools for expanding or limiting discovery behavior. For example,
expand discovery to include more than the default routers and switches, or limit discovery by excluding
specific models of routers and switches. Before you start, have a clear idea of what you want to accom-
plish, see "Determine Your Approach to Discovery" (on page 88).

When using system object ID ranges, note the following:

l When one or more IP address ranges are defined within the Auto-Discovery Rule, your system object
ID ranges apply only within the current Auto-Discovery Rule.
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l When no IP address ranges are defined within the Auto-Discovery Rule, your system object ID ranges
take precedence over all Auto-Discovery Rules that have higher Ordering numbers than this Auto-Dis-
covery Rule.

l To enable Discover Included Nodes in this rule, at least one IP address range is required. Before any
discovered node is added to the topology database, it must match both IP address range and system
object ID range specifications.

The following table includes examples of how you might want to expand or limit your Spiral Discovery
scope using System Object ID Ranges.

Task Related Topics

Expand Spiral Discovery to include device types in addi-
tion to routers and switches.

"All Devices from a Specific Vendor Dis-
covered" (on page 92)

Globally exclude one or more specific device types from
Spiral Discovery.

"Specific System Object IDs Not Dis-
covered" (on page 94)

Controlling Spiral Discovery with System Object ID Ranges

To specify a system object ID range:

1. Navigate to the Discovery System Object ID Range form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Select the Auto-Discovery Rule tab.

d. Do one of the following:

o To create an Auto-Discovery Rule, click the New icon.

o To edit an Auto-Discovery Rule, click the Open icon.

e. In the Auto-Discovery Rule form, select the System Object ID Ranges tab.

f. Do one of the following:

o To create a system object ID range, click the New icon, and continue.

o To edit a system object ID range, click the Open icon, and continue.

o To delete a system object ID range, click the  Delete icon.

2. Provide one or more System Object ID ranges for this Auto-Discovery Rule (see the table).

Use multiple System Object ID ranges to fine tune your discovery settings.

Note: If you do not include any System Object ID ranges in a particular Auto-Discovery Rule, then
you must provide at least one IP address range in that particular Auto-Discovery Rule (see "IP
Address Ranges for Auto-Discovery" (on page 104)).

Example 1. In an Auto-Discovery Rule with Discover Included Nodes enabled:

n Create a definition that includes all HP devices. Use the System Object ID prefix 1.3.6.1.4.1.11
and set the Range Type to Include in rule.
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n Create a definition that excludes any HP Printers. Use the System Object ID prefix
1.3.6.1.4.1.11.2.3.9 and set the Range Type to Ignored by rule. (Order does not matter, now the
printers are always ignored.)

Example 2. In an Auto-Discovery Rule with Discover Included Nodes disabled:

n Create a definition that excludes any HP Printers. Use the System Object ID prefix
1.3.6.1.4.1.11.2.3.9 and set the Range Type to Include in rule.

n Skip step 4, below. HP printers are not discovered within the IP address range of any Auto-Dis-
covery Rules with higher ordering numbers than this rule.

3. Click Save and Close to return to the Auto-Discovery Rule form.

4. Provide any IP ranges (see "IP Address Ranges for Auto-Discovery" (on page 104)):

n Optional if Discover Included Nodes is disabled in the Auto-Discovery Rule form.

n Required if Discover Included Nodes is enabled in the Auto-Discovery Rule form.

Click Save and Close to return to the Auto-Discovery Rule form.

5. Click Save and Close to return to the Discovery Configuration form.

6. Click Save and Close. Spiral Discovery implements your changes during the next regularly
scheduled discovery interval.

Attribute Description

System
Object ID
Prefix

Enter a prefix of an SNMP system object ID, or enter the entire SNMP system object ID. A
partial entry becomes a wildcard.

For example, if you enter 1.3.6.1.4.1.11, discovery finds all HP devices. If you enter
1.3.6.1.4.1.9, discovery finds all Cisco devices. 

Note: Do not use dashes or asterisks (*) in your system object ID value.

Range
Type

Include in rule - Instructs Auto-Discovery to find devices matching this system object ID
range.

Ignored by rule - Instructs Auto-Discovery to ignore devices matching this system object ID
range.

Notes Add any information about this rule that would be useful to you and your team.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Discovery System Object ID Range Definition

Configure an Excluded IP Addresses Filter

Sometimes there are IP addresses or ranges of IP addresses in your environment that you do not want
NNMi to discover or monitor. For details and examples, see "Filters to Exclude Certain IP Addresses" (on
page 83).

Tip: If you have a large number of IP addresses that you want to exclude from Spiral Discovery, see the
nnmdiscocfg.ovpl Reference Page.

To excluded specific IP addresses from the discovery process:
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1. Navigate to the Excluded IP Address form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Select the Excluded IP Addresses tab.

d. Do one of the following:

o To exclude an address or range of addresses from Spiral Discovery, click the New
icon, and continue.

o To edit an excluded address setting, click the Open icon, and continue.

o To delete an excluded address setting, select a row, and click the Delete icon.

2. In the IP Address Range field, type an IP address or range of addresses. For example, 27-29.*.*.*

Maximum 255 characters.

The following wildcard characters are allowed:

n Asterisk (*) represents any string

n Question mark (?) represents a single character

3. Click Save and Close. Spiral Discovery implements your changes during the next regularly sched-
uled discovery interval. To apply the changes immediately, use Actions → Configuration Poll. See
Using Actions to Perform Tasks for more information.

Configure Subnet Connection Rules

For an explanation of how Subnet Connection Rules work, see "Subnet Connection Rules" (on page 84).

If important subnets in your network environment are not automatically connected by Spiral Discovery, edit
a Subnet Connection Rule or create your own.

The following are typical situations that require Subnet Connection Rules:

l Point-to-point or point-to-multipoint connections between interfaces within subnets that have a prefix
length ranging from 28-31.

l Tunnel or other virtual connections between interfaces within subnets that have a prefix length ranging
from 28-31.

NNMi uses Subnet Connection Rules to detect connections between interfaces associated with IPv4
addresses that do not respond to Layer 2 Discovery protocols (see the list of Topology Source protocols in
Layer 2 Connection Form). Subnet Connection Rules take priority over the Layer 2 Discovery protocol
results. For special cases, you can override a Subnet Connection Rule by using the Connection Editor
command line tool, see the nnmconnedit.ovpl Reference Page for more information.

When Spiral Discovery detects a subnet, NNMi uses the matching Subnet Connection Rule to request infor-
mation about all possible IPv4 addresses (potentially detecting previously undiscovered IPv4 addresses).
NNMi checks the Excluded IP Addresses list. Any addresses in the list are dropped (for details, see "Filters
to Exclude Certain IP Addresses" (on page 83)). Then NNMi creates connections among any interfaces
associated with any newly discovered IPv4 addresses.

To configure Subnet Connection Rules:
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1. Navigate to the Subnet Connection Rule form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Select the Subnet Connection Rules tab.

d. Do one of the following:

o To establish a rule, click the New icon, and continue.

o To edit a rule, click the Open icon, and continue.

o To delete a rule, select a row, and click the Delete icon.

2. Provide the required basic settings (see Basics table).

3. Provide the Subnet Connection behavior settings for this rule (see Details table).

4. Click Save and Close to return to the Discovery Configuration form.

5. Click Save and Close to apply the configuration. Spiral Discovery implements your changes dur-
ing the next regularly scheduled discovery interval.

Task How

Name Type a meaningful name for this Subnet Connection Rule.

Note: This name is prepended to the Layer 2 connection name (when you request Quick View
information about the connection on the Layer 2 Neighbor View map). If a subnet
matches more than one rule, NNMi randomly chooses from among the matching rules.

Enable If enabled , NNMi uses the Subnet Connection Rule to create connections between inter-
faces associated with the IPv4 addresses within the specified subnets.

If disabled , NNMi ignores the Subnet Connection Rule.  

Basics for this Subnet Connection Rule
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Task How

Minimum
IPv4 Prefix
Length

Specify the minimum prefix length (subnet mask length) for the subnet where you want
Spiral Discovery to create Layer 2 connections. Spiral Discovery creates connections
between interfaces associated with IPv4 addresses that have subnet prefix lengths equal
to or greater than the specified value and meet the other specified criteria.

Valid Minimum IPv4 Prefix Length Values Number of Usable IPv4 Addresses

28 14 (16-2=14)*

29 6 (8-2=6)*

30 2 (4-2=2)*

31 2

* Two IPv4 addresses are reserved in each subnet. The first IPv4 address is used for the
network itself and the last IPv4 address is reserved for broadcast.

IfType Optional. Use this Interface MIB variable as an additional filter to identify the types of inter-
faces to include when creating the subnet connections. For example, if you want con-
nections only between frameRelay interfaces, select frameRelay as the IfType.

IfName Optional. Use this Interface MIB variable as an additional filter to identify the interfaces to
include when creating the subnet connections. This attribute is useful if you have a nam-
ing convention that is used to identify a set of interfaces. For example, lan0.

Maximum 255 characters. The following wildcard characters are allowed: asterisk (*) rep-
resents any string, and question mark (?) represents a single character.

IfDescription Optional. Use this Interface MIB variable as an additional filter to identify the interfaces to
include when creating the subnet connections. For example, you might want to select a
particular set of interfaces that have the same vendor description.

Maximum 255 characters. The following wildcard characters are allowed: asterisk (*) rep-
resents any string, and question mark (?) represents a single character.

IfAlias Optional. Use this Interface MIB variable as an additional filter to identify the interfaces to
include when creating the subnet connections. This attribute is useful if you have an alias
naming convention that is used to identify a set of interfaces. For example, Connection
to remote store in Hawaii.

Maximum 255 characters. The following wildcard characters are allowed: asterisk (*) rep-
resents any string, and question mark (?) represents a single character.

Details for this Subnet Connection Rule

Related Topics

Intrepret Root Cause Messages

Subnet Connection Rules Provided by NNMi

NNMi provides the Subnet Connection Rules described in the following table (for more information, see
"Subnet Connection Rules" (on page 84)).
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The Small Subnets Rule ensures that NNMi detects IPv4 addresses within subnets of this size, regardless
of the interface type. The remaining Subnet Connection Rules create connections based on interface type
and the specified subnet size.

Tip: See IfTypes (Interface Types) Form for more information about interface types.

To create new Subnet Connection Rules (or modify the ones provided), see "Configure Subnet Con-
nection Rules" (on page 109).

Rule Name
Minimum IPv4 Prefix Length
(Subnet Mask Length) Interface Type (#)

Asynchronous Transfer Mode 28 atm (37)

Digital Signal 0 28 ds0 (81)

Digital Signal 1 28 ds1 (18)

Digital Signal 3 28 ds3 (30)

Digital Subscriber Loop over ISDN 28 idsl (154)

Frame Relay Interfaces 28 frameRelay (32)

Integrated Services Digital Network 28 isdn (63)

Multiprotocol Label Switching 28 mpls (166)

Point to Point 28 ppp (23)

Small Subnets 30

Serial Line Internet Protocol 28 slip (28)

Serial Point to Point 28 propPointToPointSerial (22)

Synchronous Optical Networking 28 sonnet (39)

Subnet Connection Rules Provided by NNMi

Specify Discovery Seeds: Initial Routers or Specific Nodes to be Discovered

Note: Discovery seeds are optional. Before you start this task, "Determine Your Approach to Discovery" (on
page 88) and complete the prerequisites ("Prerequisites for Discovery" (on page 86)).

Nodes specified as discovery seeds are always discovered and added to the topology database. As soon
as you enter one or more optional discovery seeds, discovery begins.

If you create Auto-Discovery Rules, NNMi uses neighbor information gathered from each discovery seed to
extend discovery. See "Discovery Seeds (as a starting point)" (on page 82) for more information. NNMi can
also use Ping Sweep (instead of or in addition to discovery seeds) to gather neighbor information. See

"Ping Sweep (as a starting point)" (on page 82).

If you want Spiral Discovery to automatically find devices on your network, before you begin adding dis-
covery seeds:

l Configure at least one Auto-Discovery Rule. See "Configure Auto-Discovery Rules" (on page 101).

l Configure any number of Auto-Discovery Rules to maintain fine control over the scope of Spiral Dis-
covery.
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A discovery seed is an IP address or hostname. Consider devices with the largest neighbor data in your
network environment. For example, a good choice would be a core router connected to a network you
want to discover.

If you change your mind and delete a discovery seed from Discovery Configuration, the corresponding
node is not deleted from the topology database. See "Delete Nodes" (on page 122) for information about
removing the entire node record from the topology database.

To configure discovery seeds do one or more of the following:

l "In the Console, Configure Discovery Seeds " (on page 113)

l "With a Seed File, Add Multiple Discovery Seeds" (on page 114)

l "From the Command Line, Add Discovery Seeds" (on page 115)

Related Topics

"Discovery Seed Results" (on page 118)

"Delete Discovery Seeds" (on page 123)

In the Console, Configure Discovery Seeds

There are many ways to provide discovery seeds. Discovery seeds are optional. See "Specify Discovery
Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112)for more information.

To add an optional discovery seed using the console:

1. Navigate to the Discovery Seeds form. 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Locate the Discovery Seeds tab.

d. Do one of the following:

o To add a discovery seed, click the New icon.

o To edit a discovery seed, click the Open icon the precedes the discovery seed you
want to edit.

o To delete a discovery seed, select a row, and click the  Delete icon (see "Delete Dis-
covery Seeds" (on page 123) and "Delete Nodes" (on page 122) for more information).

2. Provide appropriate information (see table).

NNMi uses information gathered from Routers to establish subnet membership for Layer 3 con-
nections. Make sure that important Routers in your network environment are SNMP enabled.

NNMi uses either of the following criteria to identify a Router:

n Each Router responds with appropriate values for sysServices (1.3.6.1.2.1.1.7)  and ipFor-
warding (1.3.6.1.2.1.4.1). See RFC1213-MIB for details.

n Identify Routers with the Device Profile configuration settings for a particular device type.

You must provide the appropriate SNMP Community Stings to NNMi. See "Configuring Com-
munication Protocol" (on page 47).

3. Click Save and Close to return to the Discovery Configuration form.
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Tip: Click the Save and New icon to continue to adding discovery seeds.

4. Click Save and Close. As soon as you enter one or more optional discovery seeds, discovery
begins.

Attribute Definition

Hostname /
IP

Note: NNMi does not validate your entry when you use this method to add discovery
seeds. Use the nnmloadseeds.ovpl command to validate your discovery seed
entries.

To identify the node, enter one of the following:

l Fully-qualified hostname of the discovery seed

l IP address of the discovery seed, specify a physical address

When providing IPv4 addresses as discovery seeds, the following IPv4 addresses are con-
sidered invalid:

l 255.255.255.255

l IP addresses that begin or end with 0 (zero)

Discovery
Seed
Results

An automatically generated value. The most recent discovery status for this discovery
seed. See "Discovery Seed Results" (on page 118) for details.

Last Mod-
ified

The date and time of the last change in Discovery Seed Results.

Notes Provide any additional information about this discovery seed that would be useful to you
or your team.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Discovery Seed Definition

With a Seed File, Add Multiple Discovery Seeds

There are many ways to provide discovery seeds. Discovery seeds are optional. See "Specify Discovery
Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112)for more information.

Use a seed file to simultaneously add large numbers of discovery seeds. Your seed file contains one line
for each discovery seed. For example:

12.2.111.104# cisco5500
12.2.112.268# cisco6509
12.2.119.205# cisco5500

Note: Any comments included after the # in a seed file become Notes attribute values for the discovery
seeds.

To identify a discovery seed, enter one of the following:

l Fully-qualified hostname of the discovery seed

l IP address of the discovery seed, specify a physical address

When providing IPv4 addresses as discovery seeds, the following IP addresses are considered invalid:
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l 255.255.255.255

l IP addresses that begin or end with 0 (zero)

NNMi uses information gathered from Routers to establish subnet membership for Layer 3 connections.
Make sure that important Routers in your network environment are SNMP enabled.

NNMi uses either of the following criteria to identify a Router:

l Each Router responds with appropriate values for sysServices (1.3.6.1.2.1.1.7)  and ipForwarding 
(1.3.6.1.2.1.4.1). See RFC1213-MIB for details.

l Identify Routers with the Device Profile configuration settings for a particular device type.

You must provide the appropriate SNMP Community Stings to NNMi. See "Configuring Communication
Protocol" (on page 47).

To create a seed file:

In a text editor, type each entry on a separate line in the following format:

<IP_address> or <hostname> #(optional comment to help identify the node)

l <IP_address> = the IP address of the node

l <hostname> = the fully-qualified DNS hostname or short DNS hostname of the node

To add discovery seeds by loading a seed file:

Use the nnmloadseeds.ovpl command:

Windows:
<drive>:\Program Files (x86)\HP\HP BTO Software\bin\nnmloadseeds.ovpl -f <path>\<
file_name>

<drive> is the drive on which NNMi is installed

<path>/<file_name> = the name of the file that contains your discovery seeds

UNIX:
/opt/OV/bin/nnmloadseeds.ovpl -f <path>/<file_name>

A message displays, showing the number of added, invalid, and ignored discovery seeds. For example:

26 seeds added
0 seeds invalid
0 seeds duplicated

See the nnmloadseeds.ovpl Reference Page for more information.

Related Topics

"Discovery Seed Results" (on page 118)

"Delete Discovery Seeds" (on page 123)

From the Command Line, Add Discovery Seeds

There are many ways to provide discovery seeds. Discovery seeds are optional. See "Specify Discovery
Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112)for more information.

You can add optional discovery seeds using the nnmloadseeds.ovpl command:
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<seed_list> = the discovery seed entries (fully-qualified DNS hostname, short DNS hostname, or IP
address)

Windows:
<drive>:\Program Files (x86)\HP\HP BTO Software\bin\nnmloadseeds.ovpl -n <seed_
list>

<drive> is the drive on which NNMi is installed

UNIX:
/opt/OV/bin/nnmloadseeds.ovpl -n <seed_list>

In the following example, the devices with a hostname of cisco4 and cisco5, and a device with the IP
address of 12.6.91.5 are added as discovery seeds.

nnmloadseeds.ovpl -n cisco4 cisco5 12.6.91.5

Note: Identify the discovery seed by either a resolvable hostname or an IP address.

When adding individual discovery seeds using the nnmloadseeds.ovpl command:

l Fully-qualified hostname of the discovery seed

l IP address of the discovery seed, specify a physical address

When providing IPv4 addresses as discovery seeds, the following IP addresses are considered invalid:

l 255.255.255.255

l IP addresses that begin or end with 0 (zero)

Communicate any additional IP address requirements to your team to avoid unexpected discovery results.

NNMi uses information gathered from Routers to establish subnet membership for Layer 3 connections.
Make sure that important Routers in your network environment are SNMP enabled.

NNMi uses either of the following criteria to identify a Router:

l Each Router responds with appropriate values for sysServices (1.3.6.1.2.1.1.7)  and ipForwarding 
(1.3.6.1.2.1.4.1). See RFC1213-MIB for details.

l Identify Routers with the Device Profile configuration settings for a particular device type.

You must provide the appropriate SNMP Community Stings to NNMi. See "Configuring Communication
Protocol" (on page 47).

Related Topics

"Discovery Seed Results" (on page 118)

"Delete Discovery Seeds" (on page 123)

Examine Discovery Results

When verifying discovery, you can do any of the following tasks:

l "Check Initial Progress of Discovery" (on page 117)

l "Verify Success of Discovery Seeds" (on page 117)

l "Examine Discovery Inventory " (on page 120)

l "Examine Layer 2 Discovery Results" (on page 120)

l "Examine Layer 3 Discovery Results" (on page 121)
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Related Topics

"Node Discovery State Check" (on page 117)

"Discovery Seed Results" (on page 118)

Check Initial Progress of Discovery

During your initial discovery, you can check Spiral Discovery's progress by using the Help → About HP
 Network Node Manager i-series menu item.

Check this several times during a one hour period. The numbers in the Nodes, SNMP agents, Interfaces,
IP addresses, and Layer 2 Connections fields stabilize when initial discovery is complete. A report on the
health of the State Poller Service is also presented on this window.

You can also see discovery state for a node. See "Node Discovery State Check" (on page 117) for more
information.

Note: If you configure one or more Auto-Discovery Rules and you get unexpected results, check your order-

ing numbers. See "Configure Auto-Discovery Rules" (on page 101) for more information.

Node Discovery State Check

You can verify the current discovery state for a node.

To see the current Discovery State for a node:

1. Navigate to a Node form.

a. From the workspaces navigation panel, select the workspace of interest. For example, Inven-
tory.

b. Select the node view of interest. For example Nodes.

c. Select a node and click the Open icon.

2. Locate the Discovery State attribute (in the Discovery section on the left side of the form).

Possible values include:

n Newly Created – Indicates the node and its IP addresses are in the NNMi database, but further
information needs to be collected before state and status are determined.

n Discovery Completed – Indicates that discovery gathered all required information for the node.

n Rediscovery in Process – Indicates discovery is updating the information collected for the node.

Verify Success of Discovery Seeds

 The discovery seeds provide the starting point for discovery.

To verify that each discovery seed was successfully discovered:

1. Navigate to the Discovery Configuration form.

n From the workspace navigation panel, select the Configuration workspace.

n Select the Discovery Configuration.

2. Locate the Discovery Seeds tab.
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3. Check the value in the Discovery Seed Results column on each row of the table. A value of Node
Created indicates the successful discovery of each discovery seed. See "Discovery Seed Results"
(on page 118) for the meaning of other values and how to correct discovery problems.

Discovery Seed Results

When you add a discovery seed, the Discovery Service immediately tries to discover it (without waiting
until the next regularly scheduled discovery interval). If discovery is not successful, NNMi tries again 10
minutes later, and continues trying. The time between each try is doubled until it reaches 1 week or equals
your current discovery interval.

To see the current discovery results for each specified discovery seed:

1. Navigate to the Discovery Configuration form

n From the workspace navigation panel, select the Configuration workspace.

n Select Discovery Configuration.

2. Locate the Discovery Seeds tab. The table lists each discovery seed and the result that NNMi gath-
ered when contacting the discovery seed.

3. Check the value in the Discovery Seed Results column on each row of the table.

Discovery
Results Description

New seed You just entered a new discovery seed. When discovery begins, Discovery Results
changes to "In progress". If the "New seed" value does not change, check to see if the Dis-
covery Service needs to be restarted, see "Verify that NNMi Services Are Running" (on
page 28).

In progress Discovery is in progress.

Node
created

The discovery seed is successfully discovered and a new Node is created in the data-
base.

Node
created
(Non-SNMP
device)

The hostname or IP address you provided is a non-SNMP device. The Node was dis-
covered and added to the database, but no SNMP information is available because no
SNMP agent responded.

If this result is unexpected, the device might currently be down. Initiate an on-demand dis-
covery poll using Actions → Configuration Poll, click here for more information. Or try the
following:

Check whether the IP address is accessible

1. Type the following command to verify that the address is accessible:
ping <nodename>

Check the Access Control List

1. Access the Node, and open the Access Control List (ACL).

2. Verify that the NNMi management server address is in the list.

Ensure that SNMP is working

1. Type the following command to verify that the address has an SNMP agent. Supply

Discovery Seed Results Values
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Discovery
Results Description

one specific MIB variable to limit network traffic to one object rather than requesting
all possible SNMP values. For example, use the VendorID prefix with SNMPv1 or
SNMPv2c:
nnmsnmpwalk –c <communityString> <nodename or IP address> <Ven-
dorID>

2. If the nnmsnmpwalk fails:

a. Use telnet to check the device's SNMP configuration to verify that SNMP is
enabled.

b. Verify that the address of the NNMi management server is listed in the
SNMP Agent's Access list.

Check your communication configuration

1. Verify that SNMP communication is enabled for this device: "Configuring Com-
munication Protocol" (on page 47).

2. Verify that the device has a properly configured SNMPv1 or SNMPv2c read-only
community string, or that the device has a properly configured SNMPv3 USM secu-
rity setting.

Note: NNMi makes one attempt to contact each discovery seed. After you correct the prob-
lem that caused NNMi to spedify the seed as a non-SNMP device, NNMi updates
the Node record during the next discovery cycle. However, this Discovery Results
entry does not change, but everything is working properly.

Node not
created
(Duplicate
seed)

The address or hostname you provided is a Node that already exists in the database.

Node not
created
(DNS name
resolution
failed)

The hostname you provided for this discovery seed cannot be resolved to a valid IP
address through DNS.
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Discovery
Results Description

Node not
created
(License
exceeded)

Discovery rejected this discovery seed because the number of devices previously dis-
covered reached your license limit.

Failed Contact with of this discovery seed failed due to an internal NNMi error. The problem
might be related to discovery or to a system wide issue, such as running out of memory or
having trouble with database access. Check the discovery log file (see "Verify that NNMi
Services Are Running" (on page 28)):

l Windows:
<drive>:\Documents and Settings\All Users\Application Data\HP\HP
 BTO Software\log\nnm\disco.0.0.log

<drive> is the drive on which NNMi is installed.

l UNIX:
/var/opt/OV/log/nnm/disco.0.0.log

Related Topics:

"Specify Discovery Seeds: Initial Routers or Specific Nodes to be Discovered" (on page 112)

Examine Discovery Inventory

The best method for examining your discovered inventory depends on how you configure discovery.

To examine your Discovery Inventory:

1. In the Workspace navigation panel, open the Inventory workspace.

2. Select the IP Addresses view.

3. Optional. Verify that each IP address you identified as a discovery seed is listed.

4. Verify that the set of IP addresses you expect to see are visible (based on any address ranges where
Discover Included Nodes is enabled or disabled).

5. To check on the current discovery state for a particular node, see "Node Discovery State Check" (on
page 117).

Note: If you configure one or more Auto-Discovery Rules and you get unexpected results, check your order-
ing numbers. See "Configure Auto-Discovery Rules" (on page 101) for more information.

Related Topics

Using the IP Addresses View

Using the Nodes View

Examine Layer 2 Discovery Results

Layer 2 represents your network's physical connections and LAN switch traffic routes.

To examine Layer 2 inventory and connectivity results:

1. In the Workspace navigation panel, open the Inventory workspace.

2. Select the Nodes view.
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3. Select the node of interest.

4. Select Actions → Layer 2 Neighbor View.

5. Use the Number of Hops field to expand the area shown on the map.

6. Examine your network connectivity to ensure it is as expected. See "Add or Delete a Layer 2 Con-
nection" (on page 124) if changes are required.

Note: If you configure one or more Auto-Discovery Rules and you get unexpected results, check your order-
ing numbers. See "Configure Auto-Discovery Rules" (on page 101) for more information.

To examine VLAN results:

1. In the Workspace navigation panel, open the Inventory workspace.

2. Select the VLANs view.

3. Select the VLAN of interest.

4. Click Open to open the VLAN form.

5. Verify that the list includes all nodes and ports assigned to this VLAN.

Note: If you configure done or more Auto-Discovery Rules and you get unexpected results, check your
ordering numbers. See "Configure Auto-Discovery Rules" (on page 101) for more information.

Related Topics

Using the Layer 2 Neighbor View

Using the Layer 3 Neighbor View

Examine Layer 3 Discovery Results

Layer 3 represents your network's router traffic.

To examine Layer 3 inventory results:

1. In the Workspace navigation panel, open the Inventory workspace.

2. Select the Nodes view.

3. Select the router of interest.

4. Select Actions → Layer 3 Neighbor View.

5. Use the Number of Hops field to expand the area shown on the map.

6. Examine your network connectivity to ensure it is as expected. If changes are required, try the fol-
lowing:

n Use Actions → Configuration Poll. See Using Actions to Perform Tasks for more information.

n Manually add or delete the connection See "Add or Delete a Layer 2 Connection" (on page 124) .

n Verify that the addresses on each end of the connection are not listed in the Excluded IP Address
filter. See "Configure an Excluded IP Addresses Filter" (on page 108).

Note: If you configure one or more Auto-Discovery Rules and you get unexpected results, check your order-
ing number for each rule. See "Configure Auto-Discovery Rules" (on page 101) for more infor-
mation.

Related Topics
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Using the Layer 2 Neighbor View

Using the Layer 3 Neighbor View

Keep Your Topology Accurate

With NNMi, discovery is ongoing. After initial discovery, NNMi checks periodically to ensure that the maps
accurately reflect the state of your network. NNMi also updates the database to reflect any changes.

By default, NNMi uses the following methods to keep the maps accurate:

Spiral Discovery. NNMi uses neighbor information gathered from various devices on your network to dis-
cover all devices connected to your network.

Scheduled Rediscovery. Discovery occurs automatically at the interval you define. See"Adjust the Dis-
covery Interval" (on page 98) for more information about setting the discovery schedule.

Delete Nodes. As an administrator, you can also delete any nodes that you no longer use, or delete nodes
to force NNMi to rediscover them. See "Delete Nodes" (on page 122) for more information.

Tip: NNMi also monitors the health of the discovered devices. The health is indicated by the color of the
background shape of each device icon on the map. See "Status Colors" for more information. For
information about how health monitoring works, see "About the State Poller" (on page 151) and
"Monitoring Network Health" (on page 151).

Add or Delete Connections. If your network management domain includes ATM, Frame Relay, or MPLS
links between wide area networks (WANs), you may need to use the connection editor to show the links in
the Layer 2 Neighbor View maps within NNMi. For MPLS, you can provide multiple connections between
two nodes. "Add or Delete a Layer 2 Connection" (on page 124).

Delete Nodes

NNMi administrators can delete nodes from a table view, map view, or Node form. For example:

l Remove any nodes that are no longer being used in the network.

l When non-SNMP addresses that had the same DNS hostname are changed to have separate DNS
hostnames, NNMi must completely rediscover the non-SNMP nodes to correctly update the database
objects (node, interface, address, connection, and incidents).

To understand the results of deleting a Node, click here for more information.

l NNMi cleans up the database by deleting the following objects:

n Any objects representing things contained in the deleted Node (for example, all of that node's inter-
faces and IP addresses).

n Any related objects that are empty after deleting the Node (for example, subnets).

n Any connections with only zero or one end points after deleting the Node.

l During future discovery cycles, if the deleted Node meets the criteria for an Auto-Discovery Rule and
appears in a monitored router's ARP cache, NNMi adds the Node back into the NNMi database during
the next discovery cycle. To prevent this, create an Excluded IP Addresses filter for the addresses (see
"Configure an Excluded IP Addresses Filter" (on page 108)).

l During future monitoring cycles, NNMi polls only objects currently in the database.

l Each Incident associated with the deleted Node is modified in the following ways:
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n The Status attribute changes to Closed.

n The Correlation Notes indicate the deletion of the associated node, interface, or address.

n The RCA State attribute changes to FALSE.

l Incidents generated from traps (received from the deleted Node) appear in the Incident views, but
remain unresolved.

l If you are viewing a Node that has recently been deleted by another user, the deleted Node appears

as a transparent icon on the map until the map is refreshed using the Refresh icon. After Refresh,
the deleted node is removed from the map. NNMi does not automatically refresh the connectivity or set
of nodes in a map view, except on the Network Overview map.

Note: If you delete a Node with many interfaces and VLANs, you may see an error message indicating that
the Node could not be deleted. This means the database was busy with discovery. Try again
between discovery cycles.

If a deleted Node is one of your seeds, delete that seed from the Discovery Seeds table as well. See
"Delete Discovery Seeds" (on page 123).

To delete one or more nodes (maximum 20 at one time):

l In a table view, select the object of interest by selecting the  check box in the row or rows that rep-

resents the objects of interest, and click the  Delete icon. Each selected node is deleted from the
NNMi database and removed from the current view.

l In a map view, click the map symbol representing the node you want to delete, and click File → Delete
Node. The node is deleted from the NNMi database and removed from the current view.

l In a Node form, select File → Delete Node and in the confirmation dialog, click OK. The form is auto-
matically closed after NNMi deletes the Node.

To delete any number of nodes at one time:

See the nnmnodedelete.ovpl Reference Page.

Related Topics

Using Table Views

Using Map Views

Delete Discovery Seeds

There are two ways to delete discovery seeds from the NNMi Discovery configuration and the NNMi data-
base.

To delete seeds using the Discovery Configuration view:

1. Navigate to the Discovery Seeds tab in the Discovery Configuration form. 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Discovery Configuration.

c. Locate the Discovery Seeds tab.

2. To delete one or more discovery seeds, select any number of rows, and click the  Delete icon.

3. Click Save and Close.
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To delete any number of seeds at one time from the command line:

1. A user name and password are required with the nnmseeddelete.ovpl command:

-u <NNMiadminUserName> -p <NNMiadminPassword>

If you do not want to enter a user name and password at the command line, you can use the
nnmsetcmduserpw.ovpl command to specify the valid user name and password (instead of -u and -
p). The credentials set using the nnmsetcmduserpw.ovpl command are valid for command
execution by the same user.

2. At the command line of the NNMi management server, type the nnmseeddelete.ovpl command.

Specify the host name or IP address (exactly as listed in the Discovery Seeds tab in the Discovery
Configuration form).

nnmseeddelete.ovpl -seed <IP-address/hostname>

Add or Delete a Layer 2 Connection

Tip: If your network management domain includes ATM, Frame Relay, or MPLS links between wide area
networks (WANs), you may need to use the connection editor to show the links in the Layer 2 Neighbor
View maps within NNMi. For MPLS, you can provide multiple connections between two nodes.

Use the NNMi nnmconnedit.ovpl command to add or delete connection data.

The nnmconnedit.ovpl command is used to generate a template XML file (shown in the following exam-
ple). For each connection to be added or deleted, you provide information about the node and interface at
both ends of the connection. Multiple <connection> elements are allowed within the template XML file.

<connectionedits>             
<connection>             
 <operation>add or delete</operation>             
 <node>node Name, Hostname or management IP address</node>             
 <interface>ifName, ifAlias, ifDescr or ifIndex</interface>             
 <node>node Name, Hostname, or management IP address</node>             
 <interface>ifName, ifAlias, ifDescr or ifIndex</interface>             

 </connection>             
</connectionedits>

Attribute Description

operation Specify whether the connection is to be added or deleted.

node Identify the node using any of the following values:

Note: NNMi converts all Hostname attribute values to lowercase in the NNMi database.
Therefore, when entering a Hostname value, use all lowercase.

l node Name

l Hostname (fully-qualified DNS name, all lowercase)

l management IP address

interface Identify the interface using one or more of the following (MIB-II) values:

l ifName

l ifAlias

Required Layer 2 Connection Attributes in the Connection Editor File
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Attribute Description

l ifDescr

l ifIndex Note the following for ifIndex:

n For interfaces in Non-SNMP nodes, always use the ifIndex value of 0 (zero).       

n For interfaces in SNMP nodes, choose other MIB-II values to identify the interface
because often automatic interface renumbering causes confusion.

To add or delete a connection:

1. For the devices at both ends of the connection, gather the data required to identify the device and
interface.

2. On the NNMi management server, at the command line, generate a connections template file using
either add to create an add.xml template file or delete to create a delete.xml template file.

In the following example, NNMi creates an add.xml file:
nnmconnedit.ovpl -t add

Note: If you specify add, NNMi creates the template file named add.xml. If you use delete, the tem-
plate file is named delete.xml.

3. Open the template file in a text editor and fill in the correct information for each node and interface.

4. On the NNMi management server, at the command line, load the new connection information into the
NNMi database:
nnmconnedit.ovpl -f <add|delete>.xml

For example, to load the add.xml template file, enter:

nnmconnedit.ovpl -f add.xml

5. Open the Layer 2 Neighbor View map and verify the connection changes.

The connections you establish are listed in the Layer 2 Connections view in the Inventory workspace. To
delete a connection, you must use the nnmconnedit.ovpl command (no Delete action is available in the
Layer 2 Connections view).
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Creating Groups of Nodes or Interfaces

Groups of nodes or interfaces are used for a variety of purposes within NNMi. Use of these groups is
optional.

l Use node and interface groups to specify monitoring configuration settings. See"Monitoring Network
Health" (on page 151).

l Use node and interface groups to create custom view filters that help your team quickly sift through
data in the NNMi views and identify the most important information.

You can use Node Groups and Interface Groups within both contexts (view and configuration) or create a
separate set of groups to configure monitoring.

Filter

View: Object Type

Incident Node Interface IP Address

Node Groups
"Create Node Groups" (on page 126)

x x x x

Interface Groups
"Create Interface Groups" (on page 139)

x x

View Filter Possibilities

Create Node Groups

Node Group definitions match the way your team identifies important network devices. Each node group is
defined using one or more of the following:

l Device Filters (by any combination of category, vendor, family, profile)

l Additional Filters

l Additional Nodes (identified by Hostname)

l Child Node Groups

Note the following:

l When you provide both Device Filters and Additional Filters, nodes must match all specifications to
belong to this Node Group.

l Any Additional Nodes you specify are always included in the Node Group.

l You can set Custom Attributes for nodes and then create Node Groups based on these Custom Attrib-
utes. See"In a Text File, Define Node Groups" (on page 137) and nnmnetloadnodeattrs.ovpl for more
information.

Node Groups are used for a variety of purposes in NNMi:

l Filter node, interface, IP address, and incident views by Node Group.

l Control how NNMi monitors network devices using Node Groups. For example, configure a different
health monitoring interval for each group.

l NNM iSPI for Performance. If you are using NNM iSPI for Performance, control performance monitoring
and provide report filters by Node Group.

To create Node Groups, do one or more of the following:
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l "In the Console, Create Node Groups" (on page 127)

l "In a Text File, Define Node Groups" (on page 137)

To verify the contents of a Node Group:

After the Node Group is saved, from the Node Group form, select Actions → Show Members.

NNMi automatically creates Island Node Groups whenever it detects changes in Layer 2 connections. An
Island Node Group is a group of fully-connected nodes that NNMi displays in a group that is not connected
to the rest of the topology. See "Island Node Groups" (on page 149) for more information.

In the Console, Create Node Groups

Node Groups are used for a variety of purposes in NNMi:

l Filter node, interface, IP address, and incident views by Node Group.

l Control how NNMi monitors network devices using Node Groups. For example, configure a different
health monitoring interval for each group.

l NNM iSPI for Performance. If you are using NNM iSPI for Performance, control performance monitoring
and provide report filters by Node Group.

To create a Node Group (if your role allows you to do this):

1. Navigate to the Node Group form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Node Groups view.

c. Do one of the following:

o To create a Node Group, click the New icon.

o To edit a Node Group, select a row, click the Open icon.

2. In the Node Group form, provide attribute values in the Basics section.

3. NNM iSPI for Performance. Make the Node Group available within NNM iSPI for Performance (see
NNM iSPI for Performance table).

4. Identify the nodes that belong to this Node Group.

Do one or more of the following:

n Specify an SNMP Object ID strategy using the Device Filters tab.

n Specify a Node Group filter expression using the Additional Filters tab.                             

n Specify individual nodes using the Additional Nodes tab.

n Specify Child Node Groups using the Child Node Groups tab.

5. Click Save and Close to return to the Node Group form.

6. Click Save.

7. To view the members in the Node Group, select Actions → Show Members.

8. Click Save and Close.
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If you configured this Node Group for Monitoring, NNMi applies your changes during the next mon-
itoring cycle. "Configure Monitoring Behavior" (on page 152).

Note the following:

l You can create a Node Group using a comma separated values (CSV) text file. For example, if you
have node group information in an Microsoft Excel spreadsheet, you can save this information as a
.csv file and use the nnmloadnodegroups.ovpl command to add this node group information to
NNMi. See the nnmloadnodegroups.ovpl Reference Page for more information about the nnmload-
nodegroups.ovpl command, including the required format of the CSV file.

l NNMi monitors the status of each Node Group over time. To check Node Group status information,
access the Node Group Status tab.

To review a Node Group definition:

1. From the workspace navigation panel, select the Inventory workspace.

2. Select the Node Groups view.

3. Locate the row representing the Node Group, click the  Open icon.

4. The Node Group form displays.

5. When finished, click the  Close icon.

Special Actions are available within the Node Group and Interface Group views.

Related Topics

"In a Text File, Define Node Groups" (on page 137)

Specify Node Group Additional Filters

The Additional Filters Editor enables you to create expressions to further define the nodes to be included
in a Node Group. Make sure to design any complex Additional Filters offline as a Boolean expression first.
This method can help to minimize errors when entering your expressions using the Additional Filters
editor.

If any Additional Filters are created, NNMi combines any Device Filters and Additional Filters using the
AND Boolean operator as follows:

l NNMi first evaluates any Device Filters. Nodes must match all specifications to belong to this node
group.

l NNMi then evaluates the Additional Filters expression. Nodes must also match all Additional Filters
expression specifications to belong to this Node Group.

To create an Additional Filters expression:

1. Navigate to the Node Group Form: Additional Filters tab.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Node Group.

c. Do one of the following:

o To create a Node Group definition, click the New icon.

o To edit a Node Group definition, select a row, click the Open icon.

d. In the Node Group form, select the Additional Filters tab.
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2. Establish the appropriate settings for the Additional Filters you need (see the Additional Filters Editor
Components and Additional Filters Editor Buttons table).

When creating any Additional Fitters, note the following:

n Each set of expressions associated with a Boolean Operator is treated as if it were enclosed in
parentheses and evaluated together.

n View the expression displayed under Filter String to see the logic of the expression as it is
created.

n When using the AND operator to combine expressions that include Custom Attributes, include
only one customAttrName/customAttrValue pair in a sub-expression.

n The AND and OR Boolean Operators must contain at least two expressions as shown in the
example below.

AND

sysName like cisco*

sysName != cisco2811

OR

sysLocation = Boston

 sysContact In (Johnson,Hickman)

NNMi evaluates the expression above as follows:

sysName like cisco* AND sysName != cisco2811 AND (sysLocation = Boston OR
sysContact in (Johnson, Hickman))

o NNMi finds all nodes whose system Name begins with cisco, but does not include cisco2811

o Of these nodes, NNMi then finds all nodes whose system location is Boston or whose system
contact name includes Johnson or Hickman.

n The placement of your cursor and the subsequent text that is selected is important when per-
forming operations using the Additional Filters Editor. For example, you append to, replace, or
change the indentation of the expression that is selected.

n The placement of your cursor and the subsequent text that is selected is especially important
when adding your Boolean operators. See "Add Boolean Operators in the Additional Filters
Editor" (on page 134) for more information.

3. Click Save and Close.
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Attribute Description

Attribute The attribute name on which NNMi searches. Filterable attributes include the following. For
more information about each one, click the link:

Values from the Basic Attributes listed on the Node Form:

l hostname (Hostname)

l mgmtIPAddress (Management Address)

Values from the Node Form:General Tab:

l sysName (System Name)

l sysLocation (System Location)

l sysContact (System Contact)

Addresses from the Node Form: IP Addresses Tab:

l hostedIPAddress (Address)

Note: When you want to filter nodes based on an hostedIPAddress address range, use the
between operator. When using the hostedIPAddress attribute with the greater than or
equal to (>=) and less than or equal to (<=) operators, NNMi finds all addresses that match
the filter. Click here for an example. For example, the hostedIPAddress values 1.1.1.1 and
20.20.20.20, pass the filter: hostedIPaddress >= 16.120.100.0 and hostedIPaddress
<= 16.120.100.255.

Unique Keys from the Node Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Node Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Operator The standard query language (SQL) operations to be used for the search.

Note: Only the is null Operator returns null values in its search.

Valid operators are described below.

l = Finds all values equal to the value specified. Click here for an example.

Example: sysName=cisco2811 finds all devices with system name equal to cisco2811.

l != Finds all values not equal to the value specified. Click here for an example.

Example: sysName != cisco2811 finds all system names other than cisco2811.

l < Finds all values less than the value specified. Click here for an example.

Example: mgmtIPAddress < 15.239.255.255 finds all IP address values less than
15.239.255.255.

l <= Finds all values less than or equal to the value specified. Click here for an example.

Example: mgmtIPAddress <= 15.239.255.255 finds all IP address values less than
or equal to 15.239.255.255.

Additional Filters Editor Components
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Attribute Description

l > Finds all values greater than the value specified. Click here for an example.

Example: mgmtIPAddress > 15.238.0.0 finds all IP address values greater than
15.238.0.0.

l >= Finds all values greater than or equal to the value specified. Click here for an exam-
ple.

Example: mgmtIPAddress >= 15.238.0.0 finds all IP address values greater than or
equal to 15.238.0.0.

l between Finds all values equal to and between the two values specified. Click here for
an example.

Example: mgmtIPAddress between 15.238.0.10 15.238.0.120 finds all IP address
values equal to or greater than 15.238.0.10 and equal to or less than 15.238.0.120.

l in Finds any match to at least one value in a list of values. Click here for an example.

Example:

sysName in

finds all systems with names that are cisco2811 or cisco5500.

Note: As shown in the example, each value must be entered on a separate line.

NNMi displays the list of attributes using comma-separated values enclosed in paren-
theses, for example (cisco2811, cisco550). However, the comma-separated list is used
only for display purposes. The actual delimiter is the new line.

l is not null Finds all non-blank values. Click here for an example.

Example: sysName is not null finds all systems that have a name value.

l is null Finds all blank values. Click here for an example.

Example: sysName is null finds all systems that do not have an assigned name value.

l like Finds matches using wildcard characters. Click here for more information about
using wildcard characters.

The following attributes cannot be used with the like operator:

n hostedIPaddress

n mgmtIPaddress

The asterisk (*) character means any number of characters of any type at this location.

The question mark (?) character means any single character of any type at this location.

Examples:

n sysName like cisco* finds all system names that begin with cisco.

n sysName like *.xyz.com finds all system names that end with this specific
domain.

n sysName like *rtr* finds all system names that containrtr.
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Attribute Description

n sysName like *cisco??* finds all system names that includecisco followed by
two characters.

n sysName like ??rtr?bld5* finds all system names that have specific characters
at an exact location, positions 3-5 (rtr) and 7-10 (bld5).

l not between Finds all values except those between the two values specified. Click here
for an example.

Example: mgmtIPAddress not between 15.238.0.10 15.238.0.120 finds all IP
address values less than 15.238.0.10 and greater than 15.238.0.120.

l not in Finds all values except those included in the list of values. Click here for an exam-
ple.

Example:

sysName not in

finds all system name values other than cisco2811 and cisco5500.

Note: As shown in the example, each value must be entered on a separate line.

NNMi displays the list of attributes using comma-separated values enclosed in paren-
theses, for example, (cisco2811, cisco550). However, the comma-separated list is used
only for display purposes. The actual delimiter is the new line.

l not like Finds all that do not have the values specified (using wildcard strings). Click here
for an example.

The following attributes cannot be used with the not like operator:

n hostedIPaddress

n mgmtIPaddress

The asterisk (*) character means any number of characters of any type at this location.

The question mark (?) character means any single character of any type at this location.

Examples:

n sysName not like cisco* finds all system names that do not begin with cisco.

n sysName not like *.xyz.com finds all system names that do not end with this spe-
cific domain.

n sysName not like *rtr* finds all system names that do not containrtr.

n sysName not like *cisco??* finds all system names that do not includecisco fol-
lowed by two characters.

n sysName not like ??rtr?bld5* finds all system names that do not have specific
characters at an exact location, positions 3-5 (rtr) and 7-10 (bld5).

Page 132 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Creating Groups of Nodes or Interfaces

Attribute Description

Attribute The attribute name on which NNMi searches. Filterable attributes include the following. For
more information about each one, click the link:

Values from the Basic Attributes listed on the Node Form:

l hostname (Hostname)

l mgmtIPAddress (Management Address)

Values from the Node Form:General Tab:

l sysName (System Name)

l sysLocation (System Location)

l sysContact (System Contact)

Addresses from the Node Form: IP Addresses Tab:

l hostedIPAddress (Address)

Note: When you want to filter nodes based on an hostedIPAddress address range, use the
between operator. When using the hostedIPAddress attribute with the greater than or
equal to (>=) and less than or equal to (<=) operators, NNMi finds all addresses that match
the filter. Click here for an example. For example, the hostedIPAddress values 1.1.1.1 and
20.20.20.20, pass the filter: hostedIPaddress >= 16.120.100.0 and hostedIPaddress
<= 16.120.100.255.

Unique Keys from the Node Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Node Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Value The value for which you want NNMi to search.

Note the following:

l The values you enter are case sensitive.

Note: NNMi converts all Hostname attribute values to lowercase in the NNMi database.
Therefore, when entering a Hostname value, use all lowercase.

l NNMi displays a variable number of value fields depending on the Operator selected. For
example, the between Operator causes two value fields to be displayed.

l The in and not in operators require that each value be entered on a separate line.

l When entering a value for the Capability attribute, copy and paste the Unique Key value
from the Node form: Capability tab.

Note: When copying and pasting the Unique Key value, delete any leading or trailing
blank spaces as the Unique Key value must be an exact match.
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Button Description

Append Appends the current expression (Attribute, Operator,and Value) to the selected expression
already included in the filter string.

Replace Replaces the selected expression with the expression displayed in the Attribute, Operator,
and Value fields.

AND Inserts the AND Boolean Operator in the selected cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

OR Inserts the OR Boolean Operator in the current cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

AND <--
> OR

Switches the selected Boolean Operator to either AND or OR. If the selected Boolean Oper-
ator is AND, the value is changed to OR. If the selected Boolean Operator is OR, the value is
changed to AND.

Outdent Moves a nested expression up one expression level. If your filter string includes only one
nested expression, Outdent replaces the top-level expression. Click here for examples. 

Example 1

AND
 sysName like cisco*
 OR            

 sysLocation = Boston

Placing the cursor at sysLocation = Boston and selecting Outdent, results in:  

AND
 sysName like cisco*

 OR      
 sysLocation = Boston

Example 2

AND
 sysName like cisco*

Placing the cursor at sysName like cisco* and selecting Outdent, results in: 

sysName like cisco*

Delete Deletes the selected expression.

Note: If the Boolean Operator is selected, the Additional Filters Editor deletes all expressions
associated with the Boolean Operator.

Additional Filters Editor Buttons

Add Boolean Operators in the Additional Filters Editor

When adding or deleting Boolean Operators using the Additional Filters Editor, note the following:
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l Add your highest level Boolean operator first. For example, AND is the highest level Boolean operator
in the following expression

(sysName like cisco* OR sysName like hp*) AND ( sysLocation = Boston OR sysContact in
Johnson,Hickman)

l Add each additional Boolean Operator before the expressions to which it applies.

l Select the appropriate Boolean Operator in the expression before you add the expressions to which
the Boolean Operator applies.

l When a Boolean Operator is selected and you click Delete, any expressions that are associated with
the Boolean Operator are also deleted.

In the example expression below, If you select AND and then click Delete, the Additional Filters Editor
deletes the entire expression.

Click here for an example for creating Node Group Additional Filters.                                                          

Node Group Additional Filters Expression Example

(sysName like cisco* OR sysName like hp*) AND ( sysLocation = Boston OR sysContact in Johnson,Hic-
kman)

To add the expression above, after you are in the Additional Filters Editor, follow these steps:

1. Click AND.

2. Click OR.

3. Select the OR you just added to the expression.

4. In the Attribute field select sysName from the drop-down list.

5. In the Operator field, select like from the drop-down list.

6. In the Value field, enter cisco*.

7. Click Append.

8. In the Attribute field, select sysName from the drop-down list.

9. In the Operator field, select like from the drop-down list.

10. In the Value field, enter hp*.

11. Click Append.

12. Select the AND that you previously added to the expression.

13. Click OR.

14. Select the OR you just added to the expression.

15. In the Attribute field, select sysLocation from the drop-down list.
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16. In the Operator field, select = from the drop-down list.

17. In the Value field, enter Boston.

18. Click Append.

19. In the Attribute field, select sysContact from the drop-down list.

20. In the Operator field, select in from the drop-down list.

21. In the Value field:

a. enter Johnson and press <Enter>.

b. On the new line, enter Hickman.

22. Click Append.

23. Click Save to save your Additional Filters.

24. Select Actions → Show Members to view the members of the Node Group that is a result of this
filter.

Click here for an example for creating an Interface Group Additional Filters.

Interface Group Additional Filters Expression Example

(ifName like ATMS* AND ifName != ATMS/0/A) AND (ifSpeed = 10 OR ifSpeed = 100)

To add the expression above, follow these steps:

1. Click AND.

2. Click AND.

3. Select the AND you just added to the expression.

4. In the Attribute field select ifName from the drop-down list.

5. In the Operator field, select like from the drop-down list.

6. In the Value field, enter ATM*.

7. Click Append.

8. In the Attribute field, select ifName from the drop-down list.

9. In the Operator field, select != from the drop-down list.

10. In the Value field, enter ATMS/0/A.

11. Click Append.

12. Select the first AND that you added to the expression.

13. Click OR.

14. Select the OR you just added to the expression.

15. In the Attribute field, select ifSpeed from the drop-down list.

16. In the Operator field, select = from the drop-down list.

17. In the Value field, enter 10.

18. Click Append.
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19. In the Attribute field, select ifSpeed from the drop-down list.

20. In the Operator field, select = from the drop-down list.

21. In the Value field, enter 100.

22. Click Append.

23. Click Save to save your Additional Filters.

24. Select Actions → Show Members to view the members of the Node Group that is a result of this
filter.

In a Text File, Define Node Groups

Node Groups are used for a variety of purposes in NNMi:

l Filter node, interface, IP address, and incident views by Node Group.

l Control how NNMi monitors network devices using Node Groups. For example, configure a different

health monitoring interval for each group.

l NNM iSPI for Performance. If you are using NNM iSPI for Performance, control performance monitoring
and provide report filters by Node Group.

You can create a Node Group using the NNMi console or a comma separated values (CSV) text file. For
example, if you have Node Group information in a Microsoft Excel spreadsheet, you can save this infor-
mation as a .csv file and use the nnmloadnodegroups.ovpl command to add this node group information
to NNMi. 

Note the following:

l NNMi uses the OR Boolean operator to combine any Node Group Device Filter and Additional Filter
information in the CSV file.

l NNMi uses the AND Boolean operator to combine any Custom Attribute and Capability attribute
values.

l If you include Node Group Device Filter and Additional Filter values as well as Custom Attribute and
Capability values, NNMi first uses the AND Boolean operator to combine the Custom Attribute and
Capability values and then uses the AND Boolean operator to combine these result with the Node
Group filter (Device Filter and Additional Filter) results.

l See nnmloadnodegroups.ovpl for a complete list of the types of Node Group attribute values that
nnmloadnodegroups.ovpl supports.

To create a Node Group using a comma separated values (CSV) text file, use the nnmload-
nodegroups.ovpl command:

nnmloadnodegroups.ovpl -r [true|false] -u <NNMiadminUsername> -p <NNMi-
adminPassword> -f <CSV file name>

-r is used to overwrite any existing Node Group configuration information. When -r is used with true,
NNMi overwrites any existing Node Group configuration information. The default setting is false.

CSV file name is the name of the CSV file that contains the Node Group information. The CSV file requires
that the information appear in a specific order and format. For example, to create a Node Group using a
Device Filter, the information must appear in the column designated as the Device Filter column of the
CSV file.

If you want to use a Device Filter to create a Node Group, you might need to access the NNMi graphical
user interface to determine values to include in the .csv file. Therefore, note the following:
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The nnmloadnodegroups.ovpl command requires that you use the SNMP object ID value to identify the
Device Profile. You must use the Unique Key values for the following Device Filter information: 1) Device
Family, 2) Device Vendor, and 3) Device Category. Click here for more information.

To determine the SNMP object ID or Unique Key value:

1. Navigate to the Device Profile Configuration table view.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Device Profile.

2. Optional. Sort or filter the view by the attribute or attribute value you want to specify. For example, you
might want to sort the table view using the Device Vendor attribute. See Use Table Views for more
information about sorting and filtering table views.

3. Click the Open icon that precedes the Device Profile of interest.

4. The SNMP object ID value appears on the Device Profile form.

If you want to view a Unique Key value, from the Family, Vendor, or Category attribute, click the

Lookup icon and select  Open.

NNMi displays the Device Family, Device Vendor, or Device Category form.

5. Use the value displayed in the SNMP Object ID or Unique Key attribute in the form.                     

See nnmloadnodegroups.ovpl Reference Page for more information about the nnmload-
nodegroups.ovpl command, including additional requirements for the CSV file format.

Related Topics

"In the Console, Create Node Groups" (on page 127)

Define Custom Attributes on Nodes (NNM iSPI Net)

The NNM iSPI Net nnmnetloadnodeattrs.ovpl enables you to load Custom Attributes from a comma-
separated values (CVS) file. This feature is useful if you have a large number of nodes defined in an exter-
nal data storage and you would like to load the attributes into NNMi. For example, if you have Node infor-
mation in a Microsoft Excel spreadsheet and this information is not defined as a Node attribute in NNMi,

you can save this information as a .csv file and use the nnmnetloadnodeattrs.ovpl command to add
this node information to NNMi.

After the Custom Attributes are loaded into NNMi, you can use the NNMi console to create Node Groups
containing nodes with the specified Custom Attribute Name (custAttrName) and Custom Attribute Value
(custAttrValue) pair. For example, if you have a comma-separated value file that includes building loca-
tions, you can use the nnmnetloadnodeattrs.ovpl command to define BldgLocation as a Custom Attrib-
ute and load the location values for each node. You can then create a Node Group using BldgLocation as
the custAttrName and the location of interest, such as Building Five Upper, as the custAttrValue. See "In
the Console, Create Node Groups" (on page 127) for more information about creating Node Groups using
the NNMi console.

To load Custom Attributes for Nodes using a comma-separate file:

nnmnetloadnodeattrs.ovpl -u <NNMiadminUsername> -p <NNMiadminPassword> -r
[true|false] -f <CSV file name>

-r is used to overwrite any existing Node Custom Attribute information. When -r is used with true, NNMi
overwrites any existing information. The default setting is false.
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CSV file name is the name of the CSV file that contains the Node Custom Attribute information. The CSV
file requires that the information appear in a specific order and format. See nnmnetloadnodeattrs.ovpl for
more information.

You can also create Node Groups using a CVS file. See "In a Text File, Define Node Groups" (on page
137) and nnmloadnodegroups.ovpl for more information.

Create Interface Groups

Interface Group definitions match the way your team identifies important network devices. Each interface
group can include one or more interface-type specifications (based on industry-standard IANA ifType-MIB
variables).

Optional. Associate a Node Group with an Interface Group. If you specify a Node Group, any interface in
this group must be contained in a node that matches the specified Node Group.

Interface Groups are used for a variety of purposes in NNMi:

l Interface Groups are filters for interface and IP address views.

l Interface Groups can control how NNMi monitors network devices. For example, instruct NNMi to never
generate ICMP or SNMP queries to any interface used for Voice-Over-IP within your network.

To define an Interface Group (if your role allows you to do this):

1. Navigate to the Interface Group form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Interface Groups view.

c. Do one of the following:

o To create an Interface Group, click the New icon.

o To edit an Interface Group, select a row, click the Open icon.

2. Provide the definition for this interface group(see Interface Group Form help).

3. Navigate to the Interface Type Filters tab.

4. Identify one or more interface types that belong to this group:

n To add an Interface Type filter, click the New icon, and continue.

n To change an Interface Type filter, select a row, click the Open icon, and continue.

n To delete an Interface Type filter, select a row and click the  Delete icon.

5. In the Interface Type Filter form, click the  Lookup icon and select one of the options from the
drop-down menu:

n Quick View to display summary information for the currently selected IfType.  

n  Quick Find to view and select from the list of all existing IfTypes (for more information see "Use
the Quick Find Window" (on page 19)).

n  Open to display the details of the currently selected IfType.
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n  New to create a new IfType (see "Add New IfTypes (Interface Types) to the List" (on page 140)
).

6. Click Save and Close to return to the Interface Group form.

7. Click Save and Close.

If you configured this Interface Group for Monitoring, NNMi applies your changes during the next mon-
itoring cycle. See "Configure Monitoring Behavior" (on page 152).

To review an Interface Group definition:

1. From the workspace navigation panel, select the Inventory workspace.

2. Select the Interface Groups view.

3. Locate the row representing the Interface Group, click the Open icon.

4. The Interface Group form displays.

5. When finished, click the  Close icon.

Special Actions are available within the Node Group and Interface Group views.

Add New IfTypes (Interface Types) to the List

Interface Type definitions cover all known industry-standard IANA ifType-MIB variables at the time of the
release of NNMi. Interface Groups are built with Interface Types. See "Create Interface Groups" (on page
139)

The Interface Types view is provided because:

l Occasionally new Interface Types are added between releases of NNMi. If your team acquires new
devices that contain new interface types, you can add the new interface type to the NNMi list of Inter-
face Type definitions.

l When NNMi discovers a new Interface Type, NNMi automatically adds a new entry in the Interface
Types view. NNMi detects the assigned IANA ifType-MIB number. NNMi uses that number in both the
IfType attribute and the number attribute values. Use this view to provide a more meaningful IfType text
string and optional description.

To configure an IANA ifType-MIB definition:

1. Navigate to the IfTypes view:

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the IfTypes view.

2. Do one of the following:

n To create an Interface Type definition, click the  New icon, and continue.

n To edit an Interface Type definition, select a row, click the  Open icon, and continue.

n To delete an Interface Type definition, select a row and click the  Delete icon.

3. In the Interface Type Filter form, click the  Lookup icon and select one of the options from the
drop-down menu:
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n Quick View to display summary information for the currently selected IfType.  

n  Quick Find to view and select from the list of all existing IfTypes (for more information see "Use
the Quick Find Window" (on page 19)).

n  Open to display the details of the currently selected IfType.

n  New to create a new IfType.

4. Click Save and Close.

Specify Interface Group Additional Filters

The Additional Filters Editor enables you to create expressions to further define the interfaces to be
included in an Interface Group. Make sure to design any complex Additional Filters offline as a Boolean
expression first. This method can help to minimize errors when entering your expressions using the Addi-
tional Filters editor.

If any Additional Filters are created:

l NNMi first evaluates any Interface Type filter. Nodes must match at least one specification to belong to
this Interface Group.

l NNMi then evaluates the Additional Filters expression. Nodes must also match all Additional Filters
expression specifications to belong to this Interface Group.

To create any Additional Filters expression:

1. Navigate to the Interface Group Form: Additional Filters tab.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Interface Groups.

c. Do one of the following:

o To create an Interface Group definition, click the New icon.

o To edit an Interface Group definition, select a row, click the Open icon.

d. In the Interface Group form, select the Additional Filters tab.

2. Establish the appropriate settings for the Additional Filters you need. (See the Additional Filters
Editor Components and Additional Filters Editor Buttons table.)

When creating any Additional Filters, note the following:

n Each set of expressions associated with a Boolean Operator is treated as if it were enclosed in
parentheses and evaluated together. View the expression displayed under Filter String to see
the logic of the expression as it is created.

n When using the AND operator to combine expressions that include Custom Attributes, include
only one customAttrName/customAttrValue pair in a sub-expression. 

n The AND and OR Boolean Operators must contain at least two expressions as shown in the
example below.

AND
 ifName like ATMS*
 ifName != ATMS/0/A

Page 141 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Creating Groups of Nodes or Interfaces

 OR
 ifSpeed = 10000000
 ifSpeed = 100000000

Note: As shown in the example above, you must use the actual ifSpeed number.

NNMi evaluates the expression above as follows:

(ifName like ATMS* AND ifName != ATMS/0/A) AND (ifSpeed = 10000000 OR
ifSpeed = 100000000)

o NNMi finds all interfaces whose interface Name begins with ATMS, but does not include
ATMS/0/A.

o Of these interfaces, NNM then finds all interfaces whose interface speed is 10 Mbps or 100
Mbps.

n The placement of your cursor and the subsequent text that is selected is important when per-
forming operations using the Additional Filters Editor. For example, you append to, replace, or
change the indentation of the expression that is selected.

n The placement of your cursor and the subsequent text that is selected is especially important
when adding your Boolean operators. See "Add Boolean Operators in the Additional Filters
Editor" (on page 134) for more information.

3. Click Save and Close.

Attribute Description

Attribute The attribute name on which NNMi searches. Filterable attributes include the following. For
more information about each one, click the link:

Values from the Basic Attributes listed on the Interface Form:

l ifName (Name)

l hostedOn (Host On Node)

Values from the Interface Form: General Tab:

l ifAlias (InterfaceAlias)

l ifDesc (InterfaceDescription)

l ifIndex (InterfaceIndex)

l ifSpeed (Interface Speed)

Addresses from the Interface Form: IP Addresses Tab:

l ipAddress (IP Address associated with the interface)

Unique Keys from the Interface Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Interface Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Operator The standard query language (SQL) operations to be used for the search.

Additional Filters Editor Components
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Attribute Description

Note: Only the is null Operator returns null values in its search.

Valid operators are described below.

l = Finds all values equal to the value specified. Click here for an example.

Example: ifName=Fa0/14 finds all interface names that are equal to Fa0/14.

l != Finds all values not equal to the value specified. Click here for an example.

Example:ifName != lan0 finds all interface names other than lan0.

l < Finds all values less than the value specified. Click here for an example.

Example: ifSpeed <= 100000000 finds all interfaces whose interface speed is less
than 100 Mbps.

l <= Finds all values less than or equal to the value specified. Click here for an example.

Example: ifSpeed <= 100000000 finds all interfaces whose interface speed is less
than or equal to 100 Mbps.

l > Finds all values greater than the value specified. Click here for an example.

Example: ifSpeed >= 10000000 finds all interfaces whose interface speed is greater
than 10 Mbps.

l >= Finds all values greater than or equal to the value specified. Click here for an exam-
ple.

Example: ifSpeed >= 10000000 finds all interfaces whose interface speed is greater
than or equal to 10 Mbps.

l between Finds all values equal to and between the two values specified. Click here for
an example.

Example: ifSpeed between 10000000 100000000 finds all interfaces whose inter-
face speed is equal to or greater than 10 Mbps and equal to or less than 100 Mbps.

l in Finds any match to at least one value in a list of values. Click here for an example.

Example:

ifName in

finds all interfaces with names that are Fa0/14 or Fa0/15.

Note: As shown in the example, each value must be entered on a separate line.

NNMi displays the list of attributes using comma-separated values enclosed in paren-
theses, for example, (Fa0/14, Fa0/15). However, the comma-separated list is used only
for display purposes. The actual delimiter is the new line.

l is not null Finds all non-blank values. Click here for an example.

Example: ifName is not null finds all interfaces that have a name value.

l is null Finds all blank values. Click here for an example.

Example:ifName is null finds all interfaces that do not have an assigned name value.
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Attribute Description

l like Finds matches using wildcard characters. Click here for more information about
using wildcard characters.

The following attributes cannot be used with the like operator:

n ifIndex

n ifSpeed

n IPAddress

The asterisk (*) character means any number of characters of any type at this location.

The question mark (?) character means any single character of any type at this location.

Examples:

n ifName like ATM* finds all interface names that begin with ATM.

n ifName like *.xyz.com finds all system names that end with this specific domain.

n ifName like *rtr* finds all system names that containrtr.

n ifName like *cisco??* finds all system names that includecisco followed by two
characters.

n ifName like ??rtr?bld5* finds all system names that have specific characters at
an exact location, positions 3-5 (rtr) and 7-10 (bld5).

l not between Finds all values except those between the two values specified. Click here
for an example.

Example: ifSpeed not between 10000000 100000000 finds all interfaces whose
interface speed is less than 10 Mbps and greater than 100 Mbps.

l not in Finds all values except those included in the list of values. Click here for an exam-
ple.

Example:

ifName not in

finds all interface name values other than Fa0/14 or Fa0/15.

Note: As shown in the example, each value must be entered on a separate line.

NNMi displays the list of attributes using comma-separated values enclosed in paren-
theses, for example, (Fa0/14, Fa0/15). However, the comma-separated list is used only
for display purposes. The actual delimiter is the new line.

l not like Finds all that do not have the values specified (using wildcard strings). Click here
for an example.

The following attributes cannot be used with the not like operator:

n ifIndex

n ifSpeed

n IPAddress
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Attribute Description

The asterisk (*) character means any number of characters of any type at this location.

The question mark (?) character means any single character of any type at this location.

Examples:

n ifName not like ATM* finds all interface names that do not begin with ATM.

n ifName not like *.xyz.com finds all system names that do not end with this spe-
cific domain.

n ifName not like *rtr* finds all system names that do not containrtr.

n ifName not like *cisco??* finds all system names that do not includecisco fol-
lowed by two characters.

n ifName not like ??rtr?bld5* finds all system names that do not have specific
characters at an exact location, positions 3-5 (rtr) and 7-10 (bld5).
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Attribute Description

Attribute The attribute name on which NNMi searches. Filterable attributes include the following. For
more information about each one, click the link:

Values from the Basic Attributes listed on the Interface Form:

l ifName (Name)

l hostedOn (Host On Node)

Values from the Interface Form: General Tab:

l ifAlias (InterfaceAlias)

l ifDesc (InterfaceDescription)

l ifIndex (InterfaceIndex)

l ifSpeed (Interface Speed)

Addresses from the Interface Form: IP Addresses Tab:

l ipAddress (IP Address associated with the interface)

Unique Keys from the Interface Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Interface Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Value The value for which you want NNMi to search.

Note the following:

l The values you enter are case sensitive.

l NNMi displays a variable number of value fields depending on the Operator selected.
For example, the between Operator causes two value fields to be displayed.

l The in and not in operators require that each value be entered on a separate line.

l When entering a value for the Capability attribute, copy and paste the Unique Key value
from the Interface form: Capability tab.

Note: When copying and pasting the Unique Key value, delete any leading or trailing
blank spaces as the Unique Key value must be an exact match.

Button Description

Append Appends the current expression (Attribute, Operator,and Value) to the selected expression
already included in the filter string.

Replace Replaces the selected expression with the expression displayed in the Attribute, Operator,
and Value fields.

AND Inserts the AND Boolean Operator in the selected cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

Additional Filters Editor Buttons
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Button Description

OR Inserts the OR Boolean Operator in the current cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

AND < >
OR

Switches the selected Boolean Operator to either AND or OR. If the selected Boolean Oper-
ator is AND, the value is changed to OR. If the selected Boolean Operator is OR, the value is
changed to AND.

Outdent Moves a nested expression up one expression level. If your filter string includes only one
nested expression, Outdent replaces the top-level expression. Click here for examples. 

Example 1

AND
 ifName like ATMS*
 OR            

 ifSpeed = 10000000

Placing the cursor at ifSpeed = 10000000 and selecting Outdent, results in:  

AND
 ifName like ATMS*
 OR
 ifSpeed = 10000000 

Example 2

AND
 ifName like ATMS*

Placing the cursor at ifName like ATMS* and selecting Outdent, results in: 

ifName like ATMS*

Delete Deletes the selected expression.

Note: If the Boolean Operator is selected, the Additional Filters Editor deletes all expressions
associated with the Boolean Operator.

Node Groups Provided by NNMi

NNMi Provides the following kinds of Node Groups:

l Node Groups as Predefined View Filters. These Node Groups can also be used for Monitoring Con-
figuration if you find them useful.

l "Island Node Groups" (on page 149). These Node Groups contain connected nodes that NNMi dis-
plays in a group that is not connected to the rest of the topology.

Node Groups As Predefined View Filters

NNMi provides the following Node Groups. You can configure these Node Groups with specific information
about your management domain and change them to meet your needs.

Node Groups can be used to filter table and map views.
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Name Purpose

Important
Nodes

Caution: Do not delete this Node Group.

This Node Group is used by the Causal Engine. Any devices in this group receive special
treatment. When a current member of this group stops responding, the Causal Engine
generates a "Node Down" incident and sets the device status to Critical. For example,
when a WAN Edge Device is in the shadow of another problem (and, therefore, NNMi
would normally not generate an incident about that WAN edge router), NNMi generates a
"Node Down" incident because the router is listed in this Important Nodes group. 

This Node Group is empty by default. Consider populating this group with critical servers
that run important applications and critical WAN routers.

NNM iSPI for Performance. This group automatically becomes a filter for Performance
Reports (unless the group has no members). The NNMi administrator can change this
default behavior. See "In the Console, Create Node Groups" (on page 127).

Microsoft
Windows
Systems

This Node Group includes any device manufactured by Microsoft. The Node Group def-
inition is populated with one vendor entry. Any Microsoft devices within your man-
agement domain are automatically included in this Node Group.

Networking
Infrastructure
Devices

This Node Group is populated with a list of categories for network devices. Any devices
within your management domain that match these categories are automatically included
in this Node Group.

Devices in this group are automatically monitored for Component Health fault metrics.

NNM iSPI for Performance. This group automatically becomes a filter for Performance
Reports (unless the group has no members). The NNMi administrator can change this
default behavior. See "In the Console, Create Node Groups" (on page 127).

NNM iSPI NET. By default, NNMi automatically uses diagnostic flows to monitor devices
in this group.

Non-SNMP
Devices

This Node Group includes any device that does not respond to SNMP. The Node Group
definition is populated with one entry for a null MIB II sysObjectID value. Any device
within your management domain that fails to respond to SNMP queries is automatically
included in this Node Group.

Routers This Node Group is populated with a list of categories for network devices that represent
routers. Any router, switch-router, or gateway within your management domain is
included in this Node Group. See Node Capabilities Provided by NNMi for more infor-
mation.

This filter is used to create the Routers Node Group map that NNMi provides by default in
the Topology Maps workspace.

Devices in this group are automatically monitored for Component Health fault metrics

NNM iSPI for Performance. Devices in this group are automatically monitored for per-
formance, including Component Health performance metrics . This group automatically
becomes a filter for Performance Reports.

The NNMi administrator can change this default behavior. See "Set Default Monitoring"
(on page 154), "Configure Node Monitoring" (on page 168), and "In the Console, Create
Node Groups" (on page 127) for more information.

Switches This Node Group is populated with a list of categories for network devices that represent
switches. Any switch, ATM switch, or switch-router within your management domain is

Node Groups Provided by NNMi
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Name Purpose

included in this Node Group. See Node Capabilities Provided by NNMi for more infor-
mation.

This filter is used to create the Switches Node Group map that NNMi provides by default
in the Topology Maps workspace.

Related Topics

"Island Node Groups" (on page 149)

Island Node Groups

An Island Node Group is a group of fully-connected nodes that NNMi discovers and that are not connected
to the rest of the topology.

An example of an environment with multiple Island Node Groups is a financial institution or retail store with
many branches or stores. Each branch or store might be connected to other branches or stores with a
WAN (Wide Area Network) connection. Each branch or store appears as an isolated island of nodes in the
NNMi topology.

NNMi automatically updates Island Node Group discovery information whenever it detects changes in
Layer 2 connections. NNMi uses the Discovery Interval to determine when the updates actually occur.

Note the following about Island Node Groups:

l NNMi selects a representative node in each Island Node Group as the Source Node associated with
an Island Node Group incident. The representative node is selected using the following criteria:

n Sort all routers in the Node Group alphabetically by name and choose the first one in the list

n If no routers are in the Node Group, sort all nodes in the Node Group alphabetically by name and
choose the first one in the list.

l Island Node Groups are identified using "Island" in the Node Group Name. NNMi also assigns each
Island Node Group name a number to ensure the name is unique.

l Island Node Groups are manage internally. Therefore, NNMi administrators should not modify Island
Node Group configurations. NNMi overrides any user changes the next time NNMi updates the Island
Node Group discovery information.

l Island Node Groups must have at least two nodes.

l How the Status of Island Node Groups is calculated cannot be changed.

The only possible Status values for Island Node Groups are Unknown and Normal. Unknown indicates
that NNMi cannot reach any nodes in the group. Normal indicates that NNMi can reach at least one node
in the group. 

Related Topics

"Node Groups As Predefined View Filters" (on page 147)

Interface Groups Provided by NNMi

NNMi Provides the following Interface Groups as predefined view filters. These Interface Groups can also
be used for Monitoring Configuration if you find them useful.
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Feel free to populate these Interface Groups with specific information about your management domain and
change them to meet your needs.

Name Purpose

ISDN Inter-
faces

This Interface Group includes multiple interface types known to be commonly used for
ISDN purposes. Any interface within your management domain that meets the defined
criteria is automatically included in this Interface Group.

Link Aggre-
gation

NNMi Advanced. This Interface Group includes all of the Link Aggregation Aggregator
Interfaces discovered in the network. See Layer 2 Neighbor View Map Objects for more
information about Aggregator Interfaces.

Use Actions → Show Members to identify the Link Aggregation Aggregator Interfaces in
this group.

Point to
Point Inter-
faces

This Interface Group includes multiple interface types known to be commonly used for
point-to-point purposes. Any interface within your management domain that meets the
defined criteria is automatically included in this Interface Group.

Software
Loopback
Interfaces

This Interface Group includes any interface that is IfType 24, software loopback from the
IANA ifType-MIB. Any interface within your management domain that meets this loopback
address1 criteria is automatically included in this Interface Group.

VLAN Inter-
faces

This Interface Group includes interfaces of ifType l2vlan. The NNMi default Monitoring
Configuration settings enable fault monitoring for these interfaces, but disable per-
formance monitoring (because collection of performance data for VLAN interfaces tends to
be problematic).

Voice Inter-
faces

This Interface Group includes multiple interface types known to be commonly used for
voice purposes. Any interface within your management domain that meets the defined
criteria is automatically included in this Interface Group.

Interface Groups Provided by NNMi

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.

Page 150 of 422

../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm
../../../../nmConsoleHelp/Content/nmConsoleHelp/nmConVwsMap0610L2Map.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Monitoring Network Health

Monitoring Network Health

Note: If you are using NNMi Advanced, also see "Monitor Router Redundancy Groups (NNMi Advanced)"
(on page 181).

Before NNMi can monitor the health of your network, the following tasks must be completed:

l "Configuring Communication Protocol" (on page 47)

l "Discovering Your Network" (on page 76)

For the most flexibility, also complete these tasks:

l Review the "Interface Groups Provided by NNMi" (on page 149) and "Node Groups Provided by NNMi"
(on page 147).

l Create your own groups by "Creating Groups of Nodes or Interfaces" (on page 126).

The State Poller and the Causal Engine work together to automatically monitor the health of your network.

Many of the tasks you normally do to troubleshoot network problems are now automated. To learn more
about how this works, see the following topics: 

l "About the State Poller" (on page 151)

l "The NNMi Causal Engine and Monitoring" (on page 152)

You control which network devices NNMi monitors. By monitoring only the devices that are important
within your network environment, you keep the amount of traffic generated by NNM to a minimum. You can
configure NNMi to check devices with status other than critical less frequently (if at all) to prevent unim-
portant incidents from showing up in the Incident views.

To configure the polling policies that control how NNMi monitors devices in your network, see "Configure
Monitoring Behavior" (on page 152). You can configure NNMi monitoring behavior to meet your needs.

About the State Poller

The State Poller Service monitors each discovered interface, address, and SNMP agent that is designated
to be actively monitored in your management domain. State Poller can also be configured to provide Com-
ponent Health monitoring and Router Redundancy Group monitoring.

State Poller gathers information in the following area and updates the State field on each object's form:

l Verifies that each monitored IP Address is responding to ICMP ping.

l Verifies that each monitored SNMP Agent is responding to SNMP queries.

l Issues an SNMP query for the following:

n Each monitored interface, requesting the current value for MIB II ifAdminStatus and ifOperStatus.
(ifAdminStatus is set by the device administrator. ifOperStatus indicates the operational status of
interface health.)

n Router Redundancy Groups.

n Component Health data.

l By default, State Poller monitors interfaces connected to another known interface through a Layer 2
connection.

l You can extend monitoring to include the following:
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n Unconnected interfaces

n Interfaces that have an IP address (for example a router interface that services mobile laptop
machines)

n NNM iSPI for Performance. The State Poller also collects performance data and monitors thresholds.
See "Purchase an HP Smart Plug-in" (on page 319).

The State Poller stores the results of the queries in the NNMi database and notifies the Causal Engine of
any changes. The Causal Engine gathers additional information about the overall health of each interface
and SNMP agent. Using this information the Causal Engine calculates the Status of each node, interface,
and SNMP agent (see "The NNMi Causal Engine and Monitoring" (on page 152) for more information).

To configure the behavior of the State Poller, see "Configure Monitoring Behavior" (on page 152).

The NNMi Causal Engine and Monitoring

The Causal Engine actively gathers information about your network devices from incoming incidents and

traps. The Causal Engine also uses the data gathered by State Poller and by Discovery to calculate the cur-
rent health status of each node, interface, IP address, SNMP agent, and connection.

The health status is dynamic (based on what the environment looks like now).

The NNMi Causal Engine communicates device health information in the following ways:

l In the database, the Causal Engine stores a multitude of information about each device. You can
access this information in the Node, Interface, IP Address, SNMP Agent, and connection forms.

l On the maps, the color of the background shape for each map icon changes to the color that rep-
resents the most currently calculated health status, based on the Causal Engine calculations for that
node, interface, address, or connection (click here for information about status colors).

l On forms for Nodes, Interfaces, IP addresses, SNMP Agents, and connections, the Causal Engine

updates the Status attribute to show the current status: Normal, Warning, Minor, Major,

Critical, Unknown, or No Status.

l The Status column in table views is updated.

The Causal Engine also uses health status information to determine root cause. See "The NNMi Causal
Engine and Incidents" (on page 212) for more information about the Causal Engine, incidents, and root
cause analysis.

Configure Monitoring Behavior

Certain devices in your network are the most important ones. You and your team must keep those devices
up and running at all times. Adjust NNMi monitoring behavior to focus on the important devices and to
check devices with status other than critical less frequently (if at all).

Note: NNMi does not poll any private interface or Anycast Rendezvous Point IP Address1.

Based on your individual situation, adjust the NNMi behavior to meet your needs. NNMi applies your Mon-
itoring Configuration settings in the following sequence:

1Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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1. Interface Settings: NNMi monitors each of the Node's Interfaces and IP Addresses based on the first
matching Interface Settings definition. The first match is the Interface Settings definition with the low-
est Ordering number.

2. Node Setting: NNMi monitors each Node and each previously unmatched Interface or IP Address
based on the first matching Node Settings definition. The first match is the Node Settings definition
with the lowest Ordering number.

Note: Child node groups are included in the Ordering hierarchy. This means that if the parent node
group has a lower Ordering number (for example, parent=10, child=20), then the monitoring
configuration specified for the parent node group also applies to the nodes in the child node
group. To override a parent node group monitoring configuration, set the Ordering number for
the child node group to a number that is lower than the parent (for example, parent=20,
child=10).

3. Default Settings: If no match is found for a Node, Interface, or IP Address in 1 or 2, NNMi applies the
default Monitoring Configuration settings.

Task How

"Set Global Monitoring" (on page 153). Optional. Use the Global Control group.

"Set Default Monitoring" (on page 154)
.

Use the Default Settings tab to establish monitoring behavior for
any devices that are discovered, but not included in any Node
Settings or Interface Settings definitions.

"Configure Node Monitoring" (on page
168)

Optional. Use the Node Settings tab. Configure settings based
on Node Groups to customize the way NNMi monitors certain
groups of devices in your environment.

Prerequisite: "Create Node Groups" (on page 126).

Fine tune behavior for specific types of
Interfaces,see "Configure Interface
Monitoring" (on page 158) .                     

Optional. Use the Interface Settings tab. Configure settings
based on Interface Groups to customize the way NNMi monitors
certain interface types in your environment.

Prerequisite: "Create Interface Groups" (on page 139).

Tasks for Configuring the Monitoring Behavior

Set Global Monitoring

Note: To suspend all SNMP traffic generated by NNMi, rather than only the State Poller Service SNMP
 traffic, see "Communication Region Form" (on page 57) and "Specific Node Settings Form (Com-
munication Settings)" (on page 67).

To temporarily turn off all NNMi monitoring activity without tampering with your customized mon-
itoring configuration settings:

1. Navigate to the Monitoring Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Monitoring Configuration.

2. Locate the Global Control group box.

3. Clear the  check box preceding each setting that you want to enable or disable (see table).
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4. Click Save and Close. NNMi applies your changes. The next regularly scheduled monitoring
cycle uses the new settings.

Name Description

Enable State
Polling

If  enabled, State Poller monitors all managed interfaces, IP addresses, and SNMP
agents by issuing ICMP pings and SNMP read-only queries for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus indicates the
overall health of the device and is supplied by the SNMP Agent.) You can also configure
NNMi so that State Poller gathers additional information about Component Health and
Router Redundancy Groups.

If  disabled:

l Previously discovered devices remain with the last calculated state/status.

l Newly discovered devices are set to "No Status" with map-symbol background shape
color set to beige.

Enable Com-
ponent
Health Mon-
itoring

If  enabled, State Poller monitors Component Health metrics for all managed nodes.
See Node Form: Component Health Tab for more information about Component Health
metrics. 

Note: Component Health monitoring is enabled by default.

If  disabled:

l Previously discovered devices are assigned a State of Not Polled and a Status of No
Status for Component Health metrics. 

l Component Health metrics for newly discovered devices are assigned a State of Not
Polled and a Status of No Status.

Enable
Router
Redundancy
Group Mon-
itoring
(NNMi
Advanced)

If  enabled, NNMi monitors all managed Router Redundancy Groups. See Router
Redundancy Group View (NNMi Advanced) for more information about Router Redun-
dancy Groups.

Note: Router Redundancy Group monitoring is enabled by default.

If  disabled:

l Previously discovered Router Redundancy Groups are assigned a State of Not
Polled and a Status of No Status.

l Newly discovered Router Redundancy Groups are assigned a State of Not Polled
and a Status of No Status.

Global Control

Set Default Monitoring

The choices you make for "defaults" apply only to devices whose interfaces, IP addresses, SNMP agents
(Management Addresses), tracked objects, router redundancy groups, or component health monitoring set-
tings are not covered by any Interface Settings or Node Settings definitions.

To establish default NNMi monitoring behavior:

1. Navigate to the Defaults Settings tab.

a. From the workspace navigation panel, select the Configuration workspace.
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b. Select Monitoring Configuration.

c. Locate the Defaults Settings tab.

2. Locate the Default Fault Monitoring group box.

3. Configure the Default Fault Monitoring behavior (see Default Fault Monitoring table).

4. NNM iSPI for Performance. If the NNM iSPI for Performance is installed, locate the Default Per-
formance Monitoring group box.

Configure the Default Performance Monitoring behavior (see Default Performance Monitoring table).

5. By default, NNMi monitors only interfaces that are connected to other interfaces. When SNMP polling
is enabled, NNMi automatically detects most connections. See "Add or Delete a Layer 2 Connection"
(on page 124) for information about manual overrides.

Optional. If you want to expand default monitoring behavior to include unconnected Interfaces, indi-
cate your choices in the extend the scope of polling beyond connected Interfaces group box (see
Default Extend the Scope of Polling Beyond Connected Interfaces table).

6. Optional. To establish custom monitoring behavior for one or more groups of interfaces, configure
Interface Settings, see "Configure Interface Monitoring" (on page 158).

7. Optional. To establish custom monitoring behavior for one or more groups of nodes, configure Node
Settings, see "Configure Node Monitoring" (on page 168).

8. Click Save and Close. NNMi applies your changes. The next regularly scheduled monitoring
cycle uses the new settings.

Attribute Description

Enable ICMP Fault Poll-
ing

Note: This monitoring
option is useful for
devices that do not sup-
port SNMP. By default,
this feature is enabled
for the "Non-SNMP
 Devices" Node Group.

If  enabled, State Poller issues ICMP (ping) requests to verify the availability
of each managed IP address. Note: In the Global Control section of this form,
the Enable State Polling attribute must be enabled, too.

If  disabled, State Poller suspends ICMP polling of all IP addresses:

l IP addresses (both previously discovered and newly discovered) have a
State attribute value of "Not Polled" and a Status attribute value of "No
Status" with the color of the IP address map-symbol set to beige. See Layer
3 Neighbor View.

l If both ICMP and SNMP are disabled for a Node, the Node has a Status
attribute value of "No Status" and the color of the Node map-symbol back-
ground shape is set to beige.

Tip: To turn off ICMP polling within a subset of your network environment, use
the Communication Configuration workspace Region definitions. For exam-
ple, you can easily turn off ICMP communication to all private addresses
(use the Private IP Addresses region). You can also define your own
Regions that identify any unreachable addresses in your management
domain.

Enable SNMP Fault
Polling

If  enabled, State Poller monitors all interfaces by issuing SNMP read-only
queries to devices assigned to this level of the monitoring hierarchy.

By default, any connected interface is monitored for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus
indicates the operational status of interface health.) If you have unconnected

Default Fault Monitoring
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Attribute Description

interfaces that you want to monitor, expand NNMi monitoring behavior with the
Poll Unconnected Interfaces and the Poll Interfaces Hosting IP Addresses attrib-
utes.

Note: The following attributes must also be enabled:

l In the Global Control section of this form, the Enable State Polling attribute
must be enabled, too. See Layer 2 Neighbor View. (See "Set Global Mon-
itoring" (on page 153) for more information.)

l In the Communication Configuration view, enable State Poller queries with
the applicable Enable SNMP Communication attributes (see "Configuring
Communication Protocol" (on page 47) for more information).

If  disabled, for devices assigned to this level of the monitoring hierarchy:

l Causal Engine calculates Status based only on IP address State.

l The following previously discovered objects change to a State attribute
value of "Not Polled" and a Status attribute value of "No Status":

n Interfaces (plus any related map-symbol changes to a beige color)

n Router Redundancy Groups (plus any related map-symbol changes to
a beige color)

n Any fault-related items listed on the Node form, Component Health tab

Enable Component
Health Fault Polling

Note: By default, this
feature is enabled for
the "Routers" and "Net-
working Infrastructure
Devices" Node Groups.

Use this attribute to poll Component Health fault metrics. Component Health
fault metrics include the following: Fan, Power Supply, Temperature, and Volt-
age.

Note: Component Health Fault Polling is disabled by default.

If  enabled, NNMi gathers fault data related to the Component Health fault
metrics in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include Com-
ponent Health fault data about devices assigned to this level of the monitoring
hierarchy.

Note: NNMi uses the same polling interval set for the Fault Polling Interval.

Fault Polling Interval The time that State Poller waits between issuing queries to gather information
for any of the following that are enabled: ICMP Polling, SNMP Polling, Poll
Unconnected Interfaces, and Poll Interfaces Hosting IP addresses.

Note: NNMi monitors SNMP agents (Management Addresses) according to
this Fault Polling Interval, even if ICMP Polling, SNMP Polling, Poll
Unconnected Interfaces, and Poll Interfaces Hosting IP addresses are
all disabled. To prevent an SNMP Agent's address from being mon-
itored, one of the following must be true: State Polling is disabled, cur-
rent Communication Configuration settings turn off SNMP for the SNMP
 agent's address, or the parent Node is set to Not Managed or Out of
Service.
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Attribute Description

Enable SNMP
Interface Per-
formance Polling

NNM iSPI for Performance. Use this attribute to extend the range of polling data that
NNMi collects. NNM iSPI for Performance uses the additional data in a series of per-
formance reports. See "Purchase an HP Smart Plug-in" (on page 319) for more infor-
mation. When enabled, network traffic increases on your network because NNMi
gathers performance data about each member of this group on a regular schedule.

If  enabled, NNMi gathers performance data from Interfaces, CPU, memory, and
buffers in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include per-
formance data about devices assigned to this level of the monitoring hierarchy.

Note: The Enable State Polling field must be enabled, too. By default the per-
formance of connected interfaces and addresses is monitored. If you have
unconnected interfaces that you want to monitor, expand NNMi monitoring
behavior by enabling Poll Unconnected Interfaces.

Enable Com-
ponent Health Per-
formance Polling

Note: NNM iSPI
for Performance.
By default, this fea-
ture is enabled for
the "Routers"
Node Group.

NNM iSPI for Performance. Use this attribute to poll Component Health per-
formance. An NNMi administrator can set the threshold for node components
related to the following performance metrics:  CPU utilization, memory utilization,
buffer utilization, buffer miss rate, and buffer failure rate.

Note: Component Health Performance Polling is disabled by default.

If  enabled, NNMi gathers performance data related to the Component Health per-
formance metrics in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include Com-
ponent Health performance data about devices assigned to this level of the mon-
itoring hierarchy.

Note: NNMi uses the same polling interval set for the Performance Polling Interval. 

Performance Poll-
ing Interval

If you purchase and install the NNM iSPI for Performance, use this field to set the
time period that NNMi waits between issuing network traffic to gather performance
data.

NNM iSPI for Performance. Default Performance Monitoring

Attribute Description

Poll Unconnected
Interfaces

If  enabled, NNMi monitors all interfaces within discovered devices (both con-
nected and unconnected). All interfaces are monitored for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus indi-
cates the operational status of interface health.) Note: The Enable State Polling
field must be enabled, and SNMP polling of some type must be enabled (for exam-
ple, Enable SNMP Fault Monitoring and Enable SNMP Performance Polling).

If  disabled, State Poller polls according to other configuration settings.

Tip: Your discovery configuration choices may need to be adjusted to get the
results you want. For example, to meet the “connected” criteria for interfaces in
switches that do not have an IP address you must add the device to which the
interface is connected as a discovery seed. See"Discovery Seeds (as a starting
point)" (on page 82).

Default Extend the Scope of Polling Beyond Connected Interfaces
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Attribute Description

Poll Interfaces Host-
ing IP Addresses

Note: This mon-
itoring option is use-
ful for Router
interfaces. By
default, this feature
is enabled for the
"Routers" Node
Group.

If  enabled, any unconnected interface that has one or more addresses asso-
ciated with it is monitored for MIB II ifAdminStatus and ifOperStatus. (ifAdminStatus
is set by the device administrator. ifOperStatus indicates the operational status of
interface health.) Note: The Enable State Polling field must be enabled, and
SNMP polling of some type must be enabled (for example, Enable SNMP Fault
Monitoring and Enable SNMP Performance Polling).

By monitoring the Interface (in addition to the IP address), NNMi can make more
informed decisions about the health of each IP address associated with an uncon-
nected interface.

If  disabled, State Poller polls according to other configuration settings.

Tip: The Communication Configuration workspace provides a method of over-
riding this setting for specific Regions. For this purpose, NNMi provides a prede-
fined Region definition of all possible private addresses (Private IP Addresses).
You can also define your own Region to easily turn off ICMP polling to any
unreachable addresses in your management domain.

Configure Interface Monitoring

Before you start, you must establish one or more Interface Group definitions that identify the interface types
to which these monitoring settings will apply. NNMi provides nearly 250 interface types to choose from.
Interface monitoring applies to matching interfaces and the IP addresses that are hosted on those inter-
faces. See also, "Interface Groups Provided by NNMi" (on page 149).

To establish monitoring behavior for one or more predefined Interface Groups:

1. Navigate to the Interface Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Monitoring Configuration.

c. Locate the Interface Settings tab.

d. Do one of the following:

o To create an Interface Settings definition, click the New icon.

o To edit an Interface Settings definition, select a row, click the Open icon.

o To delete an Interface Settings definition, select a row and click the Delete button

2. Establish the appropriate settings to identify this Interface Setting definition (see Basics table).

3. Optional. Configure the Fault Monitoring behavior for this Interface Setting definition (see Fault Mon-
itoring table).

4. NNM iSPI for Performance. If the NNM iSPI for Performance is installed:

n Configure the Performance Monitoring behavior for this Interface Setting definition (see Per-
formance Monitoring table).

n Optional. Navigate to the Threshold Settings tab to configure the NNM iSPI for Performance. See
"Configure Threshold Monitoring for Interfaces (NNM iSPI for Performance)" (on page 162) for
more information.

5. By default, NNMi monitors only interfaces that are connected to other interfaces. When SNMP polling
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is enabled, NNMi automatically detects most connections. See "Add or Delete a Layer 2 Connection"
(on page 124) for information about manual overrides.

Optional. If you want to expand monitoring behavior for this group to include unconnected Interfaces,
indicate your choices in the extend the scope of polling beyond connected Interfaces group box (see
the Extend the Scope of Polling Beyond Connected Interfaces table).

6. Click Save and Close to return to the Monitoring Configuration form.

7. Click Save and Close. NNMi applies your changes. The next regularly scheduled monitoring
cycle uses the new settings.

Caution: When you establish monitoring configuration settings, NNMi must recalculate membership
in all Node Groups and Interface Groups. This can take some time and slow down your sys-
tem. Consider making this change during a slow time in your network environment.

Optional. Customize the node monitoring behavior. See "Configure Node Monitoring" (on page 168) .

Attribute Description

Ordering Enter a unique string (any length), characters 0 through 9. Consider using increments of 100
to allow for inserts between existing items over time.

NNMi decides which monitoring configurations apply to a node or interface based on the
ordering number assigned to the configuration definitions. NNMi monitors the device accord-
ing to the first match (checked from lowest number to highest number within each category).
Categories are read in sequence. Click here for a description of the sequence.

1. Interface Settings: NNMi monitors each of the Node's Interfaces and IP Addresses
based on the first matching Interface Settings definition. The first match is the Interface
Settings definition with the lowest Ordering number.

2. Node Setting: NNMi monitors each Node and each previously unmatched Interface or
IP Address based on the first matching Node Settings definition. The first match is the
Node Settings definition with the lowest Ordering number.

Note: Child node groups are included in the Ordering hierarchy. This means that if the
parent node group has a lower Ordering number (for example, parent=10,
child=20), then the monitoring configuration specified for the parent node group
also applies to the nodes in the child node group. To override a parent node
group monitoring configuration, set the Ordering number for the child node group
to a number that is lower than the parent (for example, parent=20, child=10).

3. Default Settings: If no match is found for a Node, Interface, or IP Address in 1 or 2,
NNMi applies the default Monitoring Configuration settings.

No duplicate Ordering numbers are allowed. Each Interface Setting ordering number must be
unique.

Interface
Group

Choose one predefined Interface Group from the list. See "Create Interface Groups" (on page
139) for more information.

Basics
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Attribute Description

Enable
ICMP Fault
Polling

Note: This
monitoring
option is use-
ful for
devices that
do not sup-
port SNMP.

If  enabled, State Poller issues ICMP (ping) requests to verify the availability of each
managed IP address. Note: In the Global Control section of this form, the Enable State
Polling attribute must be enabled, too.

If  disabled, State Poller suspends ICMP polling of all IP addresses:

l IP addresses (both previously discovered and newly discovered) have a State attrib-
ute value of "Not Polled" and a Status attribute value of "No Status" with the color of
the IP address map-symbol set to beige. See Layer 3 Neighbor View.

l If both ICMP and SNMP are disabled for a Node, the Node has a Status attribute value
of "No Status" and the color of the Node map-symbol background shape is set to
beige.

Tip: To turn off ICMP polling within a subset of your network environment, use the Com-
munication Configuration workspace Region definitions. For example, you can easily
turn off ICMP communication to all private addresses (use the Private IP Addresses
region). You can also define your own Regions that identify any unreachable
addresses in your management domain.

Enable
SNMP Fault
Polling

If  enabled, State Poller monitors all interfaces by issuing SNMP read-only queries to
devices assigned to this level of the monitoring hierarchy.

By default, any connected interface is monitored for MIB II ifAdminStatus and ifOperStatus.
(ifAdminStatus is set by the device administrator. ifOperStatus indicates the operational
status of interface health.) If you have unconnected interfaces that you want to monitor,
expand NNMi monitoring behavior with the Poll Unconnected Interfaces and the Poll Inter-
faces Hosting IP Addresses attributes.

Note: The following attributes must also be enabled:

l In the Global Control section of this form, the Enable State Polling attribute must be
enabled, too. See Layer 2 Neighbor View. (See "Set Global Monitoring" (on page 153)
for more information.)

l In the Communication Configuration view, enable State Poller queries with the appli-
cable Enable SNMP Communication attributes (see "Configuring Communication Pro-
tocol" (on page 47) for more information).

If  disabled, for devices assigned to this level of the monitoring hierarchy:

l Causal Engine calculates Status based only on IP address State.

l The following previously discovered objects change to a State attribute value of "Not
Polled" and a Status attribute value of "No Status":

n Interfaces (plus any related map-symbol changes to a beige color)

n Router Redundancy Groups (plus any related map-symbol changes to a beige
color)

n Any fault-related items listed on the Node form, Component Health tab

Fault Polling
Interval

The time that State Poller waits between issuing queries to gather information for any of
the following that are enabled: ICMP Polling, SNMP Polling, Poll Unconnected Interfaces,
and Poll Interfaces Hosting IP addresses.

Note: NNMi monitors SNMP agents (Management Addresses) according to this Fault Poll-
ing Interval, even if ICMP Polling, SNMP Polling, Poll Unconnected Interfaces, and

Fault Monitoring
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Attribute Description

Poll Interfaces Hosting IP addresses are all disabled. To prevent an SNMP Agent's
address from being monitored, one of the following must be true: State Polling is
disabled, current Communication Configuration settings turn off SNMP for the
SNMP agent's address, or the parent Node is set to Not Managed or Out of Service.

Attribute Description

Enable
SNMP Inter-
face Per-
formance
Polling

NNM iSPI for Performance. Use this attribute to extend the range of polling data that
NNMi collects. NNM iSPI for Performance uses the additional data in a series of per-
formance reports. See "Purchase an HP Smart Plug-in" (on page 319) for more infor-
mation. When enabled, network traffic increases on your network because NNMi gathers
performance data about each member of this group on a regular schedule.

If  enabled, NNMi gathers performance data from Interfaces, CPU, memory, and buffers
in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include performance
data about devices assigned to this level of the monitoring hierarchy.

Note: The Enable State Polling field must be enabled, too. By default the performance of
connected interfaces and addresses is monitored. If you have unconnected inter-
faces that you want to monitor, expand NNMi monitoring behavior by enabling Poll
Unconnected Interfaces.

Performance
Polling Inter-
val

If you purchase and install the NNM iSPI for Performance, use this field to set the time
period that NNMi waits between issuing network traffic to gather performance data.

NNM iSPI for Performance. Performance Monitoring

Attribute Description

Poll Uncon-
nected Inter-
faces

If  enabled, NNMi monitors all interfaces within discovered devices (both connected
and unconnected). All interfaces are monitored for MIB II ifAdminStatus and ifOperStatus.
(ifAdminStatus is set by the device administrator. ifOperStatus indicates the operational
status of interface health.) Note: The Enable State Polling field must be enabled, and
SNMP polling of some type must be enabled (for example, Enable SNMP Fault Mon-
itoring and Enable SNMP Performance Polling).

If  disabled, State Poller polls according to other configuration settings.

Tip: Your discovery configuration choices may need to be adjusted to get the results you
want. For example, to meet the “connected” criteria for interfaces in switches that do
not have an IP address you must add the device to which the interface is connected
as a discovery seed. See"Discovery Seeds (as a starting point)" (on page 82).

Extend the Scope of Polling Beyond Connected Interfaces
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Attribute Description

Poll Inter-
faces Host-
ing IP
Addresses

Note: This
monitoring
option is use-
ful for Router
interfaces.

If  enabled, any unconnected interface that has one or more addresses associated with
it is monitored for MIB II ifAdminStatus and ifOperStatus. (ifAdminStatus is set by the
device administrator. ifOperStatus indicates the operational status of interface health.)
Note: The Enable State Polling field must be enabled, and SNMP polling of some type
must be enabled (for example, Enable SNMP Fault Monitoring and Enable SNMP Per-
formance Polling).

By monitoring the Interface (in addition to the IP address), NNMi can make more
informed decisions about the health of each IP address associated with an unconnected
interface.

If  disabled, State Poller polls according to other configuration settings.

Tip: The Communication Configuration workspace provides a method of overriding this
setting for specific Regions. For this purpose, NNMi provides a predefined Region def-
inition of all possible private addresses (Private IP Addresses). You can also define
your own Region to easily turn off ICMP polling to any unreachable addresses in your
management domain.

Configure Threshold Monitoring for Interfaces (NNM iSPI for Performance)

Use the Threshold Settings form to configure NNMi and the NNM iSPI for Performance to monitor thresh-
olds in your network environment. (See "Purchase an HP Smart Plug-in" (on page 319) for more infor-
mation about the NNM iSPI for Performance.) If you set thresholds, NNMi can generate an Incident when
any threshold is violated. Examples of the types of threshold you can set for an interface include the fol-
lowing: (See Monitored Attributes in the table below for a complete list.)

l Input and output utilization

l Input and output error rates

l Input and output discard rates

NNM iSPI for Performance provides exceptions reports to track the frequency of threshold breaches. You
can open these reports with Actions → Reporting - Report Menu in the incident, node, or interface views
and forms. (See NNM iSPI for Performance Actions.)

To establish threshold monitoring behavior for the NNM iSPI for Performance:

1. Prerequisite. After enabling Performance Monitoring for an Interface Group and before setting thresh-
olds, analyze performance data over time to determine wise threshold settings for each group. See
"Determine Reasonable Threshold Settings (NNM iSPI for Performance)" (on page 175).

Note: When performance polling is enabled, network traffic increases on your network while NNMi
gathers performance data.

2. Navigate to the Thresholds Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Monitoring Configuration.

c. Navigate to the Interface Settings tab.

d. Do one of the following:

o To create an Interface Settings definition, click the New icon.

o To edit an Interface Settings definition, select a row, click the Open icon.
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3. Verify that Performance Monitoring is enabled for this Interface Settings definition.

4. In the Interface Settings form, navigate to the Threshold Settings tab.

5. Do one of the following:

n To create a threshold definition, click the New icon.

n To edit a threshold definition, select a row, click the Open icon.

n To delete a threshold definition, select a row and click the  Delete icon.

6. Select the attribute you want to monitor and establish the threshold values for that attribute (see Basic
Threshold Settings table). For examples of setting meaningful thresholds, see "Examples of Thresh-
old Monitoring (NNM iSPI for Performance)" (on page 175).

7. Click Save and Close to return to the Interface Settings form.

8. Click Save and Close to return to the Monitoring Configuration form.

9. Click Save and Close. NNMi applies your changes during the next regularly scheduled mon-
itoring cycle.

Note: Threshold Incidents are disabled by default within NNMi to prevent Incident storms. If you are ready
to generate Threshold Incidents, see "Generate Performance Threshold Incidents (NNM iSPI for Per-
formance)" (on page 298). See also "Custom Incident Attributes Provided by NNMi" (on page 214)
for a description of the special custom incident attributes available in Threshold Incidents.

Attribute Description

Monitored
Attribute

NNMi gathers data to calculate thresholds for the following values. Click any item in this list
for more details about that value.

Note: NNMi also displays the Monitored Attributes that apply to nodes. See "Configure
Threshold Monitoring for Nodes (NNM iSPI for Performance)" (on page 172) for more
information about these attributes.

l Input Utilization
The total number of incoming octets traversing the interface as a percentage of the total
possible number of octets (based on the ifSpeed value). From Interface to Interface, the
exact MIB variables queried vary based on interface speed and whether the system sup-
ports the high speed counters for interfaces.

Each interface in an Interface Groups has its utilization calculated by taking the total traf-
fic on all administratively up interfaces in the group and dividing that by the total pos-
sible bandwidth.

Tip: To override the ifSpeed value returned by the device's SNMP agent, see the Inter-
face form. 

l Output Utilization
The total number of outbound octets traversing the interface as a percentage of the total
possible number of octets (based on the ifSpeed value). From Interface to Interface, the
exact MIB variables queried vary based on interface speed and whether the system sup-
ports the high speed counters for interfaces.

Each interface in an Interface Group has its utilization calculated by taking the total traf-
fic on all administratively up interfaces in the group and dividing that by the total pos-

Basic Threshold Settings
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Attribute Description

sible bandwidth.

Tip: To override the ifSpeed value returned by the device's SNMP agent, see the Inter-
face form.

l Input Error Rate
Percentage based on the reported change in the number of input packets on the inter-
face and the packet error count. What constitutes an error is system specific, but likely
includes such issues as bad packet checksums, incorrect header information, and runt
packets.

l Output Error Rate
Percentage based on the reported change in the number of incoming packets with
errors as a percentage of total incoming packets. What constitutes an error is system
specific, but likely includes such issues as collisions and buffer errors.

l Input Discard Rate
Percentage based on the reported change in the number of input packets on the inter-
face and the discarded packet count. Packets may be discarded because of a variety of
issues, including receive buffer overflows, congestion, or system specific issues.

l Output Discard Rate
Percentage based on the reported change in the number of output packets on the inter-
face and the discarded packet count. Packets may be discarded because of a variety of
issues, including transmission buffer overflows, congestion, or system specific issues.

High
Value

Designate the percentage above which would indicate a value in the High range. Valid
entries are 0.00 through 100.00

Note: If you use 100.00 the threshold is disabled because it cannot be crossed.

High
Value
Rearm

Designate the percentage that when reached would indicate the end of a high threshold sit-
uation. Valid entries are 0.00 through 100.00

Note: The High Value Rearm must be less than or equal to the High Value and greater than
the Low Value Rearm.

High
Trigger
Count

Designate the number of consecutive polling cycles in which the value must remain in the
High range before the threshold state changes to High.

Note: The interface performance values are the average value over the entire polling inter-
val, so a trigger count of 1 is usually appropriate.

Low
Value

The Low Value must be less than or equal to the High Value.

Designate the percentage below which would indicate a value in the low range. Valid
entries are 0.00 through 100.00

Note: If you use 0.00 the threshold is disabled because it cannot be crossed.

Low
Value
Rearm

Designate the percentage that when reached would indicate the end of a low threshold sit-
uation. Valid entries are 0.00 through 100.00.

Note: The Low Value Rearm must be greater than or equal to the Low Value and less than
the High Rearm Value.

Low
Trigger
Count

Designate the number of consecutive polling cycles in which the value must remain in the
Low range before the threshold state changes to Low.
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Attribute Description

Note: The interface performance values are the average value over the entire polling inter-
val, so a trigger count of 1 is usually appropriate.

Determine Reasonable Threshold Settings (NNM iSPI for Performance)

You must decide how to define normal behavior for devices in the associated Node Group or Interface
Group. You can then set reasonable thresholds for the group, and avoid Threshold Incident storms. See
"Examples of Threshold Monitoring (NNM iSPI for Performance)" (on page 175).

Create a Node Group or Interface Group filter that includes the devices you want to monitor. Export the
Node Group or Interface Group filter to NNM iSPI for Performance. See "Creating Groups of Nodes or Inter-
faces" (on page 126).

Enable Performance Monitoring for the Node Group or Interface Group. See "Configure Node Monitoring"
(on page 168) or "Configure Interface Monitoring" (on page 158). Then wait a minimum of 24 hours before
following the steps below.

Access the NNM iSPI for Performance Headline report:

1. In the NNMi console, click Actions → Reporting - Report Menu.

2. Click the link for Headline. The Headline report displays data up until 12 p.m.last night.

3. Click Show Options.

4. Expand the All Nodes/Interfaces selection.

5. Choose the Node Group or Interface Group filter for which you are setting thresholds.

6. Expand All Dates/Times. Select a time period (a day, week, or month).

7. Click Confirm Selections.

8. The report for the Node Group or Interface Group you selected appears.

9. Study the Range & Exceptions graphs to guide your decision about what constitutes reasonable
threshold settings. See online help for this report for information about how to read this report.

Examples of Threshold Monitoring (NNM iSPI for Performance)

You can configure interface threshold monitoring if the NNM iSPI for Performance is installed. See "Pur-
chase an HP Smart Plug-in" (on page 319) for more information.

Several examples are presented These examples are not intended to be recommendations. Consider all
aspects of your network environment and set performance thresholds that are meaningful in your envi-
ronment:

l Thresholds to Monitor Utilization on WAN Connections

l Thresholds to Monitor Utilization on Important Interfaces

l Thresholds to Monitor Important Interfaces for Discards

l Thresholds to Monitor Important Interfaces for Errors

Example 1: Monitor Utilization on WAN Connections

You want to monitor the connections between two sites to verify that your service provider is meeting their
guaranteed throughput volume. You pay a fixed cost for a specific bandwidth over this WAN interface.

Page 165 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Monitoring Network Health

l Monitor for under-utilization which wastes money (less than 10%).

Tip: If you don't care about under-utilization, set Low Value and Rearm to 0% as shown in Example 2.

l Monitor for over-utilization, which may result in performance bottlenecks or service provider surcharges
(greater than 80%). 

Note: Sometimes an Interface's MIB II ifspeed value is not reported accurately. This may result in threshold
calculations outside the 0.00 - 100.00 range. If this happens, the Interface threshold State set to "Unavail-
able." To correct the problem:

1. Access the Inventory workspace

2. Open Interface view.

3. Open the form for the Interface that is reporting a threshold state of "Unavailable."

4. Navigate to the General tab.

5. Enter a valid entry in Input Speed or Output Speed (this overrides the value returned by the device's
SNMP agent so that NNMi can accurately calculate utilization thresholds).

Example 2: Monitor Utilization on Important Interfaces

You want to monitor an important Ethernet interface and be notified if it is getting overloaded.

An Ethernet interface configured for full-duplex operation has an acceptable operating range of 0-60%. 
When average utilization is greater than 60%, NNM generates a High Threshold incident. 
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Example 3: Monitor Important Interfaces for Discards

You want to know anytime an interface is dropping data. The acceptable limit for interface discards is 10%.
The threshold state is High when the discard rate exceeds 10% and returns to Nominal when the discard
rate drops below 5%.

Example 4: Monitor Important Interfaces for Errors

You want to know if packet errors occur. The acceptable limit for packet errors is 2%.The threshold state is
High Level (HL) when the error rate exceeds 2% and returns to normal when the error rate drops below
1%.
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Configure Node Monitoring

Before you start, you must establish one or more Node Group definitions that identify the nodes to which
these monitoring settings will apply. See also, "Node Groups Provided by NNMi" (on page 147).

To establish monitoring behavior for a predefined Node Group:

1. Navigate to the Node Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Monitoring Configuration.

c. Locate the Node Settings tab.

d. Do one of the following:

o To create a Node Settings definition, click the New icon.

o To edit a Node Settings definition, select a row, click the Open icon.

2. Establish the appropriate settings to identify this Node Setting definition (see Basics table).

3. Optional. Configure the Fault Monitoring behavior for this Node Setting definition (see Fault Mon-
itoring table).

4. NNM iSPI for Performance. If the NNM iSPI for Performance is installed:

n Configure the Performance Monitoring behavior for this Node Setting definition (see Performance
Monitoring table).

n Optional. Navigate to the Threshold Settings tab to configure the NNM iSPI for Performance. See
"Configure Threshold Monitoring for Nodes (NNM iSPI for Performance)" (on page 172) for more
information.

5. By default, NNMi monitors only interfaces that are connected to other interfaces. When SNMP polling
is enabled, NNMi automatically detects most connections. See "Add or Delete a Layer 2 Connection"
(on page 124) for information about manual overrides.
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Optional. If you want to expand monitoring behavior for this group to include unconnected Interfaces,
indicate your choices in the extend the scope of polling beyond connected Interfaces group box (see
the Extend the Scope of Polling Beyond Connected Interfaces table).

6. Click Save and Close. NNMi applies your changes. The next regularly scheduled monitoring
cycle uses the new settings.

Caution: When you establish monitoring configuration settings, NNMi must recalculate membership
in all Node Groups and Interface Groups. This can take some time and slow down your sys-
tem. Consider making this change during a slow time in your network environment.

Optional. Customize the interface monitoring behavior. See "Configure Interface Monitoring" (on page 158)
.

Attribute Description

Ordering Enter a unique string (any length), characters 0 through 9. Consider using increments of 100
to allow for inserts between existing items over time.

NNMi decides which monitoring configurations apply to a node or interface based on the
ordering number assigned to the configuration definitions. NNMi monitors the device accord-
ing to the first match (checked from lowest number to highest number within each category).
Categories are read in sequence. Click here for a description of the sequence.

1. Interface Settings: NNMi monitors each of the Node's Interfaces and IP Addresses
based on the first matching Interface Settings definition. The first match is the Interface
Settings definition with the lowest Ordering number.

2. Node Setting: NNMi monitors each Node and each previously unmatched Interface or
IP Address based on the first matching Node Settings definition. The first match is the
Node Settings definition with the lowest Ordering number.

Note: Child node groups are included in the Ordering hierarchy. This means that if the
parent node group has a lower Ordering number (for example, parent=10,
child=20), then the monitoring configuration specified for the parent node group
also applies to the nodes in the child node group. To override a parent node
group monitoring configuration, set the Ordering number for the child node group
to a number that is lower than the parent (for example, parent=20, child=10).

3. Default Settings: If no match is found for a Node, Interface, or IP Address in 1 or 2,
NNMi applies the default Monitoring Configuration settings.

No duplicate Ordering numbers are allowed. Each Node Setting ordering number must be
unique.

Node
Group

Choose one predefined Node Group from the list. See "Create Node Groups" (on page 126)
for more information.

Basics
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Attribute Description

Enable ICMP Fault Poll-
ing

Note: This monitoring
option is useful for
devices that do not sup-
port SNMP. By default,
this feature is enabled
for the "Non-SNMP
 Devices" Node Group.

If  enabled, State Poller issues ICMP (ping) requests to verify the availability
of each managed IP address. Note: In the Global Control section of this form,
the Enable State Polling attribute must be enabled, too.

If  disabled, State Poller suspends ICMP polling of all IP addresses:

l IP addresses (both previously discovered and newly discovered) have a
State attribute value of "Not Polled" and a Status attribute value of "No
Status" with the color of the IP address map-symbol set to beige. See Layer
3 Neighbor View.

l If both ICMP and SNMP are disabled for a Node, the Node has a Status
attribute value of "No Status" and the color of the Node map-symbol back-
ground shape is set to beige.

Tip: To turn off ICMP polling within a subset of your network environment, use
the Communication Configuration workspace Region definitions. For exam-
ple, you can easily turn off ICMP communication to all private addresses
(use the Private IP Addresses region). You can also define your own
Regions that identify any unreachable addresses in your management
domain.

Enable SNMP Fault
Polling

If  enabled, State Poller monitors all interfaces by issuing SNMP read-only
queries to devices assigned to this level of the monitoring hierarchy.

By default, any connected interface is monitored for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus
indicates the operational status of interface health.) If you have unconnected
interfaces that you want to monitor, expand NNMi monitoring behavior with the
Poll Unconnected Interfaces and the Poll Interfaces Hosting IP Addresses attrib-
utes.

Note: The following attributes must also be enabled:

l In the Global Control section of this form, the Enable State Polling attribute
must be enabled, too. See Layer 2 Neighbor View. (See "Set Global Mon-
itoring" (on page 153) for more information.)

l In the Communication Configuration view, enable State Poller queries with
the applicable Enable SNMP Communication attributes (see "Configuring
Communication Protocol" (on page 47) for more information).

If  disabled, for devices assigned to this level of the monitoring hierarchy:

l Causal Engine calculates Status based only on IP address State.

l The following previously discovered objects change to a State attribute
value of "Not Polled" and a Status attribute value of "No Status":

n Interfaces (plus any related map-symbol changes to a beige color)

n Router Redundancy Groups (plus any related map-symbol changes to
a beige color)

n Any fault-related items listed on the Node form, Component Health tab

Fault Monitoring
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Attribute Description

Enable Component
Health Fault Polling

Note: By default, this
feature is enabled for
the "Routers" and "Net-
working Infrastructure
Devices" Node Groups.

Use this attribute to poll Component Health fault metrics. Component Health
fault metrics include the following: Fan, Power Supply, Temperature, and Volt-
age.

Note: Component Health Fault Polling is disabled by default.

If  enabled, NNMi gathers fault data related to the Component Health fault
metrics in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include Com-
ponent Health fault data about devices assigned to this level of the monitoring
hierarchy.

Note: NNMi uses the same polling interval set for the Fault Polling Interval.

Fault Polling Interval The time that State Poller waits between issuing queries to gather information
for any of the following that are enabled: ICMP Polling, SNMP Polling, Poll
Unconnected Interfaces, and Poll Interfaces Hosting IP addresses.

Note: NNMi monitors SNMP agents (Management Addresses) according to
this Fault Polling Interval, even if ICMP Polling, SNMP Polling, Poll
Unconnected Interfaces, and Poll Interfaces Hosting IP addresses are
all disabled. To prevent an SNMP Agent's address from being mon-
itored, one of the following must be true: State Polling is disabled, cur-
rent Communication Configuration settings turn off SNMP for the SNMP
 agent's address, or the parent Node is set to Not Managed or Out of
Service.

Attribute Description

Enable SNMP
Interface Per-
formance Polling

NNM iSPI for Performance. Use this attribute to extend the range of polling data that
NNMi collects. NNM iSPI for Performance uses the additional data in a series of per-
formance reports. See "Purchase an HP Smart Plug-in" (on page 319) for more infor-
mation. When enabled, network traffic increases on your network because NNMi
gathers performance data about each member of this group on a regular schedule.

If  enabled, NNMi gathers performance data from Interfaces, CPU, memory, and
buffers in devices assigned to this level of the monitoring hierarchy.

If  disabled, NNMi does not extend data collection behavior to include per-
formance data about devices assigned to this level of the monitoring hierarchy.

Note: The Enable State Polling field must be enabled, too. By default the per-
formance of connected interfaces and addresses is monitored. If you have
unconnected interfaces that you want to monitor, expand NNMi monitoring
behavior by enabling Poll Unconnected Interfaces.

Enable Com-
ponent Health Per-
formance Polling

NNM iSPI for Performance. Use this attribute to poll Component Health per-
formance. An NNMi administrator can set the threshold for node components
related to the following performance metrics:  CPU utilization, memory utilization,
buffer utilization, buffer miss rate, and buffer failure rate.

Note: Component Health Performance Polling is disabled by default.

If  enabled, NNMi gathers performance data related to the Component Health per-
formance metrics in devices assigned to this level of the monitoring hierarchy.

NNM iSPI for Performance. Performance Monitoring
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Attribute Description

Note: NNM iSPI
for Performance.
By default, this fea-
ture is enabled for
the "Routers"
Node Group.

If  disabled, NNMi does not extend data collection behavior to include Com-
ponent Health performance data about devices assigned to this level of the mon-
itoring hierarchy.

Note: NNMi uses the same polling interval set for the Performance Polling Interval. 

Performance Poll-
ing Interval

If you purchase and install the NNM iSPI for Performance, use this field to set the
time period that NNMi waits between issuing network traffic to gather performance
data.

Attribute Description

Poll Unconnected
Interfaces

If  enabled, NNMi monitors all interfaces within discovered devices (both con-
nected and unconnected). All interfaces are monitored for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus indi-
cates the operational status of interface health.) Note: The Enable State Polling
field must be enabled, and SNMP polling of some type must be enabled (for exam-
ple, Enable SNMP Fault Monitoring and Enable SNMP Performance Polling).

If  disabled, State Poller polls according to other configuration settings.

Tip: Your discovery configuration choices may need to be adjusted to get the
results you want. For example, to meet the “connected” criteria for interfaces in
switches that do not have an IP address you must add the device to which the
interface is connected as a discovery seed. See"Discovery Seeds (as a starting
point)" (on page 82).

Poll Interfaces Host-
ing IP Addresses

Note: This mon-
itoring option is use-
ful for Router
interfaces. By
default, this feature
is enabled for the
"Routers" Node
Group.

If  enabled, any unconnected interface that has one or more addresses asso-
ciated with it is monitored for MIB II ifAdminStatus and ifOperStatus. (ifAdminStatus
is set by the device administrator. ifOperStatus indicates the operational status of
interface health.) Note: The Enable State Polling field must be enabled, and
SNMP polling of some type must be enabled (for example, Enable SNMP Fault
Monitoring and Enable SNMP Performance Polling).

By monitoring the Interface (in addition to the IP address), NNMi can make more
informed decisions about the health of each IP address associated with an uncon-
nected interface.

If  disabled, State Poller polls according to other configuration settings.

Tip: The Communication Configuration workspace provides a method of over-
riding this setting for specific Regions. For this purpose, NNMi provides a prede-
fined Region definition of all possible private addresses (Private IP Addresses).
You can also define your own Region to easily turn off ICMP polling to any
unreachable addresses in your management domain.

Extend the Scope of Polling Beyond Connected Interfaces

Configure Threshold Monitoring for Nodes (NNM iSPI for Performance)

The Threshold Settings form is used only to configure threshold monitoring when NNM iSPI for Per-
formance is installed. See "Purchase an HP Smart Plug-in" (on page 319) for more information. If you set
thresholds, NNMi generates an Incident when any threshold is violated. Examples of the types of threshold
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you can set for a node include the following: (See Monitored Attributes in the table below for a complete
list.)

l CPU 5 second utilization

l CPU 1 minute utilization

l CPU 5 minute utilization 

l Memory utilization

l Buffer utilization

l Buffer miss rate

l Buffer failure rate

The NNM iSPI for Performance provides exceptions reports to track frequency. When NNMi iSPI for Per-
formance is configured to monitor your network, network traffic increases while NNMi gathers performance
data.

To establish threshold monitoring behavior for the NNM iSPI for Performance:

1. After enabling Performance Monitoring for a Node Group and before setting thresholds, analyze per-
formance data over time to determine wise threshold settings for each group. See "Determine Rea-
sonable Threshold Settings (NNM iSPI for Performance)" (on page 175).

2. Navigate to the Thresholds Settings form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Monitoring Configuration.

c. Navigate to the Node Settings tab.

d. Do one of the following:

o To create a Node Settings definition, click the New icon.

o To edit a Node Settings definition, select a row, click the Open icon.

3. Prerequisite. Verify that Performance Monitoring is enabled for this Node Settings definition.

4. In the Node Settings form, navigate to the Threshold Settings tab.

5. Do one of the following:

n To create a threshold definition, click the New icon.

n To edit a threshold definition, select a row, click the Open icon.

n To delete a threshold definition, select a row and click the  Delete icon.

6. Select the attribute you want to monitor and establish the threshold values for that attribute (see Basic
Threshold Settings table). For examples of setting meaningful thresholds, see "Examples of Thresh-
old Monitoring (NNM iSPI for Performance)" (on page 175).

7. Click Save and Close to return to the Node Settings form.

8. Click Save and Close to return to the Monitoring Configuration form.

9. Click Save and Close. NNMi applies your changes during the next regularly scheduled mon-
itoring cycle.
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Note: Threshold Incidents are disabled by default within NNMi to prevent Incident storms. If you are ready
to generate Threshold Incidents, see "Generate Performance Threshold Incidents (NNM iSPI for Per-
formance)" (on page 298). And to learn about your incident configuration choices, see "Custom Inci-
dent Attributes Provided by NNMi" (on page 214) for a description of the special custom incident
attributes available in Threshold Incidents.

Attribute Description

Monitored
Attribute

NNMi gathers data to calculate thresholds for the following values. Click any item in this list
for more details about that value.

Note: NNMi also displays the Monitored Attributes that apply to interfaces. See "Configure
Threshold Monitoring for Interfaces (NNM iSPI for Performance)" (on page 162) for
more information about these attributes

l CPU 5Sec Utilization
Percentage of CPU usage in relation to the total amount of CPU available. This per-
centage is measure at 5-second intervals.

l CPU 1Min Utilization
Percentage of CPU usage in relation to the total amount of CPU available. This per-
centage is measured at 1-minute intervals.

l CPU 5Min Utilization
Percentage of CPU usage in relation to the total amount of CPU available. This per-
centage is measured at 5-minute intervals.

l Memory Utilization
Percentage of memory usage in relation to the total amount of memory available.

l Buffer Utilization
Percentage of buffer usage in relation to the total amount of buffer space available.

l Buffer Miss Rate
Counter indicating that the number of available buffers in the pool has dropped below
the minimum level.

l Buffer Failure Rate
Percentage value based on the number of buffer failures caused by insufficient memory
when trying to create additional buffers.

High
Value

Designate the percentage above which would indicate a value in the High range. Valid
entries are 0.00 through 100.00

Note: If you use 100.00 the threshold is disabled because it cannot be crossed.

High
Value
Rearm

Designate the percentage that when reached would indicate the end of a high threshold sit-
uation. Valid entries are 0.00 through 100.00

Note: The High Value Rearm must be less than or equal to the High Value and greater than
the Low Value Rearm.

High
Trigger
Count

Designate the number of consecutive polling cycles in which the value must remain in the
High range before the threshold state changes to High.

Low
Value

The Low Value must be less than or equal to the High Value.

Designate the percentage below which would indicate a value in the low range. Valid
entries are 0.00 through 100.00

Basic Threshold Settings
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Attribute Description

Note: If you use 0.00 the threshold is disabled because it cannot be crossed.

Low
Value
Rearm

Designate the percentage that when reached would indicate the end of a low threshold sit-
uation. Valid entries are 0.00 through 100.00.

Note: The Low Value Rearm must be greater than or equal to the Low Value and less than
the High Rearm Value.

Low
Trigger
Count

Designate the number of consecutive polling cycles in which the value must remain in the
Low range before the threshold state changes to Low.

Determine Reasonable Threshold Settings (NNM iSPI for Performance)

You must decide how to define normal behavior for devices in the associated Node Group or Interface
Group. You can then set reasonable thresholds for the group, and avoid Threshold Incident storms. See
"Examples of Threshold Monitoring (NNM iSPI for Performance)" (on page 175).

Create a Node Group or Interface Group filter that includes the devices you want to monitor. Export the
Node Group or Interface Group filter to NNM iSPI for Performance. See "Creating Groups of Nodes or Inter-
faces" (on page 126).

Enable Performance Monitoring for the Node Group or Interface Group. See "Configure Node Monitoring"
(on page 168) or "Configure Interface Monitoring" (on page 158). Then wait a minimum of 24 hours before
following the steps below.

Access the NNM iSPI for Performance Headline report:

1. In the NNMi console, click Actions → Reporting - Report Menu.

2. Click the link for Headline. The Headline report displays data up until 12 p.m.last night.

3. Click Show Options.

4. Expand the All Nodes/Interfaces selection.

5. Choose the Node Group or Interface Group filter for which you are setting thresholds.

6. Expand All Dates/Times. Select a time period (a day, week, or month).

7. Click Confirm Selections.

8. The report for the Node Group or Interface Group you selected appears.

9. Study the Range & Exceptions graphs to guide your decision about what constitutes reasonable
threshold settings. See online help for this report for information about how to read this report.

Examples of Threshold Monitoring (NNM iSPI for Performance)

You can configure interface threshold monitoring if the NNM iSPI for Performance is installed. See "Pur-

chase an HP Smart Plug-in" (on page 319) for more information.

Several examples are presented These examples are not intended to be recommendations. Consider all
aspects of your network environment and set performance thresholds that are meaningful in your envi-
ronment:

l Thresholds to Monitor Utilization on WAN Connections

l Thresholds to Monitor Utilization on Important Interfaces
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l Thresholds to Monitor Important Interfaces for Discards

l Thresholds to Monitor Important Interfaces for Errors

Example 1: Monitor Utilization on WAN Connections

You want to monitor the connections between two sites to verify that your service provider is meeting their
guaranteed throughput volume. You pay a fixed cost for a specific bandwidth over this WAN interface.

l Monitor for under-utilization which wastes money (less than 10%).

Tip: If you don't care about under-utilization, set Low Value and Rearm to 0% as shown in Example 2.

l Monitor for over-utilization, which may result in performance bottlenecks or service provider surcharges
(greater than 80%). 

Note: Sometimes an Interface's MIB II ifspeed value is not reported accurately. This may result in threshold
calculations outside the 0.00 - 100.00 range. If this happens, the Interface threshold State set to "Unavail-
able." To correct the problem:

1. Access the Inventory workspace

2. Open Interface view.

3. Open the form for the Interface that is reporting a threshold state of "Unavailable."

4. Navigate to the General tab.

5. Enter a valid entry in Input Speed or Output Speed (this overrides the value returned by the device's
SNMP agent so that NNMi can accurately calculate utilization thresholds).

Example 2: Monitor Utilization on Important Interfaces

You want to monitor an important Ethernet interface and be notified if it is getting overloaded.

An Ethernet interface configured for full-duplex operation has an acceptable operating range of 0-60%. 
When average utilization is greater than 60%, NNM generates a High Threshold incident. 
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Example 3: Monitor Important Interfaces for Discards

You want to know anytime an interface is dropping data. The acceptable limit for interface discards is 10%.
The threshold state is High when the discard rate exceeds 10% and returns to Nominal when the discard
rate drops below 5%.

Example 4: Monitor Important Interfaces for Errors

You want to know if packet errors occur. The acceptable limit for packet errors is 2%.The threshold state is
High Level (HL) when the error rate exceeds 2% and returns to normal when the error rate drops below
1%.
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Configure Node Group Status

NNMi enables an NNMi administrator to configure the Node Group status calculations using either of the
following methods:

l Assign the Node Group the most severe status of any Node Group member. This is the default method
for obtaining Node Group Status.

l Configure the percentage thresholds for one or more Node Group target statuses. For example, when
defining percentage values for a target status of Critical, you might change the default so that 30 per-
cent of the nodes in the group must have a status other than Normal, for the Node Group Status to be
Critical.

To configure Node Group status calculations, do the following:

1. Navigate to the Status Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Status Configuration.

2. Make one of the following configuration choices:

n To assign the Node Group the most severe Status of any Node Group member, in the Status Con-
figuration form, under Global Control, make sure Propagate Most Severe Status is checked:  

Propagate Most Severe Status

n

To configure percentage values for a Node Group Target Status, do the following:

n In the Status Configuration form, under Global Control, make sure the Propagate Most
Severe Status is cleared:

Propagate Most Severe Status

n Configure the percentage values for a Node Group Target Status

3. Click Save and Close.

NNMi applies your changes after the configuration is saved.
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Configure Percentage Values for the Target Status

NNMi enables you to configure how the status of a Node Group is calculated.

Note: The percentage value that is calculated for a Node Group includes only those nodes whose Man-
agement Mode is Managed. For example, if a Node Group includes 10 nodes and 3 of the nodes
are Not Managed, 5 of the nodes have a Status of Normal, and 2 have a status of Critical, the per-
centage of Critical nodes is 2/7 * 100.

To configure the percentage values for a Node Group Target Status:

1. Navigate to the Status Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Status Configuration.

2. Locate the Node Group Status Settings tab.

3. Do one of the following:

n To create a Node Group Status Settings definition, click the New icon.

n To edit a Node Group Status Settings definition, select a row, click the Open icon.

n To delete a Node Group Settings definition, select a row and click the Delete button

4. Establish the appropriate settings to identify this Node Group Status Settings definition. (See the
"Node Group Status Settings Form" (on page 179) form)

Note: You can only define one configuration for each Target Status.

Node Group Status Settings Form

The Node Group Status Settings form is used to configure the percentage thresholds for a Node Group Tar-
get Status. The percentage thresholds you specify define what percentage of nodes within the group must
have a particular Status. When the percentage thresholds are reached, the Node Group is assigned the
associated Target Status. For example, when defining percentage thresholds for a target status of Critical,
you might change the default so that 10 percent of the nodes in the group must have a status of Critical for
the Node Group Status to be Critical.

Note: Use a percentage threshold between 0 (zero) and 1 (for example, .01) to indicate the Target Status
to be reached when one node in the Node Group reaches a specified Status. For example, if you
want the Node Group Status to be set to Critical when the Status of one node in the Group becomes
Critical, enter a percentage less than one for the Critical % value.

To define percentage thresholds for a Target Status:

1. Navigate to the Node Group Status Settings form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Status Configuration. 

c. Navigate to the Node Group Status Settings tab. 

d. Do one of the following:

o To create a Node Group Status Settings definition, click the New icon. 

o To edit a Node Group Settings definition, select a row, click the Open icon.
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o To delete a Node Group Settings definition, select a row and click the  Delete icon.   

2. Set the Target Status and percentages you want (see Basic Attributes table).

3. Click Save and Close to return to the Status Configuration form. 

4. Click Save and Close. NNMi applies your changes after the configuration is saved.

Attribute Description

Target
Status

The Status you are configuring. This Status is assigned to the Node Group whenever the
specified percentage thresholds are reached.

Note the following:

l Whether all or one of the percentage thresholds must be reached for a Target Status con-
figuration depends on the Boolean operator you select. The default Boolean operator is
OR. (Also see Combine with AND below.)

l If you do not specify any percentages for a Target Status, it does not appear as a Status
for a Node Group.

Critical % Specifies the percentage threshold for the nodes within the group whose Status must be Crit-
ical for the Node Group to be assigned the Target Status.

Major % Specifies the percentage threshold for the nodes within the group whose Status must be
Major for the Node Group to be assigned the Target Status.

Minor % Specifies the percentage threshold for nodes within the group whose Status must be Minor
for the Node Group to be assigned the Target Status.

Warning
%

Specifies the percentage threshold for nodes within the group whose Status must be Warn-
ing for the Node Group to be assigned the Target Status.

Non-Nor-
mal %

Specifies the percentage threshold for nodes within the group whose Status must be any of
the following for the Node Group to be assigned the Target Status:

l Critical

l Major

l Minor

l Warning 

Unknown
%

Specifies the percentage threshold for nodes within the group whose Status must be
 Unknown for the Node Group to be assigned the Target Status.

Combine
with AND

Specifies that you want NNMi to combine the percentage thresholds you enter using the
AND Boolean operator.

When using this option, note the following:

l All percentage thresholds you enter must be reached for the Node Group to be assigned
the Target Status.

l The percentage thresholds you enter must not exceed 100 percent.

Basics Attributes
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Monitor Router Redundancy Groups (NNMi Advanced)

NNMi monitors state and priority information for any discovered HSRP and VRRP objects in the network.
These objects include Router Redundancy Members and Tracked Objects. See Router Redundancy
Group View for more information about Router Redundancy Groups and the HSRP or VRRP objects asso-
ciated with them.

The polling interval used is the Fault Polling Interval that is set for the node associated with the Router
Redundancy Member or Tracked Object.

If you do not want these objects polled:

l Set the Management Mode for each node to Unmanaged or Out of Service. See "Stop or Start Man-
aging a Node, Interface, or Address" (on page 184) for more information about Management Mode.

l Disable all Router Redundancy Group monitoring. See "Set Global Monitoring" (on page 153).

NNMi Advanced also uses these HSRP and VRRP objects when calculating a Path View between two

nodes that have IPv4 addresses. See Path View with NNMi Advanced for more information.

Current Health of the State Poller Service

At any time, you can check the current health statistics about the State Poller Service by using the Help →
About HP Network Node Manager i-series menu item.

The State Poller Service contributes towards discovery and ongoing monitoring. See "About Each NNMi
Service" (on page 26).

Verify Monitoring Configuration Settings

After you configure the monitoring settings, you can check the configuration for a particular object to verify
that everything is working correctly. Examples of objects on which you can verify monitoring configuration
settings include Nodes, Interfaces, IP addresses, Router Redundancy Groups, Tracked Objects, and Node
Components. Use the Actions → Monitoring Settings menu item to display a report.

To verify the monitoring configuration for a Node, Interface, or IP address:

1. Navigate to the view for that object (for example, Inventory → Nodes).

2. Select the object of interest by selecting the check box that precedes the object information.

3. Select Actions → Monitoring Settings.

Note: This menu item also is available on any object's form.

To verify the monitoring configuration for a Router Redundancy Member:

1. Navigate to a Router Redundancy Group view (for example, Inventory → Router Redundancy
Groups).

2. Click the Open icon that precedes the Router Redundancy Group of interest.

3. From the Router Redundancy Members tab, click the Open icon that precedes the Router Redun-
dancy Group Member of interest.

4. Select Actions → Monitoring Settings.
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To verify the monitoring configuration for a Tracked Object:

1. Navigate to a Router Redundancy view (for example, Inventory → Router Redundancy Groups).

2. Click the Open icon that precedes the Router Redundancy Group of interest.

3. From the Router Redundancy Members tab, click the Open icon that precedes the Router Redun-
dancy Group Member of interest.

4. From the Tracked Objects tab, click the Open icon that precedes the Tracked Object of interest.

5. Select Actions → Monitoring Settings.

To verify the monitoring configuration for a Node Component:

1. Navigate to the view for that object (for example, Inventory → Nodes).

2. Click the Open icon that precedes the Node of interest.

3. Select the Component Health tab.

4. Select the Node Component of interest by selecting the check box that precedes the object infor-
mation.

5. Select Actions → Monitoring Settings.

Check status and connectivity of important interfaces.

1. Open a Layer 2 Neighbor View map of each important interface's parent device. See Viewing Maps
(Network Connectivity).

2. Each connected interface has a little square symbol around the edge of the parent device's map sym-
bol. For example:

3. Hover your mouse over the square to verify the identify of your important interface on the map.

4. Verify that the status color of each important interface is not  Unknown or  Unmanaged (see About
Status Colors). For example:

5. By default, NNMi only monitors the health of connected interfaces. A line appears on the map
between interfaces when they are connected. For example:

6. If you need to add a connection, see "Add or Delete a Layer 2 Connection" (on page 124).
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Check status and connectivity of important addresses.

1. Open a Layer 3 Neighbor View map of each important parent device. See Viewing Maps (Network
Connectivity).

2. Each address that is connected to another address in the same subnet has a little hexagon symbol
around the edge of the parent device's map symbol. For example:

3. Hover your mouse over the hexagon to verify the identify of your important address on the map.

4. NNMi monitors the health of addresses only if you enable ICMP Address Monitoring. A line appears
on the map between addresses when they are connected. The line represents the subnet. For exam-
ple:

5. If ICMP Address Monitoring is enabled, verify that the status color of each important address is not
 Unknown or  Unmanaged (see About Status Colors). For example:

6. If you need to add a connection, see "Add or Delete a Layer 2 Connection" (on page 124).

See "Configure Monitoring Behavior" (on page 152) for information about establishing monitoring behav-
ior.
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Stop or Start Managing a Node, Interface, or Address

NNMi administrators can specify that a node, interface, or address should no longer be managed or is out
of service. To indicate that you want to stop or start managing a node, interface, or address, you use the
management mode values.

Reasons you might want to change the management mode include:

l The node is temporarily out of service.

l You have determined that a node, interface, or address should never be managed.

NNMi provides two management modes as described in the following table:

Name Description

Management
Mode

For node, this value is set by the user and is used to help determine the Management
Mode value for any associated interface or address.

For interfaces and addresses, this value is calculated. The Management Mode for an
interface is a computed value based on the Management Mode for the node. The Man-
agement Mode value for an address is a calculated value based on the Management
Mode for any associated interface. Otherwise, the Management Mode is determined by
node on which the address resides. Possible values include:

Managed - Used to indicate a node, interface, or address should be managed by NNMi.

Not Managed - Used to indicate that you do not plan to manage the node, interface, or
address. For example, the object might not be accessible because it is in a private net-
work. NNMi does not discover or monitor these objects.

Out of Service - Used to indicate a node, interface, or address is unavailable because it
is out of service. NNMi does not discover or monitor these objects.

Direct Man-
agement
Mode

For interfaces and addresses, this field is set by the user and is used to compute the inter-
face and address Management Mode values. Possible values include:

Inherited - For interfaces, this value is used to indicate that the interface should inherit
the Management Mode from the node on which it resides. For addresses, this value is
used to indicate that the Management Mode should be inherited from the associated inter-
face, if one exists. Otherwise the Management Mode is inherited from the node on which
it resides.

Not Managed - Used to indicate that you do not plan to manage the interface or address.
For example, the object might not be accessible because it is in a private network. NNMi
 does not discover or monitor these objects.

Out of Service - Used to indicate the interface or address is unavailable because it is out
of service. Reasons might include the interface being repaired or a known problem with
the address.   NNMi does not discover or monitor these objects.

Management Modes

Note: You cannot set the Management Mode on an interface or an address, because the value is cal-
culated.

You can change the Management Mode in one of the following ways:

l Change the value of the Management Mode or Direct Management Mode field on the form.
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Note: If you are updating the Direct Management Mode for an interface or address, NNMi also updates its
Management Mode value after you reopen or refresh the form.

l Use an action from a view or form.

l Use the nnmmanagementmode.ovpl command.

See Access Node Details for more information about setting the Management Mode for a node. See Inter-
face Form for more information about setting the Direct Management Mode for an interface. See IP
Address Form for more information about setting the Direct Management Mode for an address.

"Perform Automated Tasks" (on page 21) for more information about setting the Management Mode or
Direct Management Mode using actions.

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)for information about the results of the Management Mode value on these objects.

View the Management Mode for an Object in Your Network

NNMi provides the Management Mode workspace so that you can quickly view the management mode for
nodes, interfaces, or addresses in your network. The management mode is calculated using the Man-
agement Mode and Direct Management Mode values. NNMi administrators can set the Direct Man-
agement Mode. NNMi calculates the current Management Mode based on the combined settings of all the
associated objects. For example:

l Node — NNMi administrators can set the Management Mode value, or NNMi can calculate it.

l Interface — The Direct Management Mode (if any) NNMi administrators set for the interface or cal-
culated from the current Management Mode of the associated node and address.

l Address — The Direct Management Mode (if any) NNMi administrators set for the address or cal-
culated from the current Management Mode of the associated node and interface.

The following table describes each possible Management Mode and Direct Management Mode value. As
 shown in the table, the available Management Mode values depend on the object type (node, interface, or
address).

Object Value Description

Node Managed Used to indicate that the node should be managed by NNMi. This means it will be
discovered and monitored.

Node Not Man-
aged

Used to indicate you do not plan to manage the node. For example, the node might
not be accessible because it is in a private network. NNMi does not discover or mon-
itor these objects.

Node Out of
Service

Used to indicate the node is unavailable because it is out of service. Reasons might
include that the device is being repaired or there is a known problem with the
device. NNMi does not discover or monitor these objects.

Management Mode Values

Object Value Description

Interface
or
Address

Not Man-
aged

Used to indicate you do not plan to manage the interface or address. After the
interface or address Direct Management Mode is set to Not Managed, NNMi does
no longer discovers or monitors the interface or address.

Direct Management Mode Values
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Object Value Description

Interface
or
Address

Out of
Service

Used to indicate that the interface or address is out of service. NNMi does not dis-
cover or monitor these objects.

An interface will not be managed again until the Direct Management Mode is set
to Inherited and its associated node is set to Managed.

 An address will not be managed again until the Management Mode of any asso-
ciated interface is set to Inherited and the node's Management Mode is set to Man-
aged.

Interface Inherited Used to indicate that the interface should assume the Management Mode of the
node on which it is hosted.

Note: To manage the interface, the Management Mode of the node on which the
interface is hosted must be Managed.

Address Inherited The address assumes the Management Mode of the interface, if any, with which
the address is associated.

If the address is not associated with an interface, it assumes the Management
Mode of the node on which it is hosted.

Note: To manage the address, the Management Mode of the address' interface, if
any, must be calculated to be Managed. The Management Mode of the
node on which the interface and address are hosted must be set to Man-
aged.

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193) for more information about the effects of using the Not Managed setting.

See the Related Topics list below for information about the views available for checking the Management
Mode values for nodes, interfaces, or addresses.

Related Topics:

"Using the (Management Mode) Nodes View" (on page 187)

"Using the Managed Interfaces View" (on page 188)

"Using the (Management Mode) IP Addresses View" (on page 187)

"Using the Not Managed Nodes View" (on page 189)

"Using the Not Managed Interfaces View" (on page 190)

"Using the Not Managed Addresses View" (on page 190)

"Using the Out of Service Nodes View" (on page 190)

"Using the Out of Service Interfaces View" (on page 191)

"Using the Out of Service Addresses View" (on page 191)

Nodes View (Inventory)

Interfaces View (Inventory)

IP Addresses View (Inventory)
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Using the (Management Mode) Nodes View

The Nodes view in the Management Mode workspace identifies the management mode of all of the nodes
that are stored in the NNMi database. Sort this view by Management Mode to see which set of nodes are
managed, temporarily out of service, and not being managed.

Note: By default, the Node view is sorted by node Name values.

Use this view to select nodes whose management mode should change from their current value.

For each node, you can identify its overall status ( for example, Normal, Warning, Minor, Major, Critical
and Unknown), name, management mode, device profile, the system description, and any notes included
for the node.

See "Using the Nodes View" for more information about uses for nodes views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the (Management Mode) Interfaces View

The Interfaces view in the Management Mode workspace identifies the management mode of all of the
interfaces that are stored in the NNMi database. This view also shows the management mode of the node
associated with an interface so that you can determine how NNMi arrived at the Management Mode value
for the interface.

Sort this view by Direct Management Mode to see which interfaces are managed, temporarily out of serv-
ice, and not being managed.

Note: Check the management mode set for the associated node (Node Management Mode) to determine
the actual management mode of the interface. For example, if the Direct Management Mode for the
interface is Inherited and the management mode of the node is Out of Service, the management
mode for the interface is Out of Service. "Understand the Effects of Setting the Management Mode
to Not Managed or Out of Service " (on page 193) for information about how the management mode
is calculated for interfaces.

Use this view to select interfaces whose management mode should change from their current value.

For each interface, you can identify the interface's overall status (for example, Normal, Warning, Minor,
Major, Critical, and Unknown), associated node Name value (Hosted on Node), the interface name, the
direct management mode (set by the administrator), the management mode of its associated node, admin-
istrative and operational status, type, alias, speed, the date the interface information was last changed, its
description, and any notes included for the interface.

See "Using the (Inventory) Interfaces View" for more information about uses for the interfaces views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

Using the (Management Mode) IP Addresses View

The IP Addresses view in the Management Mode workspace identifies the management mode of all of the
addresses that are stored in the NNMi database. This view also displays the management mode of the
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interface, if any, and the node associated with each address so that you can determine how NNMi arrived
at the Management Mode value for the address.

Note: By default, this view is sorted by the IP address values.

Sort this view by Direct Management Mode to see which set of addresses are managed, temporarily out of
service, and not being managed.

Note: Check the management mode set for any associated interface (Interface Management Mode) and
for the node (Node Management Mode) to determine the address management mode. For exam-
ple, if the management mode for the interface is Inherited and the management mode of the node is
Out of Service, the management mode for the address is Out of Service. "Understand the Effects of
Setting the Management Mode to Not Managed or Out of Service " (on page 193) for information
about how the management mode for addresses is calculated.

Use this view to select addresses whose management mode should change from their current value.

For each IP address, you can identify its state, IP address, its direct management mode (set by the admin-
istrator), management mode of any associated interface (calculated by NNMi), management mode of the
node on which the address resides, associated node Name value (Hosted on Node), interface name, sub-

net, and any notes included for the IP address.

See IP Addresses View (Inventory) for more information about uses for addresses views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Managed Nodes View

The Managed Nodes view identifies all of the discovered nodes that NNMi currently manages.

Use this view to select nodes whose management mode should change to Not Managed or Out of Serv-
ice.

For each node, you can identify its overall status ( for example, Normal, Warning, Minor, Major, Critical
and Unknown), its device category (for example, switch), name, system name, system location (the current
value of the sysLocation MIB variable), date indicating the last time the node status was modified, the
device profile, and any notes included for the node.

Note: Because this view contains only nodes whose Management Mode is set to Managed, the Man-
agement Mode column is not included.

See "Using the Nodes View" for more information about uses for nodes views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Managed Interfaces View

The Managed Interfaces view identifies all of the discovered interfaces NNM currently manages.

Use this view to select interfaces whose management mode should change to Not Managed or Out of
Service.
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For each interface, you can identify the interface's overall status (for example, Normal, Warning, Minor,
Major, Critical, and Unknown), associated node Name value (Hosted on Node), the interface name, admin-
istrative and operational status, type, alias, speed, the date the interface information was last changed, its
description, and any notes included for the interface.

Note: Because this view contains only interfaces whose Management Mode is set to Managed, the Man-
agement Mode column is not included.

See "Using the (Inventory) Interfaces View" for more information about uses for the interfaces views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the IP Managed Addresses View

The Managed IP Addresses view identifies all of the addresses NNM currently manages.

Use this view to select addresses whose management mode should change to Not Managed or Out of
Service.

For each IP address, you can identify its state, associated Interface, associated node Name value (Hosted
on Node), subnet (In Subnet) and prefix length (PL), and any notes included for the IP address.

Note: Because this view contains only addresses whose Management Mode is set to Managed, the Man-
agement Mode column is not included.

See IP Addresses View (Inventory) for more information about uses for address views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Not Managed Nodes View

The Not Managed Nodes view identifies all of the nodes whose management mode is Not Managed.
These are the nodes that are no longer being discovered or monitored.

Use this view to select nodes whose management mode should change to Managed or Out of Service.

For each node, you can identify its overall status ( for example, Normal, Warning, Minor, Major, Critical
and Unknown), name, system name, system location (the current value of the sysLocation MIB variable),
contact name, date indicating the last time the node status was modified, device profile, a device category
(for example, switch), the system description, and any notes included for the node.

Note: Because this view contains only nodes whose Management Mode is set to Not Managed, the Man-
agement Mode column is not included.

See "Using the Nodes View" for more information about uses for nodes views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)
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"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Not Managed Interfaces View

The Not Managed Interfaces view identifies all of the interfaces whose management mode is Not Man-
aged. These are the interfaces that are no longer being discovered or monitored.

Use this view to select interfaces whose management mode should change to Managed or Out of Service
.

For each interface, you can identify the interface's overall status (for example, Normal, Warning, Minor,
Major, Critical, and Unknown), associated node Name value (Hosted on Node), the interface name,
administrative and operational status, type, alias, speed, the date the interface information was last
changed, its description, and any notes included for the interface.

Note: Because this view contains only interfaces whose Management Mode is set to Not Managed, the

Management Mode column is not included.

See "Using the (Inventory) Interfaces View" for more information about uses for the interfaces views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Not Managed Addresses View

The Not Managed Addresses view identifies all of the addresses whose management mode is Not Man-
aged. These are the nodes that are no longer being discovered or monitored.

Use this view to select addresses whose management mode should change to Managed or Out of Serv-
ice.

For each IP address, you can identify its state, associated Interface, associated node Name value (Hosted
on Node), subnet (In Subnet) and prefix length (PL), and any notes included for the IP address.

Note: Because this view contains only addresses whose Management Mode is set to Managed, the Man-
agement Mode column is not included.

Note: Because this view contains only addresses whose Management Mode is set to No Managed, the
Management Mode column is not included.

See IP Addresses View (Inventory) for more information about uses for address views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)
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Using the Out of Service Nodes View

The Out of Service Nodes view identifies all of the nodes whose management mode is Out of Service.
These are the nodes that are no longer being discovered and monitored.

Use this view to select nodes whose management mode should change to Managed or Not Managed.

For each node, you can identify its overall status ( for example, Normal, Warning, Minor, Major, Critical
and Unknown), name, system name, system location (the current value of the sysLocation MIB variable),
contact name, date indicating the last time the node status was modified, device profile, a device category
(for example, switch), the system description, and any notes included for the node.

Note: Because this view contains only nodes whose Management Mode is set to Out of Service, the Man-
agement Mode column is not included.

See "Using the Nodes View" for more information about uses for nodes views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Out of Service Interfaces View

The Out of Service Interfaces view identifies all of the interfaces whose management mode is Out of Serv-
ice. These are the interfaces that are no longer being discovered and monitored.

You can also use this view to select nodes whose management mode should change to Managed or Not
Managed

For each interface displayed in the view, you can identify the interface's overall status (for example, Nor-
mal, Warning, Minor, Major, Critical, and Unknown), associated node Name value (Hosted on Node), the
interface name, administrative and operational status, type, alias, speed, the date the interface information
was last changed, description, and any notes included for the interface.

Note: Because this view contains only interfaces whose Management Mode is set to Out of Service, the
Management Mode column is not included.

See "Using the Interface View" for more information about uses for interface views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

Using the Out of Service Addresses View

The Out of Service IP Addresses view identifies all of the addresses whose management mode is Out of
Service. These are the addresses that are no longer being discovered and monitored.

You can also use this view to select addresses whose management mode should change to Managed or
Not Managed.
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For each IP address, you can identify its state, associated Interface, associated node Name value (Hosted
on Node), subnet (In Subnet) and prefix length (PL), and any notes included for the IP address.

Note: Because this view contains only addresses whose Management Mode is set to Managed, the Man-
agement Mode column is not included.

Note: Because this view contains only addresses whose Management Mode is Out of Service, the Man-
agement Mode column is not included.

See IP Addresses View (Inventory) for more information about uses for address views.

Related Topics

"Stop or Start Managing a Node, Interface, or Address" (on page 184)

"Understand the Effects of Setting the Management Mode to Not Managed or Out of Service " (on page
193)

How NNMi Assigns the Management Mode to an Interface or Address

NNMi administrators can instruct NNMi to no longer manage an interface or address by setting the Direct
Management Mode value. NNMi then calculates the overall Management Mode based on the current Man-
agement Mode of all the associated objects.

For example, if you are specifying the Direct Management Mode for an address, NNMi uses the following
values to determine the Management Mode value for the address:

l Direct Management Mode you enter for the address

l Management Mode of the associated interface, if any

l Management Mode of the node that contains the address

The following table lists possible values for each object's management mode.

(Node) Management Mode (Interface) Direct Management Mode (Interface) Management Mode

Managed Inherited Managed

Not Managed Inherited Not Managed

Out of Service Inherited Out of Service

Managed Not Managed Not Managed

Not Managed Not Managed Not Managed

Out of Service Not Managed Not Managed

Managed Out of Service Out of Service

Not Managed Out of Service Out of Service

Out of Service Out of Service Out of Service

Interface
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(Node) Man-
agement Mode

(Interface) Direct Man-
agement Mode

(Address) Direct Man-
agement Mode

(Address)Management
Mode

Managed Inherited Inherited Managed

Not Managed Inherited Inherited Not Managed

Out of Service Inherited Inherited Out of Service

Managed Not applicable* Inherited Managed

Not Managed Not applicable* Inherited Not Managed

Out of Service Not applicable* Inherited Out of Service

Managed Not Managed Inherited Not Managed

Not Managed Not Managed Inherited Not Managed

Out of Service Not Managed Inherited Not Managed

Managed Not Managed Not Managed Not Managed

Not Managed Not Managed Not Managed Not Managed

Out of Service Not Managed Not Managed Not Managed

Managed Not applicable* Not Managed Not Managed

Not Managed Not applicable* Not Managed Not Managed

Out of Service Not applicable* Not Managed Not Managed

Managed Out of Service Inherited Out of Service

Not Managed Out of Service Inherited Out of Service

Out of Service Out of Service Inherited Out of Service

Managed Out of Service Out of Service Out of Service

Not Managed Out of Service Out of Service Out of Service

Out of Service Out of Service Out of Service Out of Service

Managed Not applicable* Out of Service Out of Service

Not Managed Not applicable* Out of Service Out of Service

Managed Not applicable* Out of Service Out of Service

Address

* Used to indicate there is no associated interface
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Understand the Effects of Setting the Management Mode to Not Man-
aged or Out of Service 

The results of setting the management mode to Not Managed or Out of Service for an object, depends on
whether you are setting the value for a node, interface, or address.

Management Mode:

For nodes, setting the Management Mode to Not Managed or Out of Service has the following effects:

l No incidents are generated for the node

l The node's SNMP Agent is excluded from fault polling.

l The node's interfaces or addresses are excluded from fault and performance polling.

l NNMi quits gathering Component Health data about the node.

l NNMi deletes all Polled Instances associated with the Not Managed or Out of Service node.

l The Active State for any Custom Poller Nodes associated with the Not Managed or Out of Service
node becomes Inactive.

l The node is removed from any associated Router Redundancy Groups.

l Traps related to the node, interface, or address, (for example, coldStart or warmStart) are not stored.

l The node is excluded from discovery.

l Actions → Configuration Poll is no longer available for this node.

l The status of a node is set to No Status.

l Actions → Status Poll is no longer available for the node, interfaces, or addresses.

Direct Management Mode:

For interfaces, setting the Direct Management Mode to Not Managed or Out of Service has the following
effects:  

l No incidents are generated for the interface.

l The interface and any related addresses are excluded from fault and performance polling.

l The Administrative State and Operational State of the interface are set to Not Polled.

l The status of the interface is set to No Status.

l Traps related to the interface (for example, LinkUp or LinkDown), will not be stored.

For addresses, setting the Direct Management Mode to Not Managed or Out of Service has the following
effects:   

l No incidents are generated for the address.

l The state of the address is set to Not Polled.

l The address is excluded from fault and performance polling.

Page 194 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring the NNMi User Interface

Configuring the NNMi User Interface

NNMi enables an NNMi administrator to configure the following user interface features:

l The console time out interval

l The maximum number of nodes to display on a map

l The maximum number of connections to display on a map

l The initial map view to display in the Topology Maps workspace

l Whether NNMi displays unlicensed features that require a special license, such as NNMi Advanced

To configure user interface features do the following:

1. From the workspace navigation panel, select the User Interface Configuration workspace. 

2. Make your configuration choices (see table).

3. Click Save and Close.

4. To apply your Console Timeout or Initial View configuration changes, sign out of the NNMi console.
After restarting the console, your changes should take effect. 

Attribute Description

Console
Timeout

NNMi's default session inactivity timeout value is 18 hours. Use this attribute to change the
timeout interval in days, hours, and minutes.

Note: The minimum timeout value is 1 minute.

After this period, if no mouse movement occurs, the console grays out and the user needs
to sign in to the console again.

Tip: If your network operation center (NOC) has a large screen where a map of the most
important nodes is continuously displayed, use a launched view. See "Launch a Trou-
bleshooting Workspace View" (on page 338). A map session launched with a URL
never times out. The map launched automatically updates every 30 seconds. (If you are
using Mozilla Firefox, also see Configure Mozilla Firefox Timeout Interval.)

Initial View Use this attribute to specify the initial view to be automatically displayed in the NNMi con-
sole by default.

Note the following:

l Use the value None (blank) to specify that you do not want a default view automatically
displayed by default.

l If the Node Group you select has been removed, NNMi uses None (blank view). 

Global Control Attributes for User Interface Configuration
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Attribute Description

l To select a Node Group map you have created:

n Prerequisite. Use the Node Group Map Settings configuration workspace to create
a Node Group map and enter a Topology Ordering number that lists the Node
Group map as the first or last map in the Topology Maps workspace. See "Con-
figure Basic Settings for a Node Group Map" (on page 200) for more information.

n For the Initial View attribute:

o If you placed the Node Group map as the first entry in the Topology Maps work-
space, select First Node Group in Topology Maps workspace.

o If you placed the Node Group map as the last entry in the Topology Maps work-
space, select Last Node Group in Topology Maps workspace.

Enable
URL
 Redirect

If you are using NNM iSPIs with Single Sign-On, this attribute enables NNMi to redirect
URL requests to the official Fully Qualified Domain Name (FQDN). The official FQDN is the
hostname used to enable Single Sign-On between NNMi and iSPIs and is determined dur-
ing NNMi installation. 

Note: Before enabling URL Redirect, verify that the official FQDN is set correctly and that it
is a DNS name that is resolvable from the remote systems that need to access the
NNMi management server. If the official FQDN does not meet these requirements,
users will view errors when trying to access the NNMi console. To view the official
FQDN, select Help → About HP Network Node Manager i-series or use the nnmof-
ficialqdn.ovpl script. To change the official FQDN, use the nnmsetofficialfqdn.ovpl
script. 

When URL Redirect is enabled, a user can sign on to the NNMi console using any host-
name or IP address that is valid for the NNMi management server.

Show Unli-
censed
Features

By default, NNMi displays menus, views, and workspaces that require an additional
license. If you do not have the required license, NNMi labels these features as (Unli-
censed)and displays an error message when you try to use the feature. Examples include
NNMi Advanced and NNM iSPI features.

Use this checkbox to specify whether you want these unlicensed features to be displayed
or removed from the NNMi user interface.

Note: Typically, if you do not plan to install a permanent license for these features, it is rec-
ommended that you clear this checkbox.

To remove unlicensed features from the NNMi user interface, clear the Show Unlicensed

Features checkbox .

To specify that these features should be displayed in the NNMi console, make sure the

Show Unlicensed Features  checkbox is selected.

Note: To determine which NNM iSPIs (HP Smart Plug-ins) are enabled, access Help →
About HP Network Node Manager i-series and look under the "Extension Infor-
mation" section. See "Purchase an HP Smart Plug-in" (on page 319) for more infor-
mation about possible HP Smart Plug-ins.

Note: You can override Default Map Setting using the Node Group Map Settings Configuration work-
space. See "Configure Basic Settings for a Node Group Map" (on page 200) for more information.
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Attribute Description

Map
Refresh
Interval

Specifies the refresh interval for Status Refresh.

Maximum
Number of
Displayed
Nodes

Use this attribute to change the maximum number of nodes to be displayed on a map.

Note the following:

l If you change the default value to display a large number of nodes at one time, you
might need to re-adjust this number if maps are taking longer than expected to dis-
play.

l In Layer 2 and Layer 3 Neighbor views, NNMi adds nodes one hop at a time. If NNMi
finds a large number of nodes in a single hop, the number of nodes might exceed the
maximum number specified.  

Maximum
Number of
Displayed
End Points

Use this attribute to change the maximum number of end points to be displayed on a map.

Note: If you change the default value to display a large number of end points at one time,
you might need to re-adjust this number if maps are taking longer than expected to
display.

Indicate Key
Incidents

When enabled , NNMi enlarges any objects on a Node Group map that are Source
Objects for Key Incidents.

When disabled , NNMi does not indicate the objects on a Node Group map that are
Source Objects for Key Incidents.

You can override this setting for a particular Node Group map, when you "Configure Basic
Settings for a Node Group Map" (on page 200). When viewing the Node Group map, you
can also enable or disable this feature. See Node Group Maps and Key Incident Views for
more information.

Default Map Settings Attributes for User Interface Configuration

Attribute Description

Last Modified Indicates the last date and time that any of the user interface attributes were modified.

Registration Attributes for User Interface Configuration

NNMi also enables you to configure features specific to Node Group Maps. See "Define Node Group Map
Settings" (on page 198) for more information.
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Configuring Maps

NNMi enables you to configure the following maps

l Node Group Map views

l Path View Maps

When configuring Node Group maps, you can do the following:

l Include only the nodes that are important to you.

l Specify which Node Group maps appear in the Topology Maps workspace.

l Specify refresh information.

l View node groups in the context of a relevant background image, such as a map illustrating node loca-
tions.

l View node groups in a customized arrangement.

When configuring Node Group map views, you can also specify the role level required to save maps in a
customized arrangement. See "Define Node Group Map Settings" (on page 198) for more information.

When configuring Path View maps you specify undiscovered regions of your network by creating a Path-
Connections.xml file that defines the path between the undiscovered nodes. See"Configure a Path
View Map" (on page 206) for more information.

You can also specify the maximum number of nodes to display on a map. See "Configuring the NNMi User
Interface" (on page 195) for more information.

Related Topics

"Node Group Map Settings Form" (on page 199)

Node Group Map View

Position Nodes in a Node Group Map

Define Node Group Map Settings

Node Group Map settings specify the node group and background image to be used in a Node Group
map. Map settings include the following:

l Node group name

l Topology Maps Workspace ordering

l Minimum role for saving edited locations for each node in the map

l Refresh interval

l The maximum number of map nodes

l Node connectivity information

l Node Group connectivity information

l Background image information

Node Group Map views are used for a variety of purposes in NNMi:

Page 198 of 422

../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0100NodeGrp.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0100NodeGrp.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0100NodeGrp.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0100NodeGrp.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprVwsMap0110NodeGrpPos.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Maps

l Viewing groups of only the nodes that are important to you.

l Viewing Node Groups in the context of a relevant background image.

l Viewing Node Groups in a customized arrangement.

To define Node Group Map Settings, use the "Node Group Map Settings Form" (on page 199).

To view a Node Group Map, use the Actions menu from the NNMi main toolbar from either a Node Group
or Node Group Map Settings. See Node Group Map for more information.

To view more information about the Node Group from a Node Group map, use the File → Open Node
Group for Map option to open the Node Group form for the selected Node Group.

Node Group Map Settings Form

Use the Node Group Map Settings form to configure maps based on currently defined Node Groups. Items
you configure include the background image and type of connectivity (for example, Layer 2) to be dis-
played on the map.

Note: NNMi displays the list of Node Group Map Settings whose default configuration has been changed.
If NNMi does not display a list of Node Group Map Settings, this means that NNMi is using the
default settings for each Node Group Map. To change the default settings for a Node Group Map,

either reposition the nodes on the map of interest and select  Save Layout from the Node Group
Map toolbar or use the Node Group Map Settings form to create a Node Group Map Settings con-
figuration as described below. See Position Nodes on a Node Group Map for more information

about using Save Layout.

To configure Node Group Map Settings, do the following:

1. Navigate to the Node Group Map Settings Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Node Group Map Settings.

2. Make your configuration choices (see table).

3. Click Save and Close.

Note: You can also access the Node Group Map Settings form from a Node Group Map using the File →
Open Node Group Map Settings option.

Task How

"Configure Basic Set-
tings for a Node
Group Map" (on page
200)

Use the Basics Settings pane to configure Node Group, Topology Maps, and
Refresh Interval information.

Note: To apply your Topology Maps Ordering configuration changes, sign out of
the NNMi console. After restarting the console, your changes should take
affect. Possible configuration changes include reordering a Node Group
map view or adding a new Node Group map view to the workspace.

"Configure the Con-
nectivity to be Dis-
played for a Node
Group Map" (on page
202)

Use the Connectivity tab to configure the level of node connectivity to be dis-
played on the Node Group Map. Use this tab to also specify the Node Group
connectivity to be displayed and maximum connections to be included on the
Node Group map.

Tasks for Configuring Node Group Map Settings
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Task How

"Configure Back-
ground Image Infor-
mation for a Node
Group Map" (on page
203)

Use the Background Image tab to configure information about the Background
Image to use on the Node Group map.

Configure Basic Settings for a Node Group Map

The Basic Settings configuration determines general information about the Node Group map, including the
following:

l Which Node Group to display

l Availability of the map in the Topology Maps workspace

l Location of the map in the list of views in the Topology Maps workspace

l Minimum role for saving the map layout

l Refresh interval for the Node Group map

l Maximum number of nodes to display on the map

l Whether to indicate Key Incidents

To establish Basic Settings for a Node Group Map:

1. Navigate to the Node Group Map Settings form.                 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Node Group Map Settings.

c. Do one of the following:

o To create a Node Group Map Settings definition, click the New icon.

o To edit a Node Group Map Settings definition, select a row, click the Open icon.

o To delete a Node Group Map Settings definition, select a row and click the Delete but-
ton

2. Establish the appropriate settings to identify Node Group and Refresh Settings information (see
tables).

3. Click Save and Close if you are ready to save your changes.

Attribute Description

Node
Group

Specifies which parent node group to display in the Node Group Map view. The contents
of the parent node group include any nodes and Child Node Groups associated with it.

Note: NNMi displays any Child Node Groups of the selected parent Node Group as a hex-
agon on the map.

The Expand Child in Parent Node Group Map attribute determines how a Child Node
Group appears on the Node Group Map. Expand Child in Parent Node Group Map is dis-
abled by default.

Basic Attributes
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Attribute Description

l If the Child Node Group has the Expand Child in Parent Node Group Map attribute dis-
abled, the Child Node Group appears as a hexagon on the map as shown below:

l If any Child Node Group has the Expand Child in Parent Node Group Map attribute
enabled, NNMi instead recursively displays each of the nodes in that Child Node
Group on the map.

See Node Group Form: Child Node Groups Tab for more information about configuring
Child Node Groups.

Topology
Maps Order-
ing

Use this attribute to specify the order in which you want the Node Group map to appear in
the Topology Maps workspace.

Note: If you do not want this Node Group map to appear in the Topology Maps workspace,
leave the value blank.

See Views Provided by NNMi for more information about the maps provided in the Topol-
ogy Maps workspace.

Note: To apply your Topology Maps Ordering configuration changes, sign out of the NNMi
console. After restarting the console, your changes should take affect. Possible con-
figuration changes include reordering a Node Group map view or adding a new
Node Group map view to the Topology Maps workspace.

Minimum
Role for
Saving
Map Layout

Controls the minimum user role required to save the layout of repositioned nodes in a
Node Group Map. This value also controls the minimum user role for configuring Node
Group Map Settings.

Note: Only a user with the role of Administrator can set the Minimum Role for Saving Map
Layout value.

Possible values include:

l Administrator

l Operator Level 2

l Operator Level 1

The default value is Administrator. See "Determine which NNMi Role to Assign" (on page
33)for more information about NNMi roles.

Note: A user with any role can initially reposition nodes on a Node Group Map view. How-
ever, unless your user name is assigned to the required minimum role, you cannot
save the new node locations on the map. After being saved, these node positions
are seen by any user opening this Node Group Map.

Map
Refresh
Interval

Specify the Refresh Interval you want to use in days, hours, minutes, and seconds. By
default, the Refresh Interval is 30 seconds. This interval is used to set the Refresh Status
interval for this map if it is used.

Indicate
Key Inci-
dents

When enabled , NNMi enlarges any objects on a Node Group map that are Source
Objects for Key Incidents.

When disabled , NNMi does not indicate the objects on a Node Group map that are
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Attribute Description

Source Objects for Key Incidents.

When viewing the Node Group map, you can also enable or disable this feature. See
Node Group Maps and Key Incident Views for more information.

Maximum
Number of
Displayed
Nodes

Specifies the maximum number of nodes to be displayed on the Node Group map.

Note: This number applies to the total number of nodes within the Node Group, including
any Child Node Groups displayed on the map.

Maximum
Number of
Displayed
End Points

Specifies the maximum number of end points to be displayed on a map.

Note: If maps are taking longer than expected to display, you might need to re-adjust this
number.

Configure the Connectivity to be Displayed for a Node Group Map

The Connectivity Tab of the Node Group Map Settings form enables you to specify the level of connectivity
to be displayed on the Node Group map. You also specify the connections that you want to display.

1. Navigate to the Connectivity tab of the Node Group Map Settings form.                 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Node Group Map Settings.

c. Do one of the following:

o To create a Node Group Map Settings definition, click the New icon.

o To edit a Node Group Map Settings definition, select a row, click the Open icon.

o To delete a Node Group Map Settings definition, select a row and click the Delete but-
ton

d. Select the Connectivity tab.

2. Configure the connectivity information for this Node Group Map Settings definition (see table).

3. Click Save and Close if you are ready to save your changes.

Attribute Description

Connectivity
Type

Connectivity Type determines the type of connectivity to display between nodes in the
Node Group Map view.

By default, NNMi displays the Layer 2 connectivity between nodes when displaying a
Node Group Map view. Possible values include:

l None - Choose this if you do not want any connectivity displayed on the map.

l Layer 2 - Uses Layer 2 connectivity when displaying devices in a Node Group Map
view. This connectivity is used by default when positioning node locations on a Node
Group Map.

l Layer 3 - Uses Layer 3 connectivity when displaying devices on a Node Group Map
view.

Connectivity Attributes
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Attribute Description

See Position Nodes on a Node Group Map for more information.

Add L2 Sub-
net Con-
nections

If you specify Layer 3 or None as the Connectivity Type, this option specifies that you
want to include any subnet connections determined by Subnet Connections Rules.

See "Configure Subnet Connection Rules" (on page 109) for more information.

Add L2 User
Connection
Edits

If you specify Layer 3 or None as the Connectivity Type, specifies that you want to include
any Layer 2 connections added using the NNMi nnmconnedit.ovpl command to add or
delete connection data.

See "Add or Delete a Layer 2 Connection" (on page 124) for more information.

Interface
Group

Use this option, if you want to reduce the connectivity endpoints on the Node Group Map.

The Interface Group you select defines the Interface Group to which an interface must
belong to be used to connect a Node Group to a Node Group or a Node to a Node Group.

NNMi displays Layer 2 endpoints that are interfaces in the group. NNMi displays Layer 3
endpoints that are IP addresses associated with interfaces in the group.

Nodes to
Node Group

Select this check box if you want Node to Node Group connectivity to appear on the Node
Group map.

Note: By default, this option is not enabled.

Node
Groups to
Node
Groups

Select this check box if you want Node Group to Node Group connectivity to appear on
the Node Group map.

Note: By default, this option is not enabled.

Configure Background Image Information for a Node Group Map

Use the Background Image tab of the Node Group Map Settings form to configure information about the
Background Image to use on the Node Group map.

1. Navigate to the Background Image tab of the Node Group Map Settings form.                 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Node Group Map Settings.

c. Do one of the following:

o To create a Node Group Map Settings definition, click the New icon.

o To edit a Node Group Map Settings definition, select a row, click the Open icon.

o To delete a Node Group Map Settings definition, select a row and click the Delete but-
ton

2. Establish the appropriate settings to identify the Background Image information (see table ).

3. Click Save and Close if you are ready to save your changes.
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Attribute Description

Background
Image

Enter the URL for the background image you want to use for this Node Group Map. You
can use a background image provided by NNMi or add your own.

Note: Click Background Image to view the map whose URL you enter.

Use a Background Image Provided by NNMi

NNMi provides a set of background images that include maps of many countries. If you
want to use one of those images, append the location and file name to the URL at which
you access the NNMi console. Use the format: /nnmbg/<file name>. For example:

/nnmbg/colorado.gif

To see all of the available images provided by NNMi, browse to:

http://<serverName>:<portNumber>/nnmbg/

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with
the NNMi console

Use a Background Image You Provide

You can also provide your own images. See "Background Image Sources in Node Group
Maps" (on page 205) for more information about where to load the background images
you want to use.

To see a list of all the images added to NNMi, access the following URL:

http://<serverName>:<portNumber>/nnmdocs/images/

To use an image that has been added to NNMi, use the following URL:

/nnmdocs/images/<file name>

For example: /nnmdocs/images/myimage.gif

Note the following:

l NNMi accepts images that can be loaded by a Web browser. Common file extensions
include: .gif, .png and .jpg.

l Image names are case sensitive. All background image file names provided by NNMi
 are lowercase.

l Do not use http://<localhost> in your URL. This implies the image is on your local
machine and is not available from other clients.

l If using full URLs, all client machines must be able to resolve the hostname of the
server on which the images reside.

l When you pan and zoom around the map, the background image moves in relation
with the other objects on the map.

If the image does not display, see "Troubleshoot URLs When Specifying a Background
Image" (on page 206) for more information.

Background
Image
Scale

The Background Image Scale attribute applies to the actual background image dimen-
sions when displayed on a Node Group Map.

Enter a floating point number greater than zero (0.0) to indicate the ratio at which you

Background Image Attributes

Page 204 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Maps

Attribute Description

want NNMi to scale the background image. For example, the value 1.0 represents a one-
to-one ratio, resulting in a background image displayed at actual size. A value of 2.0 rep-
resents a two-to-one ratio, resulting in a background image displayed at twice the actual
size.

Note: The default ratio value is 1.0. (This means no scaling is applied.) Use this default
value initially. You can adjust it as needed based on the relative size between the
image and nodes.

See "Scale Background Images in Node Group Maps" (on page 206) for guidelines for
scaling the background images you specify.

Background Image Sources in Node Group Maps

When specifying background images to include in Node Group Maps, NNMi enables you to use images
provided by NNMi or images that you provide.

The images that NNMi provides include maps of many countries.

To see the available images provided by NNMi:

Browse to:http://<serverName>:<portNumber>/nnmbg/

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

To use your own background images:

Place you user-supplied images in the following directory:

Windows:

<drive>:/Documents and Settings/All Users/Application Data/HP/HP BTO
 Software/shared/nnm/www/htdocs/images

<drive> is the drive on which NNMi is installed.

Unix:

/var/opt/OV/shared/nnm/www/htdocs/images

NNMi accepts images that can be loaded by a Web browser. Common file extensions include: .gif, .png
and .jpg.

To see the available images that have been added to NNMi:

Access the following URL: http://<serverName>:<portNumber>/nnmdocs/images

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

See "Node Group Map Settings Form" (on page 199) for more information about how to configure Node
Group Maps to use background images.
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Scale Background Images in Node Group Maps

Scale a specified background image for a Node Group Map using the Background Image Scale attribute.
See "Define Node Group Map Settings" (on page 198) for more information.

When you use the maps provided by NNMi, it is recommended that you initially use the default value of 1.0
for the Background Image Scale.

When you use your own images for map backgrounds and you are selecting a scale value, consider the fol-
lowing:

l NNMi renders its nodes 50 by 50 pixels. This means if your image is 500 pixels wide, there is room for
10 nodes across the image.

l To display the image at normal resolution, enter a scale value of 1.0. (This means no scaling occurs.)

l After the image displays on the map, look at the relationship between the node size and the back-
ground to determine whether you need to rescale the background image:

n If the nodes look too large compared to the background, enlarge the image using a scale value
greater than 1.0.

n If the nodes look too small compared to the background, make the image smaller using a scale
value less than 1.0.

Troubleshoot URLs When Specifying a Background Image

This topic contains troubleshooting steps to use if your background image does not display.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

If you used a relative URL (beginning with a slash (/) in the Background Image attribute value:

1. Copy and paste the URL to a browser.

2. Insert http://<serverName>:<portNumber> in front of the slash (/).

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi
console

If you used an absolute URL (beginning with http://) in the Background Image attribute value:

Copy and paste the URL to a browser.

Configure a Path View Map

Configuring a Path View map is useful when you have two or more areas of your network which are sep-
arated by undiscovered devices, such as service provider nodes. NNMi enables you to configure a Path
View map that traverses undiscovered regions of your network. To configure this kind of Path View map,
create a PathConnections.xml file that defines the following:

l Required. A Start node for each <CONNECT> to be included in the Path View map

l Optional. A unique identifier for a <CONNECT>
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l Optional. The outbound interface from each Start node per <CONNECT>

l Required. Any number of undiscovered nodes you want to be included in the map between each <CON-
NECT>

l Optional. An End node for a <CONNECT> to be included in the Path View map

l Optional. The inbound interface to each End node per <CONNECT> specified.

Each time NNMi determines a node in the Path View, NNMi checks whether the node is specified as a
Start node in the PathConnections.xml file. If the node is specified as a Start node in Path-
Connections.xml, each <CONNECT> configured in PathConnections.xml is inserted in the Path View
map.

Note: NNMi Advanced. NNMi can use RAMS data to determine router paths. When RAMS data is used to
determine the router paths, NNMi ignores the PathConnections.xml file. See Path View with
NNMi Advanced for more information.

To configure a Path View map:

Using the required format, create a PathConnections.xml file in the following location:

Windows:
<drive>:/Documents and Settings/All Users/Application Data/HP/HP BTO Soft-
ware/shared/ nnm/conf/PathConnections.xml

<drive> is the drive on which NNMi is installed

UNIX:
/var/opt/OV/shared/nnm/conf/PathConnections.xml

The following table describes each of the file elements and its format requirements. (Also see the sample
file)

Note: Each segment of the path that you specify using the <CONNECT> element is directional. If you want to
view the path between two nodes in both directions, make sure you include the Start and End nodes
for each direction. You should also include the inbound interface for the Start node. If you do not
limit the possible routers by including the inbound interface for the Start node, Path View might find
additional routers in the path.

Element Descriptions

<CONNECTIONS>

Required parent element. The file must include only one <CONNECTIONS> element.

<CONNECT>

Specifies a segment of the path. Each <CONNECT> designates a start and stop location for the <CON-
NECT>.

The file can include more than one <CONNECT> element. 

<ID>
 C1

</ID>

Optional. Identifies the connection. NNMi uses the ID value you enter when reporting errors for a <CON-
NECT>.

If you do not provide an ID value for the path between a Start and End node, any error message for the
<CONNECT> displays Not Applicable rather than the unique identification value.

Elements for the Path View Configuration File
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Element Descriptions

<START> 
 <IP_OR_DNS>xxx.xx.xxx.x</IP_OR_DNS> 
 <OUTBOUND_INTERFACE_IFINDEX>x</OUTBOUND_INTERFACE_IFINDEX> 
 <NEXT_HOPS> 

 <HOP>xxx.xx.xxx.x</HOP> 
 <HOP>xxx.xx.xxx.x</HOP> 

 </NEXT_HOPS> 
</START>

Specifies the node where a segment of the path starts. You provide values for the following elements:

l <IP_OR_DNS> provides the name or IPv4 address of a node in your network. See "Configure the
Node Name Strategy" (on page 99) for more information about node names.

l Optional. <OUTBOUND_INTERFACE_IFINDEX> designates which of the Start node's interfaces to use
for this segment of the path.

l <NEXT_HOPS> designates one or more specific IPv4 addresses or nodes that you want to be
included in the path.

<END> 
 <IP_OR_DNS>xxx.xx.xxx.x</IP_OR_DNS> 
 <INBOUND_INTERFACE_IFINDEX>x</INBOUND_INTERFACE_IFINDEX> 
</END>

Specifies the node where the <CONNECT> ends. You provide values for the following elements:

l <IP_OR_DNS> provides the name or IPv4 address of a node in your network.

l Optional.<INBOUND_INTERFACE_IFINDEX> designates which of the End node's interfaces to use for
this segment of the path.

</CONNECT>

Required. Designates the end of the XML code that defines one segment of your path view.

</CONNECTIONS>

Required parent element. Designates the end of the XML code that defines your path view.

Click here to view a sample file:

<?xml version="1.0" encoding="UTF-8"?>

<CONNECTIONS> 

 <CONNECT>
 <ID>

 C1
 </ID> 
 <START> 

 <IP_OR_DNS>StartNode.xx.xxx.x</IP_OR_DNS> 
 <OUTBOUND_INTERFACE_IFINDEX>3</OUTBOUND_INTERFACE_IFINDEX> 

 <NEXT_HOPS> 
 <HOP>hop-1.xxx.xx.xxx</HOP> 
 <HOP>hop-2.xxx.xx.xxx</HOP> 

 </NEXT_HOPS> 
 </START> 
 <END> 
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 <IP_OR_DNS>EndNode.xxx.xx.xxx</IP_OR_DNS> 
 <INBOUND_INTERFACE_IFINDEX>6</INBOUND_INTERFACE_IFINDEX> 

 </END> 
 </CONNECT> 

</CONNECTIONS>

When viewing Path View maps that are configured using the PathConnections.xml file, note the fol-
lowing:

l If the <END> element is not specified, NNMi connects directly to the Destination node to complete the
path.

l If the <END> element is specified, then the associated <IP_OR_DNS> specifies a discovered node as
the End node of this segment of your Path View.

Click here to view the sample Path View map generated from the sample file above.

Click here to view a sample file that includes both directions for the sample Path View map above.

Note: In this example, the path is the same in both directions. In many cases, the path might be different in
each direction.

<?xml version="1.0" encoding="UTF-8"?>

<CONNECTIONS>
 <CONNECT>

<ID>
C1

</ID>
 <START> 

 <IP_OR_DNS>StartNode.xx.xxx.x</IP_OR_DNS> 
 <OUTBOUND_INTERFACE_IFINDEX>6</OUTBOUND_INTERFACE_IFINDEX> 

 <NEXT_HOPS> 
 <HOP>hop-1.xxx.xx.xxx</HOP> 
 <HOP>hop-2.xxx.xx.xxx</HOP> 

 </NEXT_HOPS> 
 </START> 
 <END> 

 <IP_OR_DNS>EndNode.xxx.xx.xxx</IP_OR_DNS> 
 <INBOUND_INTERFACE_IFINDEX>3</INBOUND_INTERFACE_IFINDEX> 

 </END>
 </CONNECT> 

</CONNECTIONS>

Click here to view the sample Path View map generated from the sample file above.
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Configuring Incidents

Incidents are information that NNMi considers important to bring to your attention regarding your network.
See "How NNMi Gathers Incidents" (on page 211) for more information.

NNMi provides a set of incident configurations for the following:

l Traps generated from an SNMP agent

l Management incidents that are generated by NNMi

l Events generated by NNM 6.x or 7.x management stations

See "Incident Configurations Provided by NNMi" (on page 214) for more information about the con-
figurations provided.

NNMi provides one centralized location, the incident views, where the management events, SNMP traps,
and NNM 6.x or 7.x forwarded events are visible to your team. You control which SNMP traps and NNM 6.x
or 7.x events are considered important enough to show up as incidents. You can also configure how inci-

dents that are generated by NNMi are displayed. You and your team can easily monitor the incidents and
take appropriate action to preserve the health of your network.

You may choose to modify the incident configurations provided by NNMi or create new incident con-
figurations. To do so, see the following topics:

l "Configure SNMP Trap Forwarding" (on page 239)

l "Configure SNMP Trap Incidents" (on page 246)

l "Configure How Management Events Are Displayed" (on page 264)

l "Configure Remote NNM 6.x/7.x Events" (on page 261)

l Using the Incident Configuration form, you can also configure pairwise correlations. See "About Pair-
wise Configurations" (on page 276) for more information.

Note: If you make changes to an incident configuration provided by NNMi, remember to place your name
in the Author attribute. See "Specify an Author for Your Incident Configuration" (on page 260) for
more information.

Define relationships between multiple incidents by creating deduplication and rate configurations. See
"Reduce the Number of Incoming Incidents" (on page 266), "Correlate Duplicate Incidents (Deduplication
Configuration)" (on page 269), and "Track Incident Frequency (Rate: Time Period and Count)" (on page
273), for more information.

Note: Each time you stop and restart ovjboss, any incidents that have not yet been correlated or persisted
are lost. This means that after a restart of ovjboss, an incoming incident might not be correlated as
expected. For example, after a restart of ovjboss, a duplicate incident might not be correlated under
its original parent incident. Instead, a new parent incident might be generated. See "Stop or Start an
NNMi Process" (on page 26)for more information about starting and stopping the ovjboss process.

How NNMi Gathers Incidents

Incidents are information that NNMi considers important to bring to your attention regarding your network.
NNMi gathers incident information from the sources described in the following table. 
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Information
Source Description

Causal
Engine -
Management
Events

The NNMi Causal Engine analyzes the health of your network and provides the ongoing
health status reading for each device. The Causal Engine also extensively evaluates
problems and determines the root cause for you, whenever possible, sending incidents
to notify you of problems. Any incident generated from a Causal Engine management
event has an Origin of Management Software in your incident views. See Using the Inci-
dent Form for more information about incident attributes.

SNMP Traps Traps are unsolicited SNMP notifications that come from your network devices. The NNMi
Causal Engine uses this information as symptoms during its analysis. SNMP traps can
also appear as incidents if configured to do so, using the NNMi incident configuration fea-
ture. See "Configure SNMP Trap Incidents" (on page 246) for more information.

 NNM 6.x
and 7.x
Events

NNMi can display NNM 6.x and 7.x events that are configured to be forwarded to NNMi.

Incidents Collected by NNMi

See "The NNMi Causal Engine and Incidents" (on page 212) for an overview of what the NNMi Causal
Engine does with the information collected. See "About the Event Pipeline" (on page 213)for an overview
of the event pipeline path each trap or NNMi event takes before NNMi creates an incident. This chron-
ological path guarantees that the data is analyzed in chronological order. 

Note: The Causal Engine also sends incident information that it generates through the event pipeline to
guarantee the chronological order for determining its root cause incidents.

By default, NNMi includes preconfigured definitions for SNMP traps, NNM 6.x and 7.x events, and the inci-
dents generated by the NNMi Causal Engine. See Incident Views Provided by NNMi for more information.

Related Topics

"Configure SNMP Trap Incidents" (on page 246)

"Configure How Management Events Are Displayed" (on page 264)

"Configure Remote NNM 6.x/7.x Events" (on page 261)

"Incident Configurations Provided by NNMi" (on page 214)

"Reduce the Number of Incoming Incidents" (on page 266)

The NNMi Causal Engine and Incidents

The Causal Engine extensively evaluates network issues and determines the root cause for you, when-
ever possible, sending incidents to notify you of problems.

The NNMi Causal Engine defines root cause in terms of symptoms. To do so, it uses a set of rules to define
relationships for fault and performance (threshholding) symptoms and root causes. Sources of symptom
information include SNMP traps and the monitoring information from the State Poller. See "How NNMi
Gathers Incidents" (on page 211) for more information.

The NNMi Causal Engine communicates through incidents in the following ways:
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l The Causal Engine generates notifications about problems.

l The Causal Engine closes incidents that are no longer valid (for example, when a "Cold Start" trap is
received a short time after a "Node Down" incident was generated because a device was recently
rebooted).

l The Causal Engine creates a parent-child relationship between incidents that are all related to one
problem (for example, a "Node Down" incident contains a child "Interface Down" incident for each
neighboring interface of the node).

The Causal Engine uses the following three stages to help determine and display root cause incidents and
their related conclusions. 

Causal Engine
Stages Description

Condition Lis-
tener

Collects symptoms from NNMi processes and services.

Hypothesis
engine

Analyzes these symptoms to determine relationships until a root cause is reached.

Blackboard Based on the information sent by the hypothesis engine, the blackboard updates a
device's status and posts any related incidents.

NNMi Causal Engine Stages

The NNMi Causal Engine analyzes the health of your network and provides the ongoing health status read-
ing for each node, interface, IP address, SNMP agent, and connection. See "The NNMi Causal Engine and
Monitoring" (on page 152) for more information.

About the Event Pipeline

Any incident information that appears in your incident views first travels through the event pipeline. The
event pipeline guarantees that the incident data is analyzed in chronological order.

Note: Not all information that travels through the pipeline results in an incident.

If at any time an incident does not meet the criteria for a stage in the event pipeline, it is ignored and
passed to the next stage in the pipeline.  The following table describes the stages contained in the event
pipeline.

Event Pipe-
lineStages Description

SNMP Trap
and Event
Receiver

Accepts all SNMP traps and remote NNM 6.x or 7.x events

Incident
 Receiver

Accepts all incident information that comes from the NNMi Causal Engine. See "The
NNMi Causal Engine and Incidents" (on page 212)NNMi"The NNMi Causal Engine
and Incidents" (on page 212)

Type Enforcer Determines if a configuration exists for this trap, event, or incident.

If the incident configuration exists, the type enforcer begins to populate the incident
fields according to the configuration. Examples of the incident fields that are populated
include Severity, Origin, Category, and Correlation Nature. If an incident con-

NNMi Event Pipeline Stages
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Event Pipe-
lineStages Description

figuration is disabled or does not exist for the incident, NNMi drops the incident.

Resolver Determines if a record of the problem device or node exists in the NNMi topology data-
base. If available, the resolver populates the incident with the most current Source
Node and Source Object attribute values.

Store Bulk Collects incidents and stores them.

Notification Notifies other process and services about a new incident.   

Pairwise Checks for any current pairwise configurations for the incident.

Rate Checks for any current rate configurations for the incident.

Dedup Checks for any current deduplication configurations for the incident.

Relate Performs any additional Causal Engine correlations, and cancels the incident when
applicable.

Actions Performs any automatic actions that the NNMi administrator has configured to be run
for one or more incidents. See Using Actions to Perform Tasks for more information.

Incident Configurations Provided by NNMi

NNMi provides several incident configurations out-of-the-box. You can review these configurations or mod-
ify these configurations to better meet your needs. For example, you might want to customize the message
that appears with a particular type of incident, including adding information to the message displayed.

You might also choose to create your own configurations for additional SNMP traps that are important to
you.

These out-of-the-box configurations are organized according to the following categories:

"SNMP Trap Incident Configurations Provided by NNMi" (on page 216)

"Management Event Configurations Provided by NNMi" (on page 229)

"Remote NNM 6.x/7.x Event Configurations Provided by NNMi" (on page 226)

"Incident Pair (Pairwise) Configurations Provided by NNM" (on page 276)

Note: If you make changes to an incident configuration provided by NNMi, remember to place your name
in the Author attribute. See "Specify an Author for Your Incident Configuration" (on page 260) for
more information.

Custom Incident Attributes Provided by NNMi

NNMi uses custom incident attributes to attach additional information to incidents.

A subset of CIAs are available for any particular incident. Any relevant CIAs are displayed on the Incident
form, in the Custom Attributes tab. There are two categories of possible CIAs:

l SNMP trap varbinds identified by the Abstract Syntax Notation value (ASN.1).Varbinds are defined in
MIB files that you can load into NNMi. See "Load SNMP Trap Definitions" (on page 247).

l Custom incident attributes provided by NNMi.
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The potential custom incident attributes provided by NNMi are described in the table below.

Name Description

cia.address SNMP agent address

cia.snmpoid SNMP trap object identifier

cia.eventoid NNM 6.x/7.x object identifier (oid) for the incident

cia.remotemgr Hostname or IP address of the NNM 6.x or 7.x management station that is forwarding
the event

cia.remotetopoid Topology identifier (topoid) of the NNM 6.x or 7.x event

Custom Incident Attributes Provided by NNMi

NNM iSPI for Performance. For network performance monitoring, additional custom incident attributes are
provided for your use. Click here for more information.

Name Description

cia.thresholdReason Configured thresholds have a value of null.

Unset thresholds have a value of No threshold settings defined.

See "Configure Threshold Monitoring for Interfaces (NNM iSPI for Per-
formance)" (on page 162) for the complete list of possible performance
threshold results and for information about how to configure per-
formance thresholds.

cia.thresholdParameter The monitored attribute that is being measured. For example, Input Util-
ization. See "Configure Threshold Monitoring for Interfaces (NNM iSPI
for Performance)" (on page 162) for the complete list of possible attrib-
utes. This value is selected when configuring performance thresholds.

cia.thresholdLowerBound The configured value for the low performance threshold. See "Con-
figure Threshold Monitoring for Interfaces (NNM iSPI for Performance)"
(on page 162) for more information about how to configure per-
formance thresholds.

cia.thresholdUpperBound The configured value for the high performance threshold. See "Con-
figure Threshold Monitoring for Interfaces (NNM iSPI for Performance)"
(on page 162) for more information about how to configure per-
formance thresholds.

cia.thresholdPreviousValue Results from the previous Performance Polling Interval. For example,
the performance threshold results for the Input Error Rate might
change from Nominal to High, based on a change in the thres-
holdMeasuredValue. See Interface Form for a complete list of possible
values.

cia.thresholdCurrentValue Results from the most recent Performance Polling Interval. For exam-
ple, High. See Interface Form for a complete list of possible values.

cia.thresholdMeasuredValue The most recent measurement for the performance threshold. NNM
 iSPI for Performance monitors this measurement for threshold vio-

NNM iSPI for Performance. Custom Incident Attributes Provided for Thresholding
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Name Description

lations. This measurement is the average of all measurements taken
during the last polling interval (determined by the NNMi State Poller).

cia.thresholdMeasurementTime The time at which the threshold was reached for a performance thresh-
old. For example, if the threshold for the Input Error Rate is 6.0, and the
thresholdMeasuredValue is 6.0, the time at which the thres-
holdMeasuredValue become equal to 6.0 is stored in this custom inci-
dent attribute. The time appears in ISO 8601 format.

These CIAs are used in a variety of ways:

l In SNMP trap configurations. See "Configure SNMP Trap Incidents" (on page 246).

l In remote NNM 6.x/7.x events. See "Configure Remote NNM 6.x/7.x Events" (on page 261).

l In management events. See "Configure How Management Events Are Displayed" (on page 264).

l In automatic actions. See "Configure an Action for an Incident" (on page 283).

l In correlation configurations. See "Reduce the Number of Incoming Incidents" (on page 266).

l In URL Action definitions (accesses through the Actions menu). See "Control the Actions Menu" (on
page 303).

SNMP Trap Incident Configurations Provided by NNMi

NNMi provides the SNMP trap incident configurations described in the following table.

You might also choose to create your own configurations for additional SNMP traps that are important to
you.

Note: If you make changes to an incident configuration provided by NNMi, remember to place your name
in the Author attribute. See "Specify an Author for Your Incident Configuration" (on page 260) for
more information.

Incident Configuration Name Description
Deduplication
Configuration

Rate Con-
figuration

BGPBackward Transition Generated when the BGP Finite State
Machine moves from a higher numbered
state to a lower numbered state.

Name CIA

BGPEstablished Generated when the BGP Finite State
Machine enters the ESTABLISHED state.

Name CIA

CempMemBufferNotify Signifies that a cempMemBufferPeak object
has been updated in the buffer pool.

Name

CiscoChassisAlarmOff Signifies that the agent entity has detected
the chassisTempAlarm, chassisMinorAlarm,
or chassisMajorAlarm object in this MIB has
transitioned to the off(1) state.

Name CIA

CiscoChassisAlarmOn Signifies that the agent entity has detected
the chassisTempAlarm, chassisMinorAlarm,

Name CIA

SNMP Trap Configurations Provided by NNMi
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or chassisMajorAlarm object in this MIB has
transitioned to the on(2) state.

CiscoChassisChangeNotification Agent detects any hot-swap component
change or changes in the chassis.

Name CIA

CiscoColdStart Occurs when a Cisco Agent is powered up. 5 within a
time period of
5 minutes

CiscoDemand NeighborLayer2Change Sent to the manager whenever the D-channel
of an interface changes state.

Name CIA 

IF index

CiscoEnvMonFanNotification Indicates at least one of the fans in the fan
array has failed.

CiscoEnvMonFanStatusChange Notification Indicates a state change for a device being
monitored by ciscoEnvMonFanState.

CiscoEnvMonRedundantSupplyNotifcation Indicates the redundant power supply failed.

CiscoEnvMonSuppStatusChangeNotification Indicates a change in the state of a device
being monitored by cis-
coEnvMonSupplyState.

CiscoEnvMonTempStatusChangeNotification Indicates a change in the state of a device
being monitored by cis-
coEnvMonTemperatureState.

CiscoEnvMonTemperatureNotification Indicates the temperature measured at a
given testpoint is outside the normal range for
the testpoint, For example, it is at the warning,
critical, or shutdown stage.

CiscoEnvMonVoltStatusChangeNotification Indicates a change in the state of a device
being monitored by cis-
coEnvMonVoltageState.

CiscoEnvMonVoltageNotification Indicates the voltage measured at a given
testpoint is outside the normal range for the
testpoint. For example, it is at the warning, crit-
ical, or shutdown stage.

CiscoLinkDown Occurs when the Cisco agent detects an inter-
face has gone down.

Name CIA 

IF index

CiscoLinkUp Occurs when the Cisco agent detects an inter-
face has come back up.

Name CIA 

IF index

CiscoModuleDown Signifies that the agent entity has detected
that a module has gone down.

Name CIA 
Module Index

CiscoModuleUp Signifies that the agent entity has detected
that a module has come back up.

Name CIA 
Module Index
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CiscoVlanPortStatusChange Generated by a device when the value of
vlanTrunkPortDynamicStatus object has
been changed.

Name CIA

CiscoWarmStart Occurs when an Cisco agent is reconfigured. 5 within a
time period of
5 minutes

HSRPStateChange Sent when an HSRP interface transitions to
or from an Active or Standby state in a par-
ticular HSRP Group.

Name CIA

Ietf_VRRPStateChange Sent when a standard VRRP interface tran-
sitions to or from a Master State in a particular
VRRP Group. This trap is used by the stand-

ard VRRP protocol. It corresponds to the
vrrpTrapNewMaster trap name.

Name CIA

OSPFIfStateChange Signifies that there has been a change in the
state of a nonvirtual OSPF interface.

Name CIA

OSPFNbrStateChange Signifies that there has been a change in the
state of a nonvirtual OSPF neighbor.

Name CIA

OSPFVirtIfStateChange Signifies that there has been a change in the
state of an OSPF virtual interface.

Name CIA

RMONFallingAlarm Sent when an RMON device falls below a pre-
configured threshold.

Name CIA 
RMON Alarm
Variable

RMONRiseAlarm Sent when an RMON device exceeds a pre-
configured threshold.

Name CIA

RMON Alarm
Variable

Rc2kTemperature Signifies the SNMPv2c entity acting in an
agent role, has detected the chassis is over-
heating.

RcAggLinkDown Signifies the operational state of the Multi-
Link Trunk (MLT) Aggregator changed from
Up to Down.

RcAggLinkUp Signifies the operational state of the Multi-
Link Trunk (MLT) Aggregator changed from
Down to Up.

RcChasFanDown Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcChas-
FanOperStatus object for one of its power
supply units is about to transition to the Down
state.
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RcChasFanUp Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcChas-
FanOperStatus object for one of its power
supply units is about to transition to the Up
state.

RcChasPowerSupplyDown Signifies the rcChasPowerSupplyOperStatus
object for one of its power supply units is
about to transition to the Down state.

RcChasPowerSupplyUp Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcCha-
sPowerSupplyOperStatus object for one of its
power supply units is about to transition to the
Up state.

RcSmltIsLinkDown Signifies the operational state of the Split
Multi-Link Trunk (SMLT) Aggregator Link is
transitioning from Up to Down.

RcSmltIsLinkUp Signifies the operational state of the Split
Multi-Link Trunk (SMLT) Aggregator Link is
transitioning from Down to Up.

Rc_VrrpStateChange Sent when a Rapid City (RC) Nortel interface
transitions to or from a Master state in a par-
ticular VRRP Group. This trap is used by the
Rapid City (RC) Nortel propriety VRRP pro-
tocol. It corresponds to the rcVrrpTrap-
NewMaster trap name.

Name CIA

Rcn2kTemperature Signifies that the SNMPv2c entity, acting in
an agent role, has detected the chassis is
overheating.

RcnAggLinkDown Signifies the operational state of the Multi-
Link Trunk (MLT) Aggregator Link changed
from Up to Down.

RcnAggLinkUp Signifies the operational state of the Multi-
Link Trunk (MLT) Aggregator Interface has
changed from Down to Up.

RcnChasFanDown Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcChas-
FanOperStatus object for one of its power
supply units is about to transition into the
Down state.

RcnChasFanUp Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcChas-
FanOperStatus object for one of its power
supply units is about to transition into the Up
state.
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RcnPowerSupplyDown Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcCha-
sPowerSupplyOperStatus object for one of its
power supply units is about to transition into
the Up state.

RcnPowerSupplyUp Signifies the SNMPv2c entity, acting in an
agent role, has detected that the rcCha-
sPowerSupplyOperStatus object for one of its
power supply units is about to transition into
the Up state.

RcnSmltIsLinkDown Signifies the rcChasPowerSupplyOperStatus
object for one of its power supply units is
about to transition into the Down state.

RcnSmltIsLinkUp Signifies the rcChasPowerSupplyOperStatus
object for one of its power supply units is
about to transition into the Up state.

SNMPColdStart Signifies that the sending protocol entity is
reinitializing itself such that the agent's con-
figuration or the protocol entity imple-
mentation may be altered.

Name CIA 5 within a
time period of
5 minutes

SNMPLinkDown Signifies that the sending protocol entity rec-
ognizes a failure in one of the communication
links represented in the agent's configuration.

Name CIA 

IF index

SNMPLinkUp Signifies that the sending protocol entity rec-
ognizes that one of the communication links
represented in the agent's configuration has
come up.

Name CIA 

IF index

SNMPWarmStart Signifies that the sending protocol entity is
reinitializing itself such that neither the agent
configuration nor the protocol entity imple-
mentation is altered.

Name CIA 5 within a
time period of
5 minutes

STPNewRoot Indicates that the sending agent has become
the new root of the Spanning Tree.

Name CIA

STPTopologyChange Sent by a bridge when any of its configured
ports transitions from the Learning state to the
Forwarding state, or from the Forwarding
state to the Blocking state.

Name CIA

NNMi Advanced. SNMP Trap Incident Configurations for Route Analytics Management Servers (RAMS)

Incident Configuration Name Description
Deduplication
Configuration

Rate Con-
figuration

RexASPathChange Signifies the AS path to a route has
changed.
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RexAdjStateDown Signifies the adjacency went down.

RexAdjStateFlap Signifies the adjacency's flap count
(rexEventCount) in the duration given
by rexCountDuration has become
greater than or equal to rex-
EventThreshold.

Both adjacency up and adjacency
down count as flaps. For example: An
adjacency going down and coming up
increments the flap count by two.

RexAdjStateUp Signifies the adjacency came up.

RexBgpRedundChange Signifies a change in the number of
next hops available for reaching a pre-
fix

RexBgpVpnReachByCustGain Signifies the routes in the Customer
announced by PE that are up and not
baselined as compared to the thresh-
old value. The deviation is represented
as either of the following: 

l The number of routes in the Cus-
tomer that are up and not base-
lined

l The percentage of participating
routes in the Customer that are up
and not baselined

RexBgpVpnReachByCustLoss Signifies the routes in the Customer
announced by PE that are down and
not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following: 

l The number of routes in the Cus-
tomer that are down and not base-
lined

l The percentage of participating
routes in the Customer that are
down and not baselined
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RexBgpVpnReachByRtGain Signifies the routes in the Route Target
announced by PE that are up and not
baselined as compared to the thresh-
old value. The deviation is represented
as either of the following: 

l The number of routes in the Route
Target that are up and not base-
lined

l The percentage of participating
routes in the Route Target that are
up and not baselined

RexBgpVpnReachByRtLoss Signifies the routes in the Route Target
announced by PE that are down and
not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following: 

l The number of routes in the Route
Target that are down and not base-
lined

l The percentage of participating
routes in the Route Target that are
down and not baselined

RexPathChange Indicates the a path attributes such as
metric, number of hops, intermediate
hops from a source router to a IP prefix
or NSAP address have changed.

RexPeeringStateDown Indicates a peering between a router
and RAMS has gone down

RexPeeringStateFlap Indicates a peering between a router
and RAMS has gone down.

RexPeeringStateUp Indicates a peering between a router
and RAMS has come up.

RexPrefixDrought Signifies a particular BGP Peer Rib
has decreased significantly from the
Baseline Size as a percentage of the
baseline

RexPrefixFlood Signifies a particular BGP Peer Rib
has increased significantly from the
Baseline Size as a percentage of the
baseline.

RexPrefixStateDown Indicates the pre-
fix(rexDstPrfx,rexDstMask) announced
by Router(rexSrcRtrSysID, rexSrcRtrIP,
rexSrcRtrName) has gone down.
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RexPrefixStateFlap Indicates the prefix (rexDstPrfx,rex-
DstMask) flap count (rexEventCount) in
the duration given by rex-
CountDuration becomes greater than
or equal to rexEventThreshold. Both
prefix up and prefix down count as
flaps. For example: A prefix going
down and coming up increments the
flap count by two.

RexPrefixStateUp Indicates the pre-
fix(rexDstPrfx,rexDstMask) announced
by Router(rexSrcRtrSysID, rexSrcRtrIP,
rexSrcRtrName) has come up.

RexRtrConnected Indicates the first adjacency of a router
becomes full duplex. This means the
neighbor sends an LSA and the pre-
viously isolated router sends an LSA
across that adjacency.

RexRtrIsolated Signifies a router has become isolated
from the rest of the topology as all of its
duplex connections it has to other
routers which are not overloaded with
respect to a particular routing protocol
have gone down.

RexRtrStateFlap Signifies the router's flap count (rex-
EventCount) in the duration given by
rexCountDuration has become greater
than or equal to rexEventThreshold.
Both router isolation and router con-
nection count as flaps. For example: A
router getting isolated and then con-
nected increments the flap count by
two.

RexTest This trap is sent for test purposes

RexVpnPEParticipationByCustGain Signifies the Provider Edges (PEs) par-
ticipating in the Customer that are up
and not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following:

l The number of PEs that are up and
not baselined

l The percentage of participating
PEs that are up and not baselined
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RexVpnPEParticipationByCustLoss Signifies the Provider Edges (PEs) par-
ticipating in the Customer that are
down and not baselined as compared
to the threshold value. The deviation is
represented as either of the following:

l The number of PEs that are down
and not baselined

l The percentage of participating
PEs that are down and not base-
lined

RexBgpVpnReachByRtGain Signifies the routes in the Route Target
announced by PE that are up and not
baselined as compared to the thresh-
old value. The deviation is represented
as either of the following:

l The number of routes in the Route
Target that are up and not base-
lined

l The percentage of participating
routes in the Route Target that are
up and not baselined

RexVpnPEParticipationByRtLoss Signifies the PEs participating in the
Route Target (RT) that are down and
not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following: 

l The number of PEs that are down
and not baselined

l The percentage of participating
PEs that are down and not base-
lined

RexVpnReachByCustPEGain Signifies the routes in the Customer
announced by PE that are up and not
baselined as compared to the thresh-
old value. The deviation is represented
as either of the following: 

l The number of routes in the Cus-
tomer that are up and not base-

lined

l The percentage of participating
routes in the Customer that are up
and not baselined
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RexVpnReachByCustPELoss Signifies the routes in the Customer
announced by PE that are down and
not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following: 

l The number of routes in the Cus-
tomer that are down and not base-
lined

l The percentage of participating
routes in the Customer that are
down and not baselined

RexVpnReachByCustPrefixDown Signifies that the prefix has become
unreachable in Customer.

RexVpnReachByCustPrefixUp Signifies that the prefix has become
reachable in Customer.

RexVpnReachByRtPEGain Signifies the routes in the Route Target
announced by PE that are up and not
baselined as compared to the thresh-
old value. The deviation is represented
as either of the following: 

l The number of routes in the Route
Target that are up and not base-
lined

l The percentage of participating
routes in the Route Target that are
up and not baselined

RexVpnReachByRtPELoss Signifies the routes in the Route Target
announced by PE that are down and
not baselined as compared to the
threshold value. The deviation is rep-
resented as either of the following: 

l The number of routes in the Route
Target that are down and not base-
lined

l The percentage of participating
routes in the Route Target that are
down and not baselined

RexVpnReachByRtPrefixDown Signifies the prefix has become
unreachable in RT.

RexVpnReachByRtPrefixUp Signifies that the prefix has become
reachable in RT.

TrafficHighLinkUtilization Indicates the traffic volume has
exceeded a specified threshold on a

Page 225 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Incidents

Incident Configuration Name Description
Deduplication
Configuration

Rate Con-
figuration

link. Specify the threshold as an abso-
lute number in kilobytes per second or
in terms of percentage of link capacity.

TrafficLinkCoSUtilization Indicates the traffic volume has
exceeded a specified threshold for a
CoS queue on a link. Specify the
threshold as an absolute number in kil-
obytes per second or in terms of a per-
centage of link capacity.

TrafficLowLinkUtilization Indicates the traffic volume has fallen
below a specified threshold on a link.
Specify the threshold as an absolute
number in kilobytes per second or in
terms of percentage of link capacity.

TrafficQuantityAlert A generic trap for all non-link related
traffic alerts. Specify the threshold as
an absolute number in kilobytes per
second or in terms of percentage of
link capacity.

To see or modify these SNMP trap incident configurations:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the SNMP Trap Configuration tab.

3. Select the configuration you want to see or modify.

4. Click the Open icon to see or change the configuration.

5. When you are finished, click Save and Close.

Remote NNM 6.x/7.x Event Configurations Provided by NNMi

NNMi provides the remote NNM 6.x or 7.x incident configurations described in the following table.

Note: If you make changes to an incident configuration provided by NNMi, remember to place your name
in the Author attribute. See "Specify an Author for Your Incident Configuration" (on page 260) for
more information.

Incident Configuration Name Description
Deduplication
Configuration

Rate Con-
figuration

OvStationNormal Generated when a collection station
status is changed to normal/up.

OvStationCritial Generated when a remote collection
status is changed to down/critical.

Remote NNMi Out-of-the-Box Incident Configurations
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OvNodeWarning Generated when NNMi detects the
status of a node has become up (some
or all interfaces on the node are up).

OVNodeMajor Generated when NNMi detects the
status of a node has become up (some
or all interfaces on the node are up).

OvNodeMarginal Generated when NNMi detects the
status of a node has become up (some
or all interfaces on the node are up).

OvNodeUp Generated when NNMi detects the
status of a node has become up (some
or all interfaces on the node are up).

OvNodeDown Generated when NNMi detects the
status of a node has become down (all
interfaces on the node are down).

OvIfUp Generated when NNMi detects the
status of an interface has come up, nor-
mally by responding to an ICMP Echo
(ping) request.

OvIfDown Generated when NNMi detects the
status of an interface has come up, nor-
mally by responding to an ICMP (ping)
request.

OvMessage Generated by a user to display an event
message in the event browser.

OvIfIntermittent Generated when NNMi detects the
status of an interface has gone down
and up multiple times.

OvApaAddressUp Generated by the NNMi Causal Engine
when it detects that the address is
responding to polls.

OvApaIfUp Generated by the NNMi Causal Engine
when it detects that the interface is
responding to polls.

OvApaNodeUp Indicates a node's status went from
Down to Up.

OvApaConnUp Indicates a connection's status went
from Down to Up.

OvApaAggPortUp Indicates the OperStatus for the logical
aggregate port connection is Up.

OvApaAggPortDown Indicates the OperStatus for the logical
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aggregate port connection is Down.

OvApaAggPortDegraded Indicates the OperStatus for one of the
physical port connections in the aggre-
gate connection is Down.

OvApaAggPortConnUp Indicates that an aggregate port con-
nection between two nodes is respond-
ing to polls and no interfaces are down
on either side of the connection.

OvApaAggPortConnDown Indicates an aggregate port connection
between two nodes is not responding to
polls and all interfaces may be down on
both sides of the connection.

OvApaAddressDown Indicates a node's address status went
from Up to Down.

OvApaIfDown Iindicates a node's interface status went
from Up to Down.

OvApaNodeDown Indicates a node's status went from Up
to Down.

OvApaConnDown Indicates a connection's status went
from Up to Down.

OvAPaIfIntermittent Indicates an interface's status has gone
Down and Upmultiple times.

OvApaAddressIntermittent Indicates a node's address status has
gone Down and Up multiple times.

OvApaConnIntermittent Indicates a network's connection status
has gone Down and Up multiple times.

OvApaNodeIntermittent Indicates a node's status has gone
Down and Up multiple times.

OvApaNodeSNMPNotResponding Indicates an SNMP agent is not respond-
ing to queries.

OvApaAggPortNotDegraded Indicates all of the physical port con-
nections in the aggregate connection
are Up.

OvApaIfRemoved Indicates an interface has been
removed.

OvApaBoardUp Indicates a node's board status has
gone from Down to Up.

OvApaBoardDown Indicates a node's board status has
gone from Up to Down.
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OvApaBoardRemoved  Indicates a node's board has been
removed.

To see or modify these Remote NNM 6.x and 7.x trap incident configurations:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the Remote NNM 6.x and 7.x Event Configuration tab.

3. Select the configuration you want to see or modify.

4. Click the Open icon to see or change the configuration.

5. When you are finished, click Save and Close.

Management Event Configurations Provided by NNMi

Note: If you make changes to an incident configuration provided by NNMi, remember to place your name
in the Author attribute. See "Specify an Author for Your Incident Configuration" (on page 260) for
more information.

Deduplication is not configured for out-of-the-box management events. See "Correlate Duplicate Incidents
(Deduplication Configuration)" (on page 269) for information about how to configure deduplication.

Note: The Interface Disabled incident configuration is Disabled by default. See "Generate Interface Dis-
abled Incidents" (on page 298) for more information.

NNMi provides the incident configurations for management events. Click here for more information

Incident Configuration Name Description
Rate Con-
figuration

AddressNotResponding Indicate an address is not responding to
ICMP.

Reasons an address might not respond
include:

l Its node is down

l A device, such as a router, has been mis-
configured so that some addresses can-
not be reached

5 events in 5
minutes

AggregatorDegraded Indicates one or more (but not all) physical
interfaces that are part of the Aggregator
Interface are not operational.

AggregatorDown Indicates the operational status of the Aggre-
gator Interface is down (if monitored), or all of

Management Event Configurations Provided by NNMi
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the corresponding physical interfaces are
Down.

AggregatorLinkDegraded Indicates any Aggregator Interface is oper-
ationally down on either node, when there is
a connection between two Aggregator Inter-
faces.

AggregatorLinkDown Indicates the Aggregator Interface on either
side of an Aggregator Link connection is
down.

BufferOutOfRangeOrMalfunctioning Indicates the buffer pool is exhausted or can-
not meet demand.

ConnectionDown Indicate that both (or all) ends of a con-
nection are not responding to SNMP queries.

5 events in 5
minutes

ConnectionPartiallyUnresponsive Indicates that a connection is partially unre-
sponsive. Reasons for this include that an
undiscovered device in the connection is
down.

CpuOutOfRangeOrMalfunctioning Indicates any of 5 second, 1 minute, or 5 min-
ute utilization averages is too high.

CustomPollCritical Indicates that a Polling Instance associated
with the Custom Poller Collection is in a Crit-
ical State.

CustomPollMajor Indicates that a Polling Instance associated
with the Custom Poller Collection is in a
Major State.

CustomPollMinor Indicates that a Polling Instance associated
with the Custom Poller Collection is in a
Minor State.

CustomPollWarning Indicates that a Polling Instance associated
with the Custom Poller Collection is in a
Warning State.

DuplicateCorrelation Provided as a template for configuring dedu-
plication for an incident to specify which
attribute values NNMi must match to verify
that an incident is a duplicate.

FanOutOfRangeOrMalfunctioning Indicates the specified fan is not operating
correctly.

ImportantNodeorConnectionDown Indicates a node is not responding to an
ICMP or SNMP query. It also indicates that
only one neighbor is down so that the NNMi
Causal Engine cannot determine whether
the node or the connection is down.
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ImportantNodeUnmanageable Indicates a nodes is not responding to an
SNMP query.

InterfaceDisabled Indicates the interface has been explicitly dis-
abled by the device administrator.

5 events in 5
minutes

InterfaceDown Indicates that the interface is not responding
to polls.

5 events in 5
minutes

IslandGroupDown Indicates all nodes in a group of Layer 2 con-
nected nodes do not respond to monitoring
polls (for example, ICMP or SNMP).

These groups are automatically discovered
and contain all of the nodes that can be con-

nected through NNMi topology. Typically,
these are groups on one side of a WAN
(wide area network) connection.

LicenseExpired Indicates the NNMi license has reached its
expiration date and the license capacity is
below the current level required to manage
the discovered nodes.

LicenseMismatch Indicates the Network Node Manager license
capacity does not match the license capacity
of one of the following additional software
licenses in your network environment:

l An Integration Enablement

l An NNM iSPI

LicenseNodeCountExceeded Indicates the number of discovered nodes
exceeds the licensed managed node count.

MemoryOutOfRangeOrMalfunctioning Indicates the Source Node's memory pool is
exhausted or cannot meet the demand for
use.

ModifiedConnectionDown Indicates a connection has been dis-
connected, moved, or both and is not
responding to SNMP queries.

NnmClusterFailover Indicates the NNMi cluster detected a failure
of the active server. NNMi services were
started on the standby server.

NnmClusterLostStandby Indicates the NNMi cluster active server lost
its communication to the standby server.
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NnmClusterStartUp Indicates the NNMi cluster was started in a
state where no active server was already
present. Therefore the server was started in
the active state. 

NnmClusterTransfer Indicates the system administrator moved the
active state from one server to another. The
NNMi services will then start on the new
active server. 

NodeDown Indicates that the NNMi Causal Engine has
determined the node is down based on the
following analysis:

100% of the addresses assigned to this node
are unreachable

The SNMP agent installed on this machine is
not responding

NNMi is communicating with at least two of
the neighboring devices. And at least two
neighboring devices report problems with
connectivity to this node.

5 events in 5
minutes

NodeOrConnectionDown Indicate a node is not responding to an ICMP
 or SNMP query. It also indicates that only
one neighbor is down so that the NNMi
Causal Engine cannot determine whether
the node or the connection is down.

Node Up Note: When configuring Incident Actions or
Diagnostic Selections, use the Node
Down incident configuration and the
Closed Lifecycle State. See "Con-
figure an Action for an Incident" (on
page 283)and "Configure Diagnostics
for an Incident (NNM iSPI NET)" (on
page 291) for more information.

Indicates the node is up based on the fol-
lowing analysis:

l All of the addresses assigned to this
node are reachable.

l The SNMP agent installed on this node is
responding.

l At least two of the neighboring devices
can be reached and are not reporting
problems with connectivity to this node.

NonSNMPNodeUnresponsive Indicates that a Non-SNMP node is unre-
sponsive. Reasons for this include: 1) The
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Incident Configuration Name Description
Rate Con-
figuration

node is down, or 2) An undiscovered device
between the node and the management sta-
tion is down.

PowerSupplyOutOfRangeOrMalfunctioning Indicates a power supply for the Source
 Node is not operating correctly.

RateCorrelation Provided as a template to measure the
number of incoming incidents within a
defined time period.

RrgDegraded Note: This incident occurs only in Router
Redundancy Groups using the HSRP
 protocol and larger than two
members.

Indicates the following:

l The Router Redundancy Group has a pri-
mary and secondary device.

l The remaining devices in the group are
not in an expected protocol-specific state.
For example, in HSRP other devices may
be expected to be in the "Listen" state.

Typically, the protocol-specific com-
munication between routers is mal-
functioning. However, the group is routing
packets properly.

RrgFailover Indicates a primary role (for example, HSRP
Active or VRRP Master) moved from one
device to another in a Router Redundancy
Group.

Reasons for this incident include one or
more of the following:

l A router or interface in the Router Redun-
dancy Group has gone down.

l A tracked object (interface or IP address)
in the Router Redundancy Group has
gone down.

The group is routing packets properly.

RrgMultiplePrimary Indicates that multiple primary devices (for
example, HSRP Active or VRRP Master) are
identified in a Router Redundancy Group.

Typically, the protocol-specific com-
munication between routers in the group is
malfunctioning.
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Incident Configuration Name Description
Rate Con-
figuration

RrgMultipleSecondary Indicates that more than one secondary
device (HSRP Standby ) is identified in a
Router Redundancy Group. Note: This inci-
dent applies only to Router Redundancy
Groups using the HSRP protocol. VRRP
allows more than one secondary role (VRRP
Standby State) . Typically, the protocol-spe-
cific communication between routers in the
group is malfunctioning.

RrgNoPrimary Indicates that no primary device (for exam-
ple, HSRP Active or VRRP Master) is iden-
tified in a Router Redundancy group.

This incident typically indicates one of the fol-
lowing:

l Too many routers are down.

l Protocol-specific communication
between routers in the group is mal-
functioning.

RrgNoSecondary Indicates that no secondary device (for exam-
ple, HSRP Standby or VRRP Backup) is iden-
tified in a Router Redundancy Group.

This incident typically indicates the following:

l Protocol-specific communication
between routers in the group is mal-
functioning.

l The group is routing packets properly
because a single primary device has
been identified.

RrgSecondaryChanged Indicates that a secondary role (for example,
HSRP Standby or VRRP Backup) moved
from one device to another in a Router
Redundancy Group.

This incident typically indicates the following:

l An router or interface in the Router
Redundancy Group has gone down.

l A tracked object (interface or address)
has gone down.

l The group is routing packets properly.

SNMPTrapLimitCritical Indicates the number of SNMP traps per-
sisted in the NNMi database is approaching
the maximum allowed limit. After the max-
imum allowed limit is reached, NNM no
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Incident Configuration Name Description
Rate Con-
figuration

longer accepts SNMP traps until the number
of SNMP traps within the database is
reduced using the nnmtrimincidents.ovpl
command.

SNMPTrapLimitMajor Indicates the number of SNMP traps per-
sisted in the NNMi database has reached or
exceeded 95% of the maximum limit. After
the maximum limit is reached, NNMi only
accepts traps required for Causal Engine
analysis until the number of SNMP traps
within the database has been reduced using
the nnmtrimincidents.ovpl command.

SNMPTrapLimitWarning Indicates the number of SNMP traps per-
sisted in the NNMi database has reached or
exceeded 90% of the maximum limit. After
the maximum limit is reached, NNMi no
longer accepts SNMP traps until the number
of SNMP traps within the database is
reduced using the nnmtrimincidents.ovpl
command.

TemperatureOutOfRangeOrMalfunctioning Indicates the specified temperature sensor
on the Source Node is too hot or too cold.

TrapStorm Indicates a trap storm has occurred.

VoltageOutOfRangeOrMalfunctioning Indicates the specified voltage on one of the
Source Node's power supplies is out of
range.

NNM iSPI for Performance. For network performance monitoring, NNM iSPI for Performance provides addi-
tional management event configurations. Click here for more information.

Each of these configurations has a Category value of Performance, a Family value of Interface, and a
Nature of Root Cause.

Incident Configuration Name Description
Rate Con-
figuration

InterfaceInputDiscardRateHigh Indicates a high input discard rate on the interface. This
percentage is based on the reported change in the
number of input packets on the interface and the dis-
carded packet count.

IntefaceInputErrorRateHigh Indicates a high input error rate on the interface. This
percentage is based on the reported change in the
number of input packets on the interface and the packet
error count.

InterfaceInputUtilizationHigh Indicates a high input utilization on the interface. This

NNM iSPI for Performance. Additional Management Event Configurations                     
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Incident Configuration Name Description
Rate Con-
figuration

percentage is based on the interface speed and the
reported change in the number of input bytes on the
interface.

InterfaceInputUtilizationLow Indicates a low input utilization on the interface. This
percentage is based on the interface speed and the
reported change in the number of input bytes on the
interface.

InterfaceInputUtilizationNone Indicates there is no input utilization on the interface.
This value is based on the interface speed and the
reported change in the number of input bytes on the
interface.

InterfaceOutputDiscardRateHigh Indicates a high output discard rate on the interface.
This percentage is based on the reported change in the
number of input packets on the interface and the dis-
carded packet count.

InterfaceOutputErrorRateHigh Indicates a high output error rate on the interface. This
percentage is based on the reported change in the
number of output packets on the interface and the
packet error count.

InterfaceOutputUtilizationHigh Indicates a high output utilization on the interface. This
percentage is based on the interface speed and the
reported change in the number of output bytes on the
interface.

InterfaceOutputUtilizationLow Indicates a low output utilization on the interface. This
percentage is based on the interface speed and the
reported change in the number of output bytes on the
interface.

InterfaceOutputUtilizationNone Indicates there is no output utilization on the interface.
This value is based on the interface speed and the
reported change in the number of output bytes on the
interface.

To see or modify these management event incident configurations:

1. Navigate to the Incident Configuration view.

a. In the workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the Management Event Configuration tab.

3. Select the configuration you want to see or modify.

4. Click the Open to see or change the configuration.

5. When you are finished, click Save and Close.
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Incident Pair (Pairwise) Configurations Provided by NNM

NNM provides the pairwise configurations described in the following table.

Name Desciption

CiscoLinkDownUpPair Cancels a CiscoLinkDown incident with a CiscoLinkUp inci-
dent on the same interface for the same SNMP agent address.

This configuration is used for known Cisco devices.

NodeDownUpPair Cancels a NodeDown incident with a NodeUp incident from
the same node.

OvApaAddressDownUpPair Cancels an NNM 6.x or 7.x Node Down event with a NNM 6.x
or 7.x Node Up event from the same SNMP agent address.

OvApaAggPortConnDownUpPair Cancels an NNM 6.x or 7.x APA Aggregate Port Connection
Down event with an NNM 6.x or 7.x APA Aggregate Port Con-
nection Up event.

OvApaAggPortDegradeNotDegradePair Cancels an NNM 6.x or 7.x APA Aggregate Port Degraded
event with an NNM 6.x or 7.x APA Aggregate Port Not
Degraded event on the same interface for the same SNMP
 agent address.

OvApaAggPortDownUpPair Cancels of an NNM 6.x or 7.x APA Aggregate Port Down event
with an NNM 6.x or 7.x APA Aggregate Port Up event on the
same interface for the same SNMP agent address.

OvApaBoardDownUpPair Cancels an NNM 6.x or 7.x APA Board Down event with an
NNM 6.x or 7.x APA Board Up event from the same SNMP
 agent address.

OvApaConnDownUpPair Cancels an NNM 6.x or 7. x APA Address Down event with an
NNM 6.x or 7.x APA Address Up event on the same address
for the same SNMP agent address.

OvApaIfDownUpPair Cancels an NNM 6.x or 7.x APA If Down event with an NNM
 6.x or 7.x APA If Up event on the same interface for the same
SNMP agent address.

OvApaNodeDownUpPair Cancels an NNM 6.x or 7.x APA Node Down event with an
NNM 6.x or 7.x APA Node Up event from the same SNMP
 agent address.

OvIfDownUpPair Cancels an NNM 6.x or 7.x If Down event with an NNM 6.x or
7.x If Up event on the same interface for the same SNMP agent
address.

OvNodeDownUpPair Cancels an NNM 6.x or 7.x Node Down event with an NNM 6.x
or 7.x Node Up event from the same SNMP agent address.

RcAggLinkDownUpPair Cancels an RcAggLinkDown incident with an RcAggLinkUp
incident from the same Multi-Link Trunk (MLT) Aggregator ID
(from the MIB) and SNMP agent address.

Pairwise Configurations Provided by NNM
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Name Desciption

RcChasFanDownUpPair Cancels an RcChasFanDown incident with an RcChasFanUp
incident from the same fan ID (from the MIB) and SNMP agent
address.

RcChasPowerSupplyDownUpPair Cancels an RcChasPowerSupplyDown incident with an
RcChasPowerSupplyUp incident from the same power supply
ID (from the MIB) and SNMP agent address.

RcSmltIsLinkDownUpPair Cancels an RcSmltIstLinkDown incident with an RcSmltIst-
LinkUp incident from the same SNMP agent address.

RcnAggLinkDownUpPair Cancels an RcnAggLinkDown incident with an RcnAggLinkUp
incident from the same Multi-Link Trunk (MLT) Aggregator Link
ID (from the MIB) and SNMP agent address.

RcnChasFanDownUpPair Cancels an RcnChasFanDown incident with an RcnChas-
FanUp incident from the same fan ID (from the MIB) and SNMP

agent address.

RcnChasPowerSupplyDownUpPair Cancels an RcnChasPowerSupplyDown incident with an
RcnChasPowerSupplyUp incident from the same power
supply ID (from the MIB) and SNMP agent address.

RcnSmltIsLinkDownUpPair Cancels an RcnSmltIstLinkDown incident with an RcnSmltIst-
LinkUp incident from the same SNMP agent address.

SnmpLinkDownUpPair Cancels an SNMPLinkDown incident with an SNMPLinkUp
incident on the same interface for the same SNMP agent
address. 

To see or modify these incident pair configurations:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the Pairwise Configuration tab.

3. Select the configuration you want to see or modify, and click  Open to see or change the con-
figuration.

In the Pairwise Configuration form, click Help→ Using the Pairwise Configuration form for more
information.

4. When you are finished, click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNM saves your changes.

Configure Network Devices to Send SNMP Notifications to NNMi

An SNMP notification is a message sent from an SNMP agent on a network device to notify a network man-
agement system of an event on the network device. For example, an error occurred on the network device
and its SNMP agent sent a notification. The notification may either be an acknowledged inform (SNMPv2c
InformRequest) or an unacknowledged trap (SNMPv1 TrapResponse or SNMPv2cTrap).
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An inform is an acknowledged notification sent from one SNMP agent to another with the expectation of a
reply from the recipient. If no reply is received, the inform message is resent. A trap is a notification sent
from one SNMP agent to another without any expectation of a reply.

Configure SNMP agents in your network environment to send traps to the NNMi management server.
Sometimes SNMP agents are configured with a recheck interval, so the trap might be sent to the NNMi
management server over and over again until the problem is corrected.

The NNMi Causal Engine analyzes these traps and gathers additional information to determine the root
cause. It also provides useful troubleshooting information each time an important SNMP notification is
received, including the following information:

l The name or address of the node from which the notification came (Source Node)

l The notification identification (SNMP Object ID)

l Notification-specific variables (varbinds)

When configuring the SNMP agent on each network device, configure the agent's trap-forwarding list (or
trap-destination list) to include the NNMi management server's fully-qualified hostname or IP address.

Refer to the agent's documentation for information about how to do this. If the NNMi management server is
included on the trap-forwarding list, NNMi receives notice from the agent when something goes wrong
(even if the device does not show up on your NNMi maps).

Note: For an SNMP notification to be processed by NNMi, it must be configured using the NNMi incident
Configuration workspace. Many common SNMP notifications are configured in NNMi by default.
See "Configure SNMP Trap Incidents" (on page 246) and "SNMP Trap Incident Configurations Pro-
vided by NNMi" (on page 216) for more information.

Configure SNMP Trap Forwarding

NNMi enables you to configure SNMP trap forwarding using the Incident Configuration workspace. This
feature is useful when you want to forward traps to a specified destination. For example, you might want to
forward certain kinds of traps to one server and forward another set of traps to a different server so they
can be managed separately. 

When configuring SNMP trap forwarding you perform the following tasks:

l "Configure NNMi Security Settings for SNMPv3 Trap Forwarding" (on page 239)

l "Configure Trap Forwarding Filters" (on page 241)

l "Configure Trap Forwarding Destinations" (on page 243)

Configure NNMi Security Settings for SNMPv3 Trap Forwarding

Note: If your network environment uses SNMPv2c or SNMPv1 and does not use SNMPv3, skip this task.

If your network environment uses SNMPv3, specify which user-based security model (USM) settings the
NNMi management server uses when NNMi acts as an authoritative entity in the following situations:

l Forwarding SNMPv3 traps to other devices in your network environment

l Sending responses to SNMPv3 Inform-Requests

The settings in this form grant permission for NNMi to use the specified SNMPv3 engine.

Note: When receiving SNMPv3 data, NNMi must decrypt the data received based on your settings in the
Communication Configuration workspace. See "Configure Default SNMPv3 Settings" (on page 54). 

To configure the NNMi management station as an authoritative entity for SNMPv3:
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1. Navigate to the Incident Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

2. Navigate to the NNMi SNMPv3 Trap Forwarding Security Settings group.

3. NNMi displays the ID of the SNMPv3 engine assigned to NNMi. See the attribute value for NNMi
SNMPv3 Engine Id.

4. Provide the USM information that NNMi uses for authentication and privacy when using SNMPv3 pro-
tocol for sending traps or responses to Inform-Requests to other devices in your network environment
(see table).

5. Click Save and Close to save your changes.

Attribute Description

NNM SNMPv3 Engine
Id

Remote devices must use this SNMPv3 engine ID when sending traps to
NNMi.

SNMPv3 Engine Assigned to NNMi management server

Attribute Description

User Name The SNMPv3 user name text string used by the NNMi management server.

Authentication
Protocol

The SNMPv3 authentication protocol. Determines whether authentication is required
and indicates the type of authentication protocol used. NNMi supports the following pro-
tocols:

l HMAC-MD5-96 authentication protocol

l HMAC-SHA-1 authentication protocol

Authentication
Passphrase

The SNMPv3 USM authentication passphrase used by the NNMi management server. If
required for authentication, provide the appropriate authentication passphrase for the
authentication protocol.

The length limitations of the authentication passphrase depend on the authentication
protocol. 

Privacy Pro-
tocol

Specify the SNMPv3 USM privacy protocol used by the NNMi management server.

This determines whether encryption is required and indicates the type of privacy pro-
tocol used. NNMi supports the DES-CBC Symmetric Encryption Protocol.

Privacy Pass-
phrase

Specify the SNMPv3 USM privacy passphrase used by the NNMi management server.

If required for privacy, provide the appropriate encryption passphrase for use with the pri-
vacy protocol.

The length limitations of the privacy passphrase depend on the privacy protocol.

SNMPv3 Settings of the NNMi management server's User-Based Security Model (USM)
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Configure Trap Forwarding Filters

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information.

Use the Incident Configuration: Trap Forwarding Filters tab to configure a filter expression to specify the
SNMP trap Object Identifier (OID) pattern you want to use to determine which SNMP traps NNMi forwards.
The traps which pass the filter you specify can then be forwarded to a specified destination using the Trap
Forwarding Destinations tab. See "Configure Trap Forwarding Destinations" (on page 243) for more infor-
mation.

To configure SNMP Trap Forwarding Filters:

1. Navigate to the Incident Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the Trap Forwarding Filters tab.

3. Do one of the following:

n To create an SNMP Trap Forwarding Filter configuration, click the  New icon, and continue.

n To edit an SNMP Trap Forwarding Filter configuration, click the  Open icon, and continue.

n To delete an SNMP Trap Forwarding Filters configuration, click the  Delete icon.

4. In the SNMP Trap Configuration form, provide the required information.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

The next time that a trap of this type arrives, NNMi uses the filter you specify to determine whether to for-
ward the trap to a specified destination.

Trap Forwarding Filters Form

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information.

The Trap Forwarding Filters Form enables you to specify the SNMP trap Object Identifier (OID) pattern you
want to use to determine which SNMP traps NNMi forwards. The traps which pass the filter you specify can
then be forwarded to a specified destination using the Trap Forwarding Destinations tab. See "Configure
Trap Forwarding Destinations" (on page 243) for more information.

To configure SNMP Trap Forwarding Filters:

1. Navigate to the Incident Configuration form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the SNMP Trap Forwarding Filters tab.
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3. Make your configuration choices (see table).

n To add an SNMP Trap Forwarding Filter configuration, click the New icon, and continue.

n To edit an SNMP Trap Forwarding Filter configuration, click the Open icon, and continue.

n To delete an SNMP Trap Forwarding Filter configuration, click the Delete icon.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your changes.

Attribute Description

Name Enter the name you want to use for this SNMP Trap Forwarding Filter con-
figuration.

Alpha-numeric and special characters (~ ! @ # $ % ^ & * ( ) _+) are
allowed. No spaces are allowed.

"Trap Forwarding Filter
Expression Form" (on page
242)

Access the Trap Forwarding Filter Expression form to specify the valid
SNMP Object Identifier (OID) pattern to be used for the SNMP trap filter.

SNMP Trap Forwarding Filters Configuration

Trap Forwarding Filter Expression Form

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information.

The Trap Forwarding Filter Expression Form enables you to specify the SNMP trap Object Identifier (OID)
 pattern you want to use to filter incoming SNMP traps. The traps which pass the filter you specify can then
be forwarded to a specified destination using the Trap Forwarding Destinations tab. See "Configure Trap
Forwarding Destinations" (on page 243) for more information.

To configure an SNMP Trap Forwarding Filter Expression:

1. Navigate to the Trap Forwarding Filter Expressions form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Forwarding Filters tab.

d. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

e. On the form that opens, navigate to the Filter Expressions tab.

f. Locate the Filter Expressions List table.

g. Do one of the following:
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o To add a Trap Forwarding Filter Expression, click the  New icon.

o To edit an existing Trap Forwarding Filter Expression, select a row, and click the
 Open icon.

2. Make your configuration choices (see table).

3. Click Save and Close to return to the Incident Configuration form.

4. Click Save and Close to save your changes.

Attribute Description

Object iden-
tifier (OID)
Pattern

Enter the SNMP Object Identifier (OID) pattern you want to use for the SNMP trap filter.
Valid values include:

l The entire SNMP trap OID value. For example: .1.3.6.1.6.5.66.7.1225

l The SNMP trap OID value that includes a wildcard as a placeholder for the missing
values. For example, to specify only the SNMP trap OID matching prefix:
.1.3.6.1.6.5.66.7.*

l The SNMP trap OID valid range. For example: .1.3.6.1.6.5.66.7.1225 - 1235
.

SNMP Trap Forwarding Filter Expression Configuration

Configure Trap Forwarding Destinations

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information. You must also create the Trap For-
warding Filters for the SNMP traps you want to forward. See "Configure Trap Forwarding Filters" (on
page 241) for more information.

The Trap Forwarding Destinations tab enables you to specify the servers to which you want to forward
SNMP traps. Use this tab to also specify the Trap Forwarding Filters to be used for this destination.

To configure SNMP Trap Forwarding Destinations:

1. Navigate to the Incident Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the SNMP Trap Forwarding Destinations tab.

3. Do one of the following:

l To create an SNMP Trap Forwarding Destination configuration, click the  New icon, and continue.

l To edit an SNMP Trap Forwarding Destination configuration, click the  Open icon, and continue.

l To delete an SNMP Trap Forwarding Destination configuration, click the  Delete icon.

2. In the "Trap Forwarding Filter Association Form" (on page 245), provide the required information.

3. Click Save and Close to return to the Incident Configuration form.
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4. Click Save and Close to save your changes.

The next time a trap that passes the Trap Forwarding Filter arrives, NNMi forwards the trap to the specified
Trap Forwarding Destination.

Trap Forwarding Destination Form

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information. You must also create the Trap
Forwarding Filters for the SNMP traps you want NNMi to forward. See "Configure Trap Forwarding
Filters" (on page 241) for more information.

The Trap Forwarding Destinations form enables you to specify the servers to which you want NNMi to for-
ward SNMP traps.

To configure an SNMP Trap Forwarding Destination:

1. Navigate to the Incident Configuration form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the SNMP Trap Forwarding Destinations tab.

3. Make your configuration choices (see table).

n To add an SNMP Trap Forwarding Destination configuration, click the New icon, and con-
tinue.

n To edit an SNMP Trap Forwarding Destination configuration, click the Open icon, and con-
tinue.

n To delete an SNMP Trap Forwarding Destination configuration, click the Delete icon.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your changes.

Attribute Description

Name Enter the name you want to use for this SNMP Trap Forwarding Destination con-
figuration.

Alpha-numeric and special characters (~ ! @ # $ % ^ & * ( ) _+) are allowed. No spaces
are allowed.

IP Address Enter the IP address for the destination server.

Port Enter the UDP port number for the destination server.

Forwarding
Options

l Default - NNMi processes the trap prior to forwarding. Click here for more infor-
mation.

NNMi adds two new varbinds to the trap for storing origin address information:

n Origin IP Address

SNMP Trap Forwarding Destination Configuration
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Attribute Description

n Origin IP Address type

See "SNMP Trap Varbinds Provided by NNMi" (on page 246) for more information.

l SNMPv3 to SNMPv2 Conversion - NNMi converts an incoming SNMPv3 trap to
SNMPv2. Click here for more information.

When converting SNMPv3 traps to SNMPv2c traps, NNMi does the following:

n Includes a Context Name varbind - Contains the contextName from the original
SNMPv3 trap.

n Creates a Community Name - The Context Engine ID and User Name of the
original SNMPv3 trap are combined as follows: username@contextEngineID.
For example, ciscoAdmin@8000000b7f3cbec5632b47455e97070c

l Original Trap (UNIX only) - NNMi forwards the trap without any changes.

Specify the
Trap For-
warding Filters
to Use

Use the Trap Forwarding Filters form to specify the Trap Forwarding Filters con-
figurations to use. These filters determine which traps NNMi forwards to the destination
you specify.

Trap Forwarding Filter Association Form

Pre-requisite: Make sure you have used the NNMi nnmincidentcfg.ovpl command line utility to auto-
matically create or update the incident configurations for the SNMP traps you want to include. See
"Load SNMP Trap Definitions" (on page 247) for more information. You must also create the Trap For-
warding Filters for the SNMP traps you want to forward. See "Configure Trap Forwarding Filters" (on
page 241) for more information.

The Trap Forwarding Filter Association Form enables you to specify the Trap Forwarding Filters that you
want to apply for the SNMP traps NNMi forwards to the specified Trap Forwarding Destination.

To configure the SNMP Trap Forwarding Filters:

1. Navigate to the Trap Forwarding Filter Association form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Forwarding Destination tab.

d. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

e. On the form that opens, navigate to the Trap Forwarding Filter Association tab.

f. Locate the Trap Forwarding Filter List table.

g. To select a Trap Forwarding Filter, click the  New icon.

2. Make your configuration choices (see table).
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3. Click Save and Close to return to the Incident Configuration form.

4. Click Save and Close to save your changes.

Attribute Description

Trap For-
warding
Filter

Click the Lookup icon, and select Open from the drop-down menu to view and select

the Trap Forwarding Filter you want to use for the current Trap Forwarding Destination.

SNMP Trap Forwarding Filter

SNMP Trap Varbinds Provided by NNMi

NNMi provides the following varbinds for use when forwarding SNMP traps.

Note: NNMi does not create these varbinds if the Forwarding Options attribute is set to Original Trap (UNIX
only) when configuring trap forwarding destinations. See "Trap Forwarding Destination Form" (on
page 244) for more information.

Name oid Type Description

Origin IP
 address

.1.3.6.1.4.1.11.2.17.2.19.1.1.3 InetAddress Contains the IP address of the original
SNMP notification that generated the trap.

Origin IP
Address
type

.1.3.6.1.4.1.11.2.17.2.19.1.1.2  InetAddressType Contains the type of the IP address of the
Original IP Address varbind. The value "1"
indicates IPv4.

Context
Name

.1.3.6.1.4.1.11.2.17.2.19.1.1.1 SnmpAdminString Contains the contextName present in the
original SNMPv3 notification. This varbind
is present only when NNMi converts an
SNMPv3 notification to an SNMPv2c trap.  
See "Trap Forwarding Destination Form"
(on page 244)for more information.

SNMP Trap Varbinds Provided by NNMi

Configure SNMP Trap Incidents

Configure incidents that originate from an SNMP trap.

To configure incidents originating from SNMP traps:

1. Navigate to the Incident Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the SNMP Trap Configuration (by OID) or SNMP Trap Configuration (by Name) tab.

3. Do one of the following:

l To create an SNMP trap configuration, click the  New icon, and continue.

l To edit an SNMP trap configuration, click the  Open icon, and continue.

l To delete an SNMP trap configuration, click the  Delete icon.
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1. In the SNMP Trap Configuration form, provide the required information.

2. Click Save and Close to return to the Incident Configuration form.

3. Click Save and Close to save your changes.

The next time that a trap of this type arrives, NNMi creates an associated incident to display in the appro-
priate incident views.

Load SNMP Trap Definitions

The NNMi nnmincidentcfg.ovpl -load script provides a way for you to automatically create or update
an incident configuration for an SNMP trap using a MIB file. To load a MIB file, you can use the following
syntax:

nnmincidentcfg.ovpl -loadTraps <mib_file> -disableAllTraps true|false -u <NNMi-
adminUsername> -p <NNMiadminPassword> | -loadMib <mib_file>

Note: See nnmincidentcfg.ovpl for more information, including a complete list of the valid script arguments.

Argument Description

-loadTraps <
mib_file>

Used to load the MIB file <mib_file> that you want to use to create or update the inci-
dent configuration for an SNMP trap.

NNMi uses information from the trap definitions (TRAP-TYPES macro) or notification
(NOTIFICATION-TYPES macro) in the MIB file for the required incident configuration.

-dis-
ableAllTraps

Specifies whether all trap definitions specified using -loadTraps <mib_file> should
be loaded as disabled.

Note: The default value is false. This means that by default all trap definitions spec-
ified in <mib_file> are loaded as enabled. Set this parameter to true to disable
the trap definitions that you are loading.

-u The NNMi user name. This user must be assigned to at least an NNMi administrator
role.

Note: The user name might be a Principal object stored in the NNMi database or might
be from your environment's directory service database (depending on NNMi con-
figuration). See "Configure Sign-In Access" (on page 32) for more information.

-p The password associated with the NNMi account.

Note: The password might be an attribute in an Account object stored in the NNMi data-
base or might be from your environment's directory service database (depend-
ing on NNMi configuration). See "Configure Sign-In Access" (on page 32) for
more information.

-loadMIB <
mib_file>

Used to load a MIB file for the cases in which the <mib_file> specified with -loadTraps
has dependencies.

nnmincidentcfg.ovpl Arguments

For example, to load the MIB file CISCO-VTP_MIB, you might enter the following:

nnmincidentcfg.ovpl -loadTraps "C:\Cisco Mibs\CISCO-VTP-MIB.my"
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If the incident is already configured, NNMi performs an update based on the MIB file information. If the inci-
dent is not configured, NNMi creates a new incident configuration entry for the SNMP trap. See "Configure
SNMP Trap Incidents" (on page 246) for information about changing an SNMP trap configuration.

SNMP Trap Configuration Form

To configure incidents originating from SNMP traps:

1. Navigate to the Incident Configuration form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the SNMP Trap Configuration tab.

3. Make your configuration choices (see table).

Note: If you want to add or edit an SNMP trap configuration, verify that Enabled is selected.

n To add an SNMP trap configuration, click the New icon, and continue.

n To edit an SNMP trap configuration, click the Open icon, and continue.

n To delete an SNMP trap configuration, click the Delete icon.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your changes.

Task How

"Specify the Incident Configuration Name"
(on page 249)

Use the Basics pane of the SNMP Trap form. Specify a
name that helps you to identify the configuration for sub-
sequent use.

"Specify the SNMP Object ID" (on page
249)

Use the Basics pane of the SNMP Trap form. NNMi sup-
ports SNMPv2c and SNMPv1 formats.

Specify whether you want to enable this
configuration.

In the Basics group of the SNMP Trap form, verify that Ena-

ble is selected for each configuration you want to use.

"Display an SNMP Trap or NNM 6.x/7.x
Events as a Root Cause Incident" (on page
251)

Use the Basics pane of the SNMP Trap form.

"Specify Category and Family Attribute
Values for Organizing Your Incidents" (on
page 251)

Use the Basics pane of the SNMP Trap form. You can
organize your incidents using Category and Family.

"Specify the Incident Severity " (on page
255)

Use the Basics pane of the SNMP Trap form. Possible
Severity values include: Normal, Warning, Minor, Major,
and Critical.

"Specify Your Incident Message Format"
(on page 255)

Use the Basics pane of the SNMP Trap form. The mes-
sage format determines the message to be displayed for
the incident.

Tasks for SNMP Trap Configuration

Page 248 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Configuring Incidents

Task How

"Specify a Description for Your Incident
Configuration" (on page 260)

Use the Basics pane of the SNMP Trap form. Provide a
meaningful description.

"Specify an Author for Your Incident Con-
figuration" (on page 260)

Use the Basics pane of the SNMP Trap form.

After you complete the Basic Configuration for the SNMP trap, you can also choose to configure the infor-
mation described in the following table.

Task How

"Correlate Duplicate Inci-
dents (Deduplication Con-
figuration)" (on page 269)

Select the Deduplication Configuration tab to specify duplicate incidents
that you want to be suppressed.

"Track Incident Frequency
(Rate: Time Period and
Count)" (on page 273)

Select the Rate Configuration tab to specify a rate for duplicate incidents.
After the rate limit is reached, NNMi generates an Incident to notify you of
the problem.

"Configure an Action for an
Incident" (on page 283)

Select the Action Configuration tab to specify actions that should occur
automatically when an incident is either generated or closed.

"Configure Diagnostics for
an Incident (NNM iSPI NET)"
(on page 291)

Select the Configuration Per Node Group tab to specify diagnostic
actions that should occur automatically when an incident is generated for
a node that belongs to a particular Node Group.

Additional Configurations

Specify the Incident Configuration Name

When providing the Name for an incident configuration, use the following guidelines:

Name
The name is used to identify the incident configuration and must be unique. Use a name that will help you
to remember the purpose or kind of management event, remote NNM 6.x or 7.x event, or SNMP trap whose
incident you are configuring. Name is also used to identify your Pairwise configurations.

Specify the SNMP Object ID

When configuring incidents whose source is an SNMP trap, you are asked to provide the SNMP Object ID
values that you want to use to assist you in identifying the trap.

NNMi requires that SNMPv1 trap object identifiers be converted to SNMPv2c format. The SNMP Object IDs
must be entered in a format that is recognized by NNMi. Select the type of SNMP trap you want to con-
figure from the list below to learn about the required NNMi format.

Note: In all cases, the value you enter for an SNMP Object ID must be unique.

l "SNMP Object ID Format for SNMPv2c Traps" (on page 250)

l "SNMP Object ID Format for SNMPv1 Generic Traps" (on page 250)
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l "SNMP Object ID Format for a Specific SNMPv1 Trap" (on page 251)

SNMPv1 generic traps are standard traps that are commonly used across vendors. The SNMPv1 enter-
prise specific traps are those traps that are generated by a particular vendor's device. The vendor is also
known as the enterprise. Both include a vendor name as part of the set of information stored with each
trap.

SNMP Object ID Format for SNMPv2c Traps

NNMi stores all SNMP trap information in SNMPv2c format.

To specify an SNMPv2c trap object ID, use the MIB definition file for the device of interest. The MIB file
includes object identifiers for all of the traps that the SNMP agent generates for a particular device.

In the SNMP Object ID attribute of the SNMP Trap Configuration (by OID), SNMP Trap Configuration (by
Name), or Remote NNM 6.x/7.x Configuration form, enter the SNMP object identifier value for the trap that
you want to see in the console incident views.

SNMP Object ID Format for SNMPv1 Generic Traps

NNMi requires SNMPv1 trap object IDs to be converted to SNMPv2c format. The object IDs are converted
according to the specifications in Request for Comments (RFC) document 2576: Coexistence between Ver-
sion 1, Version 2, and Version 3 of the Internet-standard Network Management Framework.

When using SNMPv1 format, you can specify either generic or vendor specific traps. SNMPv1 generic
traps are standard traps that are commonly used across vendors. The SNMPv1 enterprise specific traps
are those traps that are generated by a particular vendor's device. The vendor is also known as the enter-
prise. Both include a vendor name as part of the set of information stored with each trap.

The six SNMPv1 generic traps have the following SNMP object identifiers that are recognized by
SNMPv2c: 

1.3.6.1.6.3.1.1.5.1 (coldStart) 

1.3.6.1.6.3.1.1.5.2 (warmStart) 

1.3.6.1.6.3.1.1.5.3 (linkDown) 

1.3.6.1.6.3.1.1.5.4 (linkUp) 

1.3.6.1.6.3.1.1.5.5 (authenticationFailure) 

1.3.6.1.6.3.1.1.5.6 (egpNeighborLoss)     

To configure an SNMP object identifier (SNMP OID) for a generic SNMPv1 trap, specify the SNMP object
ID as described in RFC 2576. You also need to include the object identifier for the vendor name (<Ven-
dorEnterprise>) as shown below:

<SNMPv2c generic trap OID>.<VendorEnterprise

The <vendorEnterprise> is the object identifier for the vendor that is included with the varbind trap infor-
mation.

For example, the SNMP object identifier for Cisco warmStart trap would be:

.1.3.6.1.6.3.1.1.5.2.1.3.6.1.4.1.9

Note: Cisco's Vendor enterprise object identifier in this example is .1.3.6.1.4.1.9
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SNMP Object ID Format for a Specific SNMPv1 Trap

NNMi requires SNMPv1 trap object identifiers to be converted to SNMPv2c format. The object IDs are con-
verted according to the specifications in RFC 2576: Coexistence between Version 1, Version 2, and Ver-
sion 3 of the Internet-standard Network Management Framework.

When using SNMPv1 format, you can specify either generic or vendor specific traps. SNMPv1 generic
traps are standard traps that are commonly used across vendors. The SNMPv1 enterprise specific traps
are those traps that are generated by a particular vendor's device. The vendor is also known as the
entrprise. Both include a vendor name as part of the set of information stored with each trap.

When specifying the SNMP object ID for an SNMPv1 specific trap, include the SNMP object ID for the ven-
dor name and for the trap that you want to see in the console incident views.

The value you enter must be in the format:

<VendorEnterprise>.0.<SpecificTrapNumber>

The <VendorEnterprise> is the object identifier for the vendor that is included in the SNMPv1 trap. The <

SpecificTrapNumber> is the SNMPv1 specific trap identification number that is provided by the vendor. 

For example, for an SNMPv1 vendor object id 1.3.6.1.3.1.12.9 and specific trap number 12234, the SNMP
object ID would be:

1.3.6.1.3.1.12.9.0.12234

Display an SNMP Trap or NNM 6.x/7.x Events as a Root Cause Incident

SNMP trap and NNM 6.x/7.x events normally appear as symptoms rather than as root cause incidents.
However, there might be times when you want an SNMP or NNM 6.x/7.x event to appear as a root cause
incident. For example, you might want an HSRP state change (cHsrpStateChange,
1.3.6.1.4.1.9.9.106.2.0.1) trap to be listed as a root cause. This trap might occur when the hot standby has
gone down indicating the system is at risk if there is a failover.  

Note: To reduce "noise" associated with duplicate incidents, NNMi changes the incident Correlation
Nature to Symptom for any user-defined Root Cause incidents that exceed the rate or dedu-
plication threshold. Any Stream Correlation incident associated with the user-defined Root Cause
incident is change to a Root Cause incident. See Stream Correlation Incidents View for more infor-
mation about Stream Correlations.

To display an SNMP trap or NNM 6.x/7.x Event as a root cause incident:

Select Root Cause in the SNMP Trap or Remote NNM 6.x/7.x Event Configuration form.

The next time the incident occurs, the Correlation Nature attribute value changes to Root Cause.

To no longer display an SNMP trap or NNM 6.x/7.x Event s a root cause incident:

Clear Root Cause in the SNMP Trap or Remote NNM 6.x/7.x Event Configuration form.

The next time the incident occurs, the Correlation Nature attribute value changes to Root Cause.

Specify Category and Family Attribute Values for Organizing Your Incidents

When configuring incidents, NNMi provides the Category and Family attributes to help you organize your
incidents.
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Preconfigured Categories
The Category attribute helps you organize your incidents. Select the category that you want to be asso-
ciated with this type of incident when it appears in an incident view. Each of the possible Category values
is described in the following table.

Category Description

Accounting Used to indicate problems related to usage statistics and allocation of costs associated
with the billing of time and services provided by devices. This category is not used by
NNMi with default configurations, but it is available for incidents you define. 

Application
Status

Indicates there is a problem with the health of the NNMi software. Examples of these
kinds of events include license expiration or that a certain NNMi process lost connection
to the Process Status Manager.

Configuration Indicates there is a problem with the configuration of a managed device. For example,
there is a physical address mismatch

Fault Indicates a problem with the network, for example Node Down.

Performance Indicates a threshold has been exceeded. For example, a utility has exceeded 90 per-
cent

Security Indicates there is a problem related to authentication. For example, an SNMP authen-
tication failure

Status Indicates some kind of status message. Examples of these kinds of incidents include
"SNMP Link Up" or an "HSRP Group status Normal" message.

Incident Categories Provided by NNMi

Note: You can add your own Category entries to NNMi. See "Create an Incident Category" (on page 253)
for more information.

Preconfigured Families

The Family attribute provides another way to organize and sort your incident views. For example, you
might choose to sort by Family to see all of the incidents related to interfaces or to connections.

The following table describes only some of the Family attribute values from which you can select.

Family Description

Address Indicates the incident is related to an address problem

Aggregated
Port

Indicates the incident is related to an aggregated port problem

Board Indicates the incident is related to an board problem

Connection Indicates the incident is related to a problem with one or more connections

Correlation Indicates the incident has been related to another incident. For example, a LinkDown inci-
dent might be correlated as a child to a LinkUp incident.

HSRP Indicates the incident is related to an HSRP problem

Incident Families Provided by NNMi
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Family Description

Interface Indicates the incident is related to a problem with one or more interfaces.

Node Indicates the incident is related to a node problem

OSPF Indicates the incident is related to an OSPF problem

Note: You can add your own Family entries to NNMi. See "Create an Incident Family" (on page 254) for
more information.

Create an Incident Category

The Category attribute helps you organize your incidents. Create any Category that makes sense to you
and your team. For a list of the Category codes provided by NNMi, "Specify Category and Family Attribute
Values for Organizing Your Incidents" (on page 251).

To create a new incident Category:

1. Navigate to the Incident Category form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Locate one of the following:

o The SNMP Trap Configuration (by OID) or SNMP Trap Configuration (by Name) tab.

o The Remote NNM 6.x/7.x Event Configuration tab.

o The Management Event Configuration tab.

Do one of the following:

o Click the  New icon.

o Select a row, click the  Open icon.

d. In the configuration form, locate the Category attribute.

e. Click the  Lookup icon, and select  New.

2. Provide the required information (see table).

3. Click Save and Close to return to the previous form.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi applies your changes.

Name Description

Label Incident category name. For example, Hardware Faults, or Cisco Error. Maximum size is 255
characters. Any character type is valid.

Unique
Key

Caution: After you click Save and Close, this value cannot be changed.

Used as a unique identifier when exporting and importing configuration definitions. To ensure
that the value you enter is unique, it is recommended that you use the Java name space con-

Category Code Attributes
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Name Description

vention when providing this value. It is also useful to include the label value as part of the
unique key as shown in the following examples:

com.<your_company_name>.nnm.trapConf.category.<category_label>

com.<your_company_name>.nnm.eventConf.category.<category_label>

com.<your_company_name>.nnm.inciConf.category.<category_label>

The maximum length is 80 alpha-numeric characters, periods allowed, no spaces allowed.

Create an Incident Family

The Family attribute helps you organize your incidents. Create any Family that makes sense to you and
your team. For a list of the Family codes provided by NNMi, "Specify Category and Family Attribute Values
for Organizing Your Incidents" (on page 251).

To create a new incident Family:

1. Navigate to the Incident Family form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Locate one of the following:

o The SNMP Trap Configuration (by OID) or SNMP Trap Configuration (by Name) tab.

o The Remote NNM 6.x/7.x Event Configuration tab.

o The Management Event Configuration tab.

Do one of the following:

o Click the  New icon.

o Select a row, click the  Open icon.

d. In the configuration form, locate the Family attribute.

e. Click the  Lookup icon, and select  New.

2. Provide the required information (see table).

3. Click Save and Close to return to the previous form.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi applies your changes.

Name Description

Label Family name. For example, Hardware Faults, or Cisco Error. Maximum size is 255 characters.
Any character type is valid.

Unique
Key

Caution: After you click Save and Close, this value cannot be changed.

Used as a unique identifier when exporting and importing configuration definitions. To ensure

Family Attributes
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Name Description

that the value you enter is unique, it is recommended that you use the Java name space con-
vention when providing this value. It is also useful to include the label value as part of the
unique key as shown in the following examples:

com.<your_company_name>.nnm.trapConf.family.<family_label>

com.<your_company_name>.nnm.eventConf.family.<family_label>

com.<your_company_name>.nnm.inciConf.family.<family_label>

The maximum length is 80 alpha-numeric characters, periods allowed, no spaces allowed.

Specify the Incident Severity

The incident severity represents the seriousness calculated for the incident. Use the severity attribute to
specify the severity that should be assigned to the incident you are configuring. Possible values are
described in the following table.

Attribute Description

Normal Indicates there are no known problems related to the associated object. This severity is
meant to be informational. Generally, no action is needed for these incidents.

Warning Indicates there may or may not be a problem related to the associated object.

Minor Indicates NNMi has detected problems related to the associated object that require further
investigation.

Major Indicates NNMi has detected problems related to the associated object to be resolved before
they become critical.

Critical Indicates NNMi has detected problems related to the associated object that require imme-
diate attention.

Incident Severity Values

See "Monitor Your Network Using Incident Views" for more information about these severity values.

Specify Your Incident Message Format

When configuring an incident, specify how the incident message appears in the incident view. The string
you specify in the Message Format attribute is visible in the view.

Note: The incident message limit is 1024 characters. If you exceed this limit, NNMi truncates the value start-
ing from the right.

You can use any combination of default and custom attributes:

"Valid Parameters for Configuring Incident Messages " (on page 256)

"Include Custom Incident Attributes in Your Message Format" (on page 259)
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Valid Parameters for Configuring Incident Messages

When configuring incident messages, you may want to use incident information as part of the message.
NNMi provides the following parameter values. Use these parameters as variables when formatting an inci-
dent message.

Tip: See the Using the Incident Form for more information about the parameter values.

Note: NNMi stores varbind values as custom incident attributes (CIAs).

See "Specify Your Incident Message Format" (on page 255) for more information about configuring mes-
sages.

Parameter Value Description

$category, $cat Value of the Category attribute in the Incident form.

$count, $cnt Value representing the number of Custom Incident Attributes that appear in
the Incident form.

$family, $fam Value from the Family attribute in the Incident form.

$firstOccurrenceTime,
$fot

Value from the First Occurrence Time attribute in the incident form.

$lastOccurrenceTime,
$lot

Value from the Last Occurrence Time attribute in the incident form.

$lifecycleState, $lcs Value from the Lifecycle State attribute in the Incident form.

$name Value of the Name attribute from the incident configuration.

$nature, $nat Value from the Nature attribute in the Incident form.

$origin, $ori Value from the Origin attribute in the Incident form.

$originOccurrenceTime,
$oot

Value from the Origin Occurrence Time attribute in the incident form.

$priority, $pri Value from the Priority attribute in the Incident form.

$sev, $severity Value of the Severity attribute of the Incident form.

Valid Parameters Visible From an Incident's Form

Parameter Value Description

$id Unique Object Identifier attribute value for the incident

(unique across the entire NNMi Database).

$ifAlias, $ifa Value from the IfAlias attribute of the Interface form.

$firstOccurrenceTimeMS, $fms Value from the First Occurrence Time attribute in the inci-
dent form, converted to millseconds (measured since
January 1, 1970, 00:00:00 GMT - Greenwich Mean
Time).

Valid Parameters Not Visible From an Incident's Form
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Parameter Value Description

$id Unique Object Identifier attribute value for the incident
(unique across the entire NNMi Database).

$ifAlias, $ifa Value from the IfAlias attribute of the Interface form.

$lastOccurrenceTimeMS,

$lms

Value from the Last Occurrence Time attribute in the inci-
dent form, converted to millseconds (measured since
January 1, 1970, 00:00:00 GMT - Greenwich Mean
Time).

$managementAddress, $mga Value from the Management Address attribute of the
associated Node form or SNMP Agent form.

$oid Value of the unique object identifier (oid) for the incident
configuration that originated from either an SNMP trap,
Management Event, or Remote NNM 6.x or 7.x event.

$otherSideOfConnection, $osc If the incident's Source Node is part of a Layer 2 con-
nection, this attribute is the following combination of
values for the node and one of its interfaces on the
other side of the Layer 2 connection:

The fully-qualified DNS name of the node appended
with the interface Name in the following format: <fully-
qualified DNS name>[interface_name]

$otherSideOfConnectionIfAlias, $oia If the incident's Source Node is part of a Layer 2 con-
nection, this attribute is the value of the ifAlias of one of
the interfaces on the other side of the Layer 2 con-
nection.

$otherSideOfConnectionManagementAddress,
$oma

If the selected interface is part of a Layer 2 connection,
this attribute is the value of the Management Address of
one of the interfaces on the other side of the Layer 2
connection.

$originOccurrenceTimeMS, $oms Value from the Origin Occurrence Time attribute in the
incident form, converted to millseconds (measured
since January 1, 1970, 00:00:00 GMT - Greenwich
Mean Time).

$sourceNodeUuid, $snu Universally Unique Object Identifier attribute value of
the source node object for the incident (unique across
all databases). This identifier distinguishes the source
node object instance from all other node objects.

$sourceNodeName, $snn Value from the Name attribute of the Node form.                     

$sourceNodeLongName, $sln The fully-qualified DNS name as displayed in the Host-
name attribute of the incident's Source Node's form.
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Parameter Value Description

$id Unique Object Identifier attribute value for the incident
(unique across the entire NNMi Database).

$ifAlias, $ifa Value from the IfAlias attribute of the Interface form.

$sourceObjectClass, $soc Value of the object class for the object you want to
include. Use this parameter when you need to request
more details of a class of objects through a web service.
Examples of object classes include:
com.hp.ov.nms.model.core.Interface and
com.hp.ov.nms.model.snmp.SnmpAgent.

$sourceObjectName, $son Value from the Name attribute of the source object. For
example, an interface object is named according to the
MIB ifName. Each ifName varies according to the ven-
dor's conventions. Using the name 4/1 as an example,
4 represents the board number and 1 represents
the port number.

$sourceObjectUuid, $sou Universally Unique Object Identifier attribute value of
the source object for the incident (unique across all data-
bases). This identifier distinguishes the source object
instance from all other similar object instances.

$uuid Universally Unique Object Identifier attribute value of
the incident (unique across all databases). This iden-
tifier distinguishes the incident object instance from all
other incident objects.

Parameter
Value Description

$<position
_number>

Value of the custom incident attribute (CIA) position number for any CIA that originated from
a varbind or was added by NNMi. For example, to indicate you want to use the varbind in
position 1, enter: $1

NNMi stores varbind values as Custom Incident Attributes. If you know the varbind position
number, use this parameter.

$<CIA_
name>

Value of the name that is used for the custom incident attribute. For example, $myco-
mpany.mycia. NNMi provides CIA values for configuring Management Events. See Cus-
tom Incident Attributes Provided by NNMi for more information about custom incident
attributes.

$<CIA_
oid>

Value of the object identifier for any custom incident attribute that originated as a varbind.
For example, $.1.3.6.1.6.3.1.1.5.1. Use this parameter when you are not certain of
a custom incident attribute (varbind) position number.

$* Used to indicate you want all of the custom incident attribute values originating as varbinds,
to be passed to the action configuration. Each varbind is returned in the following format:
$<CIA_name>:<CIA_value> in which the custom incident attribute name appears fol-
lowed by the custom incident attribute value.

Valid Parameters Established in Custom Incident Attributes
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The function described in the following table replaces the specified numeric value with the associated text
value stored in the CIA. 

Note: The associated MIB must have been loaded using the nnmloadmib.ovpl command.

Function Description

$text($<position_
number>)

The <position_number> argument specifies the numeric value of the custom incident
attribute (CIA) position number for any CIA that originated from a varbind or was
added by NNMi. For example, to indicate you want to use the varbind in position 1,
enter: $1.

NNMi replaces the numeric value with the text value stored in the CIA.

Note: If a text value is not available, NNMi returns the numeric value.

$text($<CIA_
oid>)

The <CIA_oid> argument specifies the object identifier for any custom incident attrib-
ute that originated as a varbind. For example, $.1.3.6.1.6.3.1.1.5.1. Use this
argument to the $text function when you are not certain of a custom incident attribute
(varbind) position number.

NNMi replaces the numeric value with the text value stored in the CIA.

Note: If a text value is not available, NNMi returns the numeric value.

Functions to Generate Values Within Incident Messages

Include Custom Incident Attributes in Your Message Format

NNMi includes two categories of CIAs:

l SNMP trap varbinds identified by the Abstract Syntax Notation value (ASN.1). NNMi turns varbinds into
CIAs and maintains each varbind's position number. See "Load SNMP Trap Definitions" (on page 247).

l Custom attributes provided by NNMi. See "Custom Incident Attributes Provided by NNMi" (on page
214).

You can use CIAs in your message format to extend the amount of information presented. To determine
which CIAs are available for any particular incident type, open an Incident view, locate the incident and
open the Incident form. Navigate to the Custom Attributes tab. A complete list of available CIAs (for that
incident type) appears in the table.

To include a CIA in your message format, type the dollar-sign character ($)plus any of the following:

l Varbind position number or asterisk (*) to include all varbind values

l Name of the CIA

l Object identifier (oid) of the CIA (useful when the varbind position number is not consistent among ven-
dors)

Note: A single incident cannot include two CIAs with the same name. However, two incidents can contain
CIAs having the same names and values.

The following table presents some example formats with the subsequent output.

Example Message Format Output in Incident View

Possible trouble with $3 Possible trouble with <varbind 3>

Example Incident Message Formats
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Example Message Format Output in Incident View

Possible trouble with $11 Possible trouble with <varbind 11>

Possible trouble with $77 (where the var-
bind position 77 does not exist)

Possible trouble with <Invalid or unknown cia>
77

Possible trouble with $* Possible trouble with <cia1_name: cia_value>, <cia2_
name; cia_value>,< cian_name: cia_value>

Possible trouble with $3x Possible trouble with <varbind 3>x

Possible trouble with $1.2.3.4.5 Possible trouble with <value of the CIA whose oid is
1.2.3.4.5>

Possible trouble with $mycia.mycompany Possible trouble with <value of the CIA whose name is
mycia.mycompany>

Tip: NNMi provides an error message when a CIA cannot be found. For example, if you enter an unavail-
able varbind position, name, or object identifier (oid), NNMi returns an "Invalid or unknown cia" error
message.

Specify a Description for Your Incident Configuration

NNMi provides the Description attribute to help you further identify the current incident configuration.

Description

Use the description field to provide additional information that you would like to store about the current inci-
dent configuration. This description applies only to the configuration entry.

Type a maximum of 2048 characters. Alpha-numeric, punctuation, spaces, and underline characters are
allowed.

Specify an Author for Your Incident Configuration

The Author attribute value indicates who created the incident configuration.

To create a new Author attribute value:

1. Navigate to the Author form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Open the Incident Configuration form.

d. Locate one of the following:

o The SNMP Trap Configuration (by OID) or SNMP Trap Configuration (by Name) tab.

o The Remote NNM 6.x/7.x Event Configuration tab.

o The Management Event Configuration tab.

Do one of the following:
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o Click the  New icon.

o Select a row, click the  Open icon.

e. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

f. In the configuration form, locate to the Author attribute.

g. Click the Lookup icon, and select New.

2. Type the text string that represents the new author (see table).

3. Click Save and Close to return to the previous form.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi saves your changes.

Attribute Description

Label Provide a text string that identifies the author of the incident configuration. Any characters are
allowed, including spaces and punctuation.

Note: All incident configurations provided by NNMi include HP Network Node Manager as
the Label value.

Unique
Key

Caution: After you click Save and Close, this value cannot be changed.

Used as a unique identifier when exporting and importing configuration definitions. To
ensure that the value you enter is unique, it is recommended that you use the Java name
space convention when providing this value. It is also useful to include the label value as part
of the unique key as shown in the following examples:

com.<your_company_name>.nnm.trapConf.author.<author_label>

com.<your_company_name>.nnm.evemtConf.author.<author_label>

com.<your_company_name>.nnm.inciConf.author.<author_label>

The maximum length is 80 alpha-numeric characters, periods allowed, no spaces allowed.

Incident Configuration Author

Configure Remote NNM 6.x/7.x Events

NNMi can display incidents from Remote NNM 6.x and 7.x management stations. In the NNMi incident
browser, you can manage the lifecycle of incidents generated from previous versions of NNMi.

Tip: Gradually migrate from NNM 6.x or 7.x to NNMi while using this feature.

To configure NNMi to handle incidents generated from remote NNM 6.x/7.x events, perform the following
tasks:
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l Configure the NNM 6.x/7.x Management Stations

l Configure the remote NNMi events

Configure Remote NNM 6.x and 7.x Management Stations

There are multiple benefits to configuring NNMi to recognize the NNM 6.x or 7.x management stations in
your environment:

l Configure NNMi to receive and display incidents (events) from remote NNM 6.x or 7.x management sta-
tions.

l Enable launching NNM 6.x or 7.x Dynamic Views from forwarded NNM 6.x or 7.x events (see Access
NNM 6.x and 7.x Features for more information).

l Filter NNMi view by NNM 6.x or 7.x management station (show only those incidents received from a
particular NNM 6.x or 7.x management station).

To display the details of an NNM 6.x or 7.x management station configuration:

1. From the workspace navigation panel, select the Inventory workspace.

2. Select the Management Stations view.

3. Locate the row representing the management station, click the Open icon.

4. The Management Station form displays.

5. When finished, click the  Close icon.

To configure an NNM 6.x or 7.x management station (if your role allows you to do this):

1. Navigate to the Management Stations view.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Management Stations view.

2. Do one of the following:

n To create an NNM 6.x or 7.x management station configuration, click the New icon, and con-
tinue.

n To edit an NNM 6.x or 7.x management station configuration, click the  Open icon, and con-
tinue.

n To delete an NNM 6.x or 7.x management station configuration, click the  Delete icon.

3. In the Management Station form, provide the required information:

n IPv4 address of the remote NNM 6.x or 7.x management station

n Port number used by the OpenView Application Server (ovas) on the remote management station

n Port number used by the web server on the remote NNM 6x or 7x management station

4. Click Save and Close to return to the Management Stations view.

5. If this is the first Management Station configuration, you must exit the NNMi console, and start the
NNMi console. (You do not need to exit and start the NNMi console when configuring any sub-
sequent NNM 6.x/7.x management stations.)
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6. Next, configure which incidents to receive from your NNM 6.x or 7.x management station ("Configure
Remote NNM 6.x/7.x Events" (on page 261)).

Remote NNMi Event Form

Using NNMi, you can display incidents from Remote NNM 6.x and 7.x management stations. . In the NNMi
incident browser, you can manage the lifecycle of incidents generated from previous versions of NNMi.

Tip: Gradually migrate from NNM 6.x or 7.x to NNMi while using this feature.

To configure a Remote NNM 6.x/7.x event:

1. Navigate to the Remote NNM 6.x/7.x Event Configuration form:

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the Remote NNM 6.x/7.x Event Configuration tab.

d. Do one of the following:

o To create a Remote NNM 6.x/7.x Event configuration, click the New icon.

o To edit a Remote NNM 6.x/7.x Event configuration, click the Open icon.

Note: In the Remote NNM 6.x/7.x Event Configuration form, verify that Enable is selected.

2. Make your configuration choices (see table).

3. Click Save and Close to return to the Incident Configuration form.

4. Click Save and Close to apply your changes.

Task How

"Specify the Incident Configuration
Name" (on page 249)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. Specify a name that helps you to identify the con-
figuration for subsequent use.

"Specify the SNMP Object ID" (on
page 249)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. NNMi supports SNMPv2c and SNMPv1 formats.

Specify whether you want to enable
this configuration.

In the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form, make sure Enable is checked for each con-
figuration you want to use.

Display the NNMi Remote Incident as
a Root Cause Incident

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form.

"Specify Category and Family Attrib-
ute Values for Organizing Your Inci-
dents" (on page 251)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. You can organize your incidents using Category
and Family.

"Specify the Incident Severity " (on
page 255)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. Possible Severity values include: Normal, Warn-
ing, Minor, Major, and Critical.

Tasks for Remote NNM 6.x/7.x Event Configuration
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Task How

"Specify Your Incident Message For-
mat" (on page 255)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. The message format determines the message to
be displayed for the incident.

"Specify a Description for Your Inci-
dent Configuration" (on page 260)

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form. Provide a meaningful description.

Specify an Author for Your Remote
NNM 6.x/7.x Event Configuration

Use the Basics group of the Remote NNM 6.x/7.x Event Con-
figuration form

After you complete the Basic Configuration for the remote NNM 6.x or 7.x event, you can also choose to
configure the information described in the following table.

Task How

"Correlate Duplicate Inci-
dents (Deduplication Con-
figuration)" (on page 269)

Select the Deduplication Configuration tab to specify duplicate incidents
that you want to be suppressed.

"Track Incident Frequency
(Rate: Time Period and
Count)" (on page 273)

Select the Rate Configuration tab to specify a rate for duplicate incidents.
After the rate limit is reached, NNMi generates an Incident to notify you of
the problem.

"Configure an Action for an
Incident" (on page 283)

Select the Action Configuration tab to specify actions that should occur
automatically when an incident is either generated or closed.

"Configure Diagnostics for
an Incident (NNM iSPI NET)"
(on page 291)

Select the Configuration Per Node Group tab to specify diagnostic
actions that should occur automatically when an incident is generated for
a node that belongs to a particular Node Group.

Additional Configurations

Configure How Management Events Are Displayed

Management events are those events that are generated from the NNMi Causal Engine. You can con-
figure how you want these events to be displayed in the incident views provided by NNMi. The types of
things you configure include its name, category, and the format of its message.

To configure a management event:

1. Navigate to the Management Event Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the Management Event Configuration tab.

3. Do one of the following:

a. To create a management event configuration, click the New icon.

b. To edit a management event configuration, click the Open icon.

c. To delete a management event configuration, click the Delete icon.

4. In the Management Event Configuration form, provide the required information.
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5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

The next time that a management event of this type arrives into the database, NNMi creates an associated
incident to display in the appropriate console incident views.

Management Event Form

To configure incidents originating from management events:

1. Navigate to the Incident Configuration form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the Management Event Configuration tab.

3. Make your configuration choices (see table).

Note: If you want to add or edit a management event configuration, verify that Enabled is selected.

a. To add a management event configuration, click the  New icon, and continue.

b. To edit a management event configuration, click the  Open icon, and continue.

c. To delete a management event configuration, click the  Delete icon.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your changes.

Task How

"Specify the Incident Configuration
Name" (on page 249)

Use the Basics group of the Management Event form. Spec-
ify a name that helps you to identify the configuration for sub-
sequent use.

Specify whether you want to enable this
configuration.

In the Basics group of the Management Event form, verify
that Enable is selected for each configuration you want to
use.

"Specify Category and Family Attribute
Values for Organizing Your Incidents" (on
page 251)

Use the Basics group of the Management Event form. You
can organize your incidents using Category and Family.

"Specify the Incident Severity " (on page
255)

Use the Basics group of the Management Event form. Pos-
sible Severity values include: Normal, Warning, Minor,

Major, and Critical.

"Specify Your Incident Message Format"
(on page 255)

Use the Basics group of the Management Event form. The
message format determines the message to be displayed for
the incident.

"Specify a Description for Your Incident
Configuration" (on page 260)

Use the Basics group of the Management Event form. Pro-
vide a meaningful description.

Tasks for Management Event Configuration
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Task How

"Specify an Author for Your Incident Con-
figuration" (on page 260)

Use the Basics group of the Management Event form.

After you complete the Basic Configuration for the management event, you can also choose to configure
the information described in the following table.

Task How

"Correlate Duplicate Inci-
dents (Deduplication Con-
figuration)" (on page 269)

Select the Deduplication Configuration tab to specify duplicate incidents
that you want to be suppressed.

"Track Incident Frequency

(Rate: Time Period and
Count)" (on page 273)

Select the Rate Configuration tab to specify a rate for duplicate incidents.

After the rate limit is reached, NNMi generates an Incident to notify you of
the problem.

"Configure an Action for an
Incident" (on page 283)

Select the Action Configuration tab to specify actions that should occur
automatically when an incident is either generated or closed.

"Configure Diagnostics for
an Incident (NNM iSPI NET)"
(on page 291)

Select the Configuration Per Node Group tab to specify diagnostic
actions that should occur automatically when an incident is generated for
a node that belongs to a particular Node Group.

Additional Configurations

Reduce the Number of Incoming Incidents

NNMi' s Causal Engine reduces the number of incidents by extensively evaluating problems and deter-
mining the root cause for you, whenever possible.

To help simplify diagnosing network faults, you can also reduce the number of incidents that are displayed.
To do so, you identify additional relationships between incoming incidents. After these relationships are
identified, NNMi modifies the flow of incidents by recognizing patterns of incoming management events or
SNMP traps, and then nests related incidents as correlated children or correlated parent incidents.

These strategies can dramatically reduce the number of incidents and improve the value of the incidents
displayed. For example, instead of displaying an entire incident storm typically generated by equipment
and link failures, using the deduplication configuration you specify, NNMi displays only the most mean-
ingful incidents, and lists the rest as correlated children or parents, resulting in faster and easier iden-
tification of network problems.

Using NNMi, you can reduce the number of incidents displayed in your incident views using any of the inci-
dent configurations described in the following table.

Note: NNMi provides configurations for deduplication, rate, and pairwise configurations. You can choose
to use them as is, edit them, or create your own configurations.

Configuration Description

Deduplication Determines what values NNMi should match to detect when an incident is a duplicate.
These duplicate incidents are then correlated under a new Duplicate Correlation inci-
dent. The relationship between them is indicated in the Correlated Children tab by a
Type of De-Dup Correlation. By reducing the quantity of incidents displayed, your net-

Correlation Configuration Possibilities
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Configuration Description

work administrators can focus on the important incidents.

To help your operators understand the magnitude or significance of the problem, NNMi
stores the number of duplicates generated. This value is captured as the Duplicate
Count attribute. It is incremented on the Duplicate Correlation incident. This incident
appears in the Stream Correlation Incidents view. Its Correlation Nature attribute value
is Stream Correlation. 

NNMi also stores the following information related to duplicate incidents:

First Occurrence Time: Indicates the timestamp of the first occurrence of a duplicate
incident.

Last Occurrence Time: Indicates the timestamp of the latest notification for a set of
duplicate incidents

Rate Used to measure the number of incoming incidents within a defined time period. When
a specified number is received within the specified time interval, NNMi lists each occur-
rence of the incident as a correlated child incident under a new Rate Correlation inci-
dent. The relationship between the child and parent is indicated in the Correlated
Children tab by a Type of Rate Correlation. The Rate Correlation incident appears in
the Stream Correlation Incidents view. The Correlation Nature attribute value is Stream
Correlation.

By reducing the quantity of incidents displayed, your network administrators can focus
on the important incidents. For example, you might want to specify that if a link is inter-
mittently down at least three times within 30 minutes that these incidents be listed and
the rate displayed so that you can subsequently identify any potential rerouting prob-
lems.

NNMi also stores the following information related to rate:

Count: Indicates the rate at which the incident must occur within the specified time-
frame.

Hours, Minutes, and Seconds: Used to measure the time within the rate must occur

First Occurence Time: Indicates the time at which the measured rate was reached.

Last Occurrence Time: Indicates the last time which the incident occurred.

Note: NNMi updates the Correlation Notes with the number of incidents that have
occurred within the specified time period. For example, 5 in 5 minutes.

Pairwise Used to pair the first occurrence of an incident to another subsequent incident. After the
second incident in the pair occurs, the first incident becomes a correlated child under
the second (parent ) incident. The relationship between the child and parent incident is
indicated in the Correlated Children tab by a Type of Pairwise Correlation. 

Each incident in the pair is then closed, reducing the quantity of open incidents dis-
played. 

For example, you might want to configure a pairwise relationship between a LinkDown
and a subsequent LinkUp incident. After the LinkUp incident occurs, it cancels the Link-
Down incident and updates the Correlation Notes.  The LinkDown incident appears as a
correlated child under the LinkUp parent. 
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Each of these incident reduction strategies determines patterns of incidents by monitoring the attributes
you specify when configuring incidents. See "Configuring Incidents" (on page 211) for more information.
See "Load SNMP Trap Definitions" (on page 247) for more information about how to specify the SNMP
 traps you want to receive by automatically creating or updating an incident configuration for an SNMP trap
using a MIB file.

Note: You can also reduce the number of incidents generated by setting a device's management mode to
either Not Managed or Out of Service. See "Stop or Start Managing a Node, Interface, or Address"
(on page 184) for more information about setting the management mode and the resulting behavior.

Related Topics

"Configure How Management Events Are Displayed" (on page 264)

"Configure SNMP Trap Incidents" (on page 246)

Control which Incoming Traps Are Visible in Incident Views

You can configure devices in your network environment to send traps to the NNMi management server. To
do so, use the incident configurations provided by NNMi, create your own, or both.See "Configure SNMP
Trap Incidents" (on page 246) for information about how to configure SNMP traps as incidents. See "SNMP
 Trap Incident Configurations Provided by NNMi" (on page 216) for information about the incident con-
figurations provided by NNMi.

Note: To establish this communication flow, the SNMP agent must be intentionally configured by the
device administrator to send SNMP traps to your NNMi management server.

After you configure the incidents for each SNMP trap you want to display, NNMi stores your incident con-
figurations for SNMP traps in the allowedOids.conf file. NNMi then uses this file as a positive filter to
identify the traps that should appear as incidents.

By default, NNMi enables only the following SNMP Trap incident configurations that it provides:

l CiscoWarmStart 

l CiscoColdStart 

l SNMPWarmStart 

l SNMPColdStart 

l CiscoLinkDown 

l CiscoLinkUp 

l HSRPStateChange 

l IetfVrrpStateChange 

l RcVrrpStateChange 

l SNMPLinkDown 

l SNMPLinkUp 

l RcnAggLinkUp 

l RcAggLinkUp 

l RcnAggLinkDown 

l RcAggLinkDown 
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l RcnSmltIstLinkUp 

l RcSmltIstLinkUp 

l RcnSmltIstLinkDown 

l RcSmltIstLinkDown 

See "SNMP Trap Incident Configurations Provided by NNMi" (on page 216) for more information.

To enable or disable an SNMP trap configuration:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the SNMP Trap Configuration tab.

3. Click the  Open icon in the row that represents the SNMP Trap Configuration of interest.

4. To enable the incident configuration, click Enable .

5. To disable the incident configuration, clear Enable .

Related Topics

"Reduce the Number of Incoming Incidents" (on page 266)

Correlate Duplicate Incidents (Deduplication Configuration)

The deduplication configuration determines what values NNMi should match to detect when an SNMP
trap, management event, or remote NNM 6.x/7.x event is a duplicate.

Note the following:

l NNMi applies only one deduplication configuration per incident . If NNMi generates an incident using a
specified deuplication configuration, NNMi continues to correlate duplicate incidents using the original
configuration. To use a different deduplication configuration for an incident, first delete the current dedu-
plication incident (created using the original deduplication configuration). NNMi generates the next
deduplication incident according to the new deduplication configuration settings.

l By default, NNMi updates the Duplicate Count every 30 seconds. This interval cannot be changed.

l NNMi continues to update the duplicate count regardless of an incident's lifecycle state. For example, if
an incident's Lifecycle State is set to Closed, the duplicate count continues to be incremented. See
About the Incident Lifecycle for more information. This behavior helps you identify situations in which
the incident is not yet fixed. Take note if the Duplicate Count is incremented after a lengthy time period
has elapsed, which might indicate there is a new problem with the node, interface, or address. 

l Each time you stop and restart ovjboss, any incidents that have not yet been correlated or persisted are
lost. This means that after a restart of ovjboss, an incoming incident might not be correlated as
expected. For example, after a restart of ovjboss, a duplicate incident might not be correlated under its
original parent incident. Instead, a new parent incident might be generated. See "Stop or Start an NNMi
Process" (on page 26)for more information about starting and stopping the ovjboss process.

To specify or delete a deduplication configuration:

1. Navigate to the Incident Configuration form:

a. From the workspace navigation panel, select the Configuration workspace.
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b. Select Incident Configuration.

c. Select the type of incident you want to configure: SNMP Trap Configuration, Remote NNM
 6.x/7.x Event Configuration, or Management Event Configuration.

d. Do one of the following:

i. To create a deduplication configuration, click the New icon, and continue.

ii. To edit a deduplication configuration, click the Open icon, and continue.

iii. To delete a deduplication configuration, click the  Delete icon.

2. Select the Deduplication Configuration tab.

3. Provide the required information (see table)

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your deduplication configuration.

Name Description

Enable Use this attribute to temporarily disable an incident's deduplication configuration.

To temporarily disable the deduplication configuration setting, uncheck Enable.

To enable the deduplication configuration setting, click Enable. 

Note: After a deduplication configuration is enabled, NNMi increments the Duplicate
Count for an associated incident regardless of the Lifecycle State value. For exam-
ple, if an incident's Lifecycle State is set to Closed, the duplicate count continues
to be incremented. See About the Incident Lifecycle for more information.

Dedup
Count

Specifies the number of duplicate incidents for the current configuration that NNMi stores
at one time. For example, if the Dedup Count is 10, after NNMi receives 10 duplicate inci-
dents, NNMi deletes the first duplicate incident and keeps the eleventh. (NNMi stores ten
maximum.) 

Hour Inter-
val

Used with the Minute and Second Intervals to specify the time that must elapse before a
new duplicate incident is generated for this incident configuration. For example, if the
Hour Interval value is 1, and no Minute or Second Intervals are specified, and the dupli-
cate incident is not generated within one hour, NNMi generates a new duplicate incident
the next time it occurs. 

Minute Inter-
val

Used with the Hour and Second interval to specify the time that must elapse before a new
duplicate incident is generated for this incident configuration. For example, if the Minute
Interval is 30 and no Hour or Second Intervals are specified, and the duplicate incident is
not generated within 30 minutes, NNMi generates a new duplicate incident the next time it
occurs. 

Second
Interval

Used with the Hour and Minute Intervals to specify the time that must elapse before a new
duplicate incident is generated for this incident configuration. For example, if the Second
Interval is 120 and no Hour or Minute Intervals are specified, and the duplicate incident is
not generated within 120 seconds, NNMi generates a new duplicate incident the next time
it occurs. 

Correlation
Incident
Config

Used to access the out-of-the box deduplicaton configuration provided by NNMi.

Select the default value Duplicate Correlation.

Deduplication Attributes
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Name Description

Note: You can choose to use this configuration as is or edit it. If you want to create a new
deduplication configuration, you must create a new management event configuration. See
"Configure How Management Events Are Displayed" (on page 264) for more information.
After you have created a new management event configuration, it appears in the Quick
Find list of options. See "Lookup Fields" (on page 18) for more informationn about Quick
Find.

Comparison
Criteria

Specify which group of attributes must match before the incident is identified as a dupli-
cate. The possible groups of attributes consist of the following choices.

Name value of the Incident (from the General tab on the Incident form).

Source Node value (from the Basics group on the Incident form). Address or name of the
node for which the incident was generated.

Source Object value (from the Basics group on the Incident form). For example, the
Source Object for a LinkDown incident is interface.

CIA custom incident attribute values (select from the list displayed on the Custom Attrib-
utes tab on the Incident form). If you want to use CIA as part of your comparison criteria,
see "Deduplication Comparison Parameters Form " (on page 271).

Comparison
Parameter
List

Optional. If you selected a Comparison Criteria that includes CIA, you must populate one
or more rows in this table. See "Deduplication Comparison Parameters Form " (on page
271).

Deduplication Comparison Parameters Form

Custom Incident Attributes (CIAs) are used as parameter values. Parameter values enable accurate iden-
tification of duplicate incidents. There are two categories of CIAs:

l SNMP trap varbind values (Name = the MIB varbind identifier, Type = asn_*)

l Custom attributes provided by NNMi (Name = cia.*, Type=String). See "Custom Incident Attributes Pro-
vided by NNMi" (on page 214).

The group of available CIAs depends on which incident you are configuring for this Deduplication (for
example, CiscoLinkDown). To see which CIAs are available, navigate to an Incident view, select an

instance of that incident-type, click the  Open icon and navigate to the Custom Attributes tab. The items
listed in the table are the CIAs for that particular incident-type. For example, all CiscoLinkDown incidents
would have the same group of CIAs shown in the illustration below.

Note: You can also use the CIA (varbind) position number.
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To specify a CIA to use in the identification criteria for duplicate incidents:

1. Navigate to the Deduplication Comparison Params form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Incident Configuration.

c. Navigate to the SNMP Trap Configuration, Remote NNMi Event Configuration, or Man-
agement Event Configuration tab.

d. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

e. On the form that opens, navigate to the Deduplication Configuration tab.

f. Locate the Comparison Parameter List table.

g. Do one of the following to specify which CIA:

o To add a Custom Incident Attribute parameter specification, click the  New icon.

o To edit an existing Custom Incident Attribute parameter specification, select a row, and

click the  Open icon.

2. In the Parameter Value field, type (or copy and paste) the exact text string from the Incident form, Cus-
tom Attribute tab, Name attribute value:

n NNMi-provided CIA value (see "Custom Incident Attributes Provided by NNMi" (on page 214)).

n SNMP trap varbind identified by the Abstract Syntax Notation value (ASN.1).

3. Click Save and Close to return to the previous configuration form.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi saves your changes.
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Track Incident Frequency (Rate: Time Period and Count)

Use Rate Configuration to track incident patterns based on the number of incident reoccurrences within a
specified time period. After the count within the specified time period is reached, NNMi emits a Rate Cor-
relation incident and continues to update the Correlation Notes with the number of occurrences within that
rate.

As long as your defined criteria (Count and Hours, Minutes, Seconds) is sustained, the following infor-
mation is updated in the Correlation Notes of the Rate Correlation incident:   

l the actual number of occurrences of incidents for that sustained rate (Count)

l the sustained time interval  (Hours, Minutes, Seconds)

For example, you can set a Rate configuration to track when a link is intermittently down at least three
times in 30 minutes. NNMi shows the first occurrence of the rate incident in the incident view and uses Cor-
relation Notes to update the number of incidents and time interval to reflect all the incremental incident
occurrences and time periods. To continue the example, if the rate of three times in 30 minutes is sus-

tained for 90 minutes, NNMi updates the Correlation Notes to specify that 9 incidents occurred in 90 min-
utes.

NNMi provides preconfigured Rate correlations. You can add new Rate correlations.

When you open the Incident form of the newest instance:

l On the General tab, two fields notify you that the Rate correlation is working:

n Correlation Nature: Rate

n Count: x

l On the Correlated Children tab, each incident is listed in the table.

To establish a rate correlation within an incident configuration:

1. Navigate to the Rate Configuration tab.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Incident Configuration.

c. Open the Incident Configuration form.

d. Navigate to the SNMP Trap Configuration, Remote NNM 6.x/7.x Event Configuration, or
Management Event Configuration tab.

e. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

f. On the form that opens, locate the Rate Configuration tab.

2. Provide the definition for this Rate Configuration (see table).

3. Optional. If your Comparison Criteria includes custom incident attributes (CIA) to identify one specific
incident, use the Comparison Parameter List table to define each CIA. See "Rate Comparison Param-
eters Form" (on page 274).

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi saves your changes.
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Attribute Description

Enable If enabled, NNMi actively tracks any reoccurrences of the designated incident within the
time period you specify, and generates a Rate incident.

Count Specify the number of reoccurrences required before your Rate Configuration starts work-
ing.

Set the
Time Period

Specify a time duration within which the reoccurrences are measured.

Fill in one or more of the following attribute fields:

Hours

Minutes

Seconds

Correlation
Incident
Config

Click the icon and select Quick Find. Select RateCorrelation from the list.

Comparison
Criteria

Specify which group of attributes must match before the incident is identified as a duplicat.
The possible groups of attributes consist of the following choices.

Name value of the Incident (from the General tab on the Incident form).

Source Node value (from the Basics group on the Incident form). Address or name of the
node for which the incident was generated.

Source Object value (from the Basics group on the Incident form). For example, the
Source Object for a LinkDown incident is interface.

CIA custom incident attribute values (select from the list displayed on the Custom Attrib-
utes tab on the Incident form). If you want to use CIA as part of your comparison criteria,
see "Rate Comparison Parameters Form" (on page 274).

Comparison
Parameter
List

Optional. If you selected a Comparison Criteria that includes CIA, you must populate one
or more rows in this table. See "Rate Comparison Parameters Form" (on page 274).

Rate Configuration Definition

Rate Comparison Parameters Form

Custom Incident Attributes (CIAs) are used as parameter values. Parameter values enable accurate iden-
tification of duplicate incidents. There are two categories of CIAs:

l SNMP trap varbind values (Name = the MIB varbind identifier, Type = asn_*)

l Custom attributes provided by NNMi (Name = cia.*, Type=String). See "Custom Incident Attributes Pro-
vided by NNMi" (on page 214).

The group of available CIAs depends on which incident you are configuring for this Rate (for example, Cis-
coLinkDown). To see which CIAs are available, navigate to an Incident view, select an instance of that inci-

dent-type, click the  Open icon and navigate to the Custom Attributes tab. The items listed in the table
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are the CIAs for that particular incident-type. For example, all CiscoLinkDown incidents would have the
same group of CIAs shown in the illustration below.

Note: You can also use the CIA (varbind) position number.

To specify a CIA to use in the identification criteria for duplicate incidents:

1. Navigate to the Rate Comparison Params form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select Incident Configuration.

c. Navigate to the SNMP Trap Configuration, Remote NNMi Event Configuration, or Man-
agement Event Configuration tab.

d. Do one of the following:

o To create a new configuration, click the  New icon.

o To edit an existing configuration, select a row, and click the  Open icon.

e. On the form that opens, navigate to the Rate Configuration tab.

f. Locate the Comparison Parameter List table.

g. Do one of the following to specify which CIA:

o To add a Custom Incident Attribute parameter specification, click the  New icon.

o To edit an existing Custom Incident Attribute parameter specification, select a row, and

click the  Open icon.

2. In the Parameter Value field, type (or copy and paste) the exact text string from the Incident form, Cus-
tom Attribute tab, Name attribute value:

n NNMi-provided CIA value (see "Custom Incident Attributes Provided by NNMi" (on page 214)).

n SNMP trap varbind identified by the Abstract Syntax Notation value (ASN.1).

3. Click Save and Close to return to the previous configuration form.
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4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNMi saves your changes.

About Pairwise Configurations

Often two incidents have a logical relationship to each other, for example, CiscoLinkDown followed by Cis-
coLinkUp. There is no need for both incidents to take up room in your Incident view. Nesting the two
together helps you do your job quickly and efficiently.

Use the Pairwise Configuration to pair up the occurrence of one incident with another subsequent incident.
When the second incident in the pair occurs, the first incident becomes a correlated child incident within
the parent incident (see illustration below). See "Incident Pair (Pairwise) Configurations Provided by NNM"
(on page 276) for ideas.

NNM automatically ensures that the Source Node attribute value is identical in both incidents of your
defined pair. Some incident pairs require extensive details to verify an accurate match. If both sample inci-
dents have custom incident attributes, you can refine the match criteria beyond Source Node. See "Pair
Item Configuration Form (Identify Incident Pairs)" (on page 281).

Related Topics:

"Prerequisites for Pairwise Configurations" (on page 278)

"Pairwise Configuration Form (Correlate Pairs of Incidents)" (on page 279)

Incident Pair (Pairwise) Configurations Provided by NNM

NNM provides the pairwise configurations described in the following table.

Name Desciption

CiscoLinkDownUpPair Cancels a CiscoLinkDown incident with a CiscoLinkUp inci-
dent on the same interface for the same SNMP agent address.

This configuration is used for known Cisco devices.

Pairwise Configurations Provided by NNM
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Name Desciption

NodeDownUpPair Cancels a NodeDown incident with a NodeUp incident from
the same node.

OvApaAddressDownUpPair Cancels an NNM 6.x or 7.x Node Down event with a NNM 6.x
or 7.x Node Up event from the same SNMP agent address.

OvApaAggPortConnDownUpPair Cancels an NNM 6.x or 7.x APA Aggregate Port Connection
Down event with an NNM 6.x or 7.x APA Aggregate Port Con-
nection Up event.

OvApaAggPortDegradeNotDegradePair Cancels an NNM 6.x or 7.x APA Aggregate Port Degraded
event with an NNM 6.x or 7.x APA Aggregate Port Not
Degraded event on the same interface for the same SNMP
 agent address.

OvApaAggPortDownUpPair Cancels of an NNM 6.x or 7.x APA Aggregate Port Down event
with an NNM 6.x or 7.x APA Aggregate Port Up event on the
same interface for the same SNMP agent address.

OvApaBoardDownUpPair Cancels an NNM 6.x or 7.x APA Board Down event with an
NNM 6.x or 7.x APA Board Up event from the same SNMP
 agent address.

OvApaConnDownUpPair Cancels an NNM 6.x or 7. x APA Address Down event with an
NNM 6.x or 7.x APA Address Up event on the same address
for the same SNMP agent address.

OvApaIfDownUpPair Cancels an NNM 6.x or 7.x APA If Down event with an NNM
 6.x or 7.x APA If Up event on the same interface for the same
SNMP agent address.

OvApaNodeDownUpPair Cancels an NNM 6.x or 7.x APA Node Down event with an
NNM 6.x or 7.x APA Node Up event from the same SNMP
 agent address.

OvIfDownUpPair Cancels an NNM 6.x or 7.x If Down event with an NNM 6.x or
7.x If Up event on the same interface for the same SNMP agent
address.

OvNodeDownUpPair Cancels an NNM 6.x or 7.x Node Down event with an NNM 6.x
or 7.x Node Up event from the same SNMP agent address.

RcAggLinkDownUpPair Cancels an RcAggLinkDown incident with an RcAggLinkUp
incident from the same Multi-Link Trunk (MLT) Aggregator ID
(from the MIB) and SNMP agent address.

RcChasFanDownUpPair Cancels an RcChasFanDown incident with an RcChasFanUp
incident from the same fan ID (from the MIB) and SNMP agent

address.

RcChasPowerSupplyDownUpPair Cancels an RcChasPowerSupplyDown incident with an
RcChasPowerSupplyUp incident from the same power supply
ID (from the MIB) and SNMP agent address.

RcSmltIsLinkDownUpPair Cancels an RcSmltIstLinkDown incident with an RcSmltIst-
LinkUp incident from the same SNMP agent address.
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Name Desciption

RcnAggLinkDownUpPair Cancels an RcnAggLinkDown incident with an RcnAggLinkUp
incident from the same Multi-Link Trunk (MLT) Aggregator Link
ID (from the MIB) and SNMP agent address.

RcnChasFanDownUpPair Cancels an RcnChasFanDown incident with an RcnChas-
FanUp incident from the same fan ID (from the MIB) and SNMP
agent address.

RcnChasPowerSupplyDownUpPair Cancels an RcnChasPowerSupplyDown incident with an
RcnChasPowerSupplyUp incident from the same power
supply ID (from the MIB) and SNMP agent address.

RcnSmltIsLinkDownUpPair Cancels an RcnSmltIstLinkDown incident with an RcnSmltIst-
LinkUp incident from the same SNMP agent address.

SnmpLinkDownUpPair Cancels an SNMPLinkDown incident with an SNMPLinkUp
incident on the same interface for the same SNMP agent
address. 

To see or modify these incident pair configurations:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the Pairwise Configuration tab.

3. Select the configuration you want to see or modify, and click  Open to see or change the con-
figuration.

In the Pairwise Configuration form, click Help→ Using the Pairwise Configuration form for more
information.

4. When you are finished, click Save and Close to return to the Incident Configuration form.

5. Click Save and Close. NNM saves your changes.

Prerequisites for Pairwise Configurations

NNMi automatically ensures that the Source Node attribute value is identical in both incidents of your
defined pair.

If you need to provide more details to accurately identify the logical pair of incidents (from among all pos-
sible incidents related to that source node), complete the Optional step 6 below.

Complete the following steps before attempting to set up a Pairwise Configuration:

1. Identify the two incidents or SNMP traps that consist of the logical relationship that makes the pair.

2. Configure those two incidents or traps within NNMi, if they are not already configured:

n See "Incident Configurations Provided by NNMi" (on page 214).

n See "Configure SNMP Trap Incidents" (on page 246).

n See "Configure Remote NNM 6.x/7.x Events" (on page 261).
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3. Generate one of each of the two incidents or SNMP traps so you can see an example of each in one
of the NNMi Incident views. See "Views Provided by NNMi".

4. Select the first sample incident for the pair, and click Open to display the Incident form.

Navigate to the Custom Attributes tab. These are the custom incident attributes available to use in
step 6, below. See "Custom Incident Attributes Provided by NNMi" (on page 214) for more infor-
mation about Custom Attributes.

5. Repeat the previous step with the second sample incident for the pair.

6. Optional. If both sample incidents have custom attributes, you can refine the match criteria beyond
Source Node. Some incident pairs require extensive details to verify an accurate match. See "Pair-
wise Configuration Form (Correlate Pairs of Incidents)" (on page 279).

Pairwise Configuration Form (Correlate Pairs of Incidents)

Use the Pairwise Configuration to pair the occurrence of one incident with another subsequent incident.
See "About Pairwise Configurations" (on page 276) for more information.

To configure incident pairs:

1. Complete the steps in "Prerequisites for Pairwise Configurations" (on page 278) so you know exactly
which two incidents or traps belong to this logical pair.

2. Navigate to the Pairwise Configuration form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

c. Navigate to the Pairwise Configuration tab.

d. Do one of the following:

o To create a new pair configuration, click the  New icon, and continue.
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o To edit an existing pair configuration, select a row, and click the  Open icon, and con-
tinue.

o To delete a pair configuration, select a row and click the Delete icon.

3. Provide the basic definition of the pair of incidents for this correlation (see table).

4. NNM automatically ensures that the Source Node attribute value is identical in both incidents of your
defined pair. Some incident pairs require extensive details to verify an accurate match. If both sample
incidents have custom incident attributes, you can refine the match criteria beyond Source Node.

Optional. Navigate to the Pair Items tab, and provide one or more custom incident attribute sets
whose values must match to identify the valid pair of incidents. See "Pair Item Configuration Form

(Identify Incident Pairs)" (on page 281). Then, click Save and Close to return to the Pairwise Con-
figuration form.

For example:

n If you specify a First In Pair and Second In Pair of .1.3.6.1.2.1.2.2.1.1, the first incident's varbind
value for the specified OID must match the second incident's varbind value for the specified OID

to confirm a match.

n If you specify two custom attribute sets (one with both First In Pair and Second In Pair set to posi-
tion 7, and one with both First In Pair and Second In Pair set to position 25), then the values for
both custom attributes (varbind position 7 and varbind position 25) in both Incidents must match
to confirm the logical pair.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close. NNM saves your changes. The next time the two incidents in this pair are
generated, the first one becomes a Child Incident of the second one. See "About Pairwise Con-
figurations" (on page 276) for an example.

Attribute Description

Name The name is used to identify the pairwise configuration and must be unique. Use a name
that will help you to remember the purpose for this pairwise configuration.

Maximum length 64 alpha-numeric characters. Periods allowed. No spaces allowed. 

Enable In the Basics group, verify that Enable is selected.

First Incident
Configuration

Identify the incident in the pair that would occur first in the logical sequence. Click the

Lookup icon and select Quick Find. Choose the name of one of the predefined
incident configurations. If you cannot find it, see:

l See "Incident Configurations Provided by NNMi" (on page 214).

l See "Configure SNMP Trap Incidents" (on page 246).

l See "Configure Remote NNM 6.x/7.x Events" (on page 261).

Second Inci-
dent Con-
figuration

Identify the incident in the pair that would occur second in the logical sequence.Click the

Lookup icon and select Quick Find. Choose the name of one of the predefined
incident configurations. If you cannot find it, see:

l See "Incident Configurations Provided by NNMi" (on page 214).

l See "Configure SNMP Trap Incidents" (on page 246).

Pairwise Configuration Definition
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Attribute Description

l See "Configure Remote NNM 6.x/7.x Events" (on page 261).

Description Optional. Explain the purpose of your pairwise configuration for future reference.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Pair Item Configuration Form (Identify Incident Pairs)

NNMi automatically ensures that the Source Node attribute value is identical in both incidents in your
defined pair. Some incident pairs require extensive details to verify an accurate match. If both sample inci-
dents have custom incident attributes, you can use the Pair Item Configuration form to refine the match
criteria beyond Source Node.

Specify attributes whose values must match before the identity of the incident pair is confirmed.

You can use any Custom Incident Attributes (CIAs) displayed on the Incident form of the two incidents you
are associating into a logical pair. The group of available CIAs depends on which incidents you select.
There are two categories of possible CIAs:

l SNMP trap varbinds identified by the Abstract Syntax Notation value (ASN.1) or position. For example,
a varbind OID of .1.3.6.1.2.1.2.2.1.1 or a position number of 25.

l Custom attributes provided by NNMi (Name = cia_*). See "Custom Incident Attributes Provided by
NNMi" (on page 214).

The group of available CIAs depends on which incident you are configuring (for example, Cis-
coLinkDown). To see which CIAs are available, navigate to an Incident view, select an instance of that

incident-type, click the  Open icon and navigate to the Custom Attributes tab. The items listed in the
table are the CIAs for that particular incident-type. For example, all CiscoLinkDown incidents would
have the same group of CIAs shown in the illustration below.

To configure which attributes NNMi uses to verify incident identity:
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1. Complete the steps in "Prerequisites for Pairwise Configurations" (on page 278) so your choices for
this Item Pair configuration are displayed in the NNMi console. (Two Incident forms should be open
before you proceed to step 2.)

2. Navigate to the Pair Item Configuration form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the Incident Configuration view.

c. Navigate to the Pairwise Configuration tab.

d. Do one of the following:

o To create a new pair configuration, click the  New icon.

o To edit an existing pair configuration, select a row, and click the  Open icon.

e. On the Pairwise Configuration form, locate the Pair Items tab.

f. Do one of the following:

o To create a new pair item configuration, click the  New icon.

o To edit an existing pair item configuration, select a row, and click the  Open icon.

3. Specify the attributes you want NNMi to use to confirm the identity of the pair of incidents (see table).

4. Click Save and Close to return to the Pairwise form.

5. Repeat steps 1-3 any number of times. The incidents must pass all Pair Item criteria, plus have iden-
tical Source Node attribute values.

6. Click Save and Close to return to the Incident Configuration form.

7. Click Save and Close. NNMi saves your changes.

Attribute Description

First In
Pair

Type the specification required to confirm the identify of the first incident in this logical pair of
incidents. Provide one of the following:

l The SNMP trap varbind Abstract Syntax Notation value - ASN.1 (OID)

l The SNMP trap varbind position number

Caution: varbind position numbers are not visible in the table on the Incident form's Cus-
tom Attributes tab. And the rows in that table are sorted by the visible column head-
ings and are not in varbind position order. You must access the vendor-supplied
information in the underlying MIB file to determine the appropriate position
number for any particular varbind.

l The Custom Attribute Name value (see "Custom Incident Attributes Provided by NNMi"
(on page 214) or the Name column in the table on the Incident Form: Custom Attributes
Tab of the Incident you are configuring as a member of this logical pair).

Second
In Pair

Type the specification required to confirm the identify of the second incident in this logical
pair of incidents. Provide one of the following:

l The SNMP trap varbind Abstract Syntax Notation value - ASN.1 (OID)

l The SNMP trap varbind position number

Pair Item Configuration
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Attribute Description

Caution: varbind position numbers are not visible in the table on the Incident form's Cus-
tom Attributes tab. And the rows in that table are sorted by the visible column head-
ings and are not in varbind position order. You must access the vendor-supplied
information in the underlying MIB file to determine the appropriate position
number for any particular varbind.

l The Custom Attribute Name value (see "Custom Incident Attributes Provided by NNMi"
(on page 214) or the Name column in the table on the Incident Form: Custom Attributes
Tab of the Incident you are configuring as a member of this logical pair).

Related Topics

"Incident Pair (Pairwise) Configurations Provided by NNM" (on page 276)

Configure an Action for an Incident

You can configure actions to automatically run at any point in the incident lifecycle. For example, you can
configure an action to occur when an incident of the type you are configuring is generated (Registered).
When an incident is generated, you might want to automatically open a trouble ticket or send email or
page your network operator. After the incident is Closed, you might want to automatically close the trouble
ticket.

You can configure actions for incidents generated from SNMP traps, NNM 6.x or 7.x events, and the NNMi
management events. Any time an incident configuration changes, the action directory is re-scanned and
any Jython files are reloaded to the NNMi database. See "Lifecycle Transition Action Form" (on page 284)
for more information about the actions directory.

Tip: Copy any required Jython files to the NNMi actions directory before you configure an incident action.
New or updated actions are loaded into NNMi only when an incident configuration is updated or
created. See "Lifecycle Transition Action Form" (on page 284) for the location of the NNMi action direc-
tory.

When the action runs, output is logged to the eventActions.*.*.log file. See "Verify that NNMi Services
Are Running" (on page 28) for more information about log files and where they are located.

Note: Do not use the Node Up Incident configuration to configure incident actions. Use the Node Down
incident configuration and the Closed Lifecycle State. See "Management Event Configurations Pro-
vided by NNMi" (on page 229)for more information about the Node Up and Node Down incident con-
figurations.

To configure an automatic action for an incident:

1. Navigate to the Action Configuration tab.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Configuration, Remote NNM 6.x/7.x Event Configuration, or Man-
agement Event Configuration tab.

d. Select the Action Configuration tab.

2. From the Lifecycle Actions table toolbar, do one of the following:

n To create an Action configuration, click the  New icon, and continue.

n To edit an Action configuration, click the  Open icon, and continue.
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n To delete an Action configuration, click the  Delete icon.

3. In the "Lifecycle Transition Action Form" (on page 284), provide the required information.

4. Click Save and Close to return to the SNMP Trap, Remote 6.x/7.x, or Management Event Con-
figuration form.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

The next time the lifecycle changes, NNMi launches the action associated with the lifecycle for the incident
of that type .

Lifecycle Transition Action Form

Use this form to enter the command you want to run when an incident of the type you are configuring is at a
particular lifecycle state. For example, when an incident is generated (Registered), you might want to auto-

matically open a trouble ticket or email or page your network operator.

To configure an action for an incidents:

1. Navigate to the Lifecycle Transition Actions form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Configuration, Remote NNM 6.x/7.x Event Configuration, or Man-
agement Event Configuration tab.

d. Select the Action Configuration tab.

e. From the Lifecycle Transition Action table toolbar, do one of the following:

o To create an Action configuration, click the New icon, and continue.

o To edit an Action configuration, click the Open icon, and continue.

o To delete an Action configuration, click the  Delete icon.

2. Make your configuration choices (see table).

Note: NNMi reloads the configuration information anytime the incident configuration is changed.

3. Click Save and Close to return to the SNMP Trap, Remote 6.x/7.x, or Management Event Con-
figuration form.

4. Click Save and Close to return to the Incident Configuration form.

5. Click Save and Close to save your changes.

Attribute Description

Lifecycle
State

Select a lifecycle state from the drop-down menu. Possible values are: Registered, In Prog-
ress, Completed, and Closed.

Command
Type

If you provided a Jython command, select Jython from the drop-down list.

If you are using an executable or bat file, select ScriptOrExecutable from the drop-down
list.

Create Action Attributes
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Attribute Description

Command Enter one of the following:

l A Jython method with the required parameters

l Executable command for the current operating system with the required parameters.

When entering a command value, note the following:

l Verify that you do not have two Jython methods with the same name. Otherwise, NNMi is
not able to tell which is the correct method to load.

l You can use the same Jython method for more than one incident configuration.

l Python files or other executable scripts need to reside in the following directory:

Windows:

<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
 Software\shared\nnm\actions

<drive> is the drive on which NNMi is installed.

UNIX:

/var/opt/OV/shared/nnm/actions

Note: Use absolute paths to executables instead of relying on the PATH variable as it might
not be set correctly.

l NNMi provides a set of parameters that can pass attribute values from an incident con-
figuration. See "Valid Parameters for Configuring Incident Actions " (on page 285) for
more information.

See "Example Jython Methods Provided by NNMi" (on page 290) for a description of exam-
ple Jython methods provided by NNMi.

Valid Parameters for Configuring Incident Actions

When configuring incident actions, you may want to use incident information as part of the action. NNMi
provides the following parameter values. Use these parameters as variables in your Jython methods or
executable files.

Tip: See the Using the Incident Form for more information about the parameter values.

Note: NNMi stores varbind values as custom incident attributes (CIAs).

See "Lifecycle Transition Action Form" (on page 284) for more information about configuring incident
actions.

Parameter Value Description

$category, $cat Value of the Category attribute in the Incident form.

$count, $cnt Value representing the number of Custom Incident Attributes that appear in
the Incident form.

$family, $fam Value from the Family attribute in the Incident form.

Valid Parameters Visible From an Incident's Form
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Parameter Value Description

$firstOccurrenceTime,
$fot

Value from the First Occurrence Time attribute in the incident form.

$lastOccurrenceTime,
$lot

Value from the Last Occurrence Time attribute in the incident form.

$lifecycleState, $lcs Value from the Lifecycle State attribute in the Incident form.

$name Value of the Name attribute from the incident configuration.

$nature, $nat Value from the Nature attribute in the Incident form.

$origin, $ori Value from the Origin attribute in the Incident form.

$originOccurrenceTime,
$oot

Value from the Origin Occurrence Time attribute in the incident form.

$priority, $pri Value from the Priority attribute in the Incident form.

$severity, $sev Value of the Severity attribute of the Incident form.

Parameter Value Description

$id Unique Object Identifier attribute value for the incident
(unique across the entire NNMi Database).

$ifAlias, $ifa Value from the IfAlias attribute of the Interface form.

$firstOccurrenceTimeMS, $fms Value from the First Occurrence Time attribute in the
incident form, converted to millseconds (measured
since January 1, 1970, 00:00:00 GMT - Greenwich
Mean Time).

$lastOccurrenceTimeMS, $lms Value from the Last Occurrence Time attribute in the
incident form, converted to millseconds (measured
since January 1, 1970, 00:00:00 GMT - Greenwich
Mean Time).

$managementAddress, $mga Value from the Management Address attribute of the
associated Node form or SNMP Agent form.

$oid Value of the unique object identifier (oid) for the inci-
dent configuration that originated from either an SNMP
 trap, Management Event, or Remote NNM 6.x or 7.x
event.

$otherSideOfConnection, $osc If the incident's Source Node is part of a Layer 2 con-
nection, this attribute is the following combination of
values for the node and one of its interfaces on the
other side of the Layer 2 connection:

The fully-qualified DNS name of the node appended
with the interface Name in the following format: <fully-
qualified DNS name>[interface_name]

Valid Parameters Not Visible From an Incident's Form
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Parameter Value Description

$otherSideOfConnectionIfAlias, $oia If the incident's Source Node is part of a Layer 2 con-
nection, this attribute is the value of the ifAlias of one of
the interfaces on the other side of the Layer 2 con-
nection.

$otherSideOfConnectionManagementAddress,
$oma

If the incident's Source Node is part of a Layer 2 con-
nection, this attribute is the value of the Management
Address of a node on the other side of the Layer 2 con-
nection.

$originOccurrenceTimeMS, $oms Value from the Origin Occurrence Time attribute in the
incident form, converted to millseconds (measured
since January 1, 1970, 00:00:00 GMT - Greenwich
Mean Time).

$sourceNodeUuid, $snu Universally Unique Object Identifier attribute value of
the source node object for the incident (unique across
all databases). This identifier distinguishes the source
node object instance from all other node objects.

$sourceNodeName, $snn Value from the Name attribute of the source Node form.

$sourceNodeLongName, $sln The fully-qualified DNS name as displayed in the Host-
name attribute of the incident's Source Node's form.

$sourceObjectClass, $soc Value of the object class for the object you want to
include. Use this parameter when you need to request
more details of a class of objects through a web serv-
ice. Examples of object classes include:
com.hp.ov.nms.model.core.Interface and
com.hp.ov.nms.model.snmp.SnmpAgent.

$sourceObjectName, $son Value from the Name attribute of the source object. For
example, an interface object is named according to the
MIB ifName. Each ifName varies according to the ven-
dor's conventions. Using the name 4/1 as an example,
4 represents the board number and 1 represents
the port number.

$sourceObjectUuid, $sou Universally Unique Object Identifier attribute value of
the source object for the incident (unique across all
databases). This identifier distinguishes the source
object instance from all other similar object instances..

$uuid Universally Unique Object Identifier attribute value of
the incident (unique across all databases). This iden-
tifier distinguishes the incident object instance from all
other incident objects.
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Parameter
Value Description

$<position
_number>

Value of the custom incident attribute (CIA) position number for any CIA that originated from
a varbind or was added by NNMi. For example, to indicate you want to use the varbind in
position 1, enter: $1

NNMi stores varbind values as Custom Incident Attributes. If you know the varbind position
number, use this parameter.

$<CIA_
name>

Value of the name that is used for the custom incident attribute. For example, $myco-
mpany.mycia. NNMi provides CIA values for configuring Management Events. See Cus-
tom Incident Attributes Provided by NNMi for more information about custom incident
attributes.

$<CIA_
oid>

Value of the object identifier for any custom incident attribute that originated as a varbind.
For example, $.1.3.6.1.6.3.1.1.5.1. Use this parameter when you are not certain of
a custom incident attribute (varbind) position number.

$* Used to indicate you want all of the custom incident attribute values originating as varbinds,
to be passed to the action configuration. Each varbind is returned in the following format:
$<CIA_name>:<CIA_value> in which the custom incident attribute name appears fol-
lowed by the custom incident attribute value.

Valid Parameters Established in Custom Incident Attributes

The function described in the following table replaces the specified numeric value with the associated text
value stored in the CIA. 

Note: The associated MIB must have been loaded using the nnmloadmib.ovpl command.

Function Description

$text($<position_
number>)

The <position_number> argument specifies the numeric value of the custom incident
attribute (CIA) position number for any CIA that originated from a varbind or was
added by NNMi. For example, to indicate you want to use the varbind in position 1,
enter: $1.

After the function runs, NNMi replaces the numeric value with the text value stored in
the CIA.

Note: If a text value is not available, NNMi returns the numeric value.

$text($<CIA_
oid>)

The <CIA_oid> argument specifies the object identifier for any custom incident attrib-
ute that originated as a varbind. For example, $.1.3.6.1.6.3.1.1.5.1. Use this
argument to the $text function when you are not certain of a custom incident attribute
(varbind) position number.

After the function is run, NNMi replaces the numeric value with the text value stored
in the CIA.

Note: If a text value is not available, NNMi returns the numeric value.

Functions to Generate Values Within Incident Messages
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Handling Special Characters in Action Arguments

In some cases, NNMi requires or inserts double quotes or escape characters in action arguments. The fol-
lowing table describes the circumstances around the valid uses of double quotes.

Circumstance Result

If the following special char-
acters are part of a CIA
 value requested as an argu-
ment to an action command:

, ; & > < (space) | =

Windows:

The CIA value (containing the special character) must be wrapped in dou-
ble quotes. For example, to request the CIA having a name value of
Hello;World, the argument must enclose "Hello;World" in quotes.

Request all available CIA
name/value pairs for a par-
ticular incident

$*

The $* argument returns a parsed string. For this example, the available
CIA name/value pairs are:

l $1 = 123

l $com.mycompany.mycia = 012345

l $.1.3.6.1.2.1.2.2.1.1 = 1007

Example Command

echoScript.bat $*

NNMi returns the following string in response to the command:

l Windows:
"1: 123, com.mycompany.mycia:012345,
.1.3.6.1.2.1.2.2.1.1:1007"

l UNIX:
1: 123, com.mycompany.mycia:012345,
.1.3.6.1.2.1.2.2.1.1:1007

Request specific CIA values
as an argument to an action
command

$<CIA name, position, or
OID>

To request specific CIA values, use the $ followed by the CIA name

Example Command

echoScript.bat $1  $com.mycompany.mycia
 $.1.3.6.1.2.1.2.2.1.1

For this example, the CIA name/value pairs are:

l $1 = 123

l $com.mycompany.mycia = 012345

l $.1.3.6.1.2.1.2.2.1.1 = 1007

 NNMi returns the following string in response to the command:

l Windows:
123  012345 1007

l UNIX:
123  012345 1007

Handling Special Characters in Action Arguments
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Circumstance Result

If an invalid CIA name, posi-
tion, or OID is requested as
an argument to an action
command

If the trap or event does not contain one or more of the requested CIAs,
NNMi passes error messages as arguments.

UNIX:

Invalid or unknown cia position 1

Invalid or unknown cia com.mycompany.mycia

Invalid or unknown cia .1.3.6.1.2.1.2.2.1.1

Windows: NNMi encloses each CIA value in double quotes.

Invalid or unknown cia "position 1"

Invalid or unknown cia "com.mycompany.mycia"

Invalid or unknown cia ".1.3.6.1.2.1.2.2.1.1"

Use $* in your incident
action scripts

UNIX:

It is recommended that you do not use $* (shell variable substitution) in
your incident action scripts. If you do use $* within the shell script, spec-
ifying $* expands into the arguments and are rescanned. This means that
blanks in arguments will result in multiple arguments.

If you want to use shell variable substitution, use the "$@" instead so that
blanks in arguments are ignored.

Use arguments to Jython
methods

Enclose any argument that is not preceded with a "$" (dollar sign) in dou-
ble quotes. For example, jythonMethod($Severity, "Hello; World").     

Example Jython Methods Provided by NNMi

NNMi provides a set of example Jython methods you can use when configuring actions for incidents.
These example files reside in the required directory as described in "Lifecycle Transition Action Form" (on
page 284). Also see "Lifecycle Transition Action Form" (on page 284) for more information about creating
incident actions.

Note: The argument values, such as arg1, and arg2, can be any valid parameter as described in "Valid
Parameters for Configuring Incident Actions " (on page 285).

File Name
Command Attribute
Value Description

testPrint.py testPrint_Registered() Displays the incident Lifecycle State specified by
the method name.

testPrint.py testPrint_InProgress() Displays the incident Lifecycle State specified by
the method name.

testPrint.py testPrint_Completed() Displays the incident Lifecycle State specified by
the method name.

testPrint.py testPrint_Closed() Displays the incident Lifecycle State specified by
the method name.

Example Jython Methods Provided by NNMi
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File Name
Command Attribute
Value Description

testPrintArgs.py testPrintArgs(arg1,
arg2, ...)

Displays the specified argument values.

testPrintStdoutStderr.py testPrint_
StdoutStderr()

Displays a message generated by the method to
standard out and standard error.

testPrintThrowException.py testPrint_Throw-
Exception()

Generates an SQLexception.

testPrintWithSyntaxError.py testPrint_With-
SyntaxError(num)

Generates a syntax error.

The output generated from these methods is written to the event action log. You can find the event action
log in the following directory:

Windows:

<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO Soft-
ware\log\nnm

UNIX:

/var/opt/OV/log/nnm

Configure Diagnostics for an Incident (NNM iSPI NET)

NNM iSPI NETonly: NNMi provides a set of Diagnostics (Flow Definitions) that can be run on the Source
Node each time an incident reaches a specified Lifecycle State (for example, as soon as an incident
becomes Registered).

These Diagnostics are sets of automated commands specific to one or more device types, including Cisco
routers and switches, Cisco switch/routers, and Nortel switches.

See "Configure Device Profiles" (on page 95) for more information about device types . See "Diagnostics
(Flows) Provided by NNMi (NNM iSPI NET)" (on page 295) for more information about the Diagnostics pro-
vided by NNMi.

Note: Do not use the Node Up Incident configuration to configure Diagnostics. Use the Node Down inci-
dent configuration and the Closed Lifecycle State. See "Management Event Configurations Pro-
vided by NNMi" (on page 229)for more information about the Node Up and Node Down incident
configurations.

Configuring NNMi to automatically gather diagnostic information about the Source Node whenever a spec-
ified incident reaches a selected Lifecycle State is a two-step process:

1. Specify the Node Group using the "Configuration Per Node Group Form (NNM iSPI NET)" (on page
292)

2. Specify the Diagnostics (Flow Definitions) using the "Diagnostic Selection Form (NNM iSPI NET)" (on
page 293).
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Configuration Per Node Group Form (NNM iSPI NET)

1. Navigate to the Configuration Per Node Group form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Configuration (by OID), SNMP Trap Configuration (by Name),
Remote NNM 6.x/7.x Event Configuration, or Management Event Configuration tab.

d. Do one of the following:

o To create an Incident configuration, click the  New icon, and continue.

o To edit an Incident configuration, click the  Open icon, and continue.

e. Navigate to Configuration Per Node Group tab, and do one of the following:

o To create Configuration per Node Group settings, click the  New icon, and continue.

o To edit Configuration per Node Group settings, click the  Open icon, and continue.

o To delete Configuration per Node Group settings, click the  Delete icon.

2. Provide the required information (see table).

3. Navigate to the Diagnostics Selections tab. Provide the required information in the "Diagnostic
Selection Form (NNM iSPI NET)" (on page 293).

4. Click Save and Close to return to the SNMP Trap, Remote 6.x/7.x, or Management Event Con-
figuration form.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

After configuring the Diagnostic for the incident and Node Group, the Diagnostic must match the following
criteria before it runs:

l The Source Node must be in the specified Node Group.

l The Diagnostic must be valid for the Source Node. (For example, only Nortel switch Diagnostics are
run on Nortel switches.)

l The incident’s current lifecycle state must match the configured lifecycle state.   (For example, configure
an Incident to run a specified Diagnostic when the incident is Closed. If the current Incident's Lifecycle
State is Closed, NNMi runs that Diagnostic.) 

Note: If a Source Node is in more than one Node Group, the Diagnostic is only run on the node the first
time NNMi finds a match for that Source Node based on the configuration Ordering field.   

If these criteria are met, NNM iSPI NET runs the Diagnostics and generates Diagnostic reports to help you
solve the problem on the Source Node.

After you configure Diagnostics for an incident, you can also run Diagnostics and access the Diagnostics
reports on demand, using Actions → Run Diagnostics in the Incident form. The same criteria apply (see
the criteria above). See Incident Form:Diagnostics Tab for more information.

You can also run and access Diagnostics reports from a Node form. See Node Form: Diagnostics Tab for
more information.
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Attribute Description

Node
Group

Specifies the Node Group to which the Source Node must belong. Click the Lookup
icon and choose one of the following options:

l Quick View to view summary information for the displayed Node Group name  

l  Quick Find to view the list of possible Node Groups

l  Open to display the Node Group form

l  New to create a new Node Group

Ordering Specifies the priority order NNMi should use when a node is a member of more than one
Node Group. NNMi runs diagnostics on the node using the lowest applicable Ordering
number.

For example, if a node belongs to a Node Group with an Ordering number of 4 and to a Node
Group with the Ordering number of 11, NNMi runs the diagnostics using the Node Group with
the Ordering number of 4. NNMi does not run Diagnostics on the node when NNMi
accesses the Node Group with an Ordering number of 11.

Enable Specifies whether to enable the Diagnostics configuration.

To enable the Diagnostics selection, select the Enable  checkbox.

To disable the Diagnostics selection, clear the Enable checkbox .

Diagnostic Settings Attributes

Diagnostic Selection Form (NNM iSPI NET)

To configure Diagnostics to run on a Source Node for an incident:

1. Navigate to the Diagnostics Selection form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select Incident Configuration.

c. Select the SNMP Trap Configuration (by OID), SNMP Trap Configuration (by Name),
Remote NNM 6.x/7.x Event Configuration, or Management Event Configuration tab.

d. Do one of the following:

o To create an Incident configuration, click the  New icon, and continue.

o To edit an Incident configuration, select the Incident configuration, click the  Open icon,
and continue.

e. Navigate to Configuration Per Node Group tab, and do one of the following:

o To create a Configuration per Node Group, click the  New icon, and continue.

o To edit a Configuration per Node Group, select the Configuration per Node Group setting,

click the  Open icon, and continue.

o To delete a Configuration per Node Group, select the Configuration per Node Group set-

ting and click the  Delete icon.
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f. Navigate to the Diagnostic Selection tab, and do one of the following:

o To create a Diagnostic Selection setting, click the  New icon, and continue.

o To edit a Diagnostic Selection setting, select the Diagnostic Selection setting, click the
 Open icon, and continue.

o To delete a Diagnostic Selection setting, select the Diagnostic Selection setting and click

the  Delete icon.

2. Provide the required information (see table).

3. Click Save and Close to return to the Configuration per Node Group form.

4. Click Save and Close to return to the SNMP Trap, Remote 6.x/7.x, or Management Event Con-
figuration form.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

After you configure the Diagnostic for the incident and Node Group, the Diagnostic must match the fol-
lowing criteria before the Diagnostic runs:

l The Source Node must be in the specified Node Group.

l The Diagnostic must be valid for the Source Node. (For example, only Nortel switch Diagnostics are
run on Nortel switches.)

l The incident’s current lifecycle state must match a lifecycle state for which it was configured.   (For exam-
ple, if you configure the Incident to run a specified Diagnostic when the incident is Closed, then if the
current Incident's Lifecycle State is Closed, NNMi runs that Diagnostic.) 

Note: If a Source Node is in more than one Node Group, the Diagnostic is only run on the node the first
time NNMi finds a match for that Source Node based on the configuration Ordering field.   

If these criteria are met, NNM iSPI NET runs the Diagnostics and generates Diagnostic reports to help you
solve the problem on the Source Node.

After you configure Diagnostics for an incident, you can also run Diagnostics and access the Diagnostics
reports on demand, using Actions → Run Diagnostics in the Incident form. The same criteria apply (see
the criteria above). See Incident Form:Diagnostics Tab for more information.

You can also run and access Diagnostics reports from a Node form. See Node Form: Diagnostics Tab for
more information.

Attribute Description

Flow Def-
inition

Select the Diagnostic (Flow Definition) you want to use for the specified Node Group.

Click the Lookup icon and choose one of the following options: 

l  Quick View to view summary information for the Flow Definition name displayed.

l  Quick Find to view the list of possible diagnostic Flow Definitions.

NNMi provides diagnostics for the following types of devices:

n Cisco switch

n Cisco router

n Cisco switch/router

Diagnostic Settings Attributes
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Attribute Description

n Nortel switch

See "Diagnostics (Flows) Provided by NNMi (NNM iSPI NET)" (on page 295) for more infor-
mation about the diagnostics provided and the devices to which they apply.

Lifecycle
State

Select the Incident's Lifecycle State you want to use. Possible values include:

l Registered

l In Progress

l Completed

l Closed

See About the Incident Lifecycle for more information about Lifecycle State.

When the Incident is set to this Lifecycle State, the selected Diagnostics (Flow Definitions) is
automatically run on each applicable Source Node in the specified Node Group.

Diagnostics (Flows) Provided by NNMi (NNM iSPI NET)

Diagnostics (Flows) are sets of automated commands specific to one or more device types. You can asso-
ciate these Diagnostics with specific incident configurations. After you associate a Diagnostic with an inci-
dent configuration and specify the Lifecycle State for which the Diagnostic should run, the Diagnostic
automatically runs on the Source Node for the incident whenever the specified Lifecycle State is reached.
See "Configure Diagnostics for an Incident (NNM iSPI NET)" (on page 291) for more information.

NNMi also associates these Diagnostics with each node to which the Diagnostics apply. To view the Diag-
nostics invoked for each node, open the Node form for any node of interest. See Node Form: Diagnostics
Tab for more information.

NNMi provides Diagnostics (Flows) for the following device types:

l Cisco router

l Cisco switch

l Cisco switch/router (see Cisco router and Cisco switch)

l Nortel switch

Name Description

Cisco
Router
Baseline
Information

Uses a series of show commands to determine the current configuration of a Cisco router. It
first displays the router's and NNMi management server's current times. Next, it invokes a
series of commands on the router and formats these results on the summary page. Click
here for a list of the commands included in this Diagnostic.

show version

show protocol

show interface summary

show ip route

Cisco Router Diagnostics (Flow Definitions) Provided by NNMi
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Name Description

show ip protocol

show ip traffic

show vlans

show cdp

show cdp entry

show cdp neighbors

show log

show stacks

Cisco
Show IP
 Route

Obtains routing information using the show ip route command.

Cisco
Route To
Node Diag-
nostic

Note: This Diagnostic Flow is not associated with an NNMi incident or node object and can
only be run from Operations Orchestration Central's Flow Library. Before the Diag-
nostic runs, you are prompted for access information for the source router and target
device node.

Determines failures of either ping or traceroute to a target node. Uses the router to perform
a ping and a traceroute to a target node.

Click here for a list of commands included in this Diagnostic

ping target

traceroute target

Cisco Inter-
face Diag-
nostic

Performs a number of diagnostic checks on a specified interface on the Cisco router. Diag-
nostics performed include whether the link is Down while the interface is Up. The following
error counts are checked:

l Input errors

l CRC errors

l Frame errors

l Overrun errors

l Ignored errors

Name Description

Cisco
Switch
Baseline
Information

Uses a series of show commands to determine the current configuration of a Cisco switch.
It first displays the switch's and NNMi management server's current times. Next, it invokes a
series of commands on the switch and formats these results on the summary page.Click
here for a list of the commands included in this Diagnostic.

show version

show protocol

Cisco Switch Diagnostics (Flow Definitions) Provided by NNMi
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Name Description

show interface summary

show vlans

show cdp

show cdp entry

show cdp neighbors

show log

show stacks

Cisco
Switch
Spanning
Tree Base-
line

Gathers spanning tree protocol and port information from the Cisco switch. The commands
run depend on the device's operating system:

IOS: show spanning-tree brief

CATOS; show spantree

Name Description

Nortel Port
Diagnostic

Determines statistics, including rate-limit and usage for a specified port on a Nortel switch.
This Diagnostic detects rate limit, reception and transmission errors. Similar to Cisco Inter-
face Diagnostic, this flow identifies the following types of errors on the identified port:

l FCS errors

l Undersized packets

l Oversized packets

l Collisions

l Single collisions

l Multiple collisions

l Excessive collisions

l Deferred packets

l Late collisions

Nortel
Route to
Node Diag-
nostic

Note: This Diagnostic Flow is not associated with an NNMi incident or node object and can
only be run from Operations Orchestration Central's Flow Library. Before the Diag-
nostic runs, you are prompted for access information for the source router and target
device node.

Determines failures of either ping or traceroute to a target node.

Click here for a list of commands included in this Diagnostic

ping target

traceroute target

Nortel Switch Diagnostics (Flow Definitions) Provided by NNMi
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Name Description

Nortel
Switch
Baseline

Determines the configuration of a Nortel switch. It first displays the switch's and NNMi man-
agement server's current times. Next, it invokes a series of commands on the switch and for-
mats the results on the summary page. Click here for a list of commands included in this
Diagnostic

show sys-info

show interface

show logging config

show ssh global

show stack-info

send show rate-limit

send show vlan

Nortel
Switch
Spanning
Tree Base-
line

Gathers spanning tree protocol and port information from the Nortel switch. Click here for a
list of commands included in this Diagnostic

show spanning-tree config

show spanning-tree port

show spanning-tree vlans

Generate Interface Disabled Incidents

By default, NNMi does not generate an incident for interfaces whose Administrative Status is set to Down
. If you want NNMi to generate incidents for these disabled interfaces, use the following procedures.

To enable the Interface Disabled Management Event incident configuration:

1. Navigate to the Incident Configuration view.

a. In the Workspace navigation panel, select the Configuration workspace.

b. Select the Incident Configuration view.

2. Select the Management Event Configuration tab.

3. Click the  Open icon in the row that represents the Interface Disabled configuration.

4. Click Enable .

Generate Performance Threshold Incidents (NNM iSPI for Performance
)

NNMi can generate incidents related to performance thresholds. NNMi does not generate threshold inci-
dents until the NNMi administrator configures the performance thresholds and enables the performance
incidents.

To configure NNMi to generate performance threshold incidents:
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Prerequisite: Enable performance polling and configure the performance thresholds. See "Configure
Threshold Monitoring for Interfaces (NNM iSPI for Performance)" (on page 162) for more infor-
mation.

1. Navigate to the Incident Configuration form:

a. From the workspace navigation pane, select the Configuration workspace.

b. Select Incident Configuration.

2. Select the Management Event Configuration tab.

3. Click the  Open icon that precedes the performance threshold incident configuration that you want
to enable                 

Select from the following threshold incident configurations:

InterfaceInputErrorRateHigh

IntefaceInputDiscardRateHigh

InterfaceInputUtilizationHigh

InterfaceInputUtilizationLow

InterfaceInputUtilizationNone

InterfaceOutputDiscardRateHigh

InterfaceOutputErrorRateHigh

InterfaceOutputUtilizationHigh

InterfaceOutputUtilizationLow

InterfaceOutputUtilizationNone

4. Enable the threshold incident by checking Enable in the Basics group of the Management Event
form.

5. Click Save and Close to return to the Incident Configuration form.

6. Click Save and Close to save your changes.

7. Repeat steps 3 through 6 for each configuration you want to use.

The NNM iSPI for Performance now records the number and frequency of threshold related incidents
(exceptions). The NNM iSPI for Performance provides reports to help you establish the root cause of net-
work problems. Access the NNM iSPI for Performance reports with Actions → Reporting - Report Menu in
the incident, node, or interface views and forms. (See NNM iSPI for Performance Actions.)
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Use HP Route Analytics Management System Data in Path View (

NNMi Advanced)

HP Route Analytics Management System (RAMS) is an IP Route Analytics tool that listens to routing pro-
tocols and builds a real-time routing topology map. You can use RAMS data to enhance the NNMi ability to
trace the route path between the source and destination node when displaying a Path View. Some of the
advantages include:

l When accessing RAMS data, NNMi is able to provide a Path View more quickly than when using NNMi
alone. This is because RAMS does not use SNMP to learn the routing paths. Therefore, it does not
need to handle SNMP timeout issues. 

l Because RAMS uses real-time data, rather than data collected from SNMP MIBs, it may also be more
accurate than the Path View data collected from NNMi alone.

After you configure RAMS as described in "Configure One or More Route Analytics Management Systems
(NNMi Advanced)" (on page 300), Path View provides enhanced information.

Related Topics

Path Between Two Nodes

Path Calculation Rules

Path View Limitations

Configure One or More Route Analytics Management Systems (NNMi
Advanced)

HP Route Analytics Management System (RAMS) is an IP Route Analytics tool that listens to routing pro-
tocols and builds a real-time routing topology map. You can use RAMS data to enhance the NNMi ability to
trace the route path between the source and destination node when displaying a Path View.

To enable NNMi to use RAMS data when calculating a Path View, you must use the RAMS form to con-
figure each Route Analytics Management System you want to use. The RAMS form provides details about
the RAMS appliance and the associated RAMS database to be used with NNMi when calculating a Path
View.

To configure a Route Analytics Management System:

1. Navigate to the RAMS Configuration form. 

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the RAMS Configuration.

2. Do one of the following:

n To establish a RAMS configuration, click the New icon, and continue.

n To edit a RAMS configuration, select a row, click the Open icon, and continue.

n To delete a RAMS configuration, select a row and click the Delete icon.

3. Provide the required information (see Basic Attributes table).

4. Click Save and Close to save your changes and return to the list of configured RAMS.
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Attribute Description

Host Hostname or IP address used to identify the RAMS appliance that you want NNMi to access.

Query
Password

Query password configured for the RAMS appliance.

Database
Name

Name of the database that NNMi should access when calculating a Path View. This data-
base must reside on the RAMS appliance that you have identified in the Name attribute.

Priority Used when you configure more than one RAMS appliance. Determines the order in which
NNMi attempts to access the configured RAMS appliances. The lower the number, the
higher the priority. For example, the number 1 is the highest priority.

Basic Attributes

Related Topics

"Use HP Route Analytics Management System Data in Path View (NNMi Advanced)" (on page 300)

Page 301 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Extending NNMi Capabilities

Extending NNMi Capabilities

NNMi enables you to extend its capabilities in the following ways:

l "Add Custom Attributes to a Node or Interface Object" (on page 302)

l You can integrate other programs into the console through the Actions menu. See "Configure URL
Action Basic Behavior" (on page 303).

l HP offers extended features, see "Purchase an HP Smart Plug-in" (on page 319).

Add Custom Attributes to a Node or Interface Object

If you determine that you want to keep track of additional information for a node or interface, you can add
Custom Attributes to these objects. For example, you might determine that you want to track the owner of

your nodes on the network. You might also want to track the serial number for each node.

To add Custom Attributes to a node object:

1. Navigate to the Custom Attributes tab:

a. From the workspace navigation panel, select a workspace that contains a Node view. For
example, the Inventory workspace.

b. In the Node view, select the  check box that precedes the node of interest.

c. Click the Open icon to open the Node Form.

d. Select the Custom Attributes tab.

2. Click the New icon to create a Custom Attribute.

3. Enter a Name and Value. See Node Custom Attributes Form for more information.

4. Click Save and Close to return to the main Node Form.

5. Click Save and Close to save your changes.

To add Custom Attributes to an interface object:

1. Navigate to the Custom Attributes tab:

a. From the workspace navigation panel, select a workspace that contains an Interfaces view.
For example, the Inventory workspace.

b. In the Interfaces view, select the  check box that precedes the interface of interest.

c. Click the Open icon to open the Interface form.

d. Select the Custom Attributes tab.

2. Click the New icon to create a Custom Attribute. 

3. Enter a Name and Value. See Interface Custom Attributes Form  for more information. 

4. Click Save and Close to return to the main Interface Form. 

5. Click Save and Close to save your changes.

Page 302 of 422

../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv0949aNodeFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv0949aNodeFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv0949aNodeFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv0949aNodeFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv1145InterFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv1145InterFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv1145InterFrm-CAFrm.htm
../../../../nmOperHelp/Content/nmOperHelp/nmOprNetInv1145InterFrm-CAFrm.htm


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Extending NNMi Capabilities

Control the Actions Menu

Configure additional NNMi Actions menu items that access in-house tools, Web sites, or a variety of other
resources. You configure the URL that NNMi associates with each new Actions menu item.

URL Actions are a powerful feature of NNMi. The syntax used to define the URL action includes variables
that incorporate real-time data from the NNMi database. Click here for a list of choices:

Configure URL Action Basic Behavior

Configure additional NNMi Actions menu items that access in-house tools, Web sites, or a variety of other
resources. You configure the URL that NNMi associates with each new Actions menu item (see "Control
the Actions Menu" (on page 303) for more information).

To make changes or additions to the items available in the Actions menu:

1. Navigate to the URL Action form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the URL Actions view.

c. Do one of the following:

o To edit an existing Actions menu item, select a row, click the  Open icon, and continue.

o To create a new Actions menu item, click the  New icon, and continue.

o To delete an Actions menu item, select a row, and click the  Delete icon.

2. Provide the required information to define the behavior of the URL action (see basics table).

If you make changes, remember to place your name in the Author attribute. See "URL Actions Author"
(on page 304).

3. Provide the required URL details (see "Configure URL Action Details" (on page 305)).

4. Click Save and Close to return to the URL Actions view.

5. To test your changes to the Actions menu, access a view or form that contains the appropriate object
type. Select an object instance and click the Actions menu. Verify your changes are working.

Attribute Description

Menu Label The text string that appears as the menu link. Ensure that your menu label is unique and
accurately reflects the intended use of the URL action.

If you add two URL actions with the same menu label string, both show up beneath the
Actions menu.

Unique Key Caution: This value cannot be changed after you click Save.

Used as a unique identifier when exporting and importing URL Action definitions. To
ensure that the value you enter is unique, it is recommended that you use the Java name
space convention when providing this value. It is also useful to include the Menu Label
value as part of the unique key as shown in the following example:

com.<company_name>.nnm.urlAction.<url_action_Menu_Label>

URL Action Basics
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Attribute Description

Type a maximum of 80 characters. Alpha-numeric and period characters are allowed. No
spaces are allowed.

Author Click the  Lookup icon next to the Author attribute, and do one of the following:

l To select an existing Author value, select a row, click the  Quick Find icon.

l To create a new Author value, click the  New icon. (See "URL Actions Author" (on
page 304).)

Ordering Valid entries are 1 to 100. This attribute controls where your menu item shows up in the
list of available actions (lowest number appears at the top of the group of URL actions).

Browser
Width

Optional. When empty, the default browser settings are used. If the value is 1 or more, the
browser is launched this number of pixels wide.

Browser

Height

Optional. When empty, the default browser settings are used. If the value is 1 or more, the

browser is launched this number of pixels high.

Add Browser
Decorations

If  enabled, the web browser toolbar and menus appear when a user launches your
URL.

If  disabled, the web browser has no toolbar or menu when a user launches your URL.

Path View
Only

If  enabled, your URL action appears only in the Path View window's Actions menu.
See "Syntax and Limitations for URL Actions" (on page 306) for additional information
about Path View URL configuration choices

If  disabled, your URL action can appear in the menu of multiple views.

Requires
Remote
Management
Station

If  enabled, the action appears only when remote NNM 6.x/7.x management stations
are configured to communicate with NNMi within your environment. (See "Configure
Remote NNM 6.x and 7.x Management Stations" (on page 262).)

If  disabled, the action always appears.

Description Optional. Provide a description of your URL action. Your description is visible only within
this configuration form.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

URL Actions Author

The Author attribute value indicates who created the URL Action definition. For example:

l HP provides predefined actions.

l You can define URL Actions.

To create a new Author attribute value:

1. Navigate to the Author form.

a. From the workspace navigation panel, select the Configuration workspace. 

b. Select the URL Actions view.

c. Open the URL Action form.
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d. In the URL Acton form, locate the Author attribute.

e. Click the Lookup icon, and select New.

2. Type the text that represents the new author (see table).

3. Click Save and Close to return to the URL Action form.

4. Click Save and Close. NNM saves your changes.

Attribute Description

Label Author name. The maximum length is 255 characters. Any character type is valid.

Unique
Key

Caution: After you click Save and Close, this value cannot be changed.

Used as a unique identifier when exporting and importing URL Action definitions. To ensure
that the value you enter is unique, it is recommended that you use the Java name space con-
vention when providing this value. It is also useful to include the label value as part of the
unique key as shown in the following example:

com.<your_company_name>.nnm.urlAction.author.<author_label>

The maximum length is 80 alpha-numeric characters, periods allowed, no spaces allowed.

URL Action Author

Configure URL Action Details

Configure additional NNMi Actions menu items that access in-house tools, Web sites, or a variety of other
resources. You configure the URL that NNMi associates with each new Actions menu item (see "Control
the Actions Menu" (on page 303) for more information).

To make changes or additions to the items available in the Actions menu:

1. Navigate to the URL Action form, Details tab.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the URL Actions view.

c. Do one of the following:

o To edit an existing Actions menu item, select a row, click the  Open icon, and continue.

o To create a new Actions menu item, click the  New icon, and continue.

o To delete an Actions menu item, select a row, and click the  Delete icon.

d. Provide the required information to define the behavior of the URL action (see "Configure
URL Action Basic Behavior" (on page 303)).

If you make changes, remember to place your name in the Author attribute. See "URL Actions
Author" (on page 304).

2. Provide the required URL details (see URL Action Selection Details and URL Action Object Types).

3. Optional. Provide a filter that controls where this URL action is available (see ).

4. Click Save and Close to return to the URL Actions view.
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5. To test your changes to the Actions menu, access a view or form that contains the appropriate object
type. Select an object instance and click the Actions menu. Verify your changes are working.

Attribute Description

Selection
Type

Optional. Default is Single Selection:

l If you specify any of the following, an error message appears when the user launches
the URL action prior to selecting an appropriate object or objects:

n Any Selection means zero or more selections required.

n Single Selection means exactly one selection required.

n Multiple Selection means one or more selections required.

l If you specify No Selection, the user must launch the URL action without selecting any
objects. An error message appears if any objects are selected.

Max Selec-
tion
Count

Only valid if Selection Type = Any Selection or Multiple Selection. Zero means unlimited.
Specify the maximum number of objects the user can select prior to launching this URL
action.

Enable
Cumulative
Launch

If  enabled, any object attribute references in the URL Action definition are populated
with values from all selected objects. The multiple values are separated by a comma char-
acter. For example, if the attribute is "name", the URL results would be
"name1,name2,name3".

If  disabled, the action launches a separate web page instance for each selected object.

See "Syntax and Limitations for URL Actions" (on page 306) for details about including
object attributes in your URL action. 

URL Action Selection Details

Attribute Description

Object
Type

Add one or more definitions for the actual URL syntax. See "Syntax and Limitations for URL
Actions" (on page 306).

Optional. Limit the use of the URL by object-type.

URL Action Object Types

Syntax and Limitations for URL Actions

Provide the details of the URL syntax.

To provide the details of a URL action:

1. Navigate to the URL Action Object Type form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select the URL Actions view.

c. Open the URL Action form.

d. Navigate to the Details tab.
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e. Locate the URL Action Object Types table.

f. Do one of the following:

o To add a URL Action, click the  New icon, and continue.

o To change a URL Action, select a row, click the  Open icon, and continue.

o To delete a URL Action, select a row and click the  Delete icon.

2. Optional. Limit the use of your URL by object type (see table).

3. Specify the lowest user role allowed to access this Action.

4. Provide the required URL syntax. Use a pattern similar to the following (see Full URL).

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling
https for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide
, which is available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/<application>?<yourURLparameter1>=${<objectAttribute>}&<

yourURLparameter2>=${<objectAttribute>}

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi
console

For example: http://-
companyX.com/nodeReport.jsp?node=${hostname}&snmpOid=${systemObjectId}

Tip: If the application that your URL calls is installed on the NNMi management server, the syntax can
be as follows:
/<application>?<yourURLparameter1>=${<objectAttribute>}&<yourURLparameter2>=${<objec-
tAttribute>}

5. Optional. If your URL Action applies to Nodes, Interfaces, or Incidents, you can provide filters that fur-
ther refine when the URL action is available in the Actions menu. See "Specify Optional URL Action
Filters" (on page 315) for more information.

6. Click Save and Close to return to the URL Action form.

7. Click Save and Close to return to the URL Actions view.

8. To test your changes to the Actions menu, access a view or form that contains the appropriate object
type. Select an object instance and click the Actions menu. Verify your changes are working.

Attribute Description

Object
Type

Optional. If no attribute value is provided, your URL action is visible within the Action menu in
all views and forms. If you want your menu item to be available only within a view or form of a
particular object type, copy-and-paste one of the following strings into the Object Type attrib-
ute.

Specific Object-Type Attributes:

com.hp.ov.nms.model.core.Interface [parameter list for Interface]

URL Action and Object Types Basics
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Attribute Description

${capabilities[capability.key=<UniqueKey>].capability.key} <value of one specific Capability,
see "Capability Attributes in URL Actions" (on page 312)for more information>
${customAttributes[name=<yourAttrName>].value} <value of the matching Custom Attribute,
see "Custom Attributes in URL Actions" (on page 313)for more information>
${ifAlias} <value from the IfAlias attribute>
${ifDescr} <value from the IfDescription attribute>
${ifIndex} <value from the IfIndex attribute>
${ifType.label} <value from the IfType attribute>
${journal.notes} <value from the Notes attribute>
${managementMode} <value from the Management Mode attribute>
${name} <value from the Name attribute>
${overallStatus.lastChange} <value from the Status Last Modified attribute>
${overallStatus.status} <value from the Status attribute>
${physicalAddress} <value from the Physical Address attribute>
${speed} <value from the IfSpeed attribute>
Access an attribute on the related Node form:
${hostedOn.hostname} <value from the Hosted On attribute, source Node's Hostname attrib-
ute>
${hostedOn.name} <value from the source Node's Name attribute>

com.hp.ov.nms.model.core.Node [parameter list for Node]

${capabilities[capability.key=<UniqueKey>].capability.key} <value of one specific Capability,
see "Capability Attributes in URL Actions" (on page 312)for more information>
${customAttributes[name=<yourAttrName>].value} <value of the matching Custom Attribute,
see "Custom Attributes in URL Actions" (on page 313)for more information>
${hostname} <value from the Hostname attribute>
${journal.notes} <value from the Notes attribute>
${managementMode} <value from the Management Mode attribute>
${name} <value from the Name attribute>
${overallStatus.lastChange} <value from the Status Last Modified attribute>
${overallStatus.status} <value from the Status attribute>
${snmpSupported} <value from the SNMP Supported attribute>
${systemContact} <value from the System Contact attribute>
${systemDescription} <value from the System Description attribute>
${systemLocation} <value from the System Location attribute, the current value of the sys-
Location MIB variable>
${systemName} <value from the System Name attribute>
${systemObjectId} <value from the System Object ID attribute>
Access an attribute on the related Device Profile form:
${deviceProfile.deviceModel} <value from the Device Model attribute>
${deviceProfile.SNMPObjectID}<value from the SNMP Object ID attribute>
Access an attribute on the related SNMP Agent form:
${snmpAgent.agentSettings.managementAddress} <value from the Management Address
attribute>

com.hp.ov.nms.monitoring.groups.model.NodeGroup [parameter list for Node Group]

${name} <value from the Name attribute>
${notes} <value from the Notes attribute>
${overallStatus.lastChange} <value from the Status Last Modified attribute>
${overallStatus.status} <value from the Status attribute>

com.hp.ov.nms.model.incident.Incident [parameter list for Incident]
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Attribute Description

${category.label} <value from the Category attribute>
${cias[name=<cia.name>].value} <value of one specific Custom Incident Attribute, see "Cus-
tom Incident Attributes in URL Actions" (on page 311)for more information>
${duplicateCount} <value from the Duplicate Count attribute>
${family.label} <value from the Family attribute>
${formattedMessage} <value from the Message attribute>
${getAttrOrName(<attribute>)} <value of the specified attribute of the Node associated with
the Incident (if the Node exists in the database) or the sourceNodeName attribute of the Inci-
dent (if the Node was deleted from the database or never existed in the database). [For exam-
ple, ${getAttrOrName(hostname)}>]
${journal.notes} <value from the Notes attribute>
${lifecycleState.label} <value from the Lifecycle State attribute>
${nature} <value from the Correlation Nature attribute>
${nodeUuid} <value of the uuid for the Source Node, see "Database Object Identifiers for
URL Actions" (on page 311)>
${nodeUuid.id} <value of the id for the Source Node, see "Database Object Identifiers for
URL Actions" (on page 311)
${notes} <value from the Correlation Notes attribute>
${origin} <value from the Origin attribute>
${priority.label} <value from the Priority attribute>
${registration.created} <value from Created attribute>
${registration.modified} <value from the Last Modified attribute>
${severity} <value from the Severity attribute>
${sourceName} <value from Name attribute of the source object>
${sourceNodeName} <value from the Name attribute of the source object>
${sourceUuid} <value of the uuid for the Source Object, see "Database Object Identifiers for
URL Actions" (on page 311)>
${sourceUuid.id} <value of the source object's id attribute>
Access an attribute on the related source object form:
${sourceUuid.name} <value of the source object's Name attribute>
Access an attribute on the related Node form:
${nodeUuid.hostname} <value of the fully-qualified DNS name of the Source Node or IP
address if no DNS name is available>
${nodeUuid.name} <value of the Name attribute of the Source Node>

com.hp.ov.nms.model.layer2.L2Connection [parameter list for Layer 2 Connection]

${journal.notes} <value from the Notes attribute>
${name} <value from the Name attribute of the connection>
${source} <value of the Topology Source attribute, the protocol used to create the con-
nection>

com.hp.ov.nms.model.layer3.IPAddress [parameter list for Address]

${journal.notes} <value from the Notes attribute>
${managementMode} <value from the Direct Management Mode attribute>
${name} <value from the Name attribute>
${overallStatus.lastChange} <value from the Status Last Modified attribute>
${overallStatus.status} <value from the Status attribute>
${prefixLength} <value from the Prefix Length attribute>
${value} <value from the Address attribute>

com.hp.ov.nms.model.layer3.IPSubnet [parameter list for Subnet]

${journal.notes} <value from the Notes attribute>
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Attribute Description

${name} <value from the Name attribute>
${prefix} <value from the Prefix attribute>
${prefixLength} <value from the Prefix Length attribute>

Global Object-Type Attributes: Two attributes are valid for all object types. However, the
values for these two attributes are not visible anywhere in the console, which makes them
harder to use. See "Database Object Identifiers for URL Actions" (on page 311) for more infor-
mation.
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Attribute Description

Role Specify the lowest level role allowed to access this URL action. All roles above the role you
select can also access this URL action. See "Determine which NNMi Role to Assign" (on
page 33).

Full URL Type the full URL specification. Begin with either http:// or https://. Include any required
machine name and port number. Include any required parameters. The list of available
parameters changes depending on which object type (if any) you configure as a limiting fac-
tor for your URL action (see Object Type).

l You can also use other common URL protocols such as ftp://, mailto://, news://, or telnet://.

l You can use an object parameter anywhere in the URL string. For example, to specify
hostname for an action launched from a Node form:
http://${hostname}:<portNumber>/<application>?attr-
ibuteName1=${value}&attributeName2=${value}

l You can limit the availability of the action to one specific instance of an object by using
the database identifier (see "Database Object Identifiers for URL Actions" (on page 311)).

Path View Attributes: If you specified that this action appears only in the Path View menu,
additional parameters are available:

${pathStartNodeName} <value of the Source attribute>
${pathEndNodeName} <value of the Destination attribute>
${pathList} <list of objects traversed along the path, separated by commas>
${pathCalculationDate} <date and time the path was calculated>

If the attribute does not exist (for example, you made a mistake when typing the attribute's
name), the attribute passes through literally (unresolved). For example:

A node named "mynode" is selected, and the URL is:

http://companyX.com?name=${name}&error=${error}

The output would be:

http://companyX.com?name=mynode&error=${error}

Database Object Identifiers for URL Actions

If you need the URL to identify one specific record in the NNMi database, and find that it isn't possible to
provide a unique set of attribute values that distinguish that object instance from all other similar object
instances, the database unique identifiers are a valuable last resort.

l ${uuid} Universally Unique Object Identifier -Unique across all databases.

l ${id} Unique Object Identifier - Unique across the Entire NNMi Database.

For example, the user can select an Interface object in the console, and use this URL Action to open the
form of the Node in which the Interface resides:

/nnm/launch?cmd=showForm&objtype=Node&objid=${hostedOn.id}

Custom Incident Attributes in URL Actions

Custom Incident Attributes (CIAs) are used to provide the following types of information within incidents:
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l SNMP trap varbinds identified by the Abstract Syntax Notation value, ASN.1 (Name = the MIB varbind
identifier, Type = asn_*)

l Custom attributes provided by NNMi (Name = cia.*, Type=String). See "Custom Incident Attributes Pro-
vided by NNMi" (on page 214).

To determine which group of CIAs is available for a specific incident-type (for example, CiscoLinkDown),

navigate to an Incident view, select an instance of that incident-type, click the  Open icon and navigate
to the Custom Attributes tab. The items listed in the table are the CIAs for that particular incident-type. For
example, all CiscoLinkDown incidents would have the same group of CIAs shown in the illustration below.

To pass CIA data within your URL Action, type (or copy and paste) the exact text string from the Incident
form, Custom Attribute tab, Name attribute value:

${cias[name=<cia_name>].value}

Place the CIA into a location in your URL that enables the result your want:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/<application>?<yourURLparameter1>=${cias[name=<cia_name_1
>].value}&<yourURLparameter2>=${cias[name=<cia_name_2>].value}

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If the CIA that you request in your URL Action does not exist for the selected Incident, the resulting
URL passes an empty string.

Capability Attributes in URL Actions

Node and Interface objects can have capability attributes:

l Node Capabilities Provided by NNMi

l Interface Capabilities Provided by NNMi
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l Capabilities can be provided from NNM iSPIs or from integrations with other programs

To determine which group of capabilities are available for a specific Node or Interface, navigate to a Node

view or Interface view, select an instance of the object, click the  Open icon and navigate to the Capabil-
ities tab. The items listed in the table are the Capabilities for that particular node or interface. For example,
the following illustration shows a Node form with three capability entries.

To pass Capability data within your URL Action, type (or copy and paste) the exact text string from the
Node or Interface form, Capability tab, Unique Key attribute value:

${capabilities[capability.key=<UniqueKeyValue>].capability.key}

Place the Capability into a location in your URL that enables the result your want:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/<application>?<yourURLparameter1>=${capabilities[capability.key=<
UniqueKey_1>].capability.key}&<yourURLparameter2>=${capabilities[capability.key=<UniqueKey_2
>].capability.key}

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If the Capability that you request in your URL Action does not exist for the selected Node or Interface,
the resulting URL passes an empty string.

Custom Attributes in URL Actions

Custom Attributes enable an NNMi administrator to add information to the Node object or Interface object.
Custom Attributes can also be set by external applications that have been integrated with NNMi. 
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The Node form: Custom Attributes tab and Incident form: Custom Attributes tab display a table view of any
Custom Attributes that have been added to the selected object. See "Add Custom Attributes to a Node or
Interface Object" (on page 302).

To determine which group of Custom Attributes are available for a specific Node or Interface, navigate to a

Node view or Interface view, select an instance of the object, click the  Open icon and navigate to the
Custom Attributes tab. The items listed in the table are the Custom Attributes for that particular node or inter-
face. For example, the following illustration shows a Node form with two Custom Attribute entries.

To pass Custom Attribute data within your URL Action, type (or copy and paste) the exact text string from
the Node or Interface form, Custom Attributes tab:

${customAttributes[name=<yourAttrName>].value}

Place the Custom Attribute into a location in your URL that enables the result you want:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/<application>?<yourURLparameter1>=${customAttributes[value=<
yourAttrValue>].name}&<yourURLparameter2>=${customAttributes[name=<yourAttrName>].value}

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

l Example 1:

mailto:${customAttributes[name=Admin].value}?subject=URGENT Action Required&body=$-
{customAttributes[name=message].value}&${hostname} router needs attention.

Resulting URL:
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mailto:JohnDoe@myCompany.com?subject=URGENT Action Required&body=Building-5:Floor-
23.&cisco4.myCo.com router needs attention.

l Example 2:

http://myCo.com/emailAdmin.jsp?name= ${hostname}&contact= ${customAttributes[name=
Admin].value}&body= ${customAttributes[name=message].value}

Resulting URL:

http://myCo.com/emailAdmin.jsp?name= cisco4.myCo.com&contact= johnDoe@myCo.com&body=
Building-5:Floor-23

Note: If the Custom Attribute that you request in your URL Action does not exist for the selected Node or
Interface, the resulting URL passes an empty string.

Environment Attributes in URL Actions

Environment Attributes are session-specific and not stored in the NNMi database. These attributes are

received from another application when NNMi is launched from that external application, see "Launch a
View (showView)" (on page 324) or "Launch a Form (showForm)" (on page 350) for more information.
NNMi stores the environmental attribute name-value pairs and passes them back to that application.

For example, after launching NNMi from your company website, you want to provide an Action menu item
within the NNMi console that returns the user to exactly the same place within your company website
where they were prior to launching NNMi.

${getEnvAttr(<applicationAttrName>)}

Place the Environment Attribute into a location in your URL that enables the result you want:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/<application>?<yourURLparameter1>= ${getEnvAttr(<
applicationAttrName1>)}&<yourURLparameter2>= ${getEnvAttr(<applicationAttrName2>)}

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

For example:

http://<myHost>/<myApplication>?com.my.sessionId= ${get-
EnvAttr(com.my.sessionId)}&com.my.objectName= $getEnvAttr(com.my.objectName)}

Could result in the following URL:

http://<myHost>/<myApplication>com.my.sessionId= 123&com.my.objectName= node25

Note: If the Environment Attribute that you request in your URL Action does not exist for the selected view
or form, the resulting URL passes an empty string.

Specify Optional URL Action Filters

If your URL Action applies to Nodes, Interfaces, or Incidents, you can use the Filters Editor to create expres-
sions that further define the context in which this URL Action is available within NNMi. Design complex
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Filters on paper as a Boolean expression first to minimize errors when entering your expressions using
this Filters editor.

To create any Filter expressions:

1. Navigate to the URL Action Object Type form.

a. From the workspace navigation panel, select the Configuration workspace.

b. Select URL Actions.

c. Do one of the following:

o To create an URL Action definition, click the New icon. 

o To edit an URL Action definition, select a row, click the Open icon.

d. Select the Details tab.

e. In the URL Action Object Types table, do one of the following:

o To create an URL Action Object Type definition, click the New icon. 

o To edit an URL Action Object Type definition, select a row, click the Open icon.

2. Select the Filters tab.

3. Establish the appropriate settings for the filter you want to create. (See the Custom Filter Editor Com-
ponents table.)

When creating any filters, note the following:

n Each set of expressions associated with a Boolean Operator is treated as if it were enclosed in
parentheses and evaluated together. View the expression displayed under Filter String to see
the logic of the expression as it is created.

n The AND Boolean Operators must contain at least two expressions as shown in the example
below.

AND
 capability = com.hp.nnm.capability.metric.cse
 AND

 customAttrName = ImportantRouters
 customAttrValue = Building5

NNMi evaluates the expression above as follows:

(capability = com.hp.nnm.capability.metric.cse AND (cus-
tomAttrName=ImportantRouters AND customAttrValue=Building5))

o NNMi finds all nodes with a Capability having the Unique Value of com.hp.nnm-
.capability.metric.cse.

o Of these nodes, NNM then finds all nodes with a Custom Attribute named ImportantNodes
and having the value of Building5.

n The placement of your cursor and the subsequent text that is selected is important when per-
forming operations using the Additional Filters Editor. For example, you append to, replace, or
change the indentation of the expression that is selected.

n The placement of your cursor and the subsequent text that is selected is especially important
when adding your Boolean operators. See "Add Boolean Operators in the Additional Filters
Editor" (on page 134) for more information.
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4. Click Save and Close to return to the URL Action form.

5. Click Save and Close.

Attribute Description

Attribute The attribute name NNMi should use as the filter criteria. Possible attributes include the fol-
lowing:

Interface [click here for a list of atribute vaules]

Unique Keys from the Interface Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Interface Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Node [click here for a list of attribute values]

Unique Keys from the Node Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Node Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Incident [click here for a list of attribute values]

Values from the Incident Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrType (Custom Attribute Type)

l customAttrValue (Custom Attribute Value)

Operator The standard query language (SQL) operations to be used for the search. Valid operators
are described below.

Note: Only the is null Operator returns null values in its search.

l = Finds all values equal to the value specified.

l != Finds all values not equal to the value specified.

l < Finds all values less than the value specified.

l <= Finds all values less than or equal to the value specified.

l > Finds all values greater than the value specified.

l >= Finds all values greater than or equal to the value specified.

l between Finds all values equal to and between the two values specified.

l in Searches for a match in at least one of a series of values.

Custom Filter Editor Components
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Attribute Description

Attribute The attribute name NNMi should use as the filter criteria. Possible attributes include the fol-
lowing:

Interface [click here for a list of atribute vaules]

Unique Keys from the Interface Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Interface Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Node [click here for a list of attribute values]

Unique Keys from the Node Form: Capabilities Tab:

l capability (Unique Key of the Capability)

Values from the Node Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrValue (Custom Attribute Value)

Incident [click here for a list of attribute values]

Values from the Incident Form: Custom Attributes Tab:

l customAttrName (Custom Attribute Name)

l customAttrType (Custom Attribute Type)

l customAttrValue (Custom Attribute Value)

l is not null Searches for all non-blank values.

l is null Searches for all blank values.

l like Enables you to find matches using the asterisk (*) and question mark (?) as wildcard
characters. Question mark character means "any single character of any type at this loca-
tion". Asterisk character means "any number of characters of any type at this location".

l not between Finds all values except those between the two values specified.

l not in Finds all values except those included in the list of values.

l not like Finds all values except those included in the value specified. The not like oper-
ator enables you to use the asterisk (*) and question mark (?) as wildcard characters.

Value The value for which you want NNMi to search.

Note the following:

l The values you enter are case sensitive.

l NNMi displays a variable number of value fields depending on the Operator selected.
For example, the between Operator causes two value fields to be displayed.

l The in and not in operators require that each value be entered on a separate line.
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Button Description

Append Appends the current expression (Attribute, Operator,and Value) to the selected expression
already included in the filter string.

Replace Replaces the selected expression with the expression displayed in the Attribute, Operator,
and Value fields.

AND Inserts the AND Boolean Operator in the selected cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

OR Inserts the OR Boolean Operator in the current cursor location.

Note: View the expression displayed under Filter String to see the logic of the expression as
it is created.

AND < >

OR

Switches the selected Boolean Operator to either AND or OR. If the selected Boolean Oper-

ator is AND, the value is changed to OR. If the selected Boolean Operator is OR, the value is
changed to AND.

Outdent Moves the indentation of the selected expression one tab to the left . Check the expression dis-
played under Filter String to determine the new placement of parenthesis.

Note: If the expression is located at the leftmost tab, it will not be moved.

Delete Deletes the selected expression.

Note: If the Boolean Operator is selected, the Additional Filters Editor deletes all expressions
associated with the Boolean Operator.

Additional Filters Editor Buttons

Purchase an HP Smart Plug-in

A Smart Plug-in (iSPI) extends NNMi capabilities. For example, each iSPI may or may not:

l Enhance the data that is available.

l Add new workspaces, views, and forms.

l Add tabs to existing NNMi forms.

l Change the features of the NNMi user interface.

Multiple iSPIs are available, enabling you to manage your network in a way that makes sense in your
organization:

l NNM iSPI for MPLS

l NNM iSPI for Multicast

l NNM iSPI for Performance

l NNM iSPI for Telephony

See the HP Network Node Manager i-series Software Deployment Guide, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals

For information about purchasing HP Smart Plug-ins contact your HP sales representative.

Page 319 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Extending NNMi Capabilities

Purchase Integrations with Other HP Products

Multiple HP Software products can be configured to share data with NNMi and receive data from NNMi.
See the HP Network Node Manager i-series Software Deployment Guide, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals

The integration extend NNMi capabilities. For example, each integration may or may not:

l Enhance the data that is available.

l Add new workspaces, views, and forms.

l Add tabs to existing NNMi forms.

l Change the features of the NNMi user interface.

For information about the available integrations, contact your HP sales representative.
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Integrating NNMi Elsewhere with URLs

Use URLs to provide access to the console or certain NNMi features. For example:

l Embed views within your company Web portal.

l Launch a map from within other applications, such as from an email.

l Launch a filtered view from a browser window to quickly find the information you need.

l Run a tool without opening the console.

For a quick-reference list of all URLs that launch NNMi, see Help → Documentation Library → URL
Launch Reference.

Prerequisite: NNMi requires authentication for access through URLs. See "Authentication Requirements
for launch URLs Access" (on page 321).

Related Topics:

"Launch the Console (showMain)" (on page 324)

"Launch a View (showView)" (on page 324)

"Launch a Form (showForm)" (on page 350)

"Launch Menu Items (runTool)" (on page 361)

"Confirm that NNMi Is Running (cmd=isRunning)" (on page 370)

Authentication Requirements for launch URLs Access

Log on and authentication are the same as if you log on to the console using http://<serverName>:<
portNumber>/nnm. Each user must have a preconfigured user name, password, and role assignment.
See "Configure Sign-In Access" (on page 32) for more information.

Caution: There is an inherent vulnerability in passing a plain text password as a Launch URL parameter.
Consider configuring the NNMi management server to use https/SSL so that user names/pass-
words are encrypted between client and server. (See the "Enabling https for NNMi" chapter in the
HP Network Node Manager i-series Software Deployment Guide, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals)

To bypass the log on page, include the following two parameters in your Launch URL string:

l j_username

l j_password

It is recommended that you only bypass the log on page with the "Guest" role (the Guest role provides
"read-only" access to a subset of console features). For example, if you have previously defined an
account where both the user Name and Password are "guest", the following brings up a list of example
URLs:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?j_username=guest&j_password=guest

<serverName> = the fully-qualified domain name of the NNMi management server
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<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

If the user name and password are not valid, the log on page appears with an authentication error mes-
sage.

Any Launch URL request that contains j_username and j_password redirects, so the actual user name
and password are not visible in the Web browser. 

Access to console features is limited by the role assignment. The roles are hierarchical in nature. For more
information:

"Access to Forms" (on page 322)

"Access to Workspaces" (on page 322)

"Access to Commands" (on page 323)

Access to Forms

Each role configuration controls what the user can and cannot do within a particular form. These per-
mission settings cannot be changed.

Forms
Guest
Role

Level 1
Operator
Role

Level 2
Operator
Role Administrator

Node forms Read-
Only

Read-Write except Management Mode field
which is Read-Only

Read-
Write

Read-Write

Interface
forms

Read-
Only

Read-Write except Management Mode field
which is Read-Only

Read-
Write

Read-Write

IP Address
forms

Read-
Only

Read-Write except Management Mode field
which is Read-Only

Read-
Write

Read-Write

IP Subnet
forms

Read-
Only

Read-Write except Management Mode field
which is Read-Only

Read-
Write

Read-Write

Incident forms Read-
Only

Read-Write Read-
Write

Read-Write

Node Group
forms

Read-
Only

Read-Only Read-
Only

Read-Write

Configuration
Form

Read-Write

Role Limitations for URL Access to Forms

Related Topics

"Determine which NNMi Role to Assign" (on page 33)

Access to Workspaces

For integration URLs, the user role determines access each view. The predefined role settings cannot be
changed.
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Each role configuration controls what the user can and cannot do with particular view. See "Determine
which NNMi Role to Assign" (on page 33).

Workspaces
Guest
Role

Level 1
Operator
Role

Level 2 Operator
Role Administrator

All views in the Incident workspaces Yes Yes Yes Yes

All views in the Topology workspaces Yes Yes Yes Yes

All views in the Monitoring workspace Yes Yes Yes Yes

All views in the Troubleshooting workspace Yes Yes Yes Yes

All views in the Inventory workspace Yes Yes Yes Yes

All views in the Management Mode work-
space

Yes Yes

All views in the Configuration workspace Yes

Role Limitations for URL Access to Workspaces

Access to Commands

Access to NNMi menus depends on the role assigned to the user. The following table shows the default
settings for access to NNMi menu choices.

Tip: NNMi administrators can change the Actions menu settings. See "Control Menu Access" (on page 34).

Equivalent Command in the Console
Guest
Role

Level 1
Operator
Role

Level 2
Operator
Role Administrator

Actions → Ping Command Yes Yes Yes

Actions → Trace Route Yes Yes Yes

Actions → Communications Settings Yes

Actions → Monitoring Settings Yes Yes Yes

Actions → Status Poll Yes Yes

Actions → Configuration Poll Yes Yes

Actions → Status Details Command (for Node
Groups)

Yes Yes Yes

Tools → NNMi Status Yes Yes Yes

Tools → Sign In/Out Audit Log Yes

File → Sign Out Yes Yes Yes Yes

Role Limitations to Launch URL Commands
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Launch the Console (showMain)

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch the entire console, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=showMain

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

To launch the console and bypass login, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=showMain&j_username=<accountName
>&j_password=<accountPassword>

Caution: Review in the information in "Authentication Requirements for launch URLs Access" (on page
321) before bypassing the login. 

Launch a View (showView)

Tip: A view session launched with a URL never times out. (If you are using Mozilla Firefox, see also Con-
figure Mozilla Firefox Timeout Interval.) To continuously display up-to-date information in your network
operation center (NOC), launch a URL view .

To launch a default table view that displays all instances of a specified object type, use the following
URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.
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x = objtype Value Default View
Node
Filter

Interface
Filter

Incident Incidents workspace, All Incidents table view                      Yes No

Node Inventory workspace, Nodes table view Yes No

Interface Inventory workspace, Interfaces table view Yes Yes

IPAddress Inventory workspace, IP Addresses table view Yes Yes

IPSubnet Inventory workspace, IP Subnets table view No No

NodeGroup Inventory workspace, Node Groups table view No No

InterfaceGroup Inventory workspace, Interface Groups table view No No

Default View for Each Object Type and Available Filters

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= <x>&nodegroup=

<Name>

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= <x>&ifgroup= <
Name>

Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)
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Attribute Values

ifgroup The Name attribute value of the Interface Group to use as a filter for this view.

Note: The Interface Group name is translated. If your team shares NNMi within multiple
locales, use ifgroupid or ifgroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

ifgroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Provide
the id of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attrib-
ute value for each object instance.

ifgroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Filter by Interface Group (launched Interface and IP Address views)

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= <x>&menus= <
true|false>&newWindow= <true|false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

Attributes for Launched Views
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Attribute Values

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

If you want to launch some other view, specify the view rather than the object type:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>

For more information, see:

"Launch an Incident View" (on page 327)

"Launch a Topology Maps Workspace View" (on page 330)

"Launch a Monitoring Workspace View" (on page 335)

"Launch a Troubleshooting Workspace View" (on page 338)

"Launch an Inventory Workspace View" (on page 343)

"Launch a Management Mode Workspace Views" (on page 346)

"Launch a Configuration Workspace View" (on page 349)

Launch an Incident View

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

View Name x = View ID
Node
Filter

Interface
Filter

All Incidents allIncidentsTableView Yes No

All Open Incidents allOpenIncidentsTableView Yes No

Closed Key Incidents closedKeyIncidentsTableView Yes No

Potential Incident Workspace Views and Available Filters
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View Name x = View ID
Node
Filter

Interface
Filter

Closed Root Cause Incidents closedRCIncidentTableView Yes No

Custom Incidents customIncidentTableView Yes No

Incidents by Correlation Nature incidentsByNatureTableView Yes No

Incidents by Family incidentsByFamilyTableView Yes No

Key Incidents by Lifecycle State keyIncidentsByLifecycleStateTableView Yes No

My Open Incidents myIncidentTableView Yes No

NNM 6.x / 7.x Events nnm6x7xIncidentTableView Yes No

NNM 6.x/7.x Event by Category nnm6x7xIncidentByCategoryTableView Yes No

Open Key Incidents openKeyIncidentsTableView Yes No

Open Key Incidents by Category openKeyIncidentsByCategoryTableView Yes No

Open Key Incidents by Family openKeyIncidentsByFamilyTableView Yes No

Open Key Incidents by Priority openKeyIncidentsByPriorityTableView Yes No

Open Key Incidents by Severity openKeyIncidentsBySeverityTableView Yes No

Open Root Cause by Category openRCIncidentsByCategoryTableView Yes No

Open Root Cause by Family openRCIncidentsByFamilyTableView Yes No

Open Root Cause by Priority openRCIncidentsByPriorityTableView Yes No

Open Root Cause by Severity openRCIncidentsBySeverityTableView Yes No

Open Root Cause Incidents openRCIncidentTableView  Yes No

Root Cause Incidents allRCIncidentTableView Yes No

Root Cause by Lifecycle State RCIncidentsByLifecycleStateTableView Yes No

Service Impact Incidents serviceImpactIncidentTableView Yes No

SNMP Traps snmpTrapsIncidentTableView Yes No

SNMP Traps by Family snmpTrapsIncidentByFamilyTableView Yes No

Stream Correlation Incidents streamCorrelationIncidentTableView Yes No

Unassigned Open Key Incidents unassignedKeyIncidentsTableView Yes No

Unassigned Root Cause Incidents unassignedIncidentTableView Yes No

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&nodegroup= <
Name>
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Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&menus= <
true|false>&newWindow= <true|false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

Attributes for Launched Views
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Attribute Values

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Launch a Topology Maps Workspace View

The URL required for each one is unique.

Tip: A map session launched with a URL never times out. The view automatically updates every 30 sec-
onds. This is useful if your network operation center (NOC) continuously displays a map of the most
important nodes. See "Configuring Maps" (on page 198). (If you use the Mozilla Firefox browser and
are prompted to click Continue before the map appears, see Configure Mozilla Firefox Timeout Interval
.)

Click here to show the example of a URL that opens the Node Group Overview map (cmd=sho-
wNodeGroupOverview).                 

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroupOverview

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroupOverview&menus= <
true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-

Attributes for Launched Views
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Attribute Values

nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show the example of a URL that opens the Network Overview map (cmd=ho-
wNetworkOverview).                 

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd= showNetworkOverview

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showNetworkOverview&menus= <
true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

Attributes for Launched Views
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Attribute Values

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show the example of a URL that opens the Networking Infrastructure Devices node group
map (cmd=showView).                 

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= Node&nodegroup=
Networking%20Infrastructure%20Devices

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&objtype= Node&nodegroup=
Networking%20Infrastructure%20Devices&menus= <true/false>&newWindow= <true/false
>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

Attributes for Launched Views
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false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show the example of a URL that opens the Routers node group map (cmd=sho-
wNodeGroup&name=Routers).                 

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= Routers

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= Routers
&menus= <true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2=
value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the

Attributes for Launched Views
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browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show the example of a URL that opens the Switches node group map (cmd=sho-
wNodeGroup&name=Switches).                 

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= Switches

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= Switches
&menus= <true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2=
value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

Attributes for Launched Views

Page 334 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Integrating NNMi Elsewhere with URLs

Attribute Values

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Launch a Monitoring Workspace View

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

View Name x = View ID
Node
Filter

Interface
Filter

Critical Component Health criticalComponentHealthTableView No No

Critical Interfaces criticalInterfaceTableView Yes Yes

Monitoring Workspace Views and Available Filters
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View Name x = View ID
Node
Filter

Interface
Filter

Critical Nodes criticalNodeTableView Yes No

Non-Normal Interfaces nonNormalInterfaceTableView Yes Yes

Non-Normal Nodes nonNormalNodeTableView Yes No

Not Responding Addresses notRespondingIPAddressTableView Yes Yes

Nodes by Status nodesByStatusTableView Yes No

Component Health by Status componentHealthByStatusTableView No No

Interfaces by Status interfacesByStatusTableView Yes Yes

Interfaces by Administrative
State

interfacesByAdministrativeStateTableView Yes Yes

Interfaces by Operational State interfacesByOperationalStateTableView Yes Yes

IP Addresses by State IPAddressesByStateTableView Yes Yes

Interface Performance interfacePerformanceTableView Yes Yes

Router Redundancy Groups routerRedundancyGroupsTableView No No

Node Groups nodeGroupsStatusTableView No No

 The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&nodegroup= <

Name>

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&ifgroup= <Name
>

Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)
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nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Attribute Values

ifgroup The Name attribute value of the Interface Group to use as a filter for this view.

Note: The Interface Group name is translated. If your team shares NNMi within multiple
locales, use ifgroupid or ifgroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

ifgroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Provide
the id of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attrib-
ute value for each object instance.

ifgroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Filter by Interface Group (launched Interface and IP Address views)

The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&menus= <
true|false>&newWindow= <true|false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

Attributes for Launched Views
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Attribute Values

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Launch a Troubleshooting Workspace View

There are four types of views in the Troubleshooting workspace. The URL syntax required for each one is
unique.

Tip: A map session launched with a URL never times out. The view automatically updates every 30 sec-
onds. This is useful if your network operation center (NOC) continuously displays a map of the most
important nodes. See "Configuring Maps" (on page 198). (If you use the Mozilla Firefox browser and
are prompted to click Continue before the map appears, see Configure Mozilla Firefox Timeout Interval
.)

Click here to show examples of URLs that open a Layer 2 Neighbor View (cmd=showLayer2Neighbors).

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer2Neighbors

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer2Neighbors&nodename= <x
>&hops= <#>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.
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Attribute Value

nodename The source node's DNS hostname or IP address.

Provide a full or short DNS name or an IP address.

If you use this attribute, NNMi tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the Addresses tab in the Node
form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

hops 1 - 9

Layer 2 Neighbor View Attributes

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer2Neighbors&menus= <
true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Attributes for Launched Views

Click here to show examples of URLs that open a Layer 3 Neighbor View (cmd=showLayer3Neighbors).

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
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for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer3Neighbors

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer3Neighbors&nodename=
<x>&hops= <#>

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

Attribute Value

nodename The source node's DNS hostname or IP address.

Provide a full or short DNS name or an IP address.

If you use this attribute, NNMi tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the Addresses tab in the Node
form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

hops 1 - 9

menus true = Show the menus and window toolbar in the form. If not specified, the default is true.

false  = Hide the menus and window toolbar in the view.

Layer 3 Neighbor View Attributes

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showLayer3Neighbors&menus= <
true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

Attributes for Launched Views
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Attribute Values

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show examples of URLs that open a Path View (cmd=showPath).

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showPath

http://<serverName>:<portNumber>/nnm/launch?cmd= showPath&src= <x>&dest= <y>

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

Attribute Value

src The source node's DNS hostname or IPv4 address.

dest The destination node's DNS hostname or IPv4 address.

Path View Attributes

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showPath&menus= <true/false>&n-
ewWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

Attributes for Launched Views
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Attribute Values

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Click here to show examples of URLs that open a Node Group Map View (cmd=showNodeGroup).

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= <x>

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

Attribute Value

name The Name attribute value from the Node Group form.

Note: The Node Group name is translated. If your team shares NNMi within multiple locales,
use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

Node Group Map View Attributes
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Attribute Value

objid The id is the Unique Object Identifier (unique across the entire NNMi database). Provide the
id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attribute
value for each object instance.

objuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Provide
the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showNodeGroup&name= <x>&menus= <
true/false>&newWindow= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Attributes for Launched Views

Launch an Inventory Workspace View

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>
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<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

View Name x = View ID
Node
Filter

Interface
Filter

Nodes allNodesTableView Yes No

Interfaces allInterfacesTableView Yes Yes

IP Addresses allIPAddressTableView Yes Yes

IP Subnets allIPSubnetsTableView No No

VLANs allVlansTableView No No

Layer 2 Connections allLayer2ConnectionsTableView No No

Nodes by Device Category nodesByDeviceCategoryTableView Yes No

Interfaces by IfType interfacesByIfTypeTableView Yes No

Custom Nodes customNodeTableView Yes No

Custom Interfaces customInterfaceTableView Yes Yes

Custom IP Addresses customIPAddressTableView Yes Yes

Router Redundancy Groups routerRedundancyGroupsTableView No No

Node Groups nodeGroupsTableView No No

Interface Groups interfaceGroupsTableView No No

Management Stations allManagementStationsTableView No No

Inventory Workspace Views and Available Filters

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&nodegroup= <
Name>

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&int-
erfacegroup= <Name>
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Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)

Attribute Values

ifgroup The Name attribute value of the Interface Group to use as a filter for this view.

Note: The Interface Group name is translated. If your team shares NNMi within multiple
locales, use ifgroupid or ifgroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

ifgroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Provide
the id of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attrib-
ute value for each object instance.

ifgroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-

Filter by Interface Group (launched Interface and IP Address views)
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Attribute Values

ute value for each object instance.

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&menus= <
true/false>&newWindow= = <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Attributes for Launched Views

Launch a Management Mode Workspace Views

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.
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Use the browser buttons to close the view.

View Name x = View ID
Node
Filter

Interface
Filter

Managed Nodes managedNodeTableView Yes No

Managed Interfaces managedInterfaceTableView Yes Yes

Managed IP Addresses managedIPAddressTableView Yes Yes

Not Managed Nodes notManagedNodeTableView Yes No

Not Managed Interfaces notManagedInterfaceTableView Yes Yes

Not Managed IP Addresses notManagedIPAddressTableView Yes Yes

Out of Service Nodes outOfServiceNodeTableView Yes No

Out of Service Interfaces outOfServiceInterfaceTableView Yes Yes

Out of Service IP Addresses outOfServiceIPAddressTableView Yes Yes

Nodes managementModeNodeTableView Yes No

Interfaces managementModeInterfaceTableView No Yes

IP Addresses managementModeIPAddressTableView Yes Yes

Management Mode Workspace Views

The following are optional filter parameters:The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&nodegroup= <

Name>

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&ifgroup= <Name
>

Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)

Page 347 of 422



Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Integrating NNMi Elsewhere with URLs

Attribute Values

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Attribute Values

ifgroup The Name attribute value of the Interface Group to use as a filter for this view.

Note: The Interface Group name is translated. If your team shares NNMi within multiple
locales, use ifgroupid or ifgroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

ifgroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Provide
the id of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attrib-
ute value for each object instance.

ifgroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Interface Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Filter by Interface Group (launched Interface and IP Address views)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&menus= <
true/false>&newWindow= = <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is

Attributes for Launched Views
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Attribute Values

false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Launch a Configuration Workspace View

Configuration workspaces require that the user be assigned to the Administrative role.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi view with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

Use the browser buttons to close the view.

View Name x = View ID

Node Groups nodeGroupsTableView

Node Group Map Settings allNodeGroupMapSettingsTableView

Interface Groups interfaceGroupsTableView

Management Stations allManagementStationsTableView

RAMS Servers ramsServerTableView

Configuration Workspace Views
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View Name x = View ID

URL Actions allURLActionInfosTableView

User Accounts and Roles allAccountsTableView

IfTypes allIfTypesTableView

Device Profiles allDeviceProfilesTableView

 The following are optional parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showView&view= <x>&menus= <
true/false>&newWindow= = <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

newWindow true = Display the view in a new browser window. This new window does not display the
browser-specific menu bars. The browser-specific menu bars are hidden to provide the
maximum amount of room for the requested view.

false = Display the view within the current browser window (if not specified, the default is
false).

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an exter-
nal application to NNMi. Environment Attributes are session-specific and stored in mem-
ory (not in the NNMi database). The name-value pairs can be any arbitrary string (as
required by the external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about
how to pass these same environment attribute name-value pairs from NNMi back to the
originating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.s-
essionId= 123;com.my.objectName= node25

Attributes for Launched Views

Launch a Form (showForm)

To launch a particular form, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is

available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd=showForm...

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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Launch a form to see information about a particular node, interface, address, subnet, or incident. In the
URL string, you must include one or more attributes that enable NNMi to find a specific object. If more than
one object meets the criteria, NNMi opens the first one found. When designating more than one attribute,
separate each with a semicolon character.

"Launch a Node Form" (on page 351)

"Launch an Interface Form" (on page 353)

"Launch an IP Address Form" (on page 355)

"Launch a Subnet Form" (on page 356)

"Launch an Incident Form" (on page 357)

"Launch a Node Group Form" (on page 358)

"Launch a Configuration Form" (on page 360)

Launch a Node Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&nodename=
<x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&objattrs=
name= <x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&objattrs=
hostname= <x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&objattrs=
snmpAgent.agentSettings.managementAddress= <x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&objattrs=
systemName= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.
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Attribute Values

nodename Provide a full or short DNS name or an IP address.

If you use this attribute, NNM tries to match the string you provide by fol-
lowing this procedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the Addresses
tab in the Node form.

l Check the value of the System Name field on the General tab in the
Node form.

l Check the value in the Name field on the Node form.

name The Name attribute value from the Node form.

hostname Caution: The Hostname attribute value on the Node form of the discovered
node must match what is entered here (see the Hostname attribute
the Node form help topic).

If a device has multiple hostnames or no hostname, NNMi follows a set of
rules to determine the hostname. Click here for details.

1. If a hostname is available, it must resolve to a valid IP address. NNMi
stores the fully-qualifiedhostname in the database as all lowercase
characters.

2. If more than one address is associated with a node, the loopback
address1 is used with the following exceptions:

n NNMi prefers loopback interfaces for management communication,
where possible. However, NNMi automatically filters out addresses
in the reserved loopback network range 127/24 (127.*.*.*).

n NNMi ignores any address that is virtual (HSRP/VRRP) or an Any-
cast Rendezvous Point IP Address2.

3. If a node has multiple loopback addresses, NNMi uses the loopback
address with the lowest number that resolves to a hostname (for exam-
ple, 10.16.42.197 is a lower number than 10.16.197.42).

4. If no loopback address resolves to a hostname and the device sup-
ports SNMP, NNMi uses the current value from the Management
Address attribute on the Node form.

5. If the device does not support SNMP, the IP address or DNS name
found during the current rediscovery cycle is used as the hostname.

Node Form Attributes

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured loop-
back for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNMi identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations.
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Attribute Values

This sequence is repeated during each rediscovery cycle. The hostname
could change from cycle to cycle (for example, if an address did not respond
to SNMP queries due to network problems or node reconfiguration).

snmpAgent.agentSettings.
managementAddress

The Management Address attribute value from the SNMP Agent form of the
agent assigned to the specified node. The value is an IP address.

systemName System Name attribute value (from the Node form, General tab).

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Node&nodename=
<x>&menus= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Attributes for Launched Forms

Launch an Interface Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inter-
face&objattrs= hostedOn.hostname= <x>;name= <y>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inter-
face&objattrs= hostedOn.hostname= <x>;ifName= <y>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inter-
face&objattrs= hostedOn.hostname= <x>;ifAlias= <y>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inter-
face&objattrs= hostedOn.hostname= <x>;ifIndex= <y>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Attribute Values

hostedOn.hostname The Hostname of the Node in which the interface resides. This is the Hostname
attribute value from the associated Node form.

name The Name attribute value from the Interface form.

ifName The IfName attribute value from the Interface form.

ifAlias The IfAlias attribute value from the Interface form.

ifIndex The IfIndex attribute value from the Interface form.

Interface Form Attributes

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inter-
face&objattrs= hostedOn.hostname= <x>;name= <y>&menus= <true/false>&envattrs= <
name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Attributes for Launched Forms
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Launch an IP Address Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPAddress&o-
bjattrs= value= <y>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Attribute Values

value The Address attribute value from the IP Address form.

IP Address Form Attributes

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPAddress&o-
bjattrs= value= <y>&menus= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not

in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

Attributes for Launched Forms
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Attribute Values

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Launch a Subnet Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPSub-
net&objattrs= name= <x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPSubnet&
objattrs= prefix= <x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPSubnet&

objattrs= prefix= <x>;prefixLength= <y>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Attribute Values

name The Name attribute value from the IP Subnet form.

prefix The Prefix attribute value from the IP Subnet form.

prefixLength The Prefix Length attribute value from the IP Subnet form.

IP Subnet Form Attributes

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= IPSub-
net&objattrs= name= <x>&menus= <true/false>&envattrs= <name1= value>;<name2= value
>
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Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Attributes for Launched Forms

Launch an Incident Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Incident&objid=
<x>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= Inci-
dent&objuuid= <x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Individual incident objects must be identified by their database unique identifiers.
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Attribute Values

objid The Unique Object Identifier (unique across the entire NNMi database).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attribute
value for each object instance.

objuuid The Universally Unique Object Identifier (unique across all databases).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Incident Attributes

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&showForm&objtype= Inci-
dent&objid= <x>&menus= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Attributes for Launched Forms

Launch a Node Group Form

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= NodeGroup&name=
<y>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= NodeGroup&nod-
egroupid= <y>

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= NodeGroup&nod-
egroupuuid= <y>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Attribute Values

name The Name attribute value from the Node Group form.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Node Group Form Attributes

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showForm&objtype= NodeGroup&name=
<y>&menus= <true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

Attributes for Launched Forms
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Attribute Values

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Launch a Configuration Form

Configuration forms require that the user be assigned to the Administrative role.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd= showConfigForm&name= <y>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Note: If you are using Mozilla Firefox, click here for more information.

Due to the Mozilla Firefox security implementation, launching an NNMi form with a URL has the following
limitations:

l The Close button does not work.

l The File → Close menu item does not work.

l The Save and Close button saves data, but does not close the window.

l The File → Save and Close menu item saves data, but does not close the window.

Use the browser buttons to close the form.

Attribute Values

name The name attribute value specifies which form:

l communication = the Communication Configuration form

l custompoller = the Custom Poller Configuration form

l discovery = the Discovery Configuration form

l monitoring = the Monitoring Configuration form

Configuration Form Attributes
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Attribute Values

l incident = the Incident Configuration form

l status = the Status Configuration form

l ui = the User Interface Configuration form

The following are optional filter parameters:

http://<serverName>:<portNumber>/nnm/launch?cmd= showConfigForm&name= lt;y>&menus=
<true/false>&envattrs= <name1= value>;<name2= value>

Attribute Values

menus true = Show the view menus and the Close button. If not specified, the default is true.

false = Hide the view menus and the Close button to save space in the view.

envattrs Use Environment Attributes to store <name=value> pairs that were passed from an external
application to NNMi. Environment Attributes are session-specific and stored in memory (not
in the NNMi database). The name-value pairs can be any arbitrary string (as required by the
external program).

Note: see "Environment Attributes in URL Actions" (on page 315) for information about how
to pass these same environment attribute name-value pairs from NNMi back to the orig-
inating external application.

For example, let’s assume that NNMi was launched from an application that wants to pre-
serve a session ID (123) and object attribute (node25) as follows: 

http://host/nnm?cmd= showView&objtype= Node&envattrs= com.my.sessionId=
123;com.my.objectName= node25

Attributes for Launched Forms

Launch Menu Items (runTool)

To launch a menu item, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=<x>

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Provide quick access to NNMi menu items wherever your team needs them:

"Launch the Actions: Ping Command" (on page 362)

"Launch the Actions: Trace Route Command" (on page 362)

"Launch the Actions: Communication Configuration Command" (on page 363)

"Launch the Actions: Monitoring Settings Command" (on page 364)
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"Launch the Actions: Status Poll Command" (on page 367)

"Launch the Actions: Configuration Poll Command" (on page 367)

"Launch the Actions: Status Details Command (for Node Groups)" (on page 368)

"Launch the Tools: NNMi Status Command" (on page 369)

"Launch the Tools: Sign In/Out Audit Log Command" (on page 370)

"Launch the File: Sign-Out Command" (on page 370)

Launch the Actions: Ping Command

This URL is equivalent to the Actions → Ping (from server) command in the console.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a window that requests you to enter a node name, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=ping

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

After you specify a node, the real-time results of the ping command appear.

To launch the real-time results of the ping command, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=run-
Tool&tool=ping&timeoutSecs=<x>&numPings=<x>&nodename=<x>

Attribute Values

nodename A DNS resolvable hostname or IP address. The nodename value is passed literally to the
underlying command you specify. The nodename value (in this case) is not required to cor-
relate with anything in the NNM database.

timeoutSecs Amount of time NNMi waits before abandoning a ping request.

numPings Maximum number of retries.

Ping Command Attributes

Related Topics:

Test Node Access (Ping)

Launch the Actions: Trace Route Command

This URL is equivalent to the Actions → Trace Route (from server) command in the console.
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Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a window that requests you to enter a node name, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=traceroute

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

After you specify a node, the real-time results of the trace route command appear.

To launch the real-time results of the trace route command, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=traceroute&nodename=<
x>

Attribute Values

nodename A DNS resolvable hostname or IP address. The nodename value is passed literally to the
underlying command you specify. The nodename value (in this case) is not required to cor-
relate with anything in the NNM database.

Trace Route Command Attributes

Related topics:

Find the Route (traceroute)

Launch the Actions: Communication Configuration Command

This URL is equivalent to the Actions → Communication Settings command in the console.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a window that reports the current ICMP and SNMP configuration for a node, use the fol-
lowing URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=commconf

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

After you specify a node, the real-time results of the ICMP and SNMP configuration report appear.

To launch the real-time results of the ICMP and SNMP configuration report, use the following URL:
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http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=commconf&nodename=<x>

Attribute Values

nodename Provide a full or short DNS name or an IP address.

If you use this attribute, NNM tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the Addresses tab in the Node
form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

Communication Configuration Command Attributes

Related Topics:

"Verify Your Communication Settings" (on page 75)

Launch the Actions: Monitoring Settings Command

This URL is equivalent to the Actions → Monitoring Settings command in the console.

Launch the real-time results of the Monitoring configuration report. You must specify the target object.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

Click here to show an example URL for requesting a current Monitoring configuration report on a Node:

http://<serverName>:<portNumber>/nnm/launch?cmd=run-

Tool&tool=monitoringconf&objtype=SnmpAgent&nodename=<x>

Attribute Values

nodename Provide a full or short DNS name or an IP address.

If you use this attribute, NNMi tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the IP Addresses tab in the
Node form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

Monitoring Configuration Command Node Report Attributes
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Click here to show example URLs for requesting a current Monitoring configuration report on an Interface:

NNMi displays the report for the first matching Interface found. Provide one or more attributes to ensure a
unique match. See "Launch an Interface Form" (on page 353) for more information about each available
attribute.

http://<serverName>:<portNumber>/nnm/launch?cmd=run-
Tool&tool=monitoringconf&objtype=Interface&objattrs=hostedOn.hostname=<x>;name=<x>

http://<serverName>:<portNumber>/nnm/launch?cmd-
=runTool&tool=monitoringconf&objtype=Interface&objattrs=host-
edOn.hostname=<x>;ifName=<x>

http://<serverName>:<portNumber>/nnm/launch?cmd-
=runTool&tool=monitoringconf&objtype=Interface&objattrs=host-
edOn.hostname=<x>;ifAlias=<x>

http://<serverName>:<portNumber>/nnm/launch?cmd-
=runTool&tool=monitoringconf&objtype=Interface&objattrs=host-
edOn.hostname=<x>;ifIndex=<x>

Attribute Values

hostedOn.hostname The Hostname of the Node in which the interface resides. This is the Hostname
attribute value from the associated Node form.

name The Name attribute value from the Interface form.

ifName The IfName attribute value from the Interface form.

ifAlias The IfAlias attribute value from the Interface form.

ifIndex The IfIndex attribute value from the Interface form.

Interface Form Attributes

Click here to show an example URL for requesting a current Monitoring configuration report on an IP
Address:

http://<serverName>:<portNumber>/nnm/launch?cmd=run-
Tool&tool=monitoringconf&objtype=IPAddress&objattrs=value=<x>

Attribute Values

value The Address attribute value from the IP Address form.

IP Address Form Attributes

Click here to show an example URL for requesting a current Monitoring configuration report on an Router
Redundancy Member (Instance):

http://<serverName>:<portNumber>/nnm/launch?cmd=ru-
nTool&tool=monitoringconf&objtype=RouterRedundancyInstance&objid=<x>

Attribute Values

objid The Unique Object Identifier (unique across the entire NNMi database).

Monitoring Configuration Command Router Redundancy Member Report Attributes
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Attribute Values

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attribute
value for each object instance.

objuuid The Universally Unique Object Identifier (unique across all databases).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Click here to show an example URL for requesting a current Monitoring configuration report on an
Tracked Object:

http://<serverName>:<portNumber>/nnm/launch?cmd=ru-
nTool&tool=monitoringconf&objtype=TrackedObject&objid=<x>

Attribute Values

objid The Unique Object Identifier (unique across the entire NNMi database).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attribute
value for each object instance.

objuuid The Universally Unique Object Identifier (unique across all databases).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Monitoring Configuration Command Tracked Object Report Attributes

Click here to show an example URL for requesting a current Monitoring configuration report on a Node
Component:

http://<serverName>:<portNumber>/nnm/launch?cmd=ru-
nTool&tool=monitoringconf&objtype=ComponentHealth&objid=<x>

Attribute Values

objid The Unique Object Identifier (unique across the entire NNMi database).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the id attribute
value for each object instance.

objuuid The Universally Unique Object Identifier (unique across all databases).

This attribute value is not visible on any form within the console. To find this value, use the
nnmconfigexport.ovpl command-line tool to export an XML file that includes the uuid attrib-
ute value for each object instance.

Monitoring Configuration Command Node Component Report Attributes

Related Topics:
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"Verify Monitoring Configuration Settings" (on page 181)

Launch the Actions: Status Poll Command

This URL is equivalent to the Actions → Status Poll command in the console. This command launches a
real-time check of the state of the specified device. If the state has changed since the last monitoring cycle,
NNMi calculates an updated status reading for the selected device.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a window that reports the current status for a node, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=statuspoll

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

After you specify a node, the real-time results of the node's status appear.

To launch the real-time results of a node's status, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=statuspoll&nodename=<
x>

Attribute Values

nodename Provide a full or short DNS name or an IP address.

If you use this attribute, NNMi tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the IP Addresses tab in the
Node form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

Status Poll Command Attributes

Related Topics:

Verify Current Status of a Device

Launch the Actions: Configuration Poll Command

This URL is equivalent to the Actions → Configuration Poll command in the console.
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Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a window that reports the current configuration for a node, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=configurationpoll

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

After you specify a node, the real-time results of the node's configuration appear.

To launch the real-time results of a node's configuration, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=run-
Tool&tool=configurationpoll&nodename=<x>

Attribute Values

nodename Provide a full or short DNS name or an IP address.

If you use this attribute, NNMi tries to match the string you provide by following this pro-
cedure:

l Check the value in the Hostname field on the Node form.

l Check the values in the Address column of the table on the Addresses tab in the Node
form.

l Check the value of the System Name field on the General tab in the Node form.

l Check the value in the Name field on the Node form.

Configuration Poll Command Attributes

Related Topics:

Verify Device Configuration Details

Launch the Actions: Status Details Command (for Node Groups)

This URL is equivalent to the Actions → Status Details command in the console.

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

To launch a status poll calculation for a specified Node Group, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=nodegroupstatus

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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After you specify a node group, the real-time results of the node group's status poll calculations appear.

To launch the real-time results of a node's configuration, use the following URL:

http://<serverName>:<portNumber>/nnm/launch?cmd=run-
Tool&tool=nodegroupstatus&nodegroup=<x>

Attribute Values

nodegroup The Name attribute value of the Node Group to use as a filter for this view.

Note: The Node Group name is translated. If your team shares NNMi within multiple
locales, use nodegroupid or nodegroupuuid.

If the Name value includes space characters, replace the space character in your URL
 statement with one of the following:

l %20 (W3C URL Encoding Standards)                             

l + (works in most browsers, but not guaranteed)                             

l space character (works in some browsers, but not guaranteed)

nodegroupid The id is the Unique Object Identifier (unique across the entire NNMi database). Pro-
vide the id of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the id
attribute value for each object instance.

nodegroupuuid The uuid is the Universally Unique Object Identifier (unique across all databases). Pro-
vide the uuid of the Node Group to use as a filter for this view.

This attribute value is not visible on any form within the console. To find this value, use
the nnmconfigexport.ovpl command-line tool to export an XML file that includes the
uuid attribute value for each object instance.

Filter by Node Group (launched Incident, Node, Interface, and IP Address views)

Related Topics:

Check Status Details for a Node Group

Launch the Tools: NNMi Status Command

This URL is equivalent to the Tools → NNMi Status command in the console.

To launch a report of the current status of all NNMi processes and services, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is

available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=nnmstatus

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console
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Related Topics:

"Verify that NNMi Processes Are Running" (on page 26)

Check the Status of NNMi

"NNMi Processes and Services" (on page 25)

Launch the Tools: Sign In/Out Audit Log Command

This URL is equivalent to the Tools → Sign In/Out Audit Log command in the console.

To launch a window that reports the current configuration for a node, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd=runTool&tool=signinaudit

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

NNMi logs the history of sign-in and sign-out activity for each user since the NNMi management server
was last restarted.

Related Topics:

"Audit NNMi User Activity" (on page 43)

Launch the File: Sign-Out Command

This URL is equivalent to the File → Sign Out command in the console.

To provide a link that issues a sign-out command, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http://<serverName>:<portNumber>/nnm/launch?cmd=signOut

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

This closes the user session and frees up any memory associated with the session.

Related Topics:

"Sign Out from the Console" (on page 46)

Confirm that NNMi Is Running (cmd=isRunning)
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To launch a message reporting whether NNMi is currently running, use the following URL:

Note: If the NNMi Web server uses the https protocol, use https instead of http. (See the"Enabling https
for NNMi" chapter in the HP Network Node Manager i-series Software Deployment Guide, which is
available at: http://h20230.www2.hp.com/selfsolve/manuals)

http:/<serverName>:<portNumber>/nnm/launch?cmd=isRunning

<serverName> = the fully-qualified domain name of the NNMi management server

<portNumber> = the port that the jboss application server uses for communicating with the NNMi console

One of the following messages appears:

l NNMi is running.

l A browser error message that the URL is unreachable.
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Maintaining NNMi

As an NNMi administrator, you will want to perform the following tasks when maintaining NNMi con-
figurations and data.

"Track Your NNMi Licenses" (on page 372)

"Export and Import Configuration Settings" (on page 373)

"Back Up and Restore NNMi" (on page 385)

"Archive and Delete Incidents" (on page 387)

Track Your NNMi Licenses

To assist you in tracking your NNMi licenses, NNMi displays a status message at the bottom of the main
console whenever the number of nodes in the database reaches your license limit (based on number of

nodes discovered). Install additional licenses (for 50 node increments or more) to extend the limit.

To see a report of the current number of discovered nodes and the current NNMi license limit, access
View Licensing Information from either of the following locations:

l Help → About HP Network Node Manager i-series

l The Console Sign-In window

There are four categories of licenses. Each category might have one of three states (instant-on, temporary,
or permanent):

l Instant-On or Temporary licenses

l Licenses for NNMi, itself.

l Integration Enablement licenses (for example, required when connecting to an NNMi Smart Plug-in
(iSPI) on a remote server or extending the functionality of NNMi in other ways).

l Licenses for developers (SDK licenses).

When tracking license information, note the following:

l NNMi discovers and manages nodes up to the NNMi license limit.

l If the number of discovered nodes reaches or exceeds the licensed limit, NNMi randomly "Unman-
ages" nodes until the number of "Managed" nodes matches the license limit. No new nodes are dis-
covered until a license extension is installed. If any seeds were "Unmanaged" because of license
issues, those seeds are the first nodes changed back to "Managed" after the license extension is
installed.

For example: this situation might occur when an Instant-On or Temporary license expires or when an
incremental license is intentionally uninstalled from a particular server.

l NNMi generates Incidents under the following circumstances:

n The number of discovered nodes exceeds the current license limit.

n An Instant-On or Temporary license expires.

n An NNMi Smart Plug-in (iSPI) is purchased and installed on the NNMi management server. How-
ever, the NNMi license limit does not match the NNM iSPI license limit. See "Purchase an HP Smart
Plug-in" for more information about the NNMi Smart Plug-ins.
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n The NNMi license limit does not match the required Integration Enablement license limit (for exam-
ple, when connecting to an NNMi Smart Plug-in (iSPI) on a remote server or when extending the
functionality of NNMi in other ways by using the NNMi SDK).

Export and Import Configuration Settings

Please see the nnmconfigexport.ovpl and nnmconfigimport.ovpl Reference Pages for more information,
including the complete list of the command line arguments for each command.

The choices that you make when exporting NNMi configuration settings determine how that configuration
information can be used.

For example, you might want to make a quick copy of the existing NNMi configuration settings before you
try experimenting with a new idea. You can use that exported file to restore your configuration settings if
your experiment doesn't work the way you thought it would work.

You might want to copy the NNMi configuration settings to another NNMi management server. For exam-
ple, import configuration settings when deploying after configuring NNMi in a test environment. Or when

establishing remote NNMi management servers, use the central NNMi management server's configuration
settings as a starting point.

Carefully review the following topics to make an informed choice:

"Export/Import Behavior and Dependencies" (on page 373)

"Export a Snapshot of Your Configuration Settings" (on page 377)

"Import Configuration Files to Restore Previous Settings" (on page 378)

"Transfer Configuration Settings to Another NNMi Management Server" (on page 379)

"Troubleshooting Imports of Configuration Files" (on page 382)

Export/Import Behavior and Dependencies

Your configuration settings can be exported to make a copy, and then imported onto the same NNMi man-
agement server or another NNMi management server. You need to understand the behavior and depend-
encies as described in the table below. The locale setting on the NNMi management server at the time of
Export must match the locale setting on the NNMi management server at the time of Import.

Replaces all. Export files with this behavior make changes to the NNMi database when Imported (click
here for more information).                 

l NNMi replaces all object instances with matching key identifiers (see "Troubleshooting Imports of Con-
figuration Files" (on page 382) for information about key identifiers).

l NNMi adds all object instances with key identifiers that do not exist in the NNMi database

l NNMi deletes all existing object instances whose key identifiers do not match any in the exported
file.

Incremental. Export files with this behavior make changes to the NNMi database when Imported (click
here for more information).                 

l NNMi updates all object instances with matching key identifiers (see "Troubleshooting Imports of Con-
figuration Files" (on page 382) for information about key identifiers).
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Caution: NNMi also overwrites the values of any codes associated with these object instances (for
example, incident family).

l NNMi adds all object instances with key identifiers that do not exist in the NNMi database.

l NNMi does not touch existing object instances whose key identifiers do not match any in the exported
file.

Incremental (subset). Export files with this behavior include configuration changes that were made by one
Author. Export files with this behavior make changes to the NNMi database when Imported (click here for
more information).                 

l NNMi updates all object instances with matching key identifiers (see "Troubleshooting Imports of Con-
figuration Files" (on page 382) for information about key identifiers).

Caution: NNMi also overwrites the values of any codes associated with these object instances (for
example, incident family).

l NNMi adds all object instances with key identifiers that do not exist in the NNMi database.

l NNMi does not touch existing object instances whose key identifiers do not match any in the exported

file.

Configuration
Workspace's
View Name Export Option

Import
Behavior Dependencies

Author * -c author Incremental No dependencies. Import requires one Export file
(author.xml).

* Not a workspace, but an important data object.

-c author -a
<author>

Incremental
(subset)

No dependencies. Import requires one Export file
(author.xml).

Communication -c comm Replaces all No dependencies. Import requires one Export file
(comm.xml).

Caution: SNMPv3 credentials are never
imported.

Custom Poller -c custpoll Incremental Import requires four Export files, and they must
be imported in this order:

(1) author.xml, (2) device.xml, (3) nodegroup.xml,
and (4) custpoll.xml

Note: When importing Custom Poller con-
figurations, NNMi automatically sets the
Active State attribute value for all imported

Policies to Suspended.

Export/Import Behavior and Dependencies Among Configuration Areas
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Configuration
Workspace's
View Name Export Option

Import
Behavior Dependencies

Device Profiles -c device Incremental Import requires two Export files, and they must be
imported in this order:

(1) author.xml and (2) device.xml

-c device -a
<author>

Incremental
(subset)

Import requires one Export file (device.xml).

The required Author information is embedded in
the Export file.

Discovery -c disco Replaces all Import requires three Export files, and they must
be imported in this order:

(1) comm.xml, (2) discoseed.xml, and (3)
disco.xml

Discovery
Seeds

-c discoseed Incremental Import requires two Export files, and they must be
imported in this order:

(1) comm.xml and (2) discoseed.xml

Incident -c incident Replaces all Import requires two Export files, and they must be
imported in this order:

(1) author.xml and (2) incident.xml

-c incident -a <
author>

Incremental
(subset)

Import requires one Export file (incident.xml).

The required Author information is embedded in
the Export file.

Interface
Groups

-c ifgroup Incremental Import requires five Export files, and they must be
imported in this order:

(1) iftype.xml, (2) author.xml, (3) device.xml, (4)
nodegroup.xml, and (5) ifgroup.xml

IfTypes -c iftype Incremental Interface Types. No dependencies. Import
requires one Export file (iftype.xml).

Management
Stations
(6.x/7.x)

-c station Incremental NNM 6.x or 7.x Management Stations. No
dependencies. Import requires one Export file
(station.xml).

Monitoring -c monitoring Replaces all Import requires six Export files, and they must be
imported in this order:

(1) author.xml, (2) device.xml, (3) nodegroup.xml,
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Configuration
Workspace's
View Name Export Option

Import
Behavior Dependencies

(4) iftype.xml, (5) ifgroup.xml, and (6) mon-
itoring.xml

Node Groups -c nodegroup Incremental Import requires three Export files, and they must
be imported in this order:

(1) author.xml, (2) device.xml, and (3) node-
group.xml

Caution: Island Nodes Groups are never
exported.

Node Group
Map Settings

-c ngmap Incremental Import requires four Export files, and they must
be imported in this order:

(1) author.xml, (2) device.xml, (3) nodegroup.xml,
and (4) ngmap.xml

Note: Any time you save a map layout, NNMi
 deletes any previous node locations.
Therefore, each export contains only the
node locations that were last saved.

RAMS Servers -c rams Incremental HP Router Analytics Management Systems. No
dependencies. Import requires one Export file
(rams.xml).

Status -c status Replaces all No dependencies. Import requires one Export file
(status.xml).

The imported status applies to all Node Groups
in the database.

URL Actions -c urlaction Incremental Import requires two Export files, and they must be
imported in this order:

(1) author.xml and (2) urlaction.xml

-c urlaction -a <
author>

Incremental
(subset)

Import requires one Export file (urlaction.xml).

The required Author information is embedded in
the Export file.

User Accounts
and Roles

User Principals

-c account Incremental This command gathers data from two Con-
figuration workspace views.

Import requires one Export file (account.xml).

The data from both User Accounts and Roles 
User Principals is embedded in the Export file.

User Interface -c ui Incremental No dependencies. Import requires one Export file
(ui.xml).
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Export a Snapshot of Your Configuration Settings

If you export your configuration settings before you begin making changes, you can easily "undo" your
changes if you decide that you do not like the results.

To export a snapshot of your configuration settings:

1. Import behavior is determined when you generate the Export files. Make sure you understand your
Import behavior choices before you begin. See "Export/Import Behavior and Dependencies" (on
page 373) (consider printing that topic for reference).

Caution: The locale setting on the NNMi management server at the time of Export must match the
locale setting on the NNMi management server at the time of Import. Otherwise, you risk los-
ing data. Also, make sure that both NNMi management servers have the same NNMi ver-
sion/patch number.

2. A user name and password are required with the export command:

-u <NNMiadminUserName> -p <NNMiadminPassword>

If you do not want to enter a user name and password at the command line, you can use the
nnmsetcmduserpw.ovpl command to specify the valid user name and password (instead of -u and -
p). The credentials set using the nnmsetcmduserpw.ovpl command are valid for command
execution by the same user.

3. Check whether the configuration settings you want to export have dependencies, see "Export/Import
Behavior and Dependencies" (on page 373).

n If no dependencies, export only the configuration settings you are planning to change.

n If yes, decide if you need a copy of the dependencies (only if you plan to make changes to those
configuration settings, as well). Then export all the required files.

4. At the command line of the NNMi management server, type the command to generate the required
export files.

n To export all configuration settings, use the following command:

nnmconfigexport.ovpl –c -all -f <directory>

You can use -x <file_prefix> to provide a unique prefix to the set of exported files. For exam-
ple, use today's date or a clue about the reason you needed the files:

nnmconfigexport.ovpl –c -all -f <directory> -x <file_prefix>

n To export specific configuration settings <X> from multiple configuration workspace views, sep-
arate each with a comma (see "Export/Import Behavior and Dependencies" (on page 373) or the
nnmconfigexport.ovpl Reference Pages for the list of choices):

nnmconfigexport.ovpl –c <X>, <X>, <X> -f <directory>

You can use -x <file_prefix> to provide a unique prefix to the set of exported files. For exam-
ple, use today's date or a clue about the reason you needed the files:

nnmconfigexport.ovpl –c <X>, <X>, <X> -f <directory> -x <file_prefix>

n To export configuration settings that were created by a particular author (for Author, Device Pro-
files, Incident, or URL Actions), add the -a <author> attribute to the command and provide the
Unique Key.

Note: Only one author per -a <author> export command is allowed.
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Find the Unique Keys for all authors by exporting an author.xml file, then open the file in a text
editor and locate the Key attribute values.

Find the Unique Key for a particular Author, in the NNMi console:

i. Open one of these Configuration workspaces in the NNMi console: Device Profiles Con-
figuration, Incident Configuration, or URL Actions.

ii. Select an object created by the Author of interest.

iii. Display the Author form, and copy the value of the Unique Key attribute.

5. Verify that the required xml files are in the specified directory.

You are now ready to make configuration changes.

If you need to undo your configuration setting changes, see "Import Configuration Files to Restore Pre-
vious Settings" (on page 378).

Import Configuration Files to Restore Previous Settings

If you have a set of export files, you can change the Configuration settings on your NNMi management
server to match the settings in the exported files.

Note: You can change the names of the exported files before importing. The import still works the same.

To import a previous snapshot of your configuration settings:

1. Import behavior is determined when you generate the Export files. Make sure your exported files
were generated in a manner that meets your current needs. See "Export/Import Behavior and
Dependencies" (on page 373) (consider printing that topic for reference).

Caution: The locale setting on the NNMi management server at the time of Export must match the
locale setting on the NNMi management server at the time of Import. Otherwise, you risk los-
ing data. Also, make sure that both NNMi management servers have the same NNMi ver-
sion/patch number.

2. A user name and password are required with the import command:

-u <NNMiadminUserName> -p <NNMiadminPassword>

If you do not want to enter a user name and password at the command line, you can use the
nnmsetcmduserpw.ovpl command to specify the valid user name and password (instead of -u and -
p). The credentials set using the nnmsetcmduserpw.ovpl command are valid for command
execution by the same user.

3. Check whether the configuration settings you want to import have dependencies, see "Export/Import
Behavior and Dependencies" (on page 373).

n If no dependencies, import only the configuration settings you are planning to change.

n If yes, decide if you need a copy of the dependencies (only if you made changes to those con-
figuration settings, as well). Then import all the required files.

4. At the command line of the NNMi management server, type the command to import a file:

nnmconfigimport.ovpl -f <filename>

When importing multiple XML files at once using -f <directory>, the NNMi nnmcon-
figimport.ovpl command takes care of ordering issues.

Page 378 of 422

../../../../../../../refdocs/nnmsetcmduserpw.ovpl.1M.html


Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Maintaining NNMi

n To import all configuration settings, use the following command:

nnmconfigimport.ovpl -f <directory>

You can use -x <file_prefix> to specify a unique prefix for a set of files:

nnmconfigimport.ovpl -f <directory> -x <file_prefix>

n To import specific configuration settings from multiple configuration areas, create a directory that
contains the set of files you want to import.

At the command line of the NNMi management server, type the appropriate command to import
files:

nnmconfigimport.ovpl -f <directory>

You can use -x <file_prefix> to specify a unique prefix for a set of files:

nnmconfigimport.ovpl -f <directory> -x <filePrefix>

n To import configuration settings that were created by specific authors (for Author, Device Profiles,

Incident, or URL Actions), create a directory that contains the set of files you want to import.

At the command line of the NNMi management server, type the appropriate command to import
the files:

nnmconfigimport.ovpl -f <file>

nnmconfigimport.ovpl -f <directory>

You can use -x <file_prefix> to provide a unique prefix for a set of exported files:

nnmconfigimport.ovpl -f <directory> -x <filePrefix>

5. If you encounter problems, see "Troubleshooting Imports of Configuration Files" (on page 382).

Additional import options for timeout or memory issues:

You can append the following options to any import command if you encounter problems:

Option Description
Default
Setting

-timeout
<seconds> 

For larger data imports, you may encounter timeout issues. To
increase the number of seconds that NNMi waits (per file) during an
import, append the -timeout option to the end of your command
line. 

1800 sec-
onds (mini-
mum)

-memory
<megabytes>

For larger data imports, you may encounter memory issues. To
increase the number of megabytes allotted to memory during an
import, append the -memory option to the end of your command line.

512 meg-
abytes

6. After completing the import, open NNMi and verify your configuration settings.

Transfer Configuration Settings to Another NNMi Management Server

You can export configuration settings and import them onto another NNMi management server to save
time.

To move configuration settings to another NNMi management server:
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1. Import behavior is determined when you generate the Export files. Make sure you understand your
Import behavior choices before you begin. See "Export/Import Behavior and Dependencies" (on
page 373) (consider printing that topic for reference).

Caution: The locale setting on the NNMi management server at the time of Export must match the
locale setting on the NNMi management server at the time of Import. Otherwise, you risk los-
ing data. Also, make sure that both NNMi management servers have the same NNMi ver-
sion/patch number.

2. A user name and password are required with the export command:

-u <NNMiadminUserName> -p <NNMiadminPassword>

If you do not want to enter a user name and password at the command line, you can use the
nnmsetcmduserpw.ovpl command to specify the valid user name and password (instead of -u and -
p). The credentials set using the nnmsetcmduserpw.ovpl command are valid for command
execution by the same user.

3. Check whether the configuration settings you want to export have dependencies, see "Export/Import
Behavior and Dependencies" (on page 373).

n If no dependencies, export only the configuration settings you are planning to change.

n If yes, decide if you need a copy of the dependencies (only if you plan to make changes to those
configuration settings, as well). Then export all the required files.

4. At the command line of the NNMi management server export all configuration settings, type the appro-
priate command:

nnmconfigexport.ovpl –c -all -f <directory>

You can use -x <file_prefix> to provide a unique prefix to the set of exported files. For example,
use today's date or a clue about the reason you needed the files:

nnmconfigexport.ovpl –c -all -f <directory> -x <file_prefix>

Note: You can change the names of the exported files before importing. The import still works the
same.

5. Delete any files that you do not need.

6. To export configuration settings that were created by a particular author (for Author, Device Profiles,
Incident, or URL Actions), repeat the export command for each configuration item modified by that
author. Add the -a <author> attribute to the command and provide the Unique Key.

Note: Only one author per -a <author> export command is allowed.

nnmconfigimport.ovpl -a <author> -f <directory>

You can use -x <file_prefix> to provide a unique prefix to the set of exported files. For example,
use today's date or a clue about the reason you needed the files:

nnmconfigimport.ovpl -a <author> -f <directory> -x <file_prefix>

Find the Unique Keys for all authors by exporting an author.xml file, then open the file in a text editor
and locate the Key attribute values.

Find the Unique Key for a particular Author, in the NNMi console:

a. Open one of these Configuration workspaces in the NNMi console: Device Profiles Con-
figuration, Incident Configuration, or URL Actions.

b. Select an object created by the Author of interest.
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c. Display the Author form, and copy the value of the Unique Key attribute.

7. Verify that all required xml files are in the specified directory.

To import the configuration settings onto the other NNMi management server:

1. Import behavior is determined when you generate the Export files. Make sure you understand your
Import behavior choices before you begin. See "Export/Import Behavior and Dependencies" (on
page 373) (consider printing that topic for reference).

Caution: The locale setting on the NNMi management server at the time of Export must match the
locale setting on the NNMi management server at the time of Import. Otherwise, you risk los-
ing data. Also, make sure that both NNMi management servers have the same NNMi ver-
sion/patch number.

2. A user name and password are required with the export command:

-u <NNMiadminUserName> -p <NNMiadminPassword>

If you do not want to enter a user name and password at the command line, you can use the
nnmsetcmduserpw.ovpl command to specify the valid user name and password (instead of -u and -
p). The credentials set using the nnmsetcmduserpw.ovpl command are valid for command
execution by the same user.

3. Verify that all required xml files are in the specified directory.

4. When importing multiple XML files at once using -f <directory>, the NNMi nnmcon-
figimport.ovpl command takes care of ordering issues.

At the command line of the NNMi management server, type the appropriate command to import the
configuration files that you gathered for transfer:

nnmconfigimport.ovpl -f <filename>

nnmconfigimport.ovpl -f <directory>

You can use -x <file_prefix> to specify a unique prefix for a set of files:

nnmconfigimport.ovpl -f <directory> -x <file_prefix>

5. If you encounter problems, see "Troubleshooting Imports of Configuration Files" (on page 382).

Additional import options for timeout or memory issues:

You can append the following options to any import command if you encounter problems:

Option Description
Default
Setting

-timeout
<seconds> 

For larger data imports, you may encounter timeout issues. To
increase the number of seconds that NNMi waits (per file) during an
import, append the -timeout option to the end of your command
line. 

1800 sec-
onds (mini-
mum)

-memory
<megabytes>

For larger data imports, you may encounter memory issues. To
increase the number of megabytes allotted to memory during an
import, append the -memory option to the end of your command line.

512 meg-
abytes

6. After completing the import, open NNMi and verify your configuration settings.
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Troubleshooting Imports of Configuration Files

When importing incremental sets of configuration files, NNMi abandons the import if mis-matched con-
figuration objects are encountered. Each configuration object has a set of Unique Identifiers whose values
must match for incremental updates, or must not match any existing data before NNMi adds the con-
figuration object to the database, see tables below.

If you receive an error message while trying to import configuration information, use the information below
to figure out how to use the error message to determine what you need to change before creating another
export file (thus, solving the problem).

Configuration Item
Name Primary Identifier

Editable Attrib-
ute?

Other Key Attributes that must
be unique

Author = Author form author = Unique Key
 attribute value

Yes

Author Configuration Unique Identifiers

Attribute Name = NNMi Console
Name

Primary
Identifier

Editable
Attribute?

Other Key Attributes that
must be unique

DiscoveryConfiguration = Com-
munication Region form

uuid No name = Name value

ordering = Ordering value

UsmSettings = SNMPv3 Settings form uuid No name = Unique Name value

Communication Configuration Unique Identifiers

Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

ComparisonMap = Comparison Map form uuid No ordering = Ordering
value

Policy = Custom Poller Policy form uuid No The combination of
these two:

collection = Collection
value

ordering = Ordering
value

Custom Poller Configuration Unique Identifiers

Attribute Name Primary Identifier
Editable Attrib-
ute?

Other Key Attributes that
must be unique

DeviceCategory = key = Unique Key attribute Yes

Device Profile Configuration Unique Identifiers
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Attribute Name Primary Identifier
Editable Attrib-
ute?

Other Key Attributes that
must be unique

Device Category form

DeviceFamily = Device
Family form

key = Unique Key attribute Yes

DeviceProfile = Device
Profile form

snmpObjectId = SNMP
Object ID value

Yes

DeviceVendor =
Device Vendor form

key = Unique Key attribute Yes

Attribute Name
Primary Iden-
tifier

Editable
Attribute?

Other Key Attributes that must
be unique

AutoDiscoveryRegion = Auto-Dis-
covery Rule form

uuid No name = Name value

ordering = Ordering value

Discovery Configuration Unique Identifiers

Attribute Name
Primary
 Identifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

DiscoverySeed = Discovery Seed form host = Host
Name/IP value

Yes

Discovery Seed Configuration Unique Identifiers

Attribute Name
Primary
Identifier

Editable Attrib-
ute?

Other Key Attributes that must
be unique

MgmtEventConfig = Management
Event Configuration form

uuid No name = Name value

SnmpTrapConfig = SNMP Trap Con-
figuration (by OID) form

uuid No iod = SNMP Object ID value

name = Name value

RemoteNnmEventConfig uuid No iod

name = Name value

PairwiseConfig = Pairwise Con-
figuration form

uuid No name = Name value

The combination of these two:

firstIncidentName = First Incident 
Configuration value

secondIncidentName = Second
Incident Configuration value

Incident Configuration Unique Identifiers
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Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

InterfaceGroup = Interface Group form uuid No name = Name value

Interface Groups Configuration Unique Identifiers

Attribute Name Primary Identifier Editable Attribute? Other Key Attributes that must be unique

IfType IfType attribute Yes

Interface Type Configuration Unique Identifiers

Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

InterfaceSettings = Interface Settings form uuid No ordering = Ordering
value

NodeSettings = Node Settings form uuid No ordering = Ordering
value

Monitoring Configuration Unique Identifiers

Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes that must be
unique

NodeGroup = Node Group
form

uuid No name = Name value

Node Group Configuration Unique Identifiers

Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes that must be
unique

UrlActionInfo = URL Action
form

key = Unique
 Key

Yes

URL Actions Configuration Unique Identifiers

Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

Account = User Account form uuid No name = Name value

Principal = User Principal form uuid No Name value

RoleEntry = Account Mapping form uuid No The combination of these
two:

principal = Account value

User Accounts and Roles Configuration Unique Identifiers
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Attribute Name
Primary Iden-
tifier

Editable Attrib-
ute?

Other Key Attributes
that must be unique

role = Role value

Back Up and Restore NNMi

As an NNMi administrator, develop a plan for NNMi backups. You have the following choices:

l Complete backups or backups limited to specific NNMi data and files

l Offline backups (NNMi is stopped) or online backups (NNMi is running)

For example, you might want to back up your configuration data before discovering your network. You
might also want to save your configuration, discovered topology, and incident data without stopping NNMi.

The scope of any subsequent NNMi restore is determined by the contents of your backup. Only the data
present in the backup is restored. NNMi must be stopped for all restore operations.

Note: You cannot restore NNMi files and data to a system that is different from the one you used to create
the backup files. When you back up NNMi files and data, note the NNMi version, operating system,
and character set used on the system you back up. The hostname and IP address do not have to be
identical.

"Back Up NNMi Data and Files" (on page 385)

"Restore NNMi Data and Files" (on page 386)

Related Topics

"Archive and Delete Incidents" (on page 387)

Back Up NNMi Data and Files

Before you begin a backup, ensure you have adequate storage space in your target directory (for example,
verify that you have enough space to store the contents of the directories listed in the following table).

Operating System Default Location

Windows <drive>:\Program Files (x86)\HP\HP BTO Software 

<drive> is the drive on which NNMi is installed

Windows <drive>:\Documents and Settings\All Users\ Application Data\HP\HP BTO Software

<drive> is the drive on which NNMi is installed.

UNIX /opt/OV

UNIX /var/opt/OV 

NNMi Directories

The NNMi backup command performs database level backups for embedded databases. If you installed
with the embedded database option, the embedded database data is stored in the following directory:

Windows:
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<drive>:\Documents and Settings\All Users\Application Data\HP\HP BTO
 Software\shared\nnm\databases\Postgres

<drive> is the drive on which NNMi is installed.

UNIX:

/var/opt/OV/shared/nnm/databases/Postgres

If you chose a different database at install time, your table data is not backed up using this command.

Note: You may compress the files after backup.

When backing up NNMi data and files, you specify online or offline, the scope of the backup, the format of
the backup copy (such as a tar file), and the location of the target directory where the backup is stored.
These arguments are described in the following table.

Note: See nnmbackup.ovpl for a complete description, including all command arguments.

Parameter Description

-force Used to start and stop the required processes for the NNMi backup to com-
plete successfully. NNMi uses the backup parameters provided to deter-
mine which processes to start or stop. For example, for an offline backup, if
NNMi is running, the -force option stops all NNMi processes.

-scope [con-
fig|topology|events|all]

Determines the data that is backed up.

Note: When performing offline backups it is recommended that do not pro-
vide a scope. In such cases, NNMi backs up the entire contents of the
NNMi database.

-target <directory> Specifies the output directory where the backup file is stored. NNMi creates
a parent directory named nnm-bak-<timestamp> inside the target directory
where all backup files are stored.

-type [online|offline] Determines the type of backup to be performed. If you use the online argu-
ment, NNMi must be running when the backup is performed. If you specify
offline, NNMi must be completely stopped.

-archive Creates a tar file that contains the backed up data (uncompressed).

nnmbackup.ovpl Parameters

Restore NNMi Data and Files

The NNMi nnmrestore.ovpl command restores data from an NNMi backup (created with the nnmback-
up.ovpl command). The nnmrestore.ovpl command restores NNMi to the state stored in the backup
files.

Only the data present in the backup is restored.

Note: NNMi must be stopped when restoring any NNMi data and files. Use the -force parameter to stop
NNMi automatically as part of the restore operation.

When using nnmrestore.ovpl, you need to provide the source directory as described in the parameter
table included below.

Note: See the nnmrestore.ovpl command for a complete description, including all of the command argu-
ments.
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Parameter Description

-source
<directory>

Specifies the directory to which you want the files restored.

Note:When a tar file contains the backup, the tar file extracts into a temporary folder in the
current working directory. NNMi removes the temporary folder when the restore fin-
ishes.

-force Stops NNMi prior to running the restore procedure.

Restore Parameters

Archive and Delete Incidents

NNMi enables you to archive and remove incidents that you no longer want to track. This feature is useful if
you want to purge the database of incidents that are older than a specified time period or date. With archiv-
ing, you can keep a history of incidents and manage the volume of incidents.

To archive and then delete incidents in NNMi, you use the nnmtrimincidents.ovpl command. You can
choose to only archive or only delete your incidents as described in the argument table that follows.

When archiving and deleting incidents, note the following:

l For the best performance results, archive and delete your incidents so that no more than 100,000 inci-
dents are stored in the NNMi database at one time. By default, NNMi sets the maximum number of
SNMP traps to 100,000.

l After 90 percent of the maximum limit for SNMP traps is reached or exceeded, NNMi generates an inci-
dent whose Severity is set to Warning to notify you that NNMi is approaching the maximum limit.

l After 95 percent of the maximum limit for SNMP traps is reached or exceeded, NNMi generates an inci-
dent whose Severity is set to Major to notify you that NNMi is approaching the maximum limit. In addi-
tion, NNMi only accepts traps required for Causal Engine analysis until the number of SNMP traps
within the database has been reduced using the nnmtrimincidents.ovpl command.

l After the maximum SNMP trap limit is reached or exceeded, NNMi generates an incident whose Sever-
ity is set to Critical. NNMi no longer accepts any SNMP traps until the number of SNMP traps within the
database has been reduced using the nnmtrimincidents.ovpl command.

Use the nnmtrimincidents.ovpl command to archive and delete your incidents based on any of the
attributes described in the following table. See the nnmtrimincidents.ovpl command for more information,
including a complete list of arguments for this command.

Incident
Attribute Description

-archi-
veOnly

Used to specify that you want to only archive incidents rather than archive and then delete
them.

-trimOnly Used to specify that you want to only delete incidents rather than archive and then delete
them.

-date The date must be entered in the following ISO 8601 format:

<yyyy-mm-dd>T<hh>:<mm>:<ss>[Z,-<hh>:<mm>,+<hh>:<mm>]

ISO Date Format:

Archive Incident Arguments
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Incident
Attribute Description

l yyyy — Four-digit year

l mm — Two-digit month

l dd — Two-digit day

l hh — Two digits representing the hour (00 through 23)

l mm — Two digits representing the minutes (00 through 59)

l ss — Two digits representing the seconds (00 through 59)

l +<hh>:<mm> — Local time zone which is the hours (<hh>) and minutes (<mm>)
ahead of Coordinated Universal Time

l -<hh>:<mm> — Local time zone which is the hours (<hh>) and minutes (<mm>)
behind Coordinated Universal Time

For example: 2007-11-05T08:15:30-5:00 corresponds to November 5, 2007, 8:15:30
am, Eastern Standard Time.

Note: You must specify either a -age or a -date value.

-age The age of the incident specified in number of days, weeks, or months. 

Note: You must specify either an -age or a -date value.

-family The incident Family. See Incident Form: General Tab for a list of possible Family values.

-incr The increment value that helps determine the -age value. Supported increments include
days, weeks, and months. The default increment value is days.

-path Specifies the archive file name, including the complete path. The default archive file name
is:

<date> is the date in yyyy-mm-dd format

<ms> is milliseconds

Windows:

%NnmDataDir%\tmp\incidentArchive.<date>.<ms>.txt.gz

UNIX:

/var/opt/OV/tmp/incidentArchive.<date>.<ms>.txt.gz

Note: NNMi keeps only one backup copy of the default archive file name. Therefore, to
ensure you archive all incidents of interest, provide an archive file name each time
you want to archive incidents.

-lifecycle Identifies where the incident is in the incident lifecycle. Possible values are Registered, In
Progress, Completed, and Closed.

See About the Incident Lifecycle for more information about Lifecycle State.

Note: This argument is optional.

-name Identifies the name of the incident configuration.
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Network Node Manager (NNMi 8.1x Patch 4) Online Help: Information for Administrators
Maintaining NNMi

Incident
Attribute Description

-nature Identifies the nature of the incident. Possible values are: Info, None, Root Cause, Sec-
ondary Root Cause, Service Impact, and Symptom.

See Using the Incident Form for more information.

Note: This argument is optional.

-origin Identifies the Origin of the incident configuration. Possible values are: Management Soft-
ware, Manually Created, Remotely Generated, and SNMP Trap. See Incident Form: Gen-
eral Tab for more information.

-u The user name required to run this command.  This user name must be a valid NNMi user
name with a role of either Administrator or System.

Note: The user name might be a Principal object stored in the NNMi database or might be
from your environment's directory service database (depending on NNMi con-
figuration). See "Configure Sign-In Access" (on page 32) for more information.

-p The associated password for the user name specified by the -u attribute value.

Note: The password might be an attribute in an Account object stored in the NNMi data-
base or might be from your environment's directory service database (depending
on NNMi configuration). See "Configure Sign-In Access" (on page 32) for more infor-
mation.

-quiet Use this argument when you want to trim incidents without requiring user prompts and
responses. (Status information appears.)

-sysobjectid The system object identification (system OID) from the incoming SNMP trap or Remote
NNM 6.x/7.x event that is assigned to the incident configuration.

For example, archive and delete all incidents with lifecycle equal to Closed and age equal to or greater
than 1 month.

nnmtrimincidents.ovpl -age 1 -incr months -lifecycle Closed -u <NNMiadminUsername>
-p <NNMiadminPassword>

You can also specify a batch size when archiving or deleting incidents. Specify the maximum number of
incidents to delete at one time within a single database transaction. This number then determines how
often you see a status message that the deletions are complete. Using the default value of 1,000 as an
example, NNMi displays a status message after successfully deleting each 1,000 incidents.

Note: The default value of 1,000 was selected to maintain a balance between performance and the
frequency of progress messages for the archive and delete operation. This default determines the
maximum number of incidents archived and deleted at one time within a single database trans-
action.

Related Topics

"Back Up and Restore NNMi" (on page 385)
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Glossary: –

Appendix A: Glossary Terms

A

Anycast Rendezvous Point IP
 Address

Rendezvous Point addresses
are loopback addresses used
for routers in multi-cast network
configurations.

L

Layer 2
Refers to the Data Link layer of
the multilayered com-
munication model, Open Sys-
tems Interconnection (OSI). The
Data Link layer moves data
across the physical links in the
network. The switches and
bridges are devices that redi-
rect data messages at the layer
2 level, using the destination
Media Access Control (MAC)
address to determine where to
direct the message.

Layer 3
Refers to the Network layer of
the multilayered com-

munication model, Open Sys-
tems Interconnection (OSI). The
Network layer is concerned
with knowing the address of the
neighboring nodes in the net-
work, selecting routes and qual-
ity of service, and recognizing
and forwarding incoming

messages to local host
domains. The router and
switch-router are the devices
that redirect data messages at
the Layer 3 level. Everything in
a subnet is connected at the
Layer 3 (IP) level.

Link Aggregation
A Link Aggregation is com-
prised of an Aggregator Link,
Aggregator Interface, and the
physical interfaces and con-
nections that they represent. An
Aggregator Link object rep-
resents many-to-many physical
connections. For example, two
nodes might be connected with
four physical connections.
These four physical con-
nections are depicted as a sin-
gle Aggregator Link object
using a thick line on the Layer 2
Neighbor View map. The inter-
face depicted at each end of
the Aggregator Link object is an
Aggregator Interface object. An
Aggregator Interface object rep-
resents the collection of phys-
ical interfaces for one end of an
Aggregator Link.

loopback address
The address associated with
the loopback interface. The
loopback interface is a virtual
interface on a device that pro-
vides a route for internal com-
munication. Many vendors
provide a specially configured

Page 390 of 422



Glossary: –

loopback for management pur-
poses. Exact details of how
loopbacks are configured
varies by vendor and model.
See each device's doc-
umentation for details. NNMi
identifies these loopback
addresses by using IfType 24,
softwareloopback from the
IANA ifType-MIB.
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Index: Abstract Syntax Notation – Additional Filters tab

Appendix B: Index

A

Abstract Syntax Notation 259

access

command line 42

configuring sign-in 32, 35, 37, 40

controlling 32, 34

disabling user 41

read only 321

troubleshooting 41

accessing

device details 95

help 31

integration URL

commands 323

forms 322

workspaces 322

iSPI for Performance Headline report 165,
175

NNMi from URLs 321

Account Mapping form 36, 39, 41

accounts, user

auditing activity 43

changing 32, 35, 37, 40

determining roles 33

disabling 41

editing 36, 39-40

Action Configuration tab 283-284

actions

arguments 288

configuring incident 283-284

incident parameters 285

launching commands

Communication Configuration 363

Configuration Poll 367

Monitoring Settings 364

ping 362

Sign In/Out Audit Log 370

Sign Out 370

Status Details 368

Status Poll 367

traceroute 362

out-of-box 22

Actions menu

commands

Communication Configuration 363

Configuration Poll 367

Monitor Settings 364

Ping 362

Status Details 368

Status Poll 367

Trace Route 362

configuring URL actions 303, 305

controlling 34, 303

invoking actions 21

Actions stage 213

actvity, auditing account 43

adding

Boolean operators 134

connections 124

custom attributes 302

discovery seeds 113-115

node

group filters 128

optional filters 315

SNMP trap configuration 248

Additional Filters tab 128, 141
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Index: address gathering phase – attribute values

address gathering phase

node name decision tree 81

Spiral Discovery 77

addresses

assigning management mode 192

configuring

IP 60

monitoring 181

excluding from discovery 83, 93

IPv4 84

managed 189

monitoring configuration 181

not

managed 190

out-of-box actions 22

out of service 191

restarting management 184

stopping management 184

adjusting

discovery intervals 98

administrator

backing up NNMi 385

introduction 14

overriding default node group status 178

restoring NNMi 385

role permissions 32-35, 37, 40, 192, 322-
323

tools 15

Advanced, NNMi

Enable Router Redundancy Group Monitoring153

monitoring router redundancy groups 181

RAMS 300

agents, SNMP

configuring 238

discovering 90

allowedOids.conf file 268

ampersand (&)

character 288

AND variable 134

applications, launching maps within other 321

archiving incidents 387

arguments, action 288

ARP cache 83, 96

ASN 259

assigning

hostname wildcards 61

management mode 192

node group status 178

assignments, importing community string 74

attribute values

Author form 260, 304

communication

protocol settings for node 67

regions 57

Communication Configuration form 360

community strings

defaults 52

regions 62, 72

Configuration Per Node Group 292

Configuration Poll command 367

Configuration Workspace view 349

Configure User Interface form 195

connection 124

Deduplication form 269

Default Device Credentials form 53

default monitoring 154

device

credentials 73

profile 95

Diagnostic Selection form 293
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Index: attributes – Author, URL Actions

Discovery Configuration form 360

Discovery Seeds form 113

Discovery State 117

excluded addresses 108

Family 251, 254

Hostname Wildcard 61

Incident Configuration form 360

Incident form 357

Incident views 327

incidents 251, 253-255, 387

Interface form 353

Interface Group form 141

Interface Settings form 158

Inventory Workspace view 343

IP Address form 355

IP address ranges 60

Layer 2 connection 124

Layer 2 Neighbors view 338

Lifecycle Transition Action form 284

Management Mode Workspace view 346

Monitoring Configuration form 360

Monitoring Workspace view 335

Network Overview view 330

Networking Infrastructure Devices view 330

Node Form view 351

Node Group form 128, 358

Node Group Map Settings form 199-200,
202-203

Node Group Overview view 330

node names 79, 81, 99

Node Settings form 168

organizing incidents 251

Pair Item Configuration form 281

Pairwise Configuration form 279

pairwise configurations 281

Path View 338

RAMS Configuration form 300

Rate Configuration 273

Rediscovery Interval 98

Routers view 330

SNMP

default settings 47

trap definitions 247

SNMPv3 239

Status Configuration form 360

Status Details command 368

Status Poll command 367

Subnet form 356

Switches view 330

system object ID ranges 106

Thresholds Settings form 162, 165, 172,
175

Trap Forwarding Destination form 244

Trap Forwarding Filter Association form 245

Trap Forwarding Filters form 241

Troubleshooting Workspace view 338

URL Action Object Type form 306, 315

URL Actions Author 304

URL Actions form 303, 305

User Interface Configuration form 360

attributes

capability 312

custom 313, 315

Attributes, Custom Incident 214, 255-256, 259,
271, 274, 311

audit log files 43

auditing account activity 43

authentication requirements, URL access 321

Author form 260, 304

Author, URL Actions 304
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Index: auto-discovery rules – Cisco

auto-discovery rules 83

configuring 101

basic settings 102

Ping Sweep 98

custom 88

discovery seeds 82

everything 91

IP addresses 93-94, 104

object IDs 94

overview 88

routers 89

SNMP devices 90

switches 89

system object IDs 106

vendors 92

Auto-Discovery Rules form 101, 104

autocomplete 19

automated commands 295

automated tasks, performing 21

automatic actions, configuring 283

B

background

images

configuring 203

out-of-box 205

scaling 206

specifying 206

backing up NNMi 385

basic settings, auto-discovery 102

behavior

auto-discovery 88

timeout/retry 50-51

Blackboard stage 212

Boolean operators, adding 134

browser

launching URL views 324, 327, 330, 335,
338, 343, 346, 349,
351, 353, 355-358,

360

sessions 44

buying HP iSPIs 319-320

bypassing logins 324

C

Cabletron Discovery Protocol 109

cache, ARP 83

capabilities

extending NNMi 302

categories

incidents 251, 253

Causal Engine 76, 151-152, 211-212, 238,
264, 266

causes, SNMP traps 251

CDP 83, 109

changing

names 36, 39-40

passwords 36, 39-41

roles 36, 39-40

characters, action argument 288

checking

address connectivity 181

discovery

node state 117

progress 117

seed status 118

security 34

CIAs 214, 255-256, 259, 271, 274, 311

Cisco

protocols 83, 109

routers 295
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Index: collecting incidents – components

switches 295

collecting incidents 211

comma (,) character 288

comma separated values 137

command line

adding discovery seeds 115

granting user access to commands 42

setting up access 42

verifying SNMP/ICMP configuration for IP addresses74

commands

accessing integration URL 323

automated 295

Communication Configuration 363

Configuration Poll 367

get 47

Monitoring Settings 364

nnmbackup.ovpl 385

nnmcommload.ovpl 74

nnmconfigexport.ovpl 373

nnmconfigimport.ovpl 373

nnmconnedit.ovpl 124

NNMi Status 369

nnmincidentcfg.ovpl 241, 244-245, 247

nnmloadnodegroups.ovpl 127, 137

nnmloadseeds.ovpl 114-115

nnmmanagementmode.ovpl 184

nnmrestore.ovpl 386

nnmsetcmduserpw.ovpl 42

nnmtrimincidents.ovpl 387

ovstart 26, 30

ovstatus 26, 28

ovstop 26, 30

ping 47, 295, 362

Sign In/Out Audit Log 370

Sign Out 370

Status Details 368

Status Poll 367

traceroute 295, 362

communication

protocols 47

regions 61

settings 75

team 44

Communication Community String form 62,
72

Communication Configuration

command 363

form 47, 51, 53, 56, 66, 74, 360

Communication Default Community String form52

Communication Node form 67

communication protocols, configuring 66-67

Communication Region form 57, 61, 64

Communication Settings menu item 34, 323

community strings

configuring default 51

loading from file 74

setting 62, 72

default 52

nodes 67

regions 57

SNMPv2c 50

Community Strings tab 57, 62, 72

comparison parameters, deduplications 271

Comparison Params form 274

Component Health

monitoring 153

components

Causal Engine 152, 211-212, 264, 266

event pipeline 213

nodes 181
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Index: Condition Listener stage – configuring

Condition Listener stage 212

configuration

auto-discovery 88, 90-94

creating objects 20

deduplication 266, 269, 271

describing incident configurations 260

exporting settings 373

importing settings 373

management event 229

maps 198

node group map settings 198

pairwise 237, 266, 276, 278

rate 266, 274

wizard 15

workspaces 16

Configuration Item menu item 34

Configuration Per Node Group form 292

Configuration Poll

command 367

menu item 323

Configuration workspace 33

Configuration Workspace view 349

Configure User Interface form 195

configuring

access 32

actions for incidents 284

audit log files 43

auto-discovery rules 101

automatic actions 283

background images 203

communication protocols 47

devices 66

nodes 67

community strings for regions 62

console 14

credential settings

nodes 73

regions 64

default

community strings 51

protocol settings 47

device profiles 95

discovery 96

discovery seeds 113

DNS 86

excluded addresses 108

IANA ifType-MIB definitions 140

incidents 211, 214, 216, 226, 229, 237,
246, 248-249, 255-256, 261,

265, 268, 276, 279, 281, 283-
284, 291-293

interface monitoring 158

IP address ranges 60

management

event display 264

stations 262

maps 198

monitoring

behavior 152

settings 181

network

devices 86, 238

region protocols 56

node

connectivity 202

monitoring 168

name resolution 99

node group

map settings 198

status calculations 178, 200

node group map settings 199
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Index: connection – CSV

Path View maps 206

RAMS 300

remote events 263

security settings for SNMPv3 239

sign-in access 32, 35, 37, 40

SNMP traps 239, 241, 245-246, 268

subnet connection rules 109

target status 179

threshold monitoring 162, 165, 172, 175

URL Actions 303, 305

user interface 195

USM 54-55, 65

connection

editor file 124

phase 77

connections

adding 124

deleting 124

subnet rules 84, 109, 111

connectivity

checking addresses 181

console

accessing commands 323

adding discovery seeds 113-114

administrator tools 15

configuring 14, 195

defining node groups 127

disabling user access 41

launching from URLs 324

opening 44

running outside

help 31

tools 321

signing

in 46

out 46

contacting devices 50-51

controlling

access 32, 34

Actions menu 303

address discovery 108

node names 99

correlating incidents

duplicates 269

pairs 276, 279

counts

incident frequency 273

creating

additional group filters

interface 141

nodes 128

attributes

Author 260

auto-discovery rules 91

configuration objects 20

discovery seed file 114

incident

categories 253

families 254

interface groups 126

IP ranges 91

management

event configuration 264

station configuration 262

node group map settings 200

node groups 126

credential settings

configuring 64, 73

default 53

CSV 137

- 398 -



Index: custom attributes – devices

custom attributes

interface objects 302

load for nodes 138

node objects 302

URL actions 313, 315

Custom Attributes tab 302, 313, 315

Custom Incident Attributes 214, 255-256, 259,
271, 274, 311

cycle times, discovery 98

D

data

backing up 385

RAMS 300

restoring 386

database

auto-discovery 83

object

IDs for URL Actions 311

decision tree, node name 81

Dedup stage 213

Deduplication Comparison Params form 271

deduplication configuration 266, 269, 271

Deduplication form 269

Default Community String tab 51

Default Device Credentials form 53

defaults

community strings

configuring 51

setting 52

credential settings 53

health monitoring 154

protocols

settings 47

traffic control 154

USM settings 54

views 324

defining

interface groups 139

node groups 126, 137

target status 179

definitions

flow 295

SNMP traps 247

deleting

Boolean operators 134

connections 124

incidents 387

management

event configuration 264

station configuration 262

node group map settings 200

nodes 122

SNMP trap configuration 248

table rows 20

user accounts 41

describing incidents 260

Description attribute 260

determining

node names 81

user account roles 33

developer licenses 372

developing filters 126

Device Credentials tab

Communication Regions form 64

Specific Node Settings form 73

Device Profile form 95

devices

adding group filters 128

communication protocols 66
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Index: Diagnostic Selection form – Discovery, Spiral

configuring

network 238

node names 99

diagnostics 295

discovering

SNMP 90

specific 88

vendors 92

excluding from discovery 94

profiles 85, 95

retry behavior 50-51

timeout behavior 50-51

types 95

Diagnostic Selection form 293

Diagnostics (Flows) 295

diagnostics, incident

configuring 291-293

out-of-box 295

direct management mode 193

directories, NNMi 385

directory service

configuration 32, 37, 40

disable SNMP trap definitions 247

disabled

incidents 298

disabling

user accounts 41

discovering networks

approach 88

auto-discovery regions 83

description 76

device profiles 85

discovery seeds 82, 112

everything 91

excluding

addresses 83, 93

devices 94

intervals 79

node name choices 79

prerequisites 86

process 77

routers 89

SNMP devices 90

specific devices 88

switches 89

vender devices 92

discovery

adjusting intervals 98

checking

discovery seed status 118

node state 117

progress 117

configuring 96

excluded addresses 83

IP address ranges 104

node name choices 79

protocols 83

seeds 81-82, 88, 112-115, 117-118

SNMP system object ID ranges 106

verifying 116-117, 120-121

Discovery Configuration

form 360

Discovery Configuration form 96, 98, 118

Discovery Seeds

form 113

tab 112

Discovery System Object ID Range form 106

Discovery, Spiral 76

adjusting discovery interval 98
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Index: displaying – families

configuring 88, 95

discovering

everying 91

routers and swtiches 89

excluding

SNMP object IDs 94

specific IP addresses 94

fine-tuning 85

process 77

speeding up 86

displaying

management

events 264

station configurations 262

SNMP traps as root causes 251

DNS

names 79

prerequisite 86

do not discover list 83

dollar sign ($) 288

Domain Name System 86

down

interface 298

duplicate incidents, correlating 269

E

editing

management

event configuration 264

station configuration 262

node group map settings 200

SNMP trap configuration 248

user accounts 36, 39-40

editor, connection 124

EDP 109

email, launching maps from 321

embedding views within Web portals 321

Enable Component Health Monitoring 153

Enable Router Redundancy Group Monitoring153

Enable State Polling 153

enabling JavaScript 44

ENDP 83, 109

Enterasys Discovery Protocol 109

enterprise-specific traps, SNMP 249

equals sign (=) 288

establishing monitoring behavior 154, 158,

168

events

configurations 226, 264-265

duplications 269

management 229

pipeline 213

everything, discovering 91

examples

adding group filters

interface 134

nodes 134

Jython methods 290

threshold monitoring 165, 175

excluding from discovery

addresses 83, 93-94, 108

devices 94

exporting configuration settings 373

extending capabilities

NNMi 302

Extreme Discovery Protocol 109

F

families

creating incident 254
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Index: Family – forms

Family

attribute 251

FDP 83, 109

fields, Lookup 18-19

files

allowedOids.conf 268

backing up 385

creating discovery seed 114

hostNoLookup.conf 86

ipNoLookup.conf 86

launchsamples.jsp 321

log 28, 43

MIB 247

nms-roles.properties 41-42

nms-users.properties 41-42

nnm.ports.properties 44

nnmDocs_en.war 31

PathConnections.xml 206

restoring 386

text 137

filtering

node groups 147

filters

developing 126

interface

groups 139, 141

node groups 126

out-of-box 149

SNMP trap forwarding 241

Find Node menu item 34

Firefox

launching URL views 324, 327, 330, 335,
338, 343, 346, 349,
351, 353, 355-358,

360

opening console 44

flow

definitions 295

form toolbar 20

formats, incident messages 255, 259

forms

accessing integration URL 322

Account Mapping 36, 39, 41

Author 260, 304

Auto-Discovery Rules 101, 104

Communication Community String 62, 72

Communication Configuration 47, 51, 53, 56,

66, 74, 360

Communication Default Community String 52

Communication Node 67

Communication Region 57, 61, 64

Comparison Params 274

Configuration Per Node Group 292

Configure User Interface 195

Deduplication 269

Deduplication Comparison Params 271

Default Device Credentials 53

Device Profile 95

Diagnostic Selection 293

Discovery Configuration 96, 98, 118, 360

Discovery Seeds 113

Discovery System Object ID Range 106

Hostname Wildcard 61

Incident 313, 315, 357

Incident Category 253

Incident Configuration 211, 241, 248, 260,
269, 273-274, 298,

360

Incident Family 254

Included Address Range 60

Interface 353

Interface Group 139, 141
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Index: forwarding, SNMP trap – Hostname attributes

Interface Settings 158

invoking actions 21

IP Address 355

launching outside NNMi 350

Lifecycle Transition Action 284

Lifecyle Action 283

Management Event Configuration 264-265

Monitoring Configuration 152-153, 360

Node 117, 313, 315, 351

Node Group 128, 358

Node Group Map Settings 199-200, 203

Node Group Map Settings form 202

Node Group Status Settings 179

Node Settings 168

opening 18

Pair Item Configuration 281

Pairwise 276

Pairwise Configuration 279

RAMS Configuration 300

Region Device Credentials 64

Remote NNM 6.x/7.x Event Configuration 263

SNMP Trap Configuration 248

Specific Node Device Credentials 73

Specific Node Settings 73

Status Configuration 178-179, 360

Subnet 356

Subnet Connection Rules 109

Thresholds Settings 162, 165, 172, 175

Trap Forwarding Destination 244

Trap Forwarding Filter Association 245

Trap Forwarding Filters 241

URL Action Object Type 306, 315

URL Actions 303, 305

User Account 36, 39

User Interface Configuration 360

forwarding, SNMP trap 239

Foundry Discovery Protocol 83, 109

frequency, tracking incident 273

G

gathering incidents 211

generating incidents

interface disabled 298

performance threshold 298

generic traps, SNMP 249-251

get command 47

global settings, Ping Sweep 98

graphical user interface

configuring 195

greater than sign (>) 288

groups

interface filters 141

node filters 126-128, 134, 137, 147, 149,
198

node groups 178-179, 200

out-of-box

interface 149

node groups 147

router redundancy 181

Guest role 32-35, 321-323

GUI

configuring 195

H

Headine report, accessing 165, 175

health, network

monitoring 151-152, 181

help

running outside console 31

Hostname attributes 79, 81
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Index: hostname resolution phase – incidents

hostname resolution phase 81

Hostname Wildcard form 61

Hostname Wildcards tab 57, 61

hostnames

assigning wildcards 61

discovery seeds 82

hostNoLookup.conf file 86

HSRP

objects 181

Hypothesis Engine stage 212

I

IANA ifType-MIB definitions 140

ICMP

enabling nodes 67

retries

default 47

node 67

regions 57

timeouts

default 47

nodes 67

region 57

traffic control 47

identifying

attribute pairs 281

IDs, SNMP object 94, 106, 137, 249-251

IfTypes

view 140

images, background

configuring 203

out-of box 205

scaling 206

troubleshooting 206

important nodes

group filter 147

Important Nodes group 147

importing

community string assignments 74

configuration settings 373

SNMP assignments 74

Incident Category form 253

Incident Configuration

form 360

Incident Configuration form 211, 241, 248, 260,

269, 273-274, 298

Incident Family form 254

Incident form 313, 315, 357

incident messages

valid parameters 256

Incident Receiver stage 213

Incident views 327

incidents

accident parameters 285

archiving 387

attributes 214, 229, 237, 276

Causal Engine 212

configurations 229

configuring 211, 214, 216, 226, 246, 248-
249, 261, 265, 276, 279, 283-

284, 291, 293

controlling incoming trap visibility 268

correlating

duplicate 269

pairs 276, 279

creating

categories 253

families 254

deleting 387

descriptions 260
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Index: Incidents workspace – IP addresses

gathering 211

generating

interface disabled 298

performance threshold 298

message format 255, 259

organizing 251

out-of-box actions 22

reducing incoming 266

root causes 251

severity 255

tracking

frequency 273

viewing 298

Incidents workspace 33

Included Address Range form 60

Included Address Ranges tab 57

incoming traps, controlling visibility 268

Instant-On license 372

integrating NNMi with other applications 321

integration URLs

commands 323

forms 322

workspaces 322

interface

adding

custom attributes 302

management mode 192

capability attributes 312

configuring

ifTypes 140

monitoring 158, 181

user 195

creating groups 126

defining groups 139

managed 188

monitoring

configuration 181

not managed 190

out-of-box

actions 22

groups 149

out of service 191

restarting management 184

reviewing group definitions 139

stopping management 184

utilization 165, 175

viewing

disabled incidents 298

Interface form 353

Interface Group

form 139, 141

interface groups

creating additional filters 141

defining 139

filters 139

out-of-box 149

Interface Settings form 158

Interface Type Filters tab 139

Interfaces view 187

Internet Control Message Protocol 47

Internet Explorer

opening console 44

intervals, discovery 79, 98

inventory

verifying discovery 120

Inventory workspace 33

Inventory Workspace view 343

IP Address form 355

IP addresses

configuring ranges 60
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Index: IP Addresses view – loading

discovering

discovery seeds 82

excluided from 83

networks 79

discovery ranges 104

excluding from Spiral Discovery 94

verifying

monitoring configuration 181

SNMP configuration 74

IP Addresses view 187

ipNoLookup.conf file 86

IPv4 addresses 84

ISDN Interfaces group 149

Island Node Group 149

iSPIs

NNM iSPI for Performance

CIAs 214

incidents 298

interfaces 158

management event configurations 229

node groups 126-127

nodes 168

setting default monitoring 154

State Poller 151

threshold monitoring 162, 165, 172, 175

purchasing 319-320

J

JavaScript, enabling 44

Jython methods 256, 285, 290

L

launching

Quick Start Configuration wizard 15

launching from URLs

authentication requirements 321

commands 323, 362-364, 367-370

console 324

forms 350-351, 353, 355-358, 360

menu items 361

views 321, 324, 327, 330, 335, 338, 343,
346, 349

launchsamples.jsp file 321

Layer 2 connection attributes 124

Layer 2 Discovery, verifying 120-121

Layer 2 Neighbors view 338

Layer 2 Rediscovery Interval 79

Layer 3 Neighbors view 338

LDAP

configuration 32, 37, 40

less than sign (<) 288

Level 1 Operator role 32, 35, 322-323

Level 2 Operator role 32, 35, 322-323

licenses

tracking 372

Lifecycle Action form 283

Lifecycle Transition Action form 284

limits

licenses 372

URL

actions 306

commands 323

Link Aggregation group 149

Link Layer Discovery Protocol 109

listing object instances 19

LLDP 109

loading

community strings from file 74

SNMP trap definitions 247

- 406 -



Index: log files – Monitoring Workspace view

log files 28, 43

logins, bypassing 324

Lookup fields 18-19

M

maintaining NNMi 372

Managed Addresses view 189

Managed Interfaces view 188

Managed Nodes view 188

Management Address attributes 81

Management Event Configuration form 264-

265

management event configurations 229

management mode

assigning to interface or address 192

IP addresses 187

not managed 193

out of service 193

stopping or starting 184

views 185

workspace 187

Management Mode workspace 33

Management Mode Workspace view 346

Management Stations

view 262

management stations, configuring

remote 262

SNMPv3 239

map views

configuring Path View 206

Device Profiles 95

invoking actions 21

navigating 75

maps

configuring 198

modifying device symbols 85

node group map settings 198, 206

menu access, controlling 34

menu items, launching outside NNMi 361

messages, incidents

formats 255, 259

parameters 256

methods, Jython 290

MIB file 247

MIB IANA ifType definitions 140

MIB II sysName Values 79

Microsoft Internet Explorer

opening console 44

Microsoft Windows Systems node group 147

modes, management 184

modifying

incident pair configurations 237, 276

Monitor Settings menu item 323

monitoring

configuration settings 181

interface 158

network

devices 152

health 152, 154

nodes 168

router redundance groups 181

suspending all 153

thresholds 162, 165, 172, 175

Monitoring Configuration

form 360

Monitoring Configuration form 152-153

Monitoring Settings command 364

Monitoring workspace 33

Monitoring Workspace view 335
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Index: Mozilla Firefox – NNMi

Mozilla Firefox

launching URL views 324, 327, 330, 335,
338, 343, 346, 349,
351, 353, 355-358,

360

opening console 44

multiple

browser sessions 44

N

Name attributes 79, 81

names

changing user 36, 39-40

incident configurations 249

navigating

map views 75

table views 75

network

configuring devices 238

discovering

approach 88

auto-discovery regions 83

description 76

device profiles 85

discovery seeds 82, 112

everything 91

excluding addresses 93

excluding devices 94

node name choices 79

prerequisites 86

process 77

routers 89

SNMP devices 90

specific devices 88

switches 89

vender devices 92

monitoring

health 151

naming nodes 99

regions 56

updating topology 76

viewing management modes for objects 185

Network Management Framework 251

Network Overview view 330

Networking Infrastructure Devices node group147

Networking Infrastructure Devices view 330

nms-roles.properties file 41-42

nms-users.properties file 41-42

NNM iSPI for Performance

CIAs 214

incidents 298

interfaces 158

management event configurations 229

node groups 126-127

nodes 168

setting default monitoring 154

State Poller 151

threshold monitoring 162, 165, 172, 175

nnm.ports.properties file 44

nnmbackup.ovpl command 385

nnmcommload.ovpl command 74

nnmconfigexport.ovpl command 373

nnmconfigimport.ovpl command 373

nnmconnedit.ovpl command 124

nnmDocs_en.war file 31

NNMi

6.x/7.x

configuring events 263

configuring remote events 261

displaying events as root cause incidents251

gathering incidents 211
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Index: NNMi Status command – Node Settings form

incident configurations 226

viewing management stations 262

actions 22

Advanced

Enable Router Redundancy Group Monitoring153

monitoring router redundancy groups 181

RAMS 300

backing up 385

CIAs 214

components 212

controlling access 32

directories 385

extending capabilities 302

incident configurations 214

integrating with other applications 321

launching from URLs 324

maintaining 372

processes 25-26

properties files 42

restoring 385-386

services 25-26

SNMP trap varbinds 246

tracking licenses 372

troubleshooting access 41

verifying running 370

NNMi Status command 34, 323, 369

nnmincidentcfg.ovpl command 241, 244-245,
247

nnmloadnodegroups.ovpl command 127,
137

nnmloadseeds.ovpl command 114-115

nnmmanagementmode.ovpl command 184

nnmnetloadnodeattrs command 138

nnmrestore.ovpl command 386

nnmsetcmduserpw.ovpl command 42

nnmtrimincidents.ovpl command 387

Node form 117, 313, 315

Node Form view 351

Node Group

form 128, 358

Node Group Map menu item 34

Node Group Map settings

background images 206

troubleshoot map background images 206

Node Group Map Settings form 199-200, 202-
203

Node Group Overview view 330

Node Group Status Settings form 179

node groups

actions 22

configuring

status 178, 200

creating 126

defining 126

filters 126

getting status 368

important nodes 147

maps 203, 205

out-of-box 147

populate 126

protocol traffic control 162, 165, 168, 172,
175

verifying 126

Node Groups

view 127

node identification phase 77

node names

decision tree 81

discovery choices 79

Node Settings form 168

- 409 -



Index: nodename attribute – objects

nodename attribute 367

nodes

adding

custom attributes 302, 313, 315

filters 128, 134

assigning hostname wildcards 61

capability attributes 312

components 181

configuration settings 368

configuring

communication protocol settings 67

connectivity 202

credential settings 73

diagnostics 292-293

group status calculations 178, 200

monitoring 168, 181

name resolution 99

creating groups 126

defining groups 127, 137

deleting 122

discovering

description 76

name choices 79

specific nodes 112

state check 117

filtering

groups 147

group maps 205

Island Node Groups 149

load custom attributes 138

managed 188

monitoring

configuration 181

not managed 189

out-of-box

actions 22

out of service 190

restarting management 184

selecting 75

status 367

stopping management 184

Nodes view 187

Non-SNMP Devices node group 147

Nortel

switches 295

Not Managed Addresses view 190

Not Managed Interfaces view 190

Not Managed mode 193

Not Managed Nodes view 189

Notification stage 213

notifications, sending SNMP 238

O

objects

adding custom attributes 302, 313, 315

capability attributes 312

creating 18, 20

database IDs for URLActions 311

deleting 20

excluding IDs from discovery 94

HSRP 181

listing 19

management modes 192

SNMP system object ID ranges 106

specifying SNMP ID 137, 249-251

State Poller 151

tracked 181

URL action 306
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Index: opening – passwords, changing user

viewing

management modes 185

VRRP 181

opening

console 44

forms 18

operating systems

audit log files 43

command-line access 42

discovery seeds 115

help systems 31

port numbers 44

operator

Boolean 134

roles

level 1 34

Level 1 32-33, 35, 322-323

level 2 34

Level 2 32-33, 35, 322-323

optional filters, adding 315

OR variable 134

organizing incidents 251

out-of-box

actions 22

background images 205

CIAs 214

diagnostics 295

incident

categories 251

configurations 214

families 254

interface

groups 149

Jython methods 290

management event configurations 229

node

groups 147

pairwise configurations 237, 276

SNMP trap varbinds 246

subnet connection rules 111

user roles 32, 35

view filters 147

Out of Service Addresses view 191

Out of Service Interfaces view 191

Out of Service mode 193

Out of Service Nodes view 190

ovjboss services 26, 28

ovstart command 26, 30

ovstatus command 26, 28

ovstop command 26, 30

P

Pair Item Configuration form 281

Pair Items tab 281

Pairwise

form 276

stage 213

Pairwise Configuration form 237, 276, 279

pairwise configurations 237, 266, 276, 278-
279, 281

parameters

backup 385

deduplication 271

incident

actions 256, 285

messages 255

rate 274

restore 386

passwords, changing user 36, 39-41
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Index: Path View – redundancy groups, monitoring router

Path View

attributes 338

configuring maps 206

RAMS 300

PathConnections.xml file 206

percentage, target status values 179

performance

generating incidents 298

monitoring 158

performing automated tasks 21

permanently disabling user accounts 41

permissions, role 33

ping command 47, 151, 295, 362

Ping menu item 34, 323

Ping Sweep, configuring 98

pipe symbol (|)

character 288

pipeline, event 213

Point to Point Interfaces group 149

populate node groups 126

portals, embedding views within 321

ports

numbers 44

prerequisites

discovery 86

pairwise configurations 278

prerequisites, discovery 86

problems

Causal Engine 212

processes

configuring discovery 96

description 26

NNMi 25

starting 26

stopping 26

verifying running 26

profiles, device 85, 95

progress

discovery 117

properties files 42

protocols

auto-discovery rules 83

communication 47

defaults 47

devices 66

configuring network regions 56

region 57

SNMP 50

purchasing HP iSPIs 319-320

Q

Quick Find 18-19

Quick Start Configuration wizard 15

Quick View 18

R

RAMS Configuration form 300

RAMS data and Path View 300

ranges

IP addresses 60, 104

SNMP system object ID 106

rate configuration 266, 273-274

Rate Configuration tab 273-274

Rate stage 213

read-only access 321

real-time data 300, 363, 367-368

Rediscovery Interval 98

reducing incoming incidents 266

redundancy groups, monitoring router 181
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Index: refreshing – routers

refreshing

console window 44

Region Device Credentials form 64

regions

assigning hostname wildcards 61

configuring

communication 57, 62, 72

credential settings 64

network protocols 56

USM settings 55, 65

Regions tab 56-57, 60, 62, 72

Relate stage 213

relative URLs 206

remote

event configuration 226, 261, 263

management stations 262

Remote NNM 6.x/7.x Event Configuration form263

removing

incidents 387

reports, audit 43

Request for Comments 250

requirements

pairwise configurations 278

URL access authentication 321

resolution, node name 99

Resolver stage 213

restarting management 184

restoring

NNMi 385-386

system role 41

results

discovery 116, 120-121

discovery seeds 117-118

retry behavior 50-51

reviewing node group definitions 127

RFC 250

roles

accessing

forms 322

menus 34

workspaces 322

administrator 322-323

assigning 32

assigning management modes 192

Guest 32, 35, 321-323

launching commands 323

operator

Level 1 32, 35, 322-323

Level 2 32, 35, 322-323

system 41

System 32-33, 35

user

changing 36, 39-40

deleting 41

determining account 33

out-of-box 32, 35

Web Service Client 32, 35, 323

root causes

SNMP traps 251

round-robin DNS 86

Route Analytics Management System 300

Router Redundancy Group

monitoring 153

Router Redundancy Member

form 181

routers

Cisco 295

discovering networks 89, 112

Island Node Group 149

monitoring 181
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Index: Routers – showView

Routers

node group 147

Routers view 330

rows

deleting 20

rules, auto-discovery 83

configuring 101

basic settings 102

Ping Sweep 98

custom 88

discovery seeds 82

everything 91

IP addresses 93, 104

object IDs 94

overview 88

routers 89

SNMP devices 90

switches 89

system object IDs 106

vendors 92

rules, subnet connections 84, 109, 111

running

help outside console 31

verifying

processes 26

services 28

runTool 361

S

scaling map background images 206

SDK licenses 372

security check 34

security, user-based model

configuring 47, 55, 65

credentials 50-51

default settings 54

importing SNMPv3 settings 74

Quick Start Configuration wizard 15

SNMP prerequisite 86

seeds, discovery 81-82, 88, 112-115, 117-
118

selecting

nodes 75

semicolon (;) character 288

services

NNMi 25-26

ovjboss 26, 28

starting 30

State Poller 95, 151, 181

stopping 30

verifying running 28

setting up command-line access 42

settings

auto-discovery

basic 102

Ping Sweep 98

communication protocols 47

community strings 52, 62, 72

exporting configuration 373

importing configuration 373

node group maps 198, 206

verifying communication 75

severity, incident 255

Show All Incidents menu item 34

Show All Open Incidents menu item 34

show commands 295

Show Members menu item 34

showForm 350

showMain 324

showView 324
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Index: sign-in access, configuring – Spiral Discovery

sign-in access, configuring 32, 35, 37, 40, 42

Sign In/Out Audit Log command 370

Sign In/Sign Out Audit Log menu item 34, 323

Sign Out

command 370

menu item 323

signing in

console 46

URL access 321

signing out from console 46

Simple Network Management Protocol 47

Smart Plug-ins, purchasing 319-320

SNMP

configuring

discovery 96

traps 239, 241, 245, 268

default community strings 51

discovering

devices 90

networks 77

displaying traps 251

enabling nodes 67

loading trap definitions 247

phase 81

ports

default 47

nodes 67

regions 57

protocol version 50

retries

default 47

nodes 67

regions 57

sending notifications 238

specifying object ID 137, 249-251

State Poller 151

system object ID ranges 106

timeouts

default 47

nodes 67

regions 57

traffic control 47

trap incident configurations 211, 216, 246

trap varbinds 246

traps 211, 244, 259

verifying configuration 74

SNMP Trap Configuration

form 248

tab 246

SNMP Trap Receiver stage 213

SNMP traps

disable trap definitions 247

SNMPv1 15, 47, 51, 72, 74, 86, 238, 249-251

SNMPv2 15

SNMPv2c 47, 50-51, 72, 74, 86, 238, 250-
251

SNMPv3 50, 74, 86, 239

Software Loopback Interfaces group 149

SONMP 83, 109

space character 288

special characters in action arguments 288

Specific Node Device Credentials form 73

Specific Node Settings

form 73

tab 66-67, 74

Spiral Discovery 76

adjusting discovery interval 98

configuring 88, 95

discovering

everything 91
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Index: stages – table views

routers and switches 89

excluding

SNMP object IDs 94

specirfic IP addresses 94

fine-tuning 85

process 77

speeding up 86

stages

Causal Engine 212

event pipeline 213

stand-alone help 31

starting

management 184

processes 26

services 30

State Poller

default monitoring 154

enabling 153

service 95, 151, 181

stations, remote management 262

status

configuring targets 179

Island Node Group 149

verifying

address connectivity 181

NNMi 369

processes 26

Status Configuration

form 360

Status Configuration form 178-179

Status Details command 368

Status Details Command menu item 323

Status Details menu item 34

Status Poll

command 367

menu item 34, 323

stopping

management 184

processes 26

services 30

Store Bulk stage 213

strings, community

configuring default 51

setting 52, 62, 72

subnet

connection rules 84, 109, 111

Subnet Connection Rules form 109

Subnet form 356

success, discovery seed 117

suspending all monitoring 153

Sweep, Ping 98

switch

discovering networks 89

switches

Cisco 295

Island Node Group 149

Nortel 295

Switches view 330

Synoptics Network Management Protocol 83,
109

syntax, URL Actions 306

system account password, changing 41

System Name attributes 79, 81

system object ID ranges 106

System role 32-33, 35

system role, restoring 41

T

table views

default 324
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Index: tabs – Tracked Objects

deleting rows 20

invoking actions 21

navigating 75

tabs

Action Configuration 283-284

Additional Filters 128, 141

Community Strings 57, 62, 72

Custom Attributes 302, 313, 315

Default Community String 51

Default Device Credentials 53

Device Credentials 64

Discovery Seeds 112

Hostname Wildcards 57, 61

Included Address Ranges 57, 60

Interface Type Filters 139

Management Event Configuration 264-265

Pair Items 281

Pairwise Configuration 237, 276, 279

Rate Configuration 273-274

Regions 56-57, 60, 62, 72

SNMP Trap Configuration 246, 248

Specific Node Settings 66-67, 74

target status 179

tasks

auto-discovery 89-94, 101

configuring

communication protocols 47

management events 264-265

node group map settings 199

subnet connection rules 109

controlling SNMP object ID ranges 106

discovery 96

monitoring network health 151-152

performing

automated 21

remote NNM 6.x/7.x event configuration 261,
263

SNMP trap configuration 248

subnet connection rules 109

verifying discovery 116

team communication 44

Telnet menu item 34

Temporary license 372

text files 137

threshold

configuring 178

incidents 298

monitoring 162, 165, 172, 175

target status 179

Thresholds Settings form 162, 165, 172, 175

time period

incident frequency 273

timeout

behavior 50-51

toolbar

form 20

tools menu 34

tools, console

administrator 14-15

running outside 321

topology maps

building 300

island node groups 149

updating 76, 122

Topology Maps Workspace view 330

traceroute command 295, 362

Traceroute menu item 34, 323

Tracked Objects

monitoring configuration 181
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Index: tracking – URL Actions

tracking

incidents

frequency 273

licenses 372

traffic control 47

Trap Forwarding Destination form 244

Trap Forwarding Filter Association form 245

Trap Forwarding Filters form 241

traps, SNMP

configuring

forwarding destination 244

forwarding filters 241, 245

incidents 216, 246, 248

security settings 239

trap forwarding 239, 241

controlling incoming visibility 268

displaying 251

gathering incidents 211

loading definitions 247

object ID formats 250-251

specifying Object IDs 249

vabinds 246

troubleshooting

access 41

Causal Engine 212

URLs 206

Troubleshooting workspace 33

Troubleshooting Workspace view 338

Type Enforcer stage 213

U

UI

configuring 195

UNIX

background images 205

DNS prerequisite 86

log files 28, 43

nms-roles.properties file 41-42

nms-users.properties file 41-42

nnm.ports.properties file 44

nnmbackup.ovpl command 385

nnmcommload.ovpl command 74

nnmDocs_en.war file 31

nnmloadseeds.ovpl command 114-115

PathConnections.xml file 206

updating

topology maps 76, 122

URL access

authentication requirements 321

integration URLs

commands 323

workspaces 322

launching

commands 362-364, 367-369

console 324

forms 350, 353, 355-358, 360

menu items 361

message report 370

NNMi 321

Sign In/Out Audit Log command 370

Sign Out command 370

views 324, 327, 330, 335, 338, 343,
346, 349

troubleshooting 206

URL Action Object Type form 306, 315

URL Actions

adding optional filters 315

Author 304

capability attributes 312

controlling 303
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Index: user-based security model – views

custom attributes 313, 315

Custom Incident Attributes 311

database object IDs 311

form 303, 305

limitations 306

syntax 306

user-based security model

configuring 47, 55, 65

credentials 50-51

default settings 54

importing SNMPv3 settings 74

Quick Start Configuration wizard 15

SNMP prerequisite 86

User Account form 36, 39

User Interface Configuration

form 360

users

auditing activity 43

changing passwords 41

determining account roles 33

disabling accounts 41

editing accounts 36, 39-40

out-of-box roles 32, 35

restoring system role 41

USM

configuring 47, 55, 65

credentials 50-51

default settings 54

importing SNMPv3 settings 74

Quick Start Configuration wizard 15

SNMP prerequisite 86

utilization

WAN and interface 165, 175

V

varbind values 238, 259, 274, 311

varbinds, out-of-box 246

vendor devices

discovering 92

vendor specific traps, SNMP 251

verifying

address connectivity 181

communication settings 75

configuration for IP addresses 74

discovery 116

inventory 120

Layer 2 120-121

seeds 117

nms-roles.properties file 41

NNMi running 370

node groups 126

processes running 26

services running 28

user account deletion 41

version numbers

SNMP protocols 50

viewing

incident pair configurations 237, 276

interface disabled incidents 298

interface group

definitions 139

management mode for objects 185

node group

definitions 126

remote management stations 262

views

Configuration Workspace 349

controlling incoming trap visibility 268
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Index: visibility, incoming traps – workspaces

ifTypes 140

Incidents 327

Interface Group 139

Interfaces 187

Inventory Workspace 343

IP Addresses 187

launching outside NNMi 324

Managed Addresses 189

Managed Interfaces 188

Managed Nodes 188

Management Mode Workspace 346

Management Stations 262

Monitoring Workspace 335

Node Groups 127

Nodes 187

Not Managed Addresses 190

Not Managed Interfaces 190

Not Managed Nodes 189

Out of Service Addresses 191

Out of Service Interfaces 191

Out of Service Nodes 190

predefined view filters 147

Topology Maps Workspace 330

Troubleshooting Workspace 338

workspaces 33

visibility, incoming traps 268

VLAN Interfaces group 149

Voice Interfaces group 149

VRRP

objects 181

W

WANs

Island Node Group 149

threshold monitoring 165, 175

Web portals, embedding views within 321

Web Service Client role 32-33, 35, 323

well-configured DNS 86

wide area networks

Island Node Group 149

threshold monitoring 165, 175

wildcards, assigning hostnames 61

Windows

background images 205

DNS prerequisite 86

log files 28, 43

nms-roles.properties file 41-42

nms-users.properties file 41-42

nnm.ports.properties file 44

nnmbackup.ovpl command 385

nnmcommload.ovp commandl 74

nnmDocs_en.war file 31

nnmloadseeds.ovpl command 114-115

PathConnections.xml file 206

wizard, Quick Start Configuration 15

workspaces

accessing 322

configuration 16

views 33
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